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Preface 

ARE YOU INTERESTED in creating your very own Macintosh applications? 
Is the next great Macintosh software miracle tucked away in your 
brain? If so, you've come to the right place. 

With this new edition of the Macintosh C Programming Primer in 
hand and a copy of THINK C on your hard drive, you've got everything 
you need to enter the wonderful world of Macintosh programming. The 
Mac Primer uses step-by-step approach that shows you how to add 
each element of the Macintosh user interface to your programs. You'll 
start by learning how Macintosh windows are created. Next, you'll 
learn how to draw text and graphics inside your windows. As you 
progress through the book, you'll learn about events, menus, dialog 
boxes, and much, much more. 

The Mac Primer is chock-full of reusable sample code. Each program 
is discussed in detail. Nothing is left as an exercise for the reader. 
There's no better way to learn the art of Macintosh programming. 

For readers of the first edition, this edition of the Mac Primer pre­
sents a boatload of brand-new material. All the source code has been 
rewritten and specifically designed with System 7 in mind. You'll 
learn how to create System 7-savvy programs using the latest versions 
of THINK C and ResEdit. You'll also get the inside scoop on the new 
additions to the Inside Macintosh family. 

Get yourself a copy of THINK C, grab your Mac Primer, and we'll 
meet you inside. 

Dave Mark 
Arlington, VA 

Cartwright Reed 
Philadelphia, PA 
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Introduction 

The Macintosh Programming Primer 
is a complete course in the art of 

Macintosh programming. With this 
book and Symantec's THINK C, you 
can learn to program the Macintosh. 

1 
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No OTHER COMPUTER is like the Macintosh. Some computers look like 
it, others claim they work like it, but the Mac remains unique. Writing 
programs for the Macintosh is also a unique process, and the 
Macintosh Programming Primer is the shortest, best path toward 
becoming a good Mac programmer. 

At the heart of the Macintosh is the Toolbox, a collection of over 
1,400 procedures and functions that give you access to the Macintosh 
environment. The Mac Primer will teach you how to use the Toolbox; 
that is, how to add the power of pull-down menus, windows, and scroll 
bars to your programs. 

This book serves as a bridge to the Macintosh way of programming. 
If you can't wait to code, and you've already installed THINK C on 
your hard drive, skip to the beginning of Chapter 3 to get started on 
your first Macintosh application. If you have the time, though, keep 
right on reading. 

If you've read the first edition of the Macintosh Programming 
Primer, welcome back! One of the most important changes you'll find 
in this edition is the comprehensive coverage of System 7, Apple's 
exciting new operating system. All of the sample programs presented 
in this book were written with System 7 in mind. You'll learn how to 
send and receive Apple events, record and play sounds, use the 
Notification Manager, and much more. With the Mac Primer in hand, 
you'll be able to add System 7 savvy to your own applications. 

If you're new to Macintosh programming, and wonder what "Apple 
events" are, or what the "Notification Manager" is, the Mac Primer is 
the perfect place to start. By way of concise source code examples, 
you'll quickly master the basics and the newest aspects of the 
Macintosh operating system. The concepts in this book are presented 
side by side with a complete set of source code examples. We don't skip 
the basics in bringing you up to speed. 

The Macintosh Way 

Nowadays, the Macintosh line is successful, highly praised, emulated, 
and affordable. From the PowerBooks to the high-powered Quadra 
workstation, the Macintosh is on everyone's A-list. When the first 
Macintosh was introduced in 1984, however, people were perplexed: It 
was like no computer they had ever seen-a beige box with a little 
screen and a mouse. People called the Macintosh a toy because it had 
a graphical user interface, and pictures were not the way normal 
computers communicated. 

3 



4 Macintosh C Programming Primer 

We've come a long way since the '80s. Microsoft, Hewlett-Packard, 
and finally IBM have made their way to Apple's door. Graphical User 
Interfaces (GUis) are a dime a dozen, mice are legion, and hardware 
standards espoused by Apple, such as NuBus and SCSI (Small 
Computer Systems Interface) have propagated throughout the indus­
try. Apple naysayers have disappeared, replaced by company reps who 
claim their computers work "just like a Mac." They might be right, if 
the Mac were just another pretty interface. 

The Mac's elegance, ease of use, and power stem from a combina­
tion of interface, Toolbox, and resources. 

• The Macintosh interface. Anyone who's ever used a Macintosh is 
familiar with the Mac interface. Pull-down menus, movable win­
dows, scroll bars, and graphics all combine to make the Macintosh 
one of the friendliest computers ever designed. 

• The Toolbox. Comprehensive routines were defined in the 
Macintosh ROM that drove the interface and allowed software 
designers to write powerful, easy-to-use applications. Whether 
you're building a Sanskrit word processor, or just need to find out 
what time zone you're in, the Mac Toolbox designers have prepared 
the path for you. 

• The use of resources. The building blocks for all software on the 
Macintosh, resources store program information in a series of 
templates in the program file, simplifying the creation and modifi­
cation of Mac programs. 

These three ingredients-interface, Toolbox, and resources-com­
bine to make the Macintosh the most versatile computer ever made. 
Advanced capabilities, such as recording and playing back video (a 
kind of "MacTV''), virtual memory, and personal file-sharing are not 
only featured in the new Macs of the '90s, but are also available in 
Macs made almost a decade ago by installing new versions of the 
Macintosh operating system. The careful planning that went into the 
original Mac has paid off handsomely, as the Mac line continues to 
evolve and improve. 

To write successful applications for the Macintosh, the would-be 
Mac programmer must understand how the interface, the Toolbox, and 
resources work together. First, let's look at the most visible of the 
three: the Macintosh user interface. 
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The Macintosh Graphical User Interface 

The Macintosh makes a great first impression on new users with its 
sophisticated user interface. Figure 1.1 shows some of the distinctive 
elements of the Mac "look." Because neophytes understand and use 
the windows and menus of Mac applications intuitively, the Macintosh 
interface represents an impressive improvement over both "command­
based" interfaces, such as MS-DOS, and windowed interfaces, such as 
Microsoft Windows, which is built on top of MS-DOS. Each element of 
the interface-windows, menus, dialog boxes, and icons-has a specific 
function associated with it, and extensive guidelines exist for the 
proper use of each element. With the implementation of System 7, the 
interface became more visually exciting, with brightly colored icons 
and friendly balloons of text that appear when you click the mouse on 
something you want to know about. 

Of course, pretty pictures aren't enough. The beauty of the Mac 
interface lies in how it is created. Each part of the interface is 
manipulated by a series of routines in the Macintosh ROM. For 
example, you can create an application's window with one call to the 
Macintosh ROM. 

The routines that underlie the interface-that build windows, 
control printing, and draw menus- are known collectively as the 
Macintosh Toolbox. 

LJ 
Applications 

LJ 
Utiliti.s 

Bill: 

Blll J. Craig, V.P. R&D 

Neo.atly v rangH tht> icons 
in tht actln w;ndow 

Jill Dickson, V.P. Marketing 
Product Launch 

2 • 4 just a note to let you now that we've completed the 
10 11 marketing plans !or our three new product lines. Jim in 

,.,.__-+=_..,..,......_17,,......1..,...9 graphics has done some logos and t-shirts. 

23 24 25 Since we've announced a shipping date in January, 
1=--t=-i.,30:-r.3-:-1 -1-1 think you could start hiring some programmers? 

Figure 1.1 The Macintosh desktop (circa 1992). 
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The Macintosh Toolbox 

The Toolbox can be thought of as a series of libraries that make it easy 
for you to create the features indigenous to Macintosh applications. 
For example, the Macintosh Toolbox routine GetNewWindow () creates 
a new window for use in your application. 

Using Toolbox calls to create your applications gives the results a 
distinctive Macintosh look and feel. Operations common to most appli­
cations, such as cutting, copying, and pasting, are always handled in 
the same way, which makes it easier to learn a new application. 

The Toolbox routines are grouped functionally into Managers, each 
of which is responsible for one part of the Macintosh environment 
(Figure 1.2). 

The Macintosh Toolbox undergoes constant updating and modifica­
tion; each new system revision gives you some shiny new tools as well 
as the old standbys to work with. As new routines are added to the 
Toolbox, Apple cleans up problems with older routines. 

This brings us to System 7. 
Apple has provided new Toolbox calls that revolutionize the pro­

grammer's ability to control text, audio, animation, and even real-time 
video on the Mac screen. These functions can all be incorporated into 
your program with just a few lines of code. At the same time, lower­
level routines allow you to fine-tune any of these new features. Later 
in the book, we'll talk more about the revolution in Mac programming 
these new system tools provide. 

The Macintosh graphic interface and the Toolbox are two of the 
features that make the Mac unique. A third is the concept of 
resources. 

Dialog 
Manager 

Control 
Manager 

Sound 
Manager 

Scrap 
Manager 

Notification 
Manager 

Menu 
Manager 

Window 
Manager 

Printing 
Manager 

Resource 
Manager 

QuickDraw 

Event 
Manager 

File 
Manager 

Figure 1.2 Parts of the Toolbox. 

Font 
Manager 
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Introduction 

Although the Macintosh line has expanded greatly, the basic 
compatibility of the different Macintosh models has been preserved. 
Yet, more powerful machines always provide more choices-and 
more decisions. When the only available Mac workstations were the 
Macintosh and the Mac Plus, software developers thought they had 
a certain flexibility in the way they followed the Mac programming 
guidelines provided by Apple. Now, in the midst of portables, 
workstations, and midline Mac CPUs that have widely differing 
capabilities, the successful developer hews closely to the Macintosh 
standards. 

Resources 

7 

If the Toolbox is the library of routines that make up the Macintosh 
interface, resources are the data your program uses to execute these 
library calls. GetNewWindow (), the Toolbox call that creates a new 
window, requires you to specify window parameters, such as size, 
location, and window type. To do this, you create a resource containing 
that information, passing the resource to GetNewWindow (). 
GetNewWi ndow () uses the resource information to build the 
requested window. 

Resources come in various types, each relating to a particular 
element of the Macintosh interface. For example, a resource of type 
WIND contains all the information necessary to build a window. There 
may be a number of resources of type WIND, but there is only one WIND 

type, which is identical for all Mac applications. 
Resources are integrated into the design of the Macintosh. Each Mac 

application file may possess dozens of resources. This simplifies many 
of the tasks of the applications programmer. For example, resources 
make it easy to localize a program for a different area. If you want to 
sell your program in France, say, it is relatively easy to replace 
resources containing English text with their French equivalents. 

Resources are a lso essential in developing the complex code that 
drives the Macintosh interface and hardware. Because they can easily 
be copied from one program to another, menus and dialog boxes need 
not be created more than once. After you have built up a collection of 
programs, creating new ones may begin with a cut-and-paste session 
with your existing programs. 

To edit resources, Apple developed a program called ResEdit, 
which allows you to edit any of the resources in Macintosh Primer 
programs. You can also use ResEdit to explore other Macintosh appli­
cations-even system files! Because these resources exist as part of 
the completed application, they can be edited without recompilation. 
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We make extensive use of version 2 of ResEdit throughout the 
Mac Primer, and describe the new resources required for successful 
System 7 programming. Even if you've never worked with ResEdit, 
you'll find the instructions in the Macintosh Primer complete and easy 
to follow. · 

The Macintosh interface, Toolbox, and resources are the three 
intertwined subjects we'll cover using THINK C and ResEdit to create 
standalone Macintosh applications. The next sections discuss our 
approach to learning about these issues. 

About the Book 

Most Macintosh reference books, such as Inside Macintosh and 
Macintosh Revealed, are excellent texts for those who already under­
stand Macintosh programming. They can be frustrating, however, if 
you're new to the Macintosh programming world. The Mac Primer 
bridges the gap for those of you who are just learning the basics of Mac 
programming. 

Our aim is to help you write properly structured Mac applications. 
If you're used to programming on an MS-DOS computer or a UNIX 
system, the Mac Primer is the perfect place to start your Mac pro­
gramming education. Our formative years were spent programming 
under UNIX on machines like the PDP-11 and the VAX-11/780; we've 
also spent a lot of time with IBM PCs and compatibles. We wrote the 
Macintosh Programming Primer with you in mind. 

If you've programmed on the Macintosh before, but haven't checked 
out System 7, you'll find a lot of solid code in the Primer that 
should help you implement new System 7-friendly versions of your 
applications. 

What You Need to Know 

There are only two prerequisites for reading this book. Before starting 
the Macintosh Primer, you should already have basic Mac experience: 
You should be able to run Macintosh applications and have a good feel 
for the Mac user interface. In addition, you should have some experi­
ence with a programming language, such as C, Pascal, or BASIC. If 
you have no programming experience, or if your computer language 
skills are rusty, get a book on the C language to supplement this book. 
Learn C on the Macintosh by Dave Mark is designed for this purpose 
and comes with a custom version of the THINK C language on disk. 

The Macintosh C Programming Primer examples are all written in 
C, using the THINK C development environment. Our general 
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approach, however, emphasizes the techniques involved in program­
ming with the Mac Toolbox. The skills you learn will serve you no 
matter what programming language or environment you intend to use 
in the future. 

Why We Chose THINK C 

Many development environments are available to the Mac program­
mer. The Macintosh Programmer's Workshop (MPW) is a 
complex and powerful development system written and marketed by 
Apple. Most of Apple's internal development is done with MPW, and 
many of the large Macintosh software development houses have made 
MPW their first choice. MPW uses an "everything but the kitchen 
sink" approach to software development. The basic system consists of 
an editor shell that allows you to edit your source code as well as build 
and execute complex command scripts. You can do just about anything 
in MPW, but it is definitely not a system for beginners. In addition to 
learning the editor and shell, you have to install, configure, and (oh, 
yes) pay for your choice of compilers. You can buy C, Pascal, and even 
FORTRAN compilers for MPW. MPW is ideal for complex, 
multilanguage development efforts, but not for learning to program 
the Macintosh. 

THINK C is a powerful and friendly development environment. It 
has concise, accurate documentation. For those inevitable bugs, it has 
the best debugging utilities on the market. It also has excellent 
support for programmers who write exclusively for System 7. 

Finally, THINK C is still reasonably priced (Figure 1.3). 

THINK 
c 

Macintosh 
Programmer's 

Workshop (MPW) 

Figure 1.3 Lunch economics. 

80 Lunches 

30 Lunches 
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Using THINK C 

THINK C is an integrated development environment. The source code 
editor follows all the standard Macintosh conventions and is very easy 
to use. The compiler is smart: It keeps track of the files you're cur­
rently working with, noting which have been changed since they were 
last compiled. THINK C recompiles only what it needs to. 

THINK Chas a well-thought-out Macintosh interface. For example, 
to build a standalone application, pull down the Project menu and 
select Build Rpplication. Installation is simple: Just pull the floppies 
out of the box, copy the files onto your hard drive, and go! 

THINK C also comes with integrated debugging utilities that allow 
you to test-drive your program while monitoring its progress in other 
windows. The debugging utilities also work with other Macintosh 
debugging tools, such as MacsBug and TMON. 

Inside THINK C 

The project file is unique to Symantec's C and Pascal development 
environments. It contains the names of all of your source code files, as 
well as the name you'll eventually give to your application. The project 
file also contains compilation information about each source file, such 
as the size of the compiled code (Figure 1.4). 

THINK C comes with class libraries similar to MacApp, Apple's 
ready-made library of user interface routines. THINK C debugging 
facilities are without peer. You can use THINK C to write programs 
that will take full advantage of the most advanced features of the Mac 
OS. All of these features are supported in the way Apple intended. 
THINK C also provides routines to support extensions to Apple's 
HyperCard, or Silicon Beach's SuperCard. 

lllorldClock. n 
Name obj size 

l..~;;.~;.;.;;.k..:.~ ................................... 
8342 ~ 
1642 ....................... 

-0 
~ 

Figure 1.4 Think C Project Window. 
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THINK C also comes with a full complement of utilities, including 
ResEclit, the resource editor mentioned earlier, and useful code on 
various types of Mac projects, including text editors, control panel 
devices (cdevs), and desk accessories. 

Writing Macintosh Applications 

Most Macintosh applications share a basic structure (Figure 1.5). They 
start off by initializing the Toolbox data structures and routines that 
support the Macintosh user interface. Then the application enters an 
event loop and patiently waits for the user to do something-hit a key, 
move the mouse, or some other action. Events outside the application 
are also checked: Desk accessories may be used, or disks may be 
inserted. No matter how complex the Macintosh program, this simple 
structure is maintained. 

At the heart of the Macintosh Programming Primer is a set of 
seventeen sample applications. Each builds on the basic program 
structure to provide successively more sophisticated use of the 

Figure 1.5 How a Macintosh application works. 
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Macintosh Toolbox. Each new chapter constructs a more powerful 
implementation of the basic program structure. Chapter 3 programs 
show how to create windows and draw inside them. Chapter 4 illus­
trates how to handle events (including Apple events). Chapter 5 
implements menus, and Chapter 6 makes use of dialogs. Chapter 7 
presents a potpourri of Macintosh applications, each designed to 
showcase a different part of the Macintosh Toolbox. 

Each Mac Primer example program is presented as completely as 
possible, and each program listing is discussed extensively. Nothing is 
left as an "exercise for the reader." Each chapter contains complete 
instructions and figures for entering, compiling, and running the 
programs using THINK C. 

Chapter Synopses 

The Macintosh Primer is made up of nine chapters and seven 
appendices. This introductory chapter provides an overview and starts 
you on your way. Chapter 2 starts by stepping through the installation 
of THINK C and ResEdit. Then THINK C basics are introduced. We 
present the standard C approach to the classic Hello, World program 
(Figure 1.6), and discuss drawbacks. We then go on to illustrate the 
programming conventions we'll use in the Primer. 

press « return» to ewit 

Hel lo, world!I 

Figure 1.6 Hello, World. 
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Chapter 3 starts with an introduction to the fundamentals of 
drawing on the Macintosh using QuickDraw. The Window Manager 
and windows are discussed. We then introduce resources and the 
Resource Manager. 

QuickDraw, the Window Manager, and resources are closely 
related. Windows are drawn using QuickDraw commands from 
information stored in resource files. 

l 
Four programs are introduced in Chapter 3. The Hello2 program 

introduces some of the QuickDraw drawing routines related to text; 
the Mondrian program (Figure 1.7) demonstrates QuickDraw shape­
drawing routines. ShowPICT (Figure 1.8) illustrates how easy it is to 
copy a picture from a program like MacDraw or MacPaint into a 
resource file, then draw the picture in a window of your own. Finally, 
as a bonus for completing the first three programs, you can try the 
FlyingLine (Figure 1.9), an intriguing program that can be used as a 
screen saver. 

Figure 1. 7 Mondrian. 
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ShowPICT 

• 

Figure 1.8 ShowPICT. 

Chapter 4 introduces one of the most important concepts in 
Macintosh programming: events. Events are the Mac's mechanism for 
describing the user's actions to your application. When the mouse 
button is clicked, a key is pressed, or a disk is inserted into the floppy 
drive, the operating system lets your program know by queueing an 
event. The event architecture can be found in almost every Macintosh 

Figure 1.9 FlyingLine. 
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application written. This chapter presents the architecture of the main 
event loop and shows how events should be handled. EventTracker, 
Chapter 4's first program (Figure 1.10), provides a working model of 
the event architecture. It also demonstrates how to receive Apple 
events from other applications. Updater, the second program, 
demonstrates the proper way to handle update events in windows 
(Figure 1.11). The final Chapter 4 program, EventTrigger, demon­
strates how to send Apple events to other applications (Figure 1.12). 

Chapter 5 shows you how to add the classic pull-down, hierarchical, 
and pop-up menus to your own programs. Chapter 5's program, 
WorldClock (Figure 1.13), uses all three kinds of menus. 

Chapter 6 introduces dialogs and alerts. Dialog boxes are another 
intrinsic part of the Macintosh user interface. They provide a vehicle 
for customizing your applications as you use them. Alerts are simpli­
fied dialogs, used to report errors and give warnings to the user. 

The Reminder program in Chapter 6 (Figure 1.14) uses dialogs, 
alerts, and the Notification Manager to allow you to set an alarm. The 
application then starts a countdown and notifies you when it goes 
off-even if you're running another application. 

OS Euents 
activateEv t 
High Level Event: Apple event : Open Application 
updateEvt 
key Down 
key Down 
key Down 
autoKey 
autoKey 
autoKey 
mouseDown 
mouse Up 
mouseDown 
mouse Up 
mouse Down 
mouse Up 
osEvt : Suspend event 
osEvt : Resume event 
mouseUp 
osEvt : Suspend event 
osEvt : Resume event 
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Figure 1.10 EventTracker. 
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Figure 1.11 Updater. 
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Figure 1.12 EventTrigger sends events to EventTracker. 

These events were 
caused by EventTrigger. 
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Figure 1.13 WorldClock. 
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Figure 1.14 Reminder. 
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Chapter 7, the final programming chapter, contains a potpourri of 
programs illustrating concepts, such as error-checking, memory 
management, printing, recording and generating sound, adding scroll 
bars to windows, and file management. Each program explores a 
single topic and provides a working example of reusable code. 

Chapter 8 will teach you how to add a custom icon to your applica­
tion. Then, you'll learn how to create files that will automatically 
launch your application when they're clicked on. 

After you have a handle on the essentials of Macintosh program­
ming, what's next? Chapter 9 talks about some of the tools available to 
help you with your development efforts. It looks at Inside Macintosh 
and some of the other Mac technical documentation, such as the Apple 
Event Registry and other new technical documentation on System 7. It 
also looks at software tools, from compilers to debuggers, as well as 
Apple's Developer Program and other Macintosh technical resources. 

Appendix A is a glossary of the technical terms used in the 
Macintosh Primer. 

Appendix B contains a complete listing of each of the Mac Primer 
applications, presented in the same order in which they appear in the 
book. 

Appendix C contains a THINK C command summary. Each THINK 
C menu item is introduced, along with any accompanying dialog boxes 
and alerts. We also discuss some of the changes in version 5 of 
THINKC. 

Appendix D summarizes the THINK C debugger. The operation of 
the debugger is discussed, and each menu item and window is detailed. 

Appendix E covers some debugging techniques that may be helpful 
in the THINK C environment. 

Appendix F contains a short discussion of HyperCard 2.1 XCMDs, 
along with a sample XCMD written in THINK C. 

For non-HyperCard aficionados, XCMDs are procedures written in 
C or Pascal that can be called from within HyperCard. XCMDs allow 
you to go beyond the limits of HyperCard, performing functions not 
normally available from within HyperCard. 

Appendix G is a bibliography of Macintosh programming references. 
Appendix H features The New Inside Macintosh series coming soon 

from Addison-Wesley Publishing Company. 
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How to Use This Book 

Each Macintosh Primer chapter is made up of the main text and tech 
blocks. The main text is the narrative portion of the book. Read this 
first. It contains the information you need to input and run the 
example programs. Because we've placed a premium on getting you 
going immediately, we have you run the program before discussing 
how the code works. Impatient programmers are invited to go directly 
to Appendix B, which contains listings of all the programs discussed in 
the book. If you have questions after typing in the programs, ref er to 
the chapter in which the program is discussed. If you prefer a more 
sedate pace, read a chapter at a time, type in the programs, and test 
them as you go. 

At some points, we expand on the narrative with a tech block, 
indicated by a distinctive gray background. It's OK to ignore them 
during your first read-through. An icon at the left of a tech block tells 
you what the tech block subject matter is. For example: 

Sometimes System 7 provides a way of doing things that is 
incompatible with earlier systems. This kind of tech block shows you 
how to handle these incompatibilities. 

l 
This kind of tech block continues the current issue being discussed 
at a deeper, more bit-twiddly level. Such tech blocks can be passed 
by in your first reading. 

This kind of tech block gives historical perspective to why a certain 
feature is the way it is, or discusses the way earlier versions of the 
Mac OS handled specific situations. Forward-looking, healthy­
minded individuals unconcerned with the past can skip these tech 
blocks. 

This final kind of tech block contains a warning about a technique or 
coding situation where novice Mac programmers may go astray. 
Read these carefully. 

I I 
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Macintosh C Programming Primer 

Several important terms and conventions are used throughout the 
Macintosh Primer. Whenever you see a notation like this: 

(VI:256-272) 

it refers to a volume of Inside Macintosh and a set of pages within that 
volume. The example here refers to Volume VI, pages 256 to 272. 
References to Tech Notes, documentation from Apple's Macintosh 
Developers Technical Support Group, are annotated like this: (TN :78) 
(referring to Tech Note 78). (See Chapter 9 to find out how to get Tech 
Notes.) These references to Inside Macintosh and Tech Notes are 
intended to help readers who are interested in a further discussion of 
a topic. 

All of our source code is presented in a special font. For example: 

i = 0; 
Make It So (); 

Toolbox routines and C functions are also in the code font when 
they are described in the text. Menu titles, menu items, and 
dialog items appear in the book in Chicago font just as they do on 
the screen. 

Finally, boldface is used to point out the first occurrence of 
important new terms. 

What You Need to Get Started 

First, you'll need THINK C from Symantec. The examples from the 
book use version 5. You'll also need a Toolbox reference manual. 
Apple's Inside Macintosh series is the authoritative reference on 
Macintosh software development. We suggest you purchase Volumes I, 
V, and VI of Inside Mac. Volume I contains a description of a majority 
of the Toolbox routines used in this book. Volume V contains color 
QuickDraw information that also affects the Window and Menu 
Managers. Volume VI is your authoritative reference to System 7. 

Buy Volumes l,V, and VI with your lunch money. Buy Volumes II 
through IV with somebody else's lunch money. . 

Those of you who have been getting by with your 1 megabyte floppy­
based Mac Plus should grit your teeth and fork over the cash for some 
memory and a hard drive. This book assumes you'll be using System 7 
with THINK C: you'll need (at least!) a Mac Plus or Classic with 2 
megabytes of RAM and a few megabytes of space on a hard drive. 
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This book uses THINK C version 5. Get this version. Version 4 of 
THINK C works somewhat differently than version 5 and, more 
importantly, doesn't work as well with System 7. If you're not sure 
how to put THINK C on your Mac's hard drive, read Chapter 2 for the 
installation procedure. 

Finally, use the latest system files with Mac Primer programs. We 
will be working with System 7 throughout the book, although we will 
occasionally discuss possible code workarounds for computers still 
using System 6. Since Apple no longer supports System 6 for its new 
Macs, you should get on the stick and upgrade if you plan to do 
development work. Certainly, don't use any system software older 
than version 6.07. 

The compiled, standalone programs developed in this book won't 
work on Macs that don't support System 6, specifically the 51 2K 
and the 128K Macs. Since these models are museum pieces, you 
probably don't have to worry about supporting them when writing 
Mac programs. They represent less than a few percent of the 
Macintoshes out there, in any case. 

l l 
I 

Ready, Set ... 

When you finish this book, you'll be able to create your own Macintosh 
applications. 

Get all your equipment together, take the phone off the hook, and 
fire up your Mac. 

Go! 



Setting Up 

This chapter introduces you to the 
software tools used in this book. It also 
examines some issues that are specific 

to the implementation of C on the 
Macintosh. 

2 
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THINK C Is THE programming environment we'll use throughout the 
Macintosh Primer. First, we'll show you how to install it. Then, we'll 
look at how to type in and run a sample program. We'll talk about the 
programming conventions used in this book and some of the rules you 
need to follow when using the Mac and THINK C together. 

If you've already installed THINK C on your Mac, skip to the next 
section of this chapter. 

Installing THINK C 5 

Before you copy THINK C onto your hard drive, there are a few 
preparations you'll need to make. For starters, make backup copies of 
the four floppy disks that came with your copy of THINK C. Tuck your 
original disks back into the box and use the backup floppies for the 
actual installation. 

Next, delete any old versions of THINK C you might have on your 
hard drive. Make sure you don't delete any of your source code or 
project files. You may want to place these in an out-of-the-way folder. 
Once you've installed the new version of THINK C, you can move your 
source code files back into place. 

Now, create a folder named Development at the top level of your 
hard drive. This folder will contain all of your source code, as well as 
all of the files that make up THINK C. 

Finally, make sure you have at least 5 megabytes (5Mb) of free 
space on your hard drive. Once you've freed up enough space on your 
hard drive, you're ready to go. 

..!. 

If you don't have 5Mb available on your hard drive, don't panic. Th~ 
instructions in this chapter show you how to install the seven pieces 
that make up the full THINK C development environment. Page 22 
of the THINK C User Manual tells you what's in each of the seven 
pieces, so you can leave out pieces you may not need right away. It 
there's any way you can come up with the 5Mb, though, install the 
whole shebang. 

I 

Insert the disk labeled THINK C Disk 2 into your floppy disk drive. 
A window similar to the one shown in Figure 2.1 should appear. Each 
of the three files shown in Figure 2.1 is known as a self-extracting 
archive. 

25 



26 Macintosh C Programming Primer 

An archive is a file containing other files, but in a compressed 
format. A self-extracting archive is an archive that knows how to 
convert the archived files from their compressed format back into 
their normal format. Self-extracting archives are what enable 5Mb of 
THINK C to fit onto four SOOK floppy disks. 

D THINK C 2 t!] 

i 3 items 626K in disk 1 59K available 

00 00 .Q, 

Headers & Libs.sea TH INK C 5 .0 Demos .sea 

00 'ti 
DA/cdev Tools.sea 

-01 
¢J 1¢ Q] 

Figure 2.1 THINK C Disk 2. 

Double-click on the self-extracting archive labeled Headers & 

Libs.sea. A dialog box similar to the one in Figure 2.2 will appear. 
The dialog is asking you where you'd like to place the files extracted 
from the archive. Use the normal Macintosh file-navigation t echniques 
to guide the dialog box inside your newly created Development folder. 
Make sure the name Development appears in the pop-up menu at the 
top of the dialog box, as it does in Figure 2.2. 

Once inside the Development folder, press the EKtract button. An 
AutoExtractor window will appear, telling you how many files remain 
to be extracted (Figure 2.3). Once all of the files in the archive are 
extracted, move on to the next archive. 

Double-click on the self-extracting archive labeled THINK c 5 . O 
Demos . sea. Again, a dialog box similar to the one in Figure 2.2 will 
appear. Just as you did before, guide the dialog into the Development 
folder, making sure the name Development appears in the pop-up 
menu toward the top of the dialog box. Now click the EK tract button. 
An AutoExtractor window will appear. Once all the files from THINK 
c 5 . o Demos.sea are extracted, the window will disappear. 

Repeat this process to extract all of the files from the third self­
extracting archive on this disk, DA/ cdev Tools . sea. 
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Select Destination Folder: 
I a Deuelopment ~ I 

.Q ~Hard Driue 

[jf~C1 

Desktop 

n EHtract D 
~ ( Cancel ) 

Figure 2.2 Click the EHtract button to save the compressed files in the 
Development folder. 

AutoEHtractor™ 

EHtracting: console.c 
] 

Files remaining to be eHtracted: 149 (Cancel) 

Compacted by Compact Pro™ AutoExtr actor © 1991 Bill Goodman 

Figure 2.3 A self-extracting archive in action. 

Eject the disk labeled THINK C Disk 2, and place the floppy labeled 
THINK C Disk 3 into the floppy drive. A window similar to the one 
shown in Figure 2.4 should appear. The window contains two self­
extracting archives. First, double-click on the archive named THINK 
Class Library 1. 1. sea. When the familiar dialog box appears, 
move into the Development folder and press the EHtract button. 

Once the files are extracted from THINK Class Library 1. 1. sea, 
double-click on the archive named TCL 1.1 Demos. sea. When the 
dialog box appears, move into the Development folder and press the 
EHtract button. 

Once the files are extracted from TCL 1. 1 Demos. sea, eject the 
disk labeled THINK C Disk 3, and place the floppy labeled THINK C 
Disk 4 into the floppy drive. A window similar to the one shown 
in Figure 2.5 should appear. The window contains two self-extracting 
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archives. Double-click on the archive named Resource 
Utilities.sea. When the dialog box appears, move into the 
Development folder and press the EHtract button. 

Once the files are extracted from Resource Utilities. sea, 
double-click on the archive named THINK c Utilities.sea. When the 
dialog box appears, move into the Development folder and press the 
EHtract button. OK, one more disk to go! 

Eject the disk labeled THINK C Disk 4, and place the floppy labeled 
THINK C Disk 1 into the floppy drive. A window similar to the one 
shown in Figure 2.6 should appear. Drag the files THINK c 5. O and 
THINK c Debugger 5. 0 into the THINK c 5. O Folder located inside 
the Development folder. 

That's it! Congratulations, you've just completed the grueling 
THINK C 5 installation process. 

§0 THINK C 3 BJ§ 
ii 2 items 610K in disk 1751< 

00 ~ 

TH INK Class Library 1 .1 .sea 

00 
TCL 1 .1 Demos .sea 

1--

-Or 
¢] 1¢ Q] 

Figure 2.4 THINK C Disk 3. 

_o THINK C 4 BJ~ 
ii 2 items 753K in disk 33K available 

00 00 & 

Resource Utilities .sea THINK C Utilities.sea 
1--

~ 
¢J 1¢ Q] 

Figure 2.5 THINK C Disk 4. 
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-o THINK C 1 0 
i 4 items 600K in disk t 85K available 

[iJ ~ 
.Q 

THINK C 5 .0 TH INK C Debugger 5 .0 

EJ 
READ ME lnsta lling TH INK C 

¢1 

Figure 2.6 THINK C Disk L 

These instructions were specifically designed to help you install 
THINK C 5. If you are installing anything other than THINK C 5, 
read the instructions inside your THINK C User Manual. 

Accessing the Toolbox with C 

Built into every Macintosh , regardless of model, is a set of more than 
1,400 routines, collectively known as the Mac Toolbox. These include 
routines for drawing windows on the screen, routines for handling 
menus, even routines for changing the date on the real-time clock built 
into the Mac. The existence of these rout ines helps explain the 
consistency of the Mac user interface. Everyone uses these routines. 
When you pull down a menu in Claris MacDraw, you're calling a 
Toolbox routine. When you pull down a menu in Deneba's Canvas, 
you're calling the same routine. That's why the menus look alike from 
application to application, which has a rather soothing effect on users. 
This same principle applies to scroll bars, windows, lists, dialog boxes, 
alerts, and so on. 

If you look at Toolbox calls in the pages of Inside Macintosh, you'll 
notice that the calling sequences and example code presented in each 
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chapter are written in Pascal. For instance, the calling sequence for 
the function GetNewWindow () (I:283) is listed as: 

FUNCTION GetNewWindow (windowID: INTEGER; wStorage: Ptr; 
behind: WindowPtr) : WindowPtr; 

Each calling sequence starts with either the word FUNCTION or the 
word PROCEDURE. FUN CT IONS return values; PROCEDURES don't. In the 
example, the function GetNewWindow () returns a value of type 
WindowPtr. Here's an example of a call to GetNewWindow () from 
within a program: 

WindowPtr 
Ptr 
int 

myNewWindow, myOldWindow; 
myStorage = nil; 
myWindowID = 400; 

myNewWindow = GetNewWindow( myWindowID, myStorage, 
myOldWindow ); 

In the Pascal calling sequence, the function GetNewWindow () 
returns a value of type WindowPtr. In our code, we receive the value 
returned by GetNewWindow () in the variable myNewWindow, which is 
declared as a WindowPtr. Most of the data types found in Inside 
Macintosh are automatically available to you in THINK C. (If you're 
feeling adventurous, check out the folder Mac #includes inside the 
THINK c 5. O Folder, where all of these types are defined.) The 
exceptions are summarized in the following table: 

Pascal Data Type 
INTEGER 
LONG INT 
CHAR 
BOOLEAN 

C Equivalent 
short 
long 
short 
Boolean 

For example, the Pascal BOOLEAN data type corresponds to the 
THINK C data type Boolean. The Pascal calling sequence for the 
Button () function can be found on (1:259): 

FUNCTION Button : BOOLEAN; 

Here's an example of a call to But ton () in C: 

Boolean isButton; 

isButton =Button(); 
if ( isButton == TRUE) 

SysBeep( 20 ); 
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Although Pascal is not case-sensitive, C is: Boolean and BOOLEAN 
are different. THINK C provides this Pascal type as a convenience to 
the programmer. Even though Button() has no parameters, you 
must use the parentheses. If you forget them, your program won't 
compile correctly. 

You can also pass literals directly as parameters. For example, our 
call to GetNewWindow () can be rewritten as: 

WindowPtr newWindow, oldWindow; 

rnyNewWindow = GetNewWindow( 400, nil, oldWindow ); 

This code will work fine. Passing literals as parameters, however, 
doesn't necessarily make for readable code. At the very least, we 
suggest limiting your literal parameters to #defined constants. This 
brings up the next topic. 

#include, #define, and extern statements 

The #include statement tells the C compiler to substitute the source 
code in the specified file in place of the #include statement. Here's an 
example: 

#include "BigFile.h" 

The #define statement tells the C compiler to substitute the 
second argument for the first argument throughout the rest of the 
source code file. For example: 

#define MAXFILES 20 

Most C compilers use two passes to compile source code. During the 
first pass through a source code file, the compiler pulls in #include 
files and performs all #define substitutions. The actual compilation 
occurs during the second pass through the source code. 

extern is a C key word used in variable and procedure declara­
tions. Here's an example of an extern variable declaration: 

extern Boolean done; 

This extern declaration doesn't cause any space to be allocated for 
the variable done. Instead, references to done inside the extern 
declaration's file are replaced with pointers to the "real" declaration of 
done: 

Boolean done; 
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The absence of the extern keyword tells the compiler to allocate 
space for the variable and tie all the extern references to the variable 
to this allocated space. In the code of this book, each program keeps its 
source code in a single file, so extern is not used. Once your programs 
reach a certain size, you'll want to break your source into multiple files 
(for example, the WorldClock program in Chapter 5 could easily be 
broken down into three or four files). 

C and Pascal Strings 

C and Pascal use different techniques to implement their basic string 
data types. Pascal strings start with a single byte, called the length 
byte, which determines the length of the string. For example, in 
Pascal, the string "Hello, world!" would be stored as a single byte 
with the value 13, followed by the 13 bytes containing the string: 

l 13l H I e l 1 I 1 I o I , I l WI o I r I 1 I d I ! I 
The C version of this string starts with the 13 bytes containing the 
string and is terminated with a single byte with the value 0: 

The Macintosh Toolbox uses Pascal strings, embodied by the 
Str255 data type. Since 1 byte can only hold values from 0 to 255, 
Pascal strings can be at most 255 bytes in length (not counting the 
length byte). 

Using Pascal strings in THINK C is easy. The THINK C compiler 
will automatically convert C strings that start with the characters 
"\p" to Pascal format. Consider the calling sequence for the Toolbox 
routine Drawstring () (1:172): 

PROCEDURE Drawstring( s: Str255); 

You can call Drawstring () in C like this: 

Drawstring( "\pHello, world!"); 

You can also use the two routines CToPstr () and PtoCstr () to 
translate between C and Pascal formats. These routines are provided 
as part of THINK C. They are not part of the Macintosh Toolbox. 
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Passing Parameters: When to Use the & 

Here are the rules to guide your use of the & operator in Toolbox calls: 

1. If a parameter is declared as a VAR parameter in the Pascal 
calling sequence, precede it by an & . Here's the Pascal calling 
sequence for GetFNum () (1:223): 

PROCEDURE GetFNum( fontName : Str255 ; VAR theNum : 
INTEGER ) ; 

Here's a C code fragment that calls GetFNum () : 

short myFontNurnber ; 

GetFNum ( " \pGeneva " , &myFontNumber ); 

2. If the parameter is bigger than 4 bytes (as is the case with most 
Pascal and C data structures), precede it by an & whether or not it 
is declared as a VAR parameter. Here's the Pascal calling sequence 
for UnionRect () (I:l 75): 

PROCEDURE UnionRect( srcl, src2 : Rect ; VAR dstRect : 
Rect ) ; 

Here's a C fragment that calls UnionRec t ( J : 

Rec t srcl , src2 , dstRect ; 

/* assign va l ues to srcl and src2 */ 

UnionRect ( &srcl , &src2 , &dstRect ); 

If you're wondering where Rect came from, it's one of the data 
structures defined in Inside Macintosh (1:141). A Rect holds the 
upper left and lower right points of a rectangle. We'll see more of 
these "predefined" Mac data structures later. 
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3. If the parameter is 4 bytes or smaller and is not declared as a 
VAR parameter, pass it without the &. This rule applies even if the 
parameter is a struct. This is the Pascal declaration of the routine 
PtToAngle () (1:175): 

PROCEDURE PtToAngle( r: Rect; pt: Point; VAR angle: 
INTEGER ) ; 

Here's a C fragment that calls Pt ToAng le () : 

Re ct 
Point 
short 

r; 
pt; 
angle; 

/* assign values to r and pt */ 

PtToAngle( &r, pt, &angle); 

Notice that pt was passed without a leading&. This is because 
Points are only 4 bytes in size. Most of the predefined Mac types 
are larger than 4 bytes. Point is one of the few exceptions. 

4. If the parameter is a Str255, do not use an &, even if the 
parameter is declared as a VAR. This is the Pascal declaration of the 
routine Get Font Name () (1:223): 

PROCEDURE GetFontName( fontNum: INTEGER; VAR theName: 
Str255 ); 

Here is an example of a Pascal string used in a Toolbox call: 

Short 
Str255 

f ontNum; 
fontName; 

fontNum = 4; 

GetFontName ( fontNum, fontName ); 

Note that fontName was passed without a leading&. 
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Conventions 

The purpose of any standard is to ensure consistency and quality. 
With that in mind, we present our standard for writing C code. We use 
this standard and feel comfortable with it. Feel free to use your own 
standard or adapt ours to your own personal style. Most important is 
to pick a standard and stick with it. 

When discussing (as in, arguing over) C standards, people fight 
most over indentation style. Here's an example of our indentation 
standard: 

main() 
{ 

int i; 

for ( i=O; i<lO; i++ 

DoNastyStuff(); 

WrapitUp(); 

DoNastyStuff () 
{ 

DoOneNastyThing{); 

Notice that all of our curly brace pairs ( { with its corresponding } ) 
line up in the same column. Some people like to put the open curly 
brace at the end of the previous line, like this: 

main{) { 
int i; 

for { i=O; i<lO; i++ ) { 

DoNastyStuff{); 

DoNastyStuff () 
DoOneNastyThing{); 

Hmmmm. 
Well, do what you like, but be consistent. 
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Another standard adopted by the Mac Primer concerns the naming 
of variables and routines. Generally, we name our variables and 
routines according to the standards in Inside Macintosh. This means 
that the names look like Pascal names. The advantage of this is that 
you can use the same variable names used by Inside Macintosh. This 
makes your code much easier to debug and compare with Inside 
Macintosh. Our general rules for variable and routine names are as 
follows: 

• If you're naming a variable, start with a lower-case letter and 
capitalize the first letter of every subsequent word. This yields 
variables named i , myWindow, and bigDataStructure. 

• If you're naming a global variable, start the name with a lower-case 
g. This yields variables named gCurrentWindow and gDone . 

• If you're creating a #define, start the name with a lower-case k. 
This yields #defines like this one: 

#define kNumRecords 20 

• If you're naming a routine (function, procedure, subroutine, and so 
on), start with a capital letter and capitalize the first letter of every 
subsequent word. This yields routines named Main Loop (), 
DeleteEverything () , and PutThatDown (). 

Adherence to a good set of standards will make your code more 
robust and easier to maintain. Why? Most of the Toolbox routines 
are built right into the Macintosh in read-only memory, or ROM. The 
original Macintosh came with 64K of ROM; the Mac Plus comes 
with 128K of ROM; the Mac SE, II, and llx have 256K of ROM. The 
Quadra series has a massive 1 megabyte of ROM. Many of the 
routines built into the newer Macs are not found in the original Mac, 
Mac Plus, or SE. Likewise, many routines found in the Mac Plus 
were not found in the original Macintosh. The point is, things 
change. If you carefully follow Apple's programming guidelines, the 
program you write on today's machine will continue to work on 
tomorrow's. 

ResEdit 

Inside your Development folder, in the folder labeled THINK C 5 . O 
Utilities, you'll find a folder containing ResEdit, the popular 
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resource editor from Apple. In the Finder, click on the ResEdit icon, 
then select Get Info from the File menu. A ResEdit Info window 
should appear, similar to the one in Figure 2. 7. Make sure you are 
working with ResEdit version 2.1 or later. 

It's a good idea to increase the amount of memory ResEdit uses to 
edit resources. In the lower-right corner of the ResEdit Info window, 
increase the current size: to at least 1500K to avoid memory 
problems. 

ResEdit is free, and you can usually find the latest version on your 
favorite BBS. If you purchase ResEdit from the Apple Programmers 
and Developers Association (APDA), you'll also receive additional 
documentation. See Chapter 9 for more information about APDA. 
ResEdit versions consistently improve, so use the latest version you 
can find. 

You'll make extensive use of ResEdit as you create and customize 
your program's resources. The next section explores some of the 
resources you'll be working with in this book. 

~ 
~ 

ResEdit Info 

ResEdit 
ResEdit 2.1 

Kind: application program 
Size: 622K on disk (636 ,448 bytes used) 

Yhere: Hard Drive: Development: THINK C 
5.0 Utilities: ResEdit 2.1 : 

Created : Thu 1 Dec 6 1 1990 1 12 :00 PM 
Modified : Thu 1 Dec 6 1 1990 1 12 :00 PM 
Version : 2 .1 , ©App le Computer 1 Inc. 

1984-1990 
Comments: 

D Locked 

f .... Memory ........................................... 1 

! Suggested size : 500 K ! 
I Current size: ~ K j 
: ..................................................................... ; 

Figure 2. 7 The ResEdit Info window. 
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Resources 

As we mentioned in Chapter l, much of a program's descriptive infor­
mation is stored in resources. Resources may be defined by their type 
and either their resource ID number or their name. 

Each resource has a certain type, and each type has a specific 
function. For example, the resource type WIND contains the descriptive 
information needed to create a window; MENU resources describe the 
menus at the top of the screen. Figure 2.8 shows some of the resource 
types you'll see in this book. 

Each resource type comprises four characters. Case is not ignored: 
WIND and wind are considered different resource types. Occasionally, 
resource types may include a space. For example, ' STR ', where the 
fourth character is a space. 

Actually, resource types are just long ints (4 bytes) represented 
in ASCII format. Usually, the types are selected so the ASCII 
version is readable (like WIND, MENU, and so on). 

I 

§0 Primer Resource Types t!:l§ 
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Figure 2.8 Some resource types used in this book. 
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Sample Resource File 

~ D 
DLOG WIND 

DLOGs from Sample Resource File 
!Q. Size N~me 

126 21 " One DLOG" l 129 2 1 "Another DLOG" 

~D~ WINDs from Sample Resource Fi le ~0~ 
!Q. Size Name 

128 26 "J ust One" ~ 

-0 
~ 

Figure 2.9 Sample resow·ce file with two DLOGs and one WIND resow·ce. 

Resources of the same type, residing in the same file, must have 
unique resource IDs. For example, an application may have several 
resources of type DLOG, as long as each DLOG has a unique resource ID. 
The resource file shown in Figure 2.9 contains two DLOGs, one with an 
ID of 128, and one with an ID of 129. The file also contains a single 
WIND resource with an ID of 128. Thus, each resource is uniquely 
identified by ID number and type. 

If you prefer, you may also name your resources. Each of the three 
resources shown in Figure 2.9 has a type, an ID, and a name. All of 
the examples presented in the Mac Primer use the resource type and 
resource ID to uniquely specify a resource. When you create your 
resources, however, you might want to specify resource names, as well 
as resource IDs. This will make yow· resource files easier to read in 
ResEdit. 

Resource ID numbers follow these conventions: 

Range 
-32, 768 to -1 6,385 
-16,384 to 127 
128 to 32, 767 

Use 
Reserved by Apple 
Used for system resources 
Free for use 

In certain situations, there may be additional restrictions placed 
on resource IDs; check Inside Macintosh for more information. 
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In this book, CODE resources will be created in THINK C; most of 
the other resources will be created using ResEdit. 

CODE resources contain your application's compiled object code. 
You may be used to an operating environment that allows you to 
segment your executable code. The Mac supports segmentation as 
well. Each segment is stored in a separate CODE resource and is 
loaded and unloaded as necessary. If you are interested in learning 
more about code segmentation, an informative discussion begins 
on page 97 of the THINK C User Manual. 

Data Forks and Resource Forks 

Each Macintosh file, unlike files on most other operating systems, 
contains two parts: a data fork and a resource fork. The resource fork 
stores the resources, and the data fork contains everything else. Some 
word processors store a document's text in the document's data fork 
and use the resource fork for storing the document's formatting 
information. HyperCard stacks, interestingly enough, have most of 
their information on the data fork side. The THINK C projects in this 
book will use the resource fork exclusively. 

Now that we've covered these weighty and important topics, let's 
get on with the fun stuff: our first THINK C program. 

The Hello, World Program 

Our first program is a classic you may have encountered before: Hello 
draws the text "Hello , world !" in a window on the screen. 

Just to keep things orderly, create a folder named Hello inside 
your Development folder. Keep each of the files associated with the 
Hello project inside this folder. 

Create a New Project 

To create your first program, double-click on the THINK C application 
in the THINK c 5 . O Folder. The first thing you'll see is the Open 
Project dialog box (Figure 2.10). 
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la THINK c 5.0 Folder• I 
D C Libraries m 
CJ cdeu stuff 
CJ DA stuff 
CJ Mac #includes 
CJ Mac Libraries 
CJ oops Libraries 
CJ TH INK Class Library 1.1 

<> 

Figure 2.10 The Open Project dialog box. 
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~Hard Driue 

Desktop 

a Open D 
( New ) 
( Cancel 

Click on the New button. The Name Project dialog box will appear 
(Figure 2.11). Use the standard Macintosh mechanisms to guide the 
dialog into the Hello folder you just created (move up once to the 
Development folder, and down once more into the Hello folder). 
Type Hello .JC (key Option-p for 7t) in the Name new project: field, 
then click the Sau e button. 

When you click Saue, the project window (titled Hello.7t) will 
appear (Figure 2.12). As you add files to your project, their names will 
appear in the project window. At this point, the project window is 
empty because you have not yet added any files to the project. 

la Hello •I 

Name new project: 

I Hello.nj 

A. ~Hard Driue 
~ 

( Ej•~c1 ) 

( Desktop ) 

ll Saue D 
( Cancel ) 

Figure 2.11 The Name Project dialog box. 
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Hello.n 
Name obj size 

~ 

io 
~ 

Figure 2.12 The Hello.7t project window. 

The project file acts as an information center for all files involved in 
building an application. In addition, the project file contains infor­
mation about the THINK C environment, such as the preferred font 
and font size for displaying and printing source code. Projects are a 
THINK C concept, not a Macintosh concept. 

As you compile your source code, the object code generated will be 
stored in the project file as a CODE resource. The obj size column in 
the project window reflects the current size of the object code 
associated with each file in the project. An uncompiled file will have 
an obj size ofO. 

As you may have noticed, we've managed to sneak in another 
naming convention. This one came directly out of the THINK C 
User Manual. To stay true to THINK C, name your source code 
files xxx . c, your project files xxx . n, and your resource files 
xxx . 1t. rs re. The n character is created by keying 0 pt i o n-p. 

Now, you're ready to type in your first program. 
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The Code 

Pull down the File menu and select New. An untitled source code 
window will appear. Type in the following program: 

/**************** Hello . c ****/ 

#include <stdio . h> 

main () 

printf ( " Hello , world! " ) ; 

The THINK C compiler doesn't care how you use white space, such 
as tabs, blanks, and spaces. Be generous with your white space-don't 
be afraid to throw in a blank line or two if it will improve the 
readability of your code. 

Check the code for typing errors. If everything looks all right, select 
Saue As ... from the File menu. Save the file as Hello. c. Next, select 
Add (make sure you select Add, not Add ... ) from the Source menu to 
add the file Hello . c to the project. Add adds the frontmost window to 
the project, whereas Add •.. allows you to select one or more files to 
add to the project. 

l 
A common mistake at this point is to save the file as Hello. c. 
(note the period after the c), instead of as Hello . c (without the 
trailing period). To repeat: source code files should be named 
xxx. c, project files should be named xxx. 7t, and resource files 
(when we get to them in Chapter 3) should be named xxx .1t. rsrc 
and that's it. Periods are not used at the end of any file names in 
this book. 

Running Hello, World 

Note that as soon as you added Hello . c to the project, the name 
Hello . c appeared in the project window (Figure 2.13). Since Hello . c 
has not been compiled yet, its obj size is 0. Try running the program 
by choosing Run from the Project menu, or by keying a!lR. Respond to 
the Bring the project up to date? dialog box by clicking the Yes 
button. 
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For readers who have a tendency to get depressed if you get an 
error on the computer: The first time you run this program, it's not 
going to work. It's OK, it's not your fault. We'll show you why in a 
moment. 

_i_ 

Hello. Tl' 
Name obj size 

~--~!~~~.:~·-···················-··························· .................. ~ .. .Q 

Figure 2.13 Hello . c appears in the project window. 

THINK C will now compile Hello . c. If the compiler encounters an 
error, it will do its best to describe the problem to you. If you make any 
typing mistakes, correct them, then type 3€ R again. 

Once the program compiles correctly, THINK C will try to link your 
code. Basically, THINK C is trying to make sure that all of the 
functions you call are available somewhere in the project. When a link 
fails, THINK C displays a link failed error message (Figure 2.14). At 
the same time, THINK C creates a Link Errors window, telling you 
which functions could not be resolved (Figure 2.15). 

II 
link failed 

II 
Figure 2.14 The link failed error dialog box. 
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undefined : print f .Q 

Figure 2.15 The Link EJTors window. 

In this case, THINK C couldn't find the function printf () . Don't 
worry-this is a simple problem to fix. You need to add the library 
containing p r intf () to your project. 

Click anywhere on the screen to make the link: failed dialog box 
disappear. Next, select Add ... from the Source menu. The Add Files 
dialog box will appear. The library containing printf () is located in 
the c Libraries folder. To get there from the Hello folder, move up 
once to get to the Development folder, down into the THINK C 5 . O 
Folder, and down again into the c Libraries folder (Figure 2.16). 

le c Libraries ... I 
D ANSI m 
D ANSl - A4 
D ANSI-small 
D headers 
D profile 
D sources 
D uniH 

c:::i Hard Driue 

Desktop 

Cancel 
·············-·········-······-·-·····-························-···································-···································-···········-·········· 

~ 
n Add , 
( Add All ) 
nmnm1c~ ) 

Figure 2.16 The Add Files dialog box. 
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The library you want to add to the project is called RNS I. Select 
ANS I, then click on the Rdd button (do not click on the Add Rll 
button). Once you do this, the name ANS I will move from the top half 
of the dialog box to the bottom half (Figure 2.17). The bottom half of 
the dialog box acts as a staging area, allowing you to add more than 
one file at a time to the project. In this case, we11 just add one file to 
the project, the library named ANS I. To do this, click on the Done 
button. 

You'll know you were successful if the name ANS I appears in the 
project window, just above Hello. c (Figure 2.18). Now the project is 
complete. 

Select Run from the Project menu. Respond to the Bring the 
project up to date? dialog box by clicking Yes. First, THINK C 
will load the ANS I library's object code. Then, assuming everything 

I a c ubraries ... 1 
Cl ANSl-A4 
Cl RNS I-small 
CJ headers 
Cl profile 
CJ sources 
Cl uniH 

ANSI 

/'.. ~Hard Driue 
~ 

Desktop 

Done 

Cancel 

Add All 

'zy fh~m(W(~ 
...._~~~~~~~~~~~ ........... 

Figure 2.17 HNSI is now in the bottom half of the Add Files dialog box, 
ready to be added to the project. 
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Hello.Tl' 
Name 

Figure 2.18 ANS I has been successfully added to the project. 

else went smoothly, THINK C will run the program. A window should 
appear on the screen, containing the t ext Hello , wor ld! 
(Figure 2.19). 

To exit the program, either type return or select Quit from the File 
menu. 

press « return» to eHit 

Hel l o, wor- ld!I 

Figure 2.19 Hello.it in action. 
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The Problem with Hello, World 

We don't want to get you too excited about this version of Hello. 
Although it does illustrate how to use THINK C, it does not make use 
of the Macintosh Toolbox. The first program in Chapter 3 is a 
Macintized version of Hello, called Hello2. 

In Review 

In Chapter 2, you installed THINK C and created your first project. 
Chapter 3 looks at the basics of Mac programming: QuickDraw, 
windows, and resources. It also presents four applications that 
demonstrate the versatility of the Macintosh. 

It's almost too late to turn back. To all of those who have come from 
other environments: beware! QuickDraw is addictive! 



Drawing on the 
Macintosh 

Now that you have installed THINK C, 
you can start programming. A good 
starting point is the unique routines 

that define the Macintosh graphic 
interface. On the Macintosh, the 

Toolbox routines that are responsible 
for all drawing are known collectively 

as QuickDraw. 

3 
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Introduction 

QmcKDRAw Is THE MACINTOSH drawing environment. With it, you can 
draw rectangles and other shapes and fill them with different 
patterns. You can draw text in different fonts and sizes. The windows, 
menus, and dialogs displayed on the Macintosh screen are all created 
using QuickDraw routines. 

In this chapter, we'll show you how to create your own windows and 
draw in them with QuickDraw. Let's start by examining the 
QuickDraw coordinate system, the mathematical basis for QuickDraw. 

The QuickDraw Coordinate System 

QuickDraw drawing operations are all based on a two-dimensional 
grid coordinate system. The grid is finite, running from (-32, 767, 
-32, 767) to (32, 767, 32, 767), as shown in Figure 3.1. 

( -32, 767' -32, 767 ) 

( 32, 767' 32, 767 ) 

Figure 3.1 The grid. 

51 
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t-++- ( 0, 0) i-+-; 

ti.. 

• -
~ 

Figure 3.2 The Macintosh screen on the grid. 

Every Macintosh screen is actually an array of pixels aligned to the 
grid. The lines of the grid surround the pixels. The grid point labeled 
(0,0) is just above, and to the left of, the upper left-hand corner of the 
Mac screen (Figure 3.2). 

A screen measuring 32, 768 pixels x 32, 768 pixels with a screen 
resolution of 1 pixel = 1/72 inch would be 38 feet wide and 38 feet 
tall. The Mac Classic, Plus, and SE monitors are 512 x 342 pixels. 
Apple's Mac 13" color monitor is 640 x 480 pixels. 

The grid is also referred to as the global coordinate system. Each 
window defines a rectangle in global coordinates. Every rectangle has 
a top, left, bottom, and right. For example, the window in Figure 3.3 
defines a rectangle whose left is 20, top is 20, right is 160, and bottom 
is 180. 

Interestingly, the window does not have to be set up within the 
boundaries of the screen. You can set up a window whose left is 
-50, top is 100, bottom is 200, and right is 800. On a Classic, this 
window would extend past the left and right sides of the screen 
(Figure 3.4). This is known as the Big Long Window Technique. 

Use of the Big Long Window Technique is discouraged. 

l 
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H ( 20, 20 ) H 

~ 
~ 

~ 

H-t-+-i 
H-t-+-i 
H-1-1 
t-+-H 
H-H 
H-H 

IE IE~ 
II II ~ 

( 160, 180 ) J 
Figure 3.3 A window on the grid. 

Figure 3.4 A big, long window. 

When drawing inside a window, you'll always draw with respect to 
the window's local coordinate system. The upper left-hand corner of 
a window lies at coordinate (0,0) in tha t window's local coordinate 
system (Figure 3.5). 
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{ 0, O ) in Window's Local 
Coordinate System 

~ 
~ 

" ~ 
I-+-I-+-
I-+-I-+-
1-1-1-f-
1-1-1-1-
t-+-1-1-

t-+-I-+-

.LU 

.LU 

.LU 

Figure 3.5 Local coordinates. 

To draw a rectangle inside your window, specify the top, left, 
bottom, and right in your window's local coordinates (Figure 3.6). Even 
if you move your window to a different position on the screen, the 
rectangle coordinates stay the same. This is because the rectangle was 
specified in local coordinates. 

_IIIIIIIII 

( 0, O) in Window's Local 
Coordinate System, ( 20, 20) in 

Global Coordinates 

~ 
~ 

l'llii 
~ 

~o t-t-t-t-
L t-t-t-t-

t-t-t-t-
t-t-t-t-

( 20, 30) in Window's Local 1-H 1-H t-t-t-t-
~ 1-H 1-t-t-t-

Coordinate System, ( 40, 50 ) in 
Global Coordinates 

Figure 3.6 Rectangle drawn in window's local coordinates. 
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Local coordinates are handy! Suppose you write an application that 
puts up a window and draws a circle in the window (Figure 3. 7). 
Then, the user of your application drags the window to a new 
position (Figure 3.8). 

You sti ll know exactly where that circle is, even though its 
window has been moved. That's because you specified your cirdle 
in the window's local coordinates. 

§0 Drawing Window = 

G ( 20, 20) 

Figure 3.7 Circle drawn in window's local coordinates. 

Figure 3.8 When window moves, local coordinates stay the same. 
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On the Macintosh, text and graphics created by your programs will 
be displayed in windows. Windows are the devices that Macintosh 
programs use to present information to a user. 

Because we need windows to draw in, let's look more closely at 
windows and the Window Manager. 

Window Management 

When you draw graphics and text on the Macintosh, you draw them 
inside a window. The Window Manager is the collective name for all 
the routines that allow you to display and maintain the windows on 
your screen. Window Manager routines are called whenever a window 
is moved, resized, or closed. 

Window Parts 

Although windows can be defined to be any shape you choose, the 
standard Macintosh window is rectangular. Figure 3.9 shows the 
components of a typical window. 

The close box (also known as the go-away box) is used to close the 
window. The drag region is where you grab the window to move it 

Close Box Title Bar or Drag Region Zoom Box 

Window 

Thumb Grow Box 

Figure 3.9 Window components. 
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around the screen; this region also contains the window's title. Scroll 
bars are used to examine contents of the window not currently in 
view. The thumb is dragged within the scroll bar to display the 
corresponding section of the window. The grow box (also known as 
the size box) lets you resize the window. The zoom box toggles the 
window between its standard size and a predefined size, normally 
about the size of the full screen. 

There are several types of windows. The window in Figure 3.9 is 
known as a document window. When you use desk accessories or 
print documents, you will notice other kinds of windows. These 
windows may not have all of the same components as the standard 
window, but they operate the same way. 

Window Types 

Six standard types of windows are defined by the Window Manager. 
Each type has a specific use. In this section, each type is described and 
its use is discussed. 

The documentFroc window (Figure 3.10) is the standard window 
used in applications. This one has a size box, so it is resizable; it also 
has a close box in the upper left-hand corner that closes the window. 

The noGrowDocProc window (Figure 3.11) is the standard window 
without scroll bars or a grow box. Use this window for information 
that has a fixed size. The rDocProc window (Figure 3.12) has a black 
title bar; it has no scroll bars or grow box. This window is most often 
used with desk accessories. 

::o Window 

~ 

lQ 
!QI ~ '2J 

Figure 3.10 The documentProc window. 
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-D Window 

Figure 3.11 The noGrowDocProc window. 

D Lllindow 

Figure 3.12 The rDocProc window. 

The remaining three types of windows are dialog box windows: 
dBoxProc, plainDBox, and altDBoxProc (Figure 3.13). Dialog boxes 
will be discussed in Chapter 6. 
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Figure 3.13 The dBoxProc, p lainDBo x, and altDBox Pr oc windows. 

The windows described here are the standard models. You can 
customize them by adding a few options. For example, the 
documentProc, noGr0wDocProc, and rDocProc window types 
can come either with or without the close box. A zoom box can be 
added to documentProc and noGrowDocProc windows (see 
Chapter 4). We'll show you everything you need to know to create 
exactly the type of window you want for your application. 

Setting Up a Window for Your Application 

If you plan to use one of the standard window designs for your 
applications, creating a window is easy. First, build a WIND resource 
using ResEdit (we'll show you how a little later in the chapter). Figure 
3.14 shows ResEdit's WIND editor. Like all resources, each WIND has its 
own unique resource ID. As you'll see, this resource ID is used to fetch 
the WIND resource from the resource file. Later in the chapter, we'll 
walk through the WIND creation process in detail. 
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WIND ID= 128 from Sample WIND.r 

LJbCLJDDLJD 

Top: llu I Height: ~ 

Left: ~ Width: ~ 

Figure 3.14 ResEdit's WIND editor. 

Color: ®Default 
0 Custom 

l8J Ini tially uisible 

l8l Close boH 

Once your WIND resource is built, you're ready to start coding. One 
of the first things your program will do is initialize the Toolbox. The 
Window Manager is initialized at this point. 

Next, load your WIND resource from the resource file, using the 
GetNewWindow () Toolbox routine: 

short 
Ptr 
WindowPtr 

windowID ; 
wStorage ; 
windo w, behind; 

window = GetNewWindow( windowID , wStorage , behind) ; 

GetNewWindow () loads the WIND resource that has a resource ID of 
windowID. The WIND information is stored in memory at the space 
pointed to by wStorage. The Window Manager will automatically 
allocate its own memory if you pass nil as your wStorage parameter. 
For now, this technique is fine. As your applications get larger, you'll 
want to consider developing your own memory management scheme. 

The parameter behind determines whether your window is placed 
in front of or behind any other windows. If the value is nil, the new 
window is placed behind the rest of your application's windows. If 
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(WindowPtr) - lL is passed as the third parameter, the new window 
appears in front of all other windows. For example: 

window = GetNewWindow ( 400 , nil , (WindowPtr) - lL ) ; 

loads a WIND with a resource ID of 400, asks the Window Manager to 
allocate storage for the window record, and puts the window in front of 
all other windows. A pointer to the window data is returned in the 
variable window. 

' l 
The expression (WindowPtr ) - lL is a typecast, asking the 
compiler to convert the constant - lL (a long with a value of -1) to 
the type WindowPtr before passing it as a parameter. Depending 
on the options you have set for your projects, THINK C may or may 
not require you to typecast your parameters to match the type of the 
receiving parameter. The programs in this book were designed to 
work with THINK C's factory settings. For more information on the 
THINK C options dialog, see page 179 in the THINK C User 
Manual. 

When you create the WIND resource with ResEdit, you are given a 
choice of making the window visible or not. Visible windows appear as 
soon as they are loaded from the resource file with GetNewWindow ( l . 
If the visible flag is not set, you can use ShowWindow ( ) to make the 
window visible: 

ShowWindow( window) ; 

where window is the pointer you got from GetNewWindow () . Most 
applications start with invisible windows and use ShowWindow () 
when they want the window to appear. The Window Manager routine 
HideWindow () makes the window invisible again. In general, you'll 
use ShowWindow () and Hi deWindow () to control the visibility of 
your windows. 

At this point, you've learned the basics of the Window Manager. 
You can create a WIND resource using ResEdit, load the resource using 
GetNewWindow (),and make the window appear and disappear using 
ShowWindow () and HideWi ndow () .This technique will be illustrated 
shortly. After you have put up the kind of window you want, you can 
start drawing in it. The next section shows you how to use QuickDraw 
routines to draw in your window. 
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Drawing in Your Window: The QuickDraw 
Toolbox Routines 

There are many QuickDraw drawing routines. They can be conve­
niently divided into four groups: routines that draw lines, shapes, text, 
or pictures. These routines do all of their drawing using a graphics 
"pen." The pen's characteristics affect a ll drawing, whether the 
drawing involves lines, shapes, or text. 

Before starting to draw, you have to put the pen somewhere 
(MoveTo () ), define the size of the line it will draw (PenS i ze () ), 
choose the pattern used to fill thick lines (PenPat ( ) ), and decide how 
the line you are drawing changes what's already on the screen 
(PenMode () ). Figure 3.15 shows how changing the graphics pen 
changes the drawing effect. 

Every window you create has its own pen. The location of a 
window's pen is defined in the window's local coordinate system. Once 
a window's pen characteristics have been defined, they will stay 
defined until you change them. 

Lines drawn with 4-pixels-wide graphics pen, using pen patterns 
v v 

IJ IJ ~ ~ 
Source patCopy patOr patXor 
Pattern 

~ [) ~ ~ 
Destination notPatCopy notPatOr notPatXor 

Pattern 

Copy source pattern onto destination pattern using 
one of eight graphics pen modes 

Figure 3.15 Graphics pen characteristics. 

~ 
patBic 

~ 
notPatBic 
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Setting the Current Window 

Because your application can have more than one window open at a 
time, you must first tell QuickDraw which window to draw in. This is 
done with a call to SetPort () : 

wi ndow = GetNewWindow ( 400 , nil , (WindcwPtr) - lL ) ; 

SetPort( window) ; 

In this example, SetPort () made window the current window. 
Until the next call to SetPort (), all QuickDraw drawing operations 
will occur in window, using window's pen. Once you've called 
Set Port () and set the window's pen attributes, you're ready to start 
drawing. 

The basic data structure behind all QuickDraw operations is the 
Graf Port . When you call SetPort (),you are actually setting the 
current Graf Port (I : 271) . Since every window has a Grafl?ort 
data structure associated with it, in effect you are setting the current 
window. The GrafPort data structure contains fields such as 
pnSize and pnLoc, which define the Graf Port pen's current size 
and location. QuickDraw routines such as PenSize () modify the 
appropriate field in the current Graf Port data structure. 

11 

Drawing Lines 

The LineTo () routine allows you to draw lines from the current pen 
position (which you have set with MoveTo ()) to any point in the 
current window. For example, a call to: 

window = GetNewWindow ( 400 , nil, (WindowPtr) - lL ) ; 

SetPort( window) ; 

MoveTo( 39 , 47 ) ; 

LineTo ( 407 , 231 ) ; 

would draw a line from (39, 47) to (407, 231) in w:..ndow's local 
coordinate system (Figure 3.16). 
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~o Window 

Figure 3.16 Drawing a line with QuickDraw. 

It is perfectly legal to draw a line outside the current boundary of a 
window. QuickDraw will clip it automatically so that only the portion 
of the line within the window is drawn. QuickDraw will keep you from 
scribbling outside of the window boundaries. This is true for all 
QuickDraw drawing routines. 

l 

., 

The last program in this chapter is the FlyingLine, an extensive 
example of what you can do using the QuickDraw line-drawing 
routines. 

Drawing Shapes 

QuickDraw has a set of drawing routines for each of the following 
shapes: rectangles, ovals, rounded-comer rectangles, and arcs. Each 
shape can be filled, inverted, or drawn as an outline (Figure 3.17). 

The current pen's characteristics are used to draw each shape 
where appropriate. For example, the current fill pattern will have no 
effect on a framed rectangle. The current PenMode ( ) setting, 
however, will affect all drawing. The second program in this chapter, 
Mondrian, shows you how to create different shapes with QuickDraw 
(Figure 3.18). It also demonstrates the different pen modes. 
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Figure 3.17 Some QuickDraw shapes. 

Figure 3.18 Mondrian. 

Drawing Text 

65 

QuickDraw allows you to draw different text formats easily on the 
screen. QuickDraw can vary text by font, style, size, spacing, and 
mode. Let's examine each of the text characteristics. 

Font refers to the typeface of the text you are using. Courier, 
Helvetica, and Geneva are some of the typefaces available on the 
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Macintosh. Style refers to the appearance of the typeface (bold, italic, 
underline, and so on). The size of text on the Macintosh is measured 
in points, where a point is equal to V72 inch. Spacing defines the 
average number of pixels in the space between letters on a line of text. 
Figure 3.19 shows some of the characterics of QuickDraw text. 

r s File Edit Format Font Document Utilities Window 

QuickDraw TeHt Uariations 

~. the cel\ler of the Uruled Worlds, New York 
was growing q U i Ck 1 Y. This was underlined by the fact that many of 
the poorer planets were unable to find spa ce for their embassies. New 
York landlords boldly demanded a rental of 1 million credits a day. 
As a result, ambassadors set up shop in two other cities. 

Chicago had the biggest spaceport on earth and ended up with many 
statesmen. 

Geneva was a favorite with those worlds that had been colonized by 
European nations. 

476 Chars Normal 
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Figure 3.19 Examples of QuickDraw text and derivative science fiction 
writing. 

The mode of text is similar to the mode of the pen. The text mode 
defines the way drawn text interacts with text and graphics already 
drawn. Text can be defined to overlay the existing graphics (srcOr); 
text can be inverted as it is placed on the existing graphics (s rcXor); 
or text can simply paint over the existing graphics (s r cCopy). The 
other modes (srcBic, notS r cCopy, notSrcOr, and so on) are 
described in Inside Macintosh (!:157). Figure 3.20 demonstrates the 
two most popular text modes. 
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Figure 3.20 The two most popular Quick.Draw modes. 

Drawing Pictures 

QuickDraw can save text and graphics created with the drawing 
routines as picture resources called PI CTs. You can create a picture 
(using a program such as Canvas or MacDraw), copy the picture to the 
clipboard, and paste it into a PI CT resource using ResEdit. Later in 
the chapter, you'll see how to make use of PICT resources in the 
ShowPICT program. 

About Regions 

QuickDraw allows you to define a collection of lines and shapes as a 
region. You can then perform operations on the entire region (Figure 
3.21). 

By now most of you are probably itching to start coding. First, let's 
look at the basic Mac programming structure used in this chapter's 
programs. Then we'll hit the keyboards! 
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Figure 3.21 Two QuickDraw region operations. 

Basic Mac Program Structure 

We've looked at a general outline of the QuickDraw and Window 
routines needed to make a Macintosh application go. The basic 
algorithm used in each of the Chapter 3 programs goes something like 
this: 

main(} 

ToolBoxinit(); 
Otherinits(}; 
DoPrimeDirective(}; 

while ( ! Button(} } 

Like most C programs, our program starts with the routine main ( } , 
which first initializes the Toolbox. It then takes care of any program­
specific initialization, such as loading windows or pictures from the 
resource file. Next, the program performs its prime directive. In the 
case of the Hello, World! program, the prime directive is drawing a 
text string in a window. Finally, the program waits for the mouse 
button to be clicked. This format is very basic: Except for clicking the 
button, there is no interaction between the user and the program. This 
will be added in the next chapter. 
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The QuickDraw Programs 

Each of the following programs demonstrates different parts of the 
Toolbox. The Hello2 program demonstrates some of the Quick.Draw 
routines related to text; Mondrian displays Quick.Draw shapes and 
modes; ShowPICT loads a PICT resource and draws the picture in a 
window. Finally, you'll code the FlyingLine, an intriguing program 
that can be used as a screen saver. 

Let's look at another version of the Hello, World! program presented 
in Chapter 2. 

Hello2 

The Hello2 program will do the following: 

• Initialize the Toolbox; 
• Load a resource window, show it, and make it the current port; 
• Draw the text string "Hello, world!" in the window; 
• Quit when the mouse button is clicked. 

To get started, create a folder inside the Development folder and 
name it Hello2. This is where you'll build your first Macintosh 
application. The next few sections will show you how to create the 
three files you'll need for this project. First, you'll create a resource file 
to hold Hello2's resources. Next, you'll create a project file, just as you 
did with Hello2's predecessor in Chapter 2. Finally, you'll create a 
source code file for Hello2's source code and add the source code file to 
the project. 
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Hello2 Resources 

As we discussed in Chapter 2, at the heart of every THINK C program 
is a project file. A typical project file has a name like xxx . 7t, where 
xxx is the name of the program. When you open a project named 
xxx. 7t, THINK C automatically looks for a file named xxx. 7t. rsrc 
and makes any resources in this file available to your program. 

In a bit, you'll create a project file named Hello2. 7t. Before you do 
that, you'll use ResEdit to create a file named Hello2. 7t. rsrc and, 
inside Hello2. 7t. rsrc, you'll create a single WIND resource. 

Find your copy of ResEdit (make sure you use version 2.1 or later) 
and double-click on its icon. Then click the mouse and ResEdit will 
prompt you for a resource file to open. Click on the New button. When 
the Saue File dialog box appears, use the standard Mac navigation 
techniques to move into the Hello2 folder you just created. Type 
Hello2. 7t. rsrc in the New File Name: field and click the New 
button (Figure 3.22). 

I OJ Hello2 ~ ~ 
.Q CJ Hard Driue 

t: j(~( t 

Desktop 

-0 
n , 

New File Name: New 

I Hello2. n .rsrc ( Cancel ) 

Figure 3.22 Create a new resource file in the Hello2 folder. 

ResEdit will create an empty resource file named Hello2. 7t. rsrc 
and open a window listing of all that file's resources. Since the file is 
empty, no resources are listed. You're about to change that. 

Select Create New Resource from the Resource menu. When 
prompted to select a resource type, select WIND from the scrolling list 
and click OK (you could also have typed in WIND and clicked OK). Two 
new windows should appear, a window listing all of the WIND 
resources (Figure 3.23) and, on top of that, a window showing the 
newly created WIND (Figure 3.24). 
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Figure 3.23 ResEdit's list of WI ND resources for Hello2 . n. rsrc. 
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Figure 3.24 ResEdit's WIND editor. 
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The WIND resource you've just created will act as a templa te for the 
Hello2 program, telling Hello2 the type and size of window in which to 
display the Hello, World! text. 

The icons toward the top of the WIND editor allow you to select the 
window's type. Click on the second icon from the left, choosing the 
window with no grow box and no zoom box. 
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Next, edit the Left: field, changing its value to 5. This will cause 
the window to appear 5 pixels from the left edge of the screen. Also, 
change the value in the Width: field to 300. Figure 3.25 shows what 
your WIND editor should look like at this point. 

If the field names Bottom: and Right: appear instead of the field 
names Height: and Width: in the WIND editor, select Show 
Height & Width from the WIND menu. 

l 
You can use the MiniScreen menu to see what your window will 

look like on various Macintosh screens. By default, ResEdit shows 
your WIND on a Mac Classic screen (512 pixels wide, 342 pixels tall). 

Next, select Set 'WI NO' Characteristics ... from the WI NO menu 
(Figure 3.26). Change the Window title: to My First Wi ndow. The 
re fC on: field is a 4-byte integer reserved for use by your application. 
You can use this field for anything you want. Feel free to type a 
number in the re fC on: field if you like, though we won't make use of 
it in this program. 

The Proc ID: field contains a number that corresponds to the 
window's type. If you like, click the OK button, returning to the WIND 
editor, and select a differ ent window type from the icons at the top of 

liiD WIND ID = 128 from Hello2.Tl. rsrc 

Top:~ Height: ~ 

left :~ Width: ~ 

Color: @ Default 

0 Custom 

[8J Initially uisible 

!8l Close boH 

Figure 3.25 The WIND editor, after a few changes have been made. 
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Window title: I My First Windo~ 

refCon: ._Io ____ __, 

ProclD: ._I 4 ____ __, 

Cancel t OK D 

Figure 3.26 The 'WI ND' Characteristics dialog box. 

the window. Go back to the ' WIND ' Characteristics window and 
check out the Proc ID: field. Notice the change? Make sure you change 
the ProclD: back to 4, then click the OK button to return to the WIND 
editor. 

J J_ 

The number found in the ProclD: field can be derived from the 
pages of Inside Macintosh (1:273), which contains a list of constants 
corresponding to the different WIND types available from the 
Window Manager. The WIND we just created used the constant 
noGr owDocProc, which has a value of 4. To add a zoom box to 
one of these window types, add 8 to the value of its constant. For 
example, to add a zoom box to a noGrowDocP roe, change the 
constant from 4 to 12. 

For the moment, leave Proc ID: with a value of 4. You'll learn 
how to add a zoom box to your windows in Chapter 4. 

l 

Next, select Preuiew at Full Size from the WI ND menu. A model 
of your window will appear in the proper position on the screen. Click 
the mouse to make the test window disappear. 

Next, select Get Resource Info from the Resource menu. When 
the resource information window appears (Figure 3.27), make sure the 
WIND's resource ID is set to 128. The resource ID is the number you'll 
pass to GetNewWindow () to retrieve this WIND from the resource file. 
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§0~ Info for WIND 128 from Hello2.n.rsrc ~ 

Type: 

ID: 

Nome: 

WIND 

112e J 

TeHt Windo~ 

Size: 36 

Owner type 

Owner ID: DRUR i2 
-----WDEF 

Sub ID: MDEF ~ 

Attributes: 
D system Heap 
181 Purgeoble 

D Locked D Prelood 
D Protected D Compressed 

Figure 3.27 Resource Info window for WIND 128. 

Next, make sure the Pu rgea b le checkbox is checked. This allows 
the Macintosh Memory Manager to purge the WIND resource from 
memory once it's not needed anymore. This approach maximizes the 
amount of memory available for your application. 

If you like, name your WIND by typing some text in the Name: field. 
While this won't affect your program, assigning a name to a resource 
can make it easier to tell one WIND resource from another in a list of 
resources. In general, when you have more than one resource of a 
given type, assign each resource a name, so you can tell them apart at 
a glance. Figure 3.28 shows how the name appears in the list of WINDS 
first shown in Figure 3.23. 

~U WINDs from Hello2.n.rsrc 0§ 
.IQ. Size Name 

128 36 "Text Wf ndow" .Q, 

izy 
VJ 

Figure 8.28 WIND 128 appears in the list of WIND resources. Notice the 
resources' name appearing on the right side of the window. 



Drawing on the Macintosh 75 

Next, choose Saue from the File menu, saving the changes you've 
made to the resource file. Finally, choose Quit from the File menu. 
Now you're ready to start up THINK C. 

Some of you may note that the Size: field in Figure 3.27 has a 
number different from that in the WIND you created. There are 
several explanations for this. You may be using a different version 
of ResEdit than we are. You may have used a different name for 
your WIND than we did. This does make a difference as far as 
resource size goes. As long as the basic values in your ResEdit 
screens match the values in the screen shots, you should be OK. 

The Hello2 Project File 

Start up THINK C by opening the THINK C 5. 0 Folder and double­
clicking on the THINK c 5 . O icon. When the dialog box appears, click 
on the New button. When the next dialog box appears, navigate into 
the Hello2 folder and save the new project file as Hello2. 7t (Figure 
3.29). 

la Hello2 •I 

Name new project: 

I Hello2. 11 

~ CJ Hard Driue 

( Ejt~c1 J 

[ Desktop J 

¢ Saue Il 
[ Cancel J 

Figure 3.29 Save the new project file as Hello2 . 7t. 
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Next, select New from the File menu and type the following source 
code into the window that appears: 

#define kBaseResID 
#define kMoveToFront 

128 
(WindowPtr)-lL 

#define kHorizontalPixel 30 
#define kVerticalPixel 50 

/***************/ 
/* Functions */ 
/***************/ 

void 
void 

ToolBoxinit( void); 
Windowinit( void); 

/****************** main ***************************/ 

void main( void 

ToolBoxinit(); 
Windowini t (); 

while ( ! But ton () 

/****************** ToolBoxinit *********************/ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
InitFonts(); 
InitWindows(); 
Ini tMenus () ; 
TEini t () ; 
InitDialogs( nil ); 
InitCursor(); 

/****************** Windowinit ***********************/ 

void Windowinit( void 

WindowPtr window; 



Drawing on the Macintosh 77 

window= GetNewWindow( kBaseResID , nil , kMoveToFront ); 

if ( window == nil 

SysBeep ( 10 ) ; 

ExitToShell () ; 

ShowWindow( window ) ; 
SetPort( window); 

/* Couldn ' t load the WIND 
resource ! ! ! *I 

MoveTo( kHorizontalPixel , kVerticalPixel ); 
DrawString( " \pHello , world !" ); 

When you've typed that in, select Saue As ... from the File menu 
and save your source code (in the Hello2 folder) as Hello2. c. Select 
Add from the Source menu to add Hello2 . c to the project. The 
name Hello2 . c should appear in the project window. 

Next, you'll need to add a file called MacTraps to your project. 
MacTraps is a precompiled file that contains everything your project 
will need to access the Macintosh Toolbox routines. Select Add . .. from 
the Source menu. Find MacTraps inside the THINK c 5 . O Folder, 
inside the Mac Libraries folder. In the Add ... dialog, double-click on 
MacTraps to move it from the top half of the dialog to the bottom half. 
Once MacTraps (and nothing but MacTraps) appears in the bottom 
half of the dialog, click on Done. 

When you're done, the Project window should look like Figure 3.30. 

Hello2. 11 
Name obj size 

[He11o2.c 
0 '° 

. ' I 

-0 
~ 

Figure 3.30 The project file after Hello2 . c has been added. 
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Running Hello2 

Now you're ready to run Hello2. Select Run from the Project menu. 
When asked to Bring the project up to date?, click Yes. You may 
get a complaint about a syntax error or two. If so, just retype the line 
the compiler highlights. 

If you make any changes to Hello2. c, you'll be asked whether 
you'd like to Saue changes before running? Click Yes. 

Once you've gotten Hello2 to compile without a hitch, it will 
automatically start running, as shown in Figure 3.31. Voila. Hello2 
should display a window with the text Hello, world! in it. Quit the 
program by clicking the mouse button. 

D My First Window 

Hello, world! 

Figure 3.31 Hello2 in action. 

If Hello2 compiles, but the Hello2 window fails to appear; it may 
indicate a problem with the resource]ile. If you heard a ~~ep whet:l: 
THINK Cran your program, THINK C could rioUind your resour~· 
file. Make sure your project file is named Hello2 .n. and YQW 
resource file is named Hello2. n. rsrc (no spaces in either 
name). Also, make sure both files are in the same Hello2 folder. 

Another common reason why Hello2 doesn't work is that code 
font left the Hell'o2. n. rsrc window open in ResEqft. 01.bse and 
save your resource file before running projects! 



_J Walking Through the Hello2 Code 

We'll be walking through the source code of each of the programs 
presented in the Mac Primer. We'll start with each program's #defines 
and global variables, then dig into every one of the program's 
functions. 

The first few lines of Hello2 . c are #defines. THINK C #defines 
are the same as those found in other C programming environments. 
During compilation, THINK C takes the first argument of the 
#define, finds each occurrence in the source code, and substitutes the 
second argument. For example, in the first #define, the number 128 
will be substituted for each occurrence of kBaseResID. 

l l 
#def ines don't actually modify your copy of the source code. 
THINK C creates its own copy of the source code and makes the 
substitution on its copy. 

#define kBaseResID 12 8 
#define kMoveToFront (WindowPtr )-11 

#define kHorizontalPixel 30 
#define kVerticalPixel 50 

The constants kHorizontalPixel and kVerticalPixel describe, 
in the window's local coordinates, where the text string will be drawn. 

Next come the function prototypes. Each program in this book 
uses function prototypes at the top of each source code file. While not 
strictly necessary, function prototypes will make your source code 
easier to read, and will aid in ensuring that each function is called 
with parameters of the correct type. 

void ToolBoxini t( void ) ; 
void Windowinit( void ) ; 

main() calls ToolBoxinit () to initialize the Macintosh Toolbox, 
then Windowinit () to load a window from the resource file then 
draw some text in the window. 

79 
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/****************** main ***************************/ 

void main( void 

ToolBoxinit(); 
Windowinit(); 

while ( ! Button () 

ToolBoxinit () will remain unchanged throughout the book. 
Although you won't always use all the data structures and variables 
initialized by ToolBoxinit (),you are perfectly safe in doing so. It is 
much easier and safer to initialize each of the Macintosh Toolbox 
managers than to try to figure out which ones you'll need and which 
you won't. 

/****************** ToolBoxinit *********************/ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
InitFonts(); 
InitWindows(); 
InitMenus(); 
TEini t () ; 
InitDialogs( nil); 
InitCursor(); 

Each call initializes a different part of the Macintosh interface. The 
call to InitGraf () initializes QuickDraw. 

Ini tFonts () initializes the Font Manager and loads the system 
font into memory. Since the Window Manager uses· the Font Manager 
(to draw the window's title, for example), you must initialize fonts 
first. InitWindows () initializes the Window Manager and draws the 
desktop and the empty menu bar. InitMenus () initializes the Menu 
Manager so you can use menus. (Chapter 5 shows how to use the 
Menu Manager). Ini tMenus () also draws the empty menu bar. 

TEinit () initializes TextEdit, the Text-Editing Manager that 
MiniEdit uses (discussed in the THINK C User Manual and in Inside 
Macintosh). Ini tDialogs () initializes the Dialog Manager (demon­
strated in Chapter 6). InitCursor () sets the cursor to the arrow 
cursor and makes the cursor visible. 
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The following global variables are initialized by InitGraf () and 
can be used in your routines: 

• thePort always points to the current GrafPort . Because it is 
the first QuickDraw global, passing its address to InitGraf () 
tells QuickDraw where in memory all of the other QuickDraw 
globals are located. 

• white is a pattern variable set to a white fill; black, gray, 
ltGray, and dkGray are initialized as different shades between 
black and white. 

• arrow is set as the standard cursor shape, an arrow. You can 
pass arrow as an argument to QuickDraw's cursor-handling 
routines. 

• screenBits is a data structure that describes the main Mac 
screen. The field screenBits .bounds is declared as a Rect 
and contains a rectangle that encloses the main Mac screen. 

• randSeed is used as a seed by the Macintosh random number 
generator (we'll show you how to use the random number 
generator in this chapter). 

InitWindows () and InitMenus () both draw the empty menu 
bar. This is done intentionally by the ROM programmers for a 
reason that is such a dark secret they didn't even document it in 
Inside Macintosh. 

I I 

As we said, it's not necessary to call each of these routines in every 
program you'll ever write. Why, then, should you call I ni tMenus (), 
for example, if you don't use menus? Well, suppose you decide to add 
menus later. Calling In i t Menus () now means you won't spend time 
later wondering why your program is crashing when all you did was 
add a new menu-handling routine. 

You may take advantage of an external procedure that does use 
menus. As we discussed earlier, some manager s r equire the use of 
information in other managers. If one manager is not initialized, your 
program may not work. Use the Too l boxinit () routine in all your 
programs. 
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/****************** Windowinit ***********************/ 

void Windowinit( void 

WindowPtr window; 

window= GetNewWindow( kBaseResID, nil, kMoveToFront ); 

Windowinit () calls GetNewWindow () to load the WIND resource 
with a resource ID of kBaseResID from your resource file. The first 
parameter specifies the resource ID. The second parameter tells the 
Toolbox how memory for the new window data structure should be 
allocated. Because you passed nil as the second parameter, the 
Toolbox will allocate the memory for you. Finally, the third parameter 
to GetNewWindow () tells the Window Manager to create this window 
in front of any of the application's open windows. 

if ( window == nil 

SysBeep ( 10 ) ; 

Exit To Shell() ; 

/* Couldn't load the WIND 
resource!!! */ 

GetNewWindow () returns a pointer to the new window data struc­
ture in the variable window. GetNewWindow () will return a value of 
nil if it can't create the window for some reason. GetNewWindow () 
can fail for several reasons. On one hand, since we passed n i 1 as the 
second parameter, we've asked GetNewWindow () to allocate memory 
for the window's data structure. If GetNewWindow () can't allocate 
enough memory to create the window, it will fail and return n i 1. 

Even more likely, if GetNewWindow () returns nil, it's because it 
couldn't load the WIND resource from the resource file. If this is the 
case, check to make sure the resource has the proper resource ID, and 
that the resource file is named correctly. 

If window is nil, both SysBeep () and ExitToShell () are called. 
SysBeep () will emit a single beep (or whatever sound passes for a 
beep on your Mac). The value passed to SysBeep (} is ignored. Make 
sure you pass a value, though, as SysBeep () expects one. 
ExitToShell () will immediately exit the program, returning to 
whatever program spawned it (in this case, THINK C). 

ShowWindow( window); 
SetPort( window); 
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MoveTo( kHorizontalPixel , kVerticalPixel ); 
DrawString( " \pHello , world !" ) ; 

Next, Windowinit () calls ShowWindow () to make the window 
visible. If the WIND resource's uisible check box was not checked, it is 
at this point that the window actually appears on the screen. The call 
to Set Port () makes window the current window. All subsequent 
QuickDraw drawing operations will take place in window. Next, 
window's pen is moved to the local coordinates 50 down and 30 across 
from the upper left-hand corner of window, and Dr awstring () is 
used to draw the string Hello , world ! starting at the current pen 
coordinates. 

As mentioned earlier, the characters \p found at the beginning of a 
quoted string tell the compiler to generate the string in Pascal form 
(using the leading length byte), as opposed to C form (with a trailing 
nil byte). Use this technique whenever you pass a quoted string to 
a Toolbox function that requires an str255 parameter. 

Hello2 can easily be turned into a standalone application. Pull down 
the Project menu and select Build Application .... When the Build 
Application dialog box appears, type Hello2 in the Saue 
application as: field, then click Saue. THINK C will turn the 
projects compiled code into a standalone application, copying all of the 
resources from the project resource file (Hello2 . 7t. rsrc) into the 
application's resource fork. Take your new application out for a test 
drive by double-clicking its icon in the Finder. You'll find out how to 
add a custom icon to your applications in Chapter 8. 

Variants 

This section presents some variants to the Hello2 program. We'll start 
by changing the font used to draw Hello , world !. Next, we'll modify 
the style of the text, using boldface, italics, and so on. We'll also show 
you how to change the size of your text. Finally, we'll experiment with 
different window types. 
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Changing the Font 

Every window has an associated font. You can change the current 
window's font by calling TextFont (), passing an integer that repre­
sents the font you'd Hke to use: 

short myFontNumber ; 

TextFont( myFontNumber ); 

Macintosh font numbers start at 0 and count up from there. THINK 
C has predefined a number of font names with which you can 
experiment . For example, monaco is defined as 4, times as 20. If you 
want to check out the whole list, open the file Fonts . h in the Apple 
#includes folder, which is inside the Mac #includes folder. 

The best way to make use of a specific font is to pass its name as a 
parameter to the Toolbox routine GetFNum () . GetFNum () will return 
the font number associated with that name. You can then pass the 
font number to TextFont () . 

Did someone in the back ask, "How can you tell which fonts have 
been installed in the system?" An excellent question! Not every Mac 
has the same set of fonts installed. Some folks have the 
LaserWriter font set; others a set of fonts for their StyleWriter. Some 
people might even have a complete set of foreign language fonts. 
For the most part, your applications shouldn't care which fonts are 
installed. There are, however, two exceptions to this rule. All dialog 
boxes and menus are drawn in the system font, which defaults to 
font number 0. The default font for applications is called the 
application font, usually font number 1 . In the United States, the 
system font is Chicago, and the application font is Geneva. 

For now, put the GetFNum () and TextFont () calls before your call 
to Move To () and after your call to. Set Port (), and try different font 
names (use the Key Caps desk accessory for a list of font names on 
your Mac). GetFNum () will set fontNum to 0 if it can't find the 
requested font. Don't forget to declare fontNum at the top of 
Windowinit () . 
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/****************** Windowinit ***********************/ 

void Windowinit( void 

WindowPtr 
short 

window; 
f ontNum; 

window GetNewWindow( kBaseResID , nil, 
kMoveToFront ); 

if ( window == nil 

SysBeep ( 10 ) ; 

Exit To Shell() ; 

ShowWindow( window); 
SetPort( window); 

/* Couldn't load the WIND 
resource! ! ! *I 

Get!'Num( "\pMonaco", &fontNum ); 

if ( fontNum != 0 ) 
TextFont( fontNum ); 

MoveTo( kHorizontalPixel, kVerticalPixel ); 
DrawString("\pHello, world!"); 

Changing Text Style 

The Macintosh supports seven font styles: bold, italic, underlined, 
outline, shadow, anhBrl, and e x t e n d e d , or any combination of 
these. Chapter 5 shows you how to set text styles using menus. For 
now, try inserting the call TextFace ( style ) before the call to 
Drawstring ().Here's one example: 

/****************** Windowlnit ***********************/ 

void Windowinit( void 

WindowPtr window; 
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window GetNewWindow( kBaseResID , nil , 

kMoveToFront ) ; 

if ( window == nil 

SysBeep ( 10 ) ; 

Exit ToShell () ; 

ShowWindow( window ) ; 

SetPort( window) ; 

/* Couldn ' t load the WIND 

resource ! ! ! * I 

TextFace( bold) ;/* Try the other styles*/ 

MoveTo( kHorizontalPixel , kVe r t i calPixel ) ; 
DrawString( " \pHello , world ! " ) ; 

Some predefined styles taken from the #include file 
QuickDraw . h: 

bold 
italic 
underline 
outl i ne 

s hadow 
condense 
ext end 

You can also combine styles; try TextFace ( bold + italic ) or 
some other combination. 

Changing Text Size 

It's also easy to change the size of the fonts, using the TextSi ze () 
Toolbox routine: 

short myFontSize ; 

TextSize( myFontSize ) ; 

The number you supply as an argument to TextSize () is the font 
size that will be used the next time text is drawn in the current 
window. The Font Man ager will draw the smoothest text it can in the 
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Figure 3.32 _Font scaling wjth a non-TrueType font. 
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, 

font size you specify. TrueType fonts (Apple's new font technology 
available under System 7) will yield the best results. If the current 
font is not a TrueType font, and the requested size is not available, the 
Font Manager will scale the font to the requested size; this may result 
in jagged characters (Figure 3.32). 

Try this variation in your code: 

/*** *************** Windowini t ***************** ~*****/ 

void Windowinit( void 

WindowPtr window ; 

window = GetNewWindow ( kBaseResID , nil , 
kMoveToFront ) ; 

if ( window == nil 

SysBeep ( 10 ) ; 

ExitToShell () ; 

ShowWindow( window); 
SetPorc( window ) ; 

/* Couldn ' t load the WIND 

resource ! ! ! *I 
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TextSize( 24 ); /*Try some other sizes ... */ 

MoveTo( kHorizontalPixel, kVerticalPixel ); 
DrawString("\pHello, world!"); 

Changing the Hello2 Window 

Another modification you can try involves changing Hello2's window 
type. Use ResEdit to edit the WIND resource in Hello2. 7t. rsrc. Click 
on one of the other window types, save your changes, and run 
Hello2. 7t again to check out your results. 

Now that you have mastered QuickDraw's text-handling routines, 
you're ready to exercise the shape-drawing capabilities of QuickDraw 
with the next program: Mondrian. 

Mondrian 

The Mondrian program opens a window and draws randomly gen­
erated ovals, alternately filled with white or black. Like Hello2, 
Mondrian waits for a mouse click to exit. The program, with its vari­
ants, demonstrates most of QuickDraw's shape-drawing functionality. 

Mondrian is made up of three steps: 

• As always, start by initializing the Toolbox; 
• Next, initialize the drawing window; 
• Finally, draw random QuickDraw ovals in a loop until the mouse 

button is clicked. 

Create a new folder called Mondrian in the Development folder. 
Just as you did with Hello2, you'll use this folder to collect all the files 
associated with the Mondrian program. Start by creating the 
Mondrian resource file. 

Resources 

The Mondrian program needs a WIND resource, just as Hello2 did. Use 
ResEdit to create a new resource file called Mondrian. 7t. rsrc inside 
the Mondrian folder. Next, use ResEdit to create a new WIND. 
resource, matching the specifications in Figure 3.33. Select Set 
'WI ND' Characteristics ... from the WI ND menu and change the 



Drawing on the Macintosh 

~ f lll 11111 IMDll'm WlndDW 

i"Fllilif•• 

Top:~ Height:~ 

Left:~ Width:~ 

Color: @Default 
O Custom 

O Initially uisible 

0 Close boH 

Figure 3.33 The WIND resource from Mondrian . n. rsrc. 
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Window Title: field to Mondrian. Next, select Get Resource Info 
from the Resource menu, set the IO: field to 128, and check the 
Purgeable checkbox. Quit ResEdit, saving your changes. 

Next, go into THINK C and create a new project called Mondrian . 7t 

inside the Mondrian folder. Use Add .•. from the Source menu to add 
MacTraps to the project. You'll find MacTraps inside the 
Development folder, inside the THINK C 5. 0 Folder, inside the Mac 
Libraries folder. 

Once MacTraps is added, open a new source code window, as you 
did with Hello2 , and enter the program: 

#define kBaseResID 
#define kMoveToFront 
#define kRandomUpperLimit 

/******* ****** / 

/* Globals */ 
/****** ** *****/ 

128 
(Windo wPtr)-lL 
32768 

long gFillColor blackColor; 
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/***************/ 
/* Functions */ 
/***************/ 

Macintosh C Programming Primer 

void 
void 
void 
void 
void 
short 

ToolBoxinit( void); 
Windowinit( void); 
MainLoop( void); 
DrawRandomRect( void); 
RandomRect( Rect *rectPtr ); 
Randomize( short range); 

/****************** main ***************************/ 

void main( void 

ToolBoxinit(); 
Windowinit(); 
MainLoop(); 

/****************** ToolBoxinit *********************/ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
InitFonts (); 
InitWindows(); 
InitMenus(); 
TEinit (); 
InitDialogs( nil ); 
Ini tCursor () ; 

/****************** Window!nit ***********************/ 

void Windowinit( void 

WindowPtr window; 
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window GetNewWindow( kBaseResID , nil, 
kMoveToFront ); 

if ( window == nil 

SysBeep( 10 ); 

ExitToShell (); 

ShowWindow( window); 
SetPort( window); 

I* Couldn't load the WIND 
resource!!! */ 

/****************** MainLoop ***********************/ 

void MainLoop( void ) 

GetDateTime( (unsigned long*) ( &randSeed) ); 

while ( ! Button() ) 
{ 

DrawRandomRect(); 

if ( gFillColor == blackColor 
gFillColor 

else 
gFillColor 

whiteColor; 

blackColor; 

/****************** DrawRandomRect *****************/ 

void DrawRandomRect( void ) 

Rect randomRect; 

RandomRect( &randomRect ); 
ForeColor( gFillColor ); 
PaintOval( &randomRect ); 
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/****************** RandomRect *********************/ 

void RandomRect( Rect *rectPtr ) 

WindowPtr window; 

window= FrontWindow(); 

rectPtr->left = Randomize( window->portRect.right 
- window->portRect.left ); 

rectPtr->right =Randomize( window->portRect.right 
- window->portRect.left ); 

rectPtr->top =Randomize( window->portRect.bottom 
- window->portRect.top ); 

rectPtr->bottorn = Randomize( window->portRect.bottom 
- window->portRect.top ); 

/****************** Randomize **********************/ 

short Randomize( short range ) 

long randornNumber; 

randomNumber =Random(); 

if ( randomNurnber < 0 ) 
randomNumber *= -1; 

return( (randomNumber *range) I kRandomUpperLimit ); 

Running Mondrian 

Once you've finished typing in the code, save it as Mondrian. c and 
add it to the project using Rdd (not Rdd ... ) from the Source menu. 
Next, select Run from the Project menu, clicking Yes to the question 
Bring the project up to date? If the source code compiles 
correctly, you should see something like Figure 3.34. The Mondrian 
window will appear, filled with black and white randomly generated 
ovals. Click the mouse button to exit Mondrian. If you get a different 
result, check out your resource; make sure the WIND resource has the 
correct resource ID; make sure your resource file is named correctly. If 
your resource file appears to be all right, go through the code for 
typing errors. 

Now let's look at the Mondrian code. 
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Figure 3.34 Running Mondrian. 

Walking Through the Mondrian Code 

The Mac Primer uses the convention of starting resource ID numbers 
at 128, adding one each time a new resource ID is needed. Use any 
number you want (as long as it's between 128 and 32,767). 

Remember, if you change the number of the starting resource ID, 
you'll need to change the resource ID of all the resources in your 
. rsrc files, too. 

J. 1 l 
The #defines kBaseResID and kMoveToFront are identical to 

those used in Hello2. The global variable gFillColor determines the 
color used to draw each oval. As each oval is drawn , gFillColor is 
alternated between blackColor and whiteColor. 

#define kBaseResID 
#define kMoveToFront 
#define kRandomUpperLimit 

128 
(WindowPtr )- lL 
32768 
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/*"'***********/ 
/* Globals */ 
/*"'***********/ 
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long gFillColor = blackColor; 

Next come Mondrian's function prototypes: 

/***************/ 
/* Functions */ 
/***************/ 

void 
void 
void 
void 
void 
short 

ToolBoxinit( void); 
Windowinit( void); 
MainLoop( void); 
DrawRandomRect( void); 
RandomRect( Rect *rectPtr ); 
Randomize( short range); 

The main routine is exactly the same as it was in Hello2: 

/****************** main ***************************/ 

void main( void 

ToolBoxinit(); 
Windowinit () ; 
MainLoop(); 

The Toolbox initialization routine is also the same as in Hello2. 

/****************** ToolBoxinit *********************/ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
InitFonts(); 
InitWindows(); 
InitMenus(); 
TEini t () ; 

InitDialogs( nil); 
InitCursor(); 
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Windowlnit () loads WIND number 128 from the resource file, 
storing a pointer to it in myWindow. If the window couldn't be created 
for some reason, GetNewWindow () will return a value of nil. In that 
case, Mondrian issues a beep, then exits to the Finder. 

/ •**********•****** Windowlnit ******************•** • • / 

void Windowinit( void 

WindowPtr window; 

window = GetNewWindow( kBaseResID , nil , 
kMoveToFront ) ; 

if ( window == nil 

SysBeep( 10 ) ; 

ExitToShell() ; 

/ * Couldn ' t load t he WIND 
resource ! ! ! *I 

If GetNewWindow () was able to create the window, window is 
made visible and is made the current port. 

ShowWindow ( window ) ; 
SetPort ( window ); 

Main Loop () starts by using the current time (in seconds since 
January 1, 1904) to seed the Mac random number generator . The 
QuickDraw global randSeed is used as a seed by the random number 
generator. If you didn't modify randSeed, you'd generate the same 
patterns every t ime you ran Mondrian. 

The GetDateTime ( l Toolbox routine requires a pointer to an 
unsigned long integer. That's why (Unsigned long *l is put in 
front of randSeed in MainLoop ( ) . Although providing this 
information is not required for Toolbox calls by THINK C, it will save 
you plenty of debugging time later on. 

l l 
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/****************** MainLoop ***********************/ 

void MainLoop( void ) 

GetDateTirne( (unsigned long*) ( &randSeed) ); 

MainLoop () then sets up a loop that falls through when the mouse 
button is pressed. In the loop, DrawRandomRect () is called, first 
generating a random rectangle inside the window, then drawing an 
oval in the rectangle. Next, gFillColor is flipped from black to white 
or from white to black. 

while ( ! Button() 
{ 

DrawRandornRect(); 

if ( gFillColor ;= blackColor 
gFillColor 

else 
gFillColor 

whiteColor; 

blackColor; 

DrawRandomRect () controls the actual drawing of the ovals in the 
window. RandomRect () generates a random rectangle bounded by the 
Mondrian window, ForeColor () sets the current drawing color to 
gFillColor, and PaintOval () paints the oval inside the generated 
rectangle. 

/****************** DrawRandomRect *****************/ 

void DrawRandomRect( void) 

Rect randornRect; 

RandomRect( &randomRect ); 
ForeColor( gFillColor ); 
PaintOval( &randomRect ); 

RandomRect () uses the Front Window () Toolbox routine to 
retrieve a pointer to the frontmost window. Since Mondrian only uses 
one window, Front Window () is guaranteed to return a pointer to the 
window we want. 
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/****************** RandomRect ********************* / 

void Ra~domRect( Rect *rectPtr ) 

WindowPtr window ; 

window = FrontWindow( ); 

Next, RandomRect () sets up the rectangle to be used in drawing 
the oval. Each of the four sides of the rectangle is generated as a 
random number between the right and left (or top and bottom, as 
appropriate) sides of the window pointed to by window. 

The notation structPtr- >aField refers to the field aField in 
the struct pointed to by structPtr. For example: 

rectPtr- >left 

refers to the field named left in the struct pointed to by 
rectPtr. Struct pointer notation is specific to C, not peculiar to the 
Macintosh. 

.. I . 

Every window data structure has a field named portRect (of type 
Rect) that defines the boundary of the content region of the window. 
Because window is a pointer to a window data structure, you use 
window- >portRect to access this rectangle. 

rectPtr- >left = Randomize( window->portRect.right 
- window- >portRect . left ) ; 

rectPtr- >right = Randomize( window->portRect . right 
- window->portRect . left ); 

rectPtr- >top =Randomize( window->portRect . bottom 
- window- >portRect .top ) ; 

rectPtr- >bottom =Randomize( window->portRect . bottom 
- window- >portRect.top ); 

Randomize () takes an integer argument and returns a positive 
integer greater than or equal to 0, and less than the argument. You 
may find Randomize () helpful in your own applications. 



98 

_J 

Macintosh C Programming Primer 

/****************** Randomize **********************/ 

short Randomize( short range 

long randomNumber; 

Randomize () starts by calling Random () , a Toolbox utility that 
returns a random number between -32, 767 and 32, 767. 

randomNumber =Random(); 

If the value returned is negative, multiply it by -1. This creates a 
number between 0 and 32, 767. 

if ( randomNumber < 0 
randomNumber *= -1; 

Finally, multiply that number by the input parameter, then divide 
by kRandomUpperLimit (which was defined earlier to be 32,768). This 
creates a number greater than or equal to 0 and less than the input 
parameter. 

return( (randomNumber *range) I kRandomUpperLimit ); 

Variants 

Here are some variants of Mondrian. The first few change the shape of 
the repeated figure in the window from ovals to some other shapes. 

Your first new shape will be a rectangle. This one's easy: Just 
change the PaintOval () call to PaintRect (). When you run this, 
you should see rectangles instead of ovals. 

Your next new shape is the rounded rectangle. You'll need two new 
parameters for PaintRoundRect (): oval Width and oval Height. 
These two parameters affect the curvature of the corners of the 
rectangle (l:l 79). Try the following values for ovalWidth and 
ovalHeight: 

#define kOvalWidth 20 
#define kOvalHeight 20 
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Now, change DrawRandomRect () as follows: 

/****** ****** *** * ** DrawRandomRect ***************** / 

void DrawRandomRect ( void) 

Re c t randomRect ; 

RandomRect ( &randomRect ); 
ForeColor( gFillColor ); 
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PaintRoundRect( &randomRect , kOvalWidth, kOvalHeiqht ); 

When you run this variation, you should see something like 
Figure 3.35. 

Figure 3.35 Mondrian with rounded rectangles. 

Instead of filling the rectangles, try using FrameRoundRect ( ) to 
draw just the outline of your rectangles: 

/****************** DrawRandomRect ***************** / 

void DrawRandomRect( void) 

Rect randomRect ; 
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RandomRect( &randomRect ); 
ForeColor( gFillColor ); 
FrameRoundRect( &randomRect, kOvalWidth, kOvalBeiqht ); 

The framing function is more interesting if you change the state of 
your pen: The default setting for your pen is a size of 1 pixel wide by 1 
pixel tall, and the pattern used to fill drawn lines is black. Start by 
adding #defines of PEN_WIDTH and PEN_HEIGHT: 

#define kPenWidth 10 
#define kPenHeight 2 

Change the pen state by modifying Windowinit () as follows: 

/****************** Windowinit ***********************/ 

void Windowinit( void 

WindowPtr window; 

window = GetNewWindow( kBaseResID , nil, 
kMoveToFront ); 

if ( window == nil 

SysBeep ( 10 ) ; 

ExitToShell (); 

ShowWindow( window); 
SetPort{ window); 

/* Couldn't load the WIND 
resource! ! ! *I 

PenSize( kPenWidth, kPenBeiqht ); 
PenPat( gray); 

Here, you changed the pen pattern to gray, the pen width to 
kPenWidth, and the pen height to kPenHeight. Your result should 
look something like Figure 3.36. 

While you're at it, try using InvertRountRect () instead of 
FrameRoundRect (). InvertRoundRect () will invert the pixels in 
its rectangle. The arguments are handled in the same way (Figure 
3.37). 
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Mondrian 

Figure 3.36 Mondrian with framed, rounded rectangles. 

Figure 3.37 A '60s Mondrian with inverted, rounded rectangles. 

Next, try using F rameArc () in place of I nvertRoundRect () . 
Frame Arc ( ) requires two new parameters. The first defines the arc's 
starting angle, and the second defines the size of the arc. Both are 
expressed in degrees (Figure 3.38). 
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Figure 3.38 Figuring your arc. 

Change DrawRandomRect () as follows: 

/****************** DrawRandomRect *****************/ 

void DrawRandomRec~( void) 

Rect randomRect; 

RandomRect( &randomRect ) ; 
ForeColor( gFillColor ); 
FrameArc( &randomRect, kStartDegrees, kArcDegrees ); 

Don't forget to #define kStartDegrees and kArcDegrees. Try 
using values of 0 and 270. Experiment with PaintArc () and 
InvertArc (). 

We'll do one final variation with QuickDraw, which is useful only on 
color monitors. If you change the ForeColor () arguments in 
MainLoop (), you can see colored filled ovals (or whatever your 
program is currently producing). Change the declaration of the global 
gFillColor as follows: 

long gFillColor redColor; 

Modify MainLoop () as follows: 

/****************** MainLoop ***********************/ 

void MainLoop( void ) 

GetDateTime( &randSeed ); 
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while ( ! Button (} } 

DrawRandomRect(}; 

if ( gFillColor == redColor ) 
gFillColor = yellowColor; 

else 
gFillColor = redColor; 

Finally, make sure DrawRandomRect () calls a Paint () function to 
do its drawing (as opposed to a Frame () or Invert () function): 

/****************** DrawRandomRect *****************/ 

void DrawRandomRect( void} 

Rect randomRect; 

RandomRect( &randomRect }; 

ForeColor( gFillColor }; 

PaintArc( &randomRect, kStartDegrees, kArcDegrees ); 

The following colors have already been defined for you: 
blackColor, whiteColor, redColor, yellowColor, greenColor, 
blueColor, cyanColor, and magentaColor. These colors are part of 
Classic QuickDraw-the original, eight-color QuickDraw model that 
was part of the original Macintosh. Newer Macs support a new version 
of QuickDraw called Color QuickDraw, which supports millions of 
different colors. (Color QuickDraw is discussed in Volume II of the Mac 
Primer.) The programs you write using the eight colors of Classic 
QuickDraw will run on any Macintosh (even the Mac II series). 

The next program demonstrates how to load QuickDraw picture 
resources and draw them in a window. 

Show PICT 

ShowPICT will take your favorite artwork (in the form of a PICT 
resource) and display it in a window. You can create a PICT resource 
by copying any graphic to the Mac clipboard, then pasting it into a 
ResEdit PICT window. We'll show you how a little later. We copied our 
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artwork from the scrapbook that comes with the Macintosh System 
disks. 

Show PICT is made up of five distinct steps: 

• Initialize the Toolbox; 
• Load a resource window, show it , and make it the current port; 
• Load a picture from the resource file; 
• Center the picture, then draw it in the window; 
• Wait for the mouse button to be clicked. 

Resources 

Start by creating a new folder, called ShowPICT, in the Development 
folder. Next, using ResEdit, create a new resource file called 
ShowPICT .1t . rsrc in the ShowPICT folder. Create a WIND resource 
using the specifications shown in Figure 3.39. Select Set 'WI NO' 
Characteristics ... from the WI ND menu and set the Window title: 
field to ShowPICT, then click OK. Next, select Get Resource Info 
from the Resource menu, set the resource ID of the WIND to 128, and 
check the Purgeable checkbox. Close the Resource Info window, close 
the WIND editing window, and close the WIND list window, leaving the 
window titled ShowPICT .1t . rsrc as the only open window. 

Now you'll create a PICT resource. Pull down the S menu and 
select the Scrapbook. Find a picture that is of type PICT- you can 
tell by checking the label on the bottom right of the Scrapbook 

~0 WIND ID = 128 f rom ShowPICT.11.rsrc 

• f lll ldll IMDUtr. Window 

Top:~ Height:~ 

Left:~ Width: ~ 

Figure 3.39 ShowPICT's WIND resource. 

Color: ® Default 
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0 Close bo11 
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window-pull down the Edit menu, and select Copy. Close the 
Scrapbook and return to ResEdit. Select Paste from the Edit menu; 
ResEdit will use the copied picture to create a PICT resource (Figure 
3.40). 

In the ShowPICT . 1t. rsrc window, double-click on the PICT icon. A 
window displaying all of the PICTs in ShowPICT . 1t. rsrc will appear 
(Figure 3.41). Click on your picture (it should be t he only one) and 
select Get Resourc e Info from the Resource menu. Set the 
resource ID of the PI CT to 128 and check the Purgeable checkbox. 
Finally, quit ResEdit, saving your changes to ShowPICT. 7t. rsrc. 

!!!D~ ShowPICT.11.rsrc - E!l!!! 

CJ ~ 
~,j 
PICT WIND 

-0 
fQj 

Figure 3.40 ResEdit window showing ShowPICT's two resource types, P ICT 
and WIND. 

PICTs from ShowPICT.11.rsrc 

Figure 3.41 The PICT resource created for ShowPICT. 
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Next, go into THINK C and create a new project called ShowPICT .1t 

inside the ShowPICT folder. Select New from the File menu and enter 
the following code: 

#define kBaseResID 
#define kMoveToFront 

/***************/ 
/* Functions */ 
/***************/ 

128 
(WindowPtr) -11 

void 
void 
void 
void 

ToolBoxinit( void); 
Windowinit( void); 
DrawMyPicture( void); 

CenterPict( PicHandle picture, Rect *destRectPtr ); 

/****************** main ***************************/ 

void main( void 

ToolBoxinit(); 
Windowinit\); 

DrawMyPicture(); 

while ( ! Button () 

/****************** ToolBoxinit *********************/ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
Ini tFonts () ; 
InitWindows(); 
InitMenus(); 
TEinit (); 
InitDialogs( nil); 
InitCursor(); 
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/****************** Windowinit ***********************/ 

void Windowinit( void 

WindowPtr window; 

window= GetNewWindow( kBaseResID, nil, kMoveToFront ); 

if ( window == nil 

SysBeep ( 10 ) ; 

ExitToShell (); 

ShowWindow( window); 
SetPort( window); 

/* Couldn't load the WIND 

resource! ! ! *I 

/****************** DrawMyPicture ********************/ 

void DrawMyPicture( void ) 

Rect pictureRect; 
WindowPtr 
PicHandle 

window; 
picture; 

window= FrontWindow(); 

pictureRect = window->portRect; 

picture= GetPicture( kBaseResID ); 

if ( picture == nil 

SysBeep( 10 ); 

ExitToShell(); 

/* Couldn't load the PICT 
resource! ! ! *I 

CenterPict( picture, &pictureRect ); 
DrawPicture( picture, &pictureRect ); 
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/****************** CenterPict ********************/ 

void CenterPict( PicHandl e picture , Rect *destRectPtr 

Rect windRect , pictRect; 

windRect = *destRectPtr ; 
pictRect = (* *(picture)) . picFrame; 
OffsetRect( &pictRect , windRect.left - pictRect.left , 

windRect . top - pictRect . top); 
OffsetRect ( &pictRect, (windRect.right -

pictRect.right ) /2 , (windRect.bottom -
pictRect.bott om)/2) ; 

*destRectPtr = pictRect; 

Running ShowPICT 

After you've finished typing in the code, save the file as ShowPICT . c 
and add it to your project. Next, select Rdd ... from the Source menu 
and add MacTraps to your project. Finally, select Run from the 
Project menu. If everything went well, a window similar to the one 
in Figure 3.42 should appear. Did your PICT appear in your ShowPICT 
window? If not, check your PICT's resource ID. Check the name of 
your project and resource file. Check your WIND resource. If everything 
else seems to be OK, check your code for typing errors. 

ShowPICT 

• 

Figure 3.42 Running ShowPICT. 
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The #defines kBaseResID and kMoveToFront perform the same 
function as they did in earlier programs. 

#define kBaseResID 

#define kMoveToFront 

/***************/ 
/* Functions */ 

/***************/ 

128 

(WindowPtr) -lL 

void ToolBoxinit( void); 

void Windowinit( void); 
void DrawMyPicture( void ); 

void CenterPict( PicHandle picture, Rect *destRectPtr ); 

main() starts by initializing the Toolbox. Next, Windowinit () is 
called to set up ShowPICT's window. 

/****************** main ***************************/ 

void main( void 

ToolBoxinit(); 

Windowini t () ; 

DrawMyPicture () loads the PICT from the resource file, then 
draws the PICT in the ShowPICT window. Finally, main () waits for a 
click of the mouse button. 

DrawMyP ict ure () ; 

while ( ! But ton () 

The Toolbox initialization routine remains the same: 

/****************** ToolBoxinit *********************/ 

void ToolBoxinit( void 

InitGraf( &thePort ); 

InitFonts(); 
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InitWindows(); 

Ini tMenus () ; 
TEini t () ; 
InitDialogs( nil); 
InitCursor (); 

Macintosh C Programming Primer 

Windowinit () remains the same as in Mondrian. 

/****************** Windowinit ***********************/ 

void Window!nit( void 

WindowPtr window; 

window= GetNewWindow( kBaseResID, nil, kMoveToFront ); 

if ( window == nil 

SysBeep ( 10 ) ; 

ExitToShell (); 

ShowWindow( window); 

SetPort( window ); 

/* Couldn't load the WIND 

resource! ! ! *I 

DrawMyP icture () calls Front Window() to retrieve a pointer to 
the frontmost window. Since ShowPICT uses only one window, 
Front Window () is guaranteed to return a pointer to the correct 
window. 

/****************** DrawMyPicture ********************/ 

void DrawMyPicture( void ) 

Rect pictureRect; 
WindowPtr 
PicHandle 

window; 
picture; 

window= FrontWindow(); 



Drawing on the Macintosh 111 

Next, pictur eRect is set to the size of the ShowPICT window's 
content region: 

pictureRect = window- >portRect ; 

Next, GetPicture () is called to retrieve the PICT resource from 
the resource file . If the PI CT can't be loaded, the program beeps, then 
exits. 

picture= Get Pi cture ( kBaseResID ) ; 

if ( p i cture == nil 

SysBeep ( 10 ) ; 

ExitToShell() ; 

/* Couldn ' t load the PICT 

resource ! ! ! *I 

It's important to remember that Getpicture () may return nil for 
several different reasons. The most likely: Getpicture () either 
couldn't find or couldn't load the PICT resource. GetPicture () 
will also return nil if it can't allocate enough memory to create the 
picture's data structure. 

ll . -,-
Next, the picture and the Rect are passed to CenterPict () . 

CenterPict () constructs a new Rect the size of picture , center­
ing it in the original Rect . Finally, DrawMyPi cture () uses 
DrawPicture () to draw picture in the newly centered Rect . 

CenterPict( picture , &pictureRect ) ; 
DrawPicture( picture , &pictureRect ) ; 

In this program, CenterPict () is used to center a picture in a 
window. The original Rect is copied into the local variable windRect . 
The picture's framing Rect is then copied to the local variable 
pictRect . Finally, each field in the original Rect is modified, based 
on the co1Tesponding fields in windRect and pictRect. For example, 
pictRect . top is adjusted to become the new top of the picture. 

CenterP ict () is a useful utility routine. You'll be seeing it again 
in other chapters. 
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/ ****************** CenterPict ******************** / 

void Cent erPict( PicHandle picture , Rect *destRectPtr 

Rect windRect , pictRect; 

windRect = *destRectPtr ; 
p i ctRect = (**(picture)) . picFrame ; 
OffsetRect ( &pictRect , windRect . left - pictRect . left , 

windRect . top - pictRect . top) ; 

OffsetRect ( &pictRect, (windRect. right -

pictRect. right) /2 , (windRect. bot tom -
pictRect . bottom)/2) ; 

*destRec tPtr = pictRect ; 

A Handle is a specialized pointer to a pointer. Handles are a 
necessary part of the Mac's memory management scheme. They 
allow the Macintosh Memory Manager to relocate blocks of memory 
as it needs to, without disturbing your program. 

If your program makes use of a pointer to a variable or a block of 
memory, you depend on that variable or block of memory to stay in 
one place. If the block moves, your pointer will no longer point to it! 

Since pointer blocks are not allowed to move, they tend to 
fragment the memory available to your program. That's where 
Handles come in. A Handle is a pointer to a pointer. If you have a 
Handle to a block of memory, the Macintosh Memory Manager can 
move the block around in memory without affecting your program's 
Handle to the block. This allows the Memory Manager to maximize 
the efficiency of the memory available to your program. 

We'll show you some of the basics of using handles, but we 
won't spend a lot of time on them (there's an entire chapter 
dedicated to handles and related topics in Volume II of the Mac 
Primer). You should read up on handles and the Mac memory 
management scheme. Eventually you'll want to write code that 
takes advantage of handles. 

l 
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In ShowPICT, we declare a handle to a picture (pointer to a pointer 
to a picture). We then set the handle to the value returned by 
GetPicture (): 

PicHandle picture ; 
pictur e = GetPicture( kBaseResID ); 

Like most of the Toolbox functions that return handles, 
GetP i c t ure () actually allocates the memory for the picture itself, 
as well as the memory for the pointer to the picture. The great thing 
about handles is that you hardly know they're there. 

l I 

T 

Variants 
...!.. 

Try using different pictures, either from the Scrapbook or from 
MacPaint or some other Macintosh graphics program. With a little 
experimentation, you should be able to copy and paste these files into 
your resource file. In Chapter 4, you'll see an enhanced ShowPICT 
program. 

Screen Saver: The FlyingLine Program 

The FlyingLine is the last program in the QuickDraw chapter . 
Although it does demonstrate the use of line drawing in QuickDraw, 
we included it mostly because it's fun. The FlyingLine draws a set of 
lines that move across the screen with varying speeds, dfrections, and 
orientations. The program can be used as a screen saver (we even 
show you how to hide the menu bar). 

The FlyingLine program consists of four steps: 

• Initialize the Toolbox; 
• Set up the FlyingLine window; 
• Initialize the FlyingLine data structure, drawing it once; 
• Redraw the FlyingLine inside a loop until a mouse click occurs. 

Create a folder called FlyingLine inside your Development 
folder. FlyingLine needs no resources, so you won't need to create a 
resource file for this project. Go into THINK C and create a new 
project called F lyingLine. 7t inside the FlyingLine folder. Select 
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New from the File menu to open a new window for the FlyingLine 
source code: 

#define kNumLines 
#define kMoveToFront 
#define kRandomUpperLimit 
#define kEmptyString 
#define kEmptyTitle 
#define kVisible 
#define kNoGoAway 
#define kNilRefCon 

/*************/ 
/* Globals */ 
/*************/ 

50 /* Try 100 or 150 */ 
(WindowPtr)-lL 
32768 

"\p" 
kEmptyString 
true 
false 
(long) nil 

Re ct 
short 

gLines[ kNumLines ); 

short 
short 

gDeltaTop=3, gDeltaBottom=3; /* These four 

are the key to FlyingLine!*/ 
gDeltaLeft=2, gDeltaRight=6; 
gOldMBarHeight; 

/***************/ 
/* Functions */ 
/***************/ 

void 
void 
void 
void 
void 
short 
void 
void 

ToolBoxinit( void); 
Windowinit( void); 
Lines!nit( void); 
MainLoop( void); 
RandomRect( Rect *rectPtr ); 
Randomize( short range); 
RecalcLine( short i ); 
DrawLine( short i ); 

/****************** main ***************************/ 

void main( void 

ToolBoxini t () ; 
Windowinit{); 
Linesinit(); 
MainLoop(); 
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/****************** ToolBoxinit *********************/ j 

void ToolBoxinit( void 

InitGraf( &thePort ); 
InitFonts () ; 
InitWindows () ; 
Ini tMenus () ; 
TEinit (); 
InitDialogs( nil); 
InitCursor(); 

! 

/****************** Windowinit ***********************/ 

void Window!nit( void) 

Rect totalRect, mBarRect; 
RgnHandle 
WindowPtr 

mBarRgn; 
window; 

gOldMBarHeight = MBarHeight; 
MBarHeight :::: O; 

window= NewWindow( nil, &(screenBits.bounds), 
kEmptyTitle, kVisible, plainDBox, kMoveToFrorit 
kNoGoAway, kNilRefCon ); 

SetRect{ &mBarRect, screenBits.bounds.left, 
screenBits.bounds.top, 
screenBits.bounds.right, 
screenBits. bounds. top+gOldMBarHeight ). ; 

mBarRgn = NewRgn(); 
RectRgn( mBarRgn, &mBarRect ); 
UnionRgn( window->visRgn, mBarRgn, window->visRgn ) 
DisposeRgn( mBarRgn ); 
SetPort( window); 
FillRect( &(window->portRect), black); 

PenMode{ patXor ); 
I* Change black to ltGray, */ 
/*<-- and comment out this line*/ 

! 
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/****************** Linesinit **********************/ 

void Linesinit( void) 

short i; 

HideCursor(); 
GetDateTime( (unsigned long*) ( &randSeed) ); 
RandomRect( &(gLines[ 0 )) ); 
DrawLine( 0 ); 

for ( i=l; i<kNumLines; i++ ) 

gLines[ i ) = gLines[ i-1 ]; 
RecalcLine( i ); 
DrawLine( i ); 

/****************** MainLoop ***********************/ 

void MainLoop( void ) 

short i; 

while ( ! Button() ) 

DrawLine{ kNumLines - 1 ); 
for ( i=kNumLines-1; i>O; i­

gLines [ i ] = gLines[ i-1 ]; 
RecalcLine( 0 ); 
DrawLine( 0 ); 

MBarHeight = gOldMBarHeight; 

/****************** RandomRect *********************/ 

void RandomRect{ Rect *rectPtr ) 

WindowPtr window; 

window= FrontWindow(); 
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rectPtr->left =Randomize( window->portRect.right 
- window->portRect.left ); 

rectPtr->right = Randomize( window->portRect.right 
- window->portRect.left ); 

rectPtr->top =Randomize( window->portRect.bottom 
- window->portRect.top ); 

rectPtr->bottom = Randomize( window->portRect.bottom 
- window->portRect.top ~; 

/****************** Randomize **********************/ 

short Randomize( short range 

long randomNumber; 

randomNumber =Random(); 

if ( randomNumber < 0 ) 
randomNumber *= -1; 

return( (randomNumber *range) I kRandomUpperLimit ); 

/****************** RecalcLine *********************/ 

void RecalcLine( short i ) 

WindowPtr window; 

window= FrontWindow(); 

gLines[ i J .top += gDeltaTop; 
if ( ( gLines[ i ] .top < window->portRect.top I I 

( gLines[ i ].top> window->portRect.bottom) 

gDeltaTop *= -1; 
gLines[ i ] .top += 2*gDeltaTop; 

gLines[ i ] .bottom+= gDeltaBottom; 
if ( ( gLines[ i ] .bottom< window->portRect.top ) I I 

( gLines[ i ] .bottom> window->portRect.bottom ) 
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gDeltaBottom *= -1; 
gLines[ i J .bottom+= 2*gDeltaBottom; 

gLines[ i J .left += gDeltaLeft; 
if ( ( gLines [ i J. left < window->portRect. left ) I I 

( gLines[ i ] .left > window->portRect.right ) ) 

gDeltaLeft *= -1; 
gLines[ i ] .left += 2*gDeltaLeft; 

gLines[ i J .right += gDeltaRight; 
if ( ( gLines[ i ] .right< window->portRect.left ) I I 

( gLines[ i J .right > window->portRect.right ) ) 

gDeltaRight *= -1; 
gLines[ i J .right += 2*gDeltaRight; 

/****************** DrawLine ***********************/ 

void DrawLine( short i ) 

MoveTo( gLines[ i J .left, gLines[ i) .top); 
LineTo( gLines[ i J .right, gLines[ i J .bottom); 

Running FlyingLine 

Save your source code in the FlyingLine folder as FlyingLine. c. 
Select Add from the Source menu to add the file to the project. Next, 
use Add ... to add MacTraps to the project. Finally, select Run from 
the Project menu. If everything went well, you should see something 
like Figure 3.43. The window will be completely black except for the 
flying line; the menu bar should be hidden. As usual, click the mouse 
to exit. Now, let's take a look at the code. 
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_J 
Figure 3.43 Running FlyingLine. 

Walking Through the FlyingLine Code 

Most of FlyingLine should be familiar to you. The biggest change is in 
Windowinit () ,where you create a window from scratch and hide the 
menu bar. We won't go into exhaustive detail on the FlyingLine 
algorithm, because it has little to do with the Toolbox. This one's just 
for fun! 

kNumLines defines the number of lines in the FlyingLine. 
kMoveToFront plays the same role as in previous programs. 

#define kNumLines 
#define kMoveToFront 

50 /* Try 100 or 150 */ 
(WindowPtr) - lL 

#define kRandomUpperLimit 32768 

The rest of the #defines will be used as parameters in the call to 
NewWindow () later in the program. 

#define kEmptyString " \p " 

#define kEmptyTitle kEmptyString 

#define kVisible true 

#define kNoGoAway false 
#define kNilRefCon (long> nil 
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The array gLines holds all of the individual lines in the 
FlyingLine. gDeltaTop, gDeltaBottom, gDeltaLeft, and 
gDeltaRight help determine the movement of the FlyingLine as it 
zooms around the screen. Finally, gOldMBarHeight saves the menu 
bar height, so you can restore it when the program exits. 

/*************/ 
/* Globals */ 
/*************/ 

Re ct 
short 

short 
short 

gLines[ kNumLines ]; 
gDeltaTop=3, gDeltaBottom=3; /*These four 

are the key to flying line!*/ 
gDeltaLeft=2, gDeltaRight=6; 
gOldMBarHeight; 

/***************/ 
/* Functions */ 
/***************/ 

void 
void 
void 
void 
void 
short 
void 
void 

ToolBoxinit( void); 
Windowinit( void); 
Linesinit( void); 
MainLoop( void); 
RandomRect( Rect *rectPtr ); 
Randomize( short range); 
RecalcLine( short i ); 
DrawLine( short i ); 

The only change made to main () is the addition of the call to 
Linesini t () before the call to MainLoop (). 

/****************** main ***************************/ 

void main( void 

ToolBoxini t () ; 
Windowini t () ; 
Linesini t () ; 
MainLoop(); 

The Toolbox initialization for FlyingLine is the same as for the 
previous programs: 
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/****************** ToolBoxinit ********************* / 

void ToolBoxinit( void 

InitGraf( &thePort ) ; 
InitFonts () ; 
InitWindows(); 
InitMenus () ; 
TEinit (); 
InitDialogs( nil ); 
InitCursor() ; 

The window initialization code for FlyingLine is unusual because 
the window itself is unusual. Normally, Mac programs display a menu 
bar. FlyingLine, however, will not. FlyingLine hides the menu bar (by 
making it 0 pixels tall) and creates a window that covers the entire 
screen. 

/****************** Windowinic ***********************/ 

void Windowinit( void) 

Rect totalRect , mBarRect ; 

RgnHandle 
WindowPtr 

mBarRgn ; 
window ; 

The Macintosh System's internal global variable MBarHeight 
contains the height of the menu bar in pixels. Windowinit () saves 
the current value of MBarHeight in the global gOldMBarHe ight, 
then sets the menu bar height to 0. 

gOldMBarHeight = MBarHeight; 
MBarHeight = 0 ; 

Although it's important to understand the technique involved here, it 
is even more important to remember that it's generally bad practice 
to mess with system globals. They are likely to change when new 
system versions come out. We use system globals in Flyinglifle 
because Apple doesn't make it easy to hide the menu bar (mainly 
because they don't want programmers to do it). Because a screen 
saver has to hide the menu bar, Flyingline uses a system global. 
Make sure you have good reasons to use system globals. 

I I 
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The call to NewWindow () is an alternative to GetNewWindow (). 
GetNewWindow () creates a window using the information specified in 
a WIND resource. NewWindow () also creates a window, but gets the 
window specifications from its parameter list: 

FUNCTION NewWindow( wStorage : Ptr; boundsRect : Rect; 

title : Str255; visible : BOOLEAN; procID : INTEGER; 

behind WindowPtr; goAwayFlag : BOOLEAN; 

refCon : LONGINT ) : WindowPtr; 

The program specifies the size of the window as a Rect, using the 
QuickDraw global screenBits .bounds to create a window the size of 
the main screen. 

window= NewWindow( nil, &(screenBits.bounds), 
kErnptyTitle, kVisible, plainDBox, kMoveToFront, 
kNoGoAway, kNilRefCon ); 

The next bit of code is tricky. It calls SetRect () to create a 
rectangle surrounding the normal menu bar. Next, it uses this Rect to 
create a new region. Then, it adds this region to the visible region of 
your window. As a result of this hocus-pocus, your window can overlap 
the menu bar, taking up the entire screen. If this makes you uncom­
fortable, don't panic. The call to NewWindow () is normally all you'll 
need in your applications. This extra code is just here to allow your 
window to obscure the menu bar. 

SetRect( &rnBarRect, screenBits.bounds.left, 
screenBits.bounds.top, 

screenBits.bounds.right, 
screenBits.bounds.top+gOldMBarHeight ); 

rnBarRgn = NewRgn(); 
RectRgn( rnBarRgn, &rnBarRect ); 
UnionRgn( window->visRgn, rnBarRgn, window->visRgn ); 
DisposeRgn( rnBarRgn ); 

Next, the program calls Setport () so that all its drawing will 
occur in window. Then, it uses FillRect () to fill the window with 
the black pattern. It uses PenMode () to set the pen's drawing mode 
to patXor. Experiment with some of the other pen modes. In addition, 
try changing the second FillRect () parameter to ltGray, and 
commenting out the call to PenMode () . 
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SetPort( window) ; 

FillRect( &(window->portRect ), black) ; 

PenMode( patXor ) ; 

/ * Change black to ltGray , * / 
/*<-- and comment out this 

line */ 

123 

Don't be fooled by imitations. The second parameter to 
FillRect () is a pattern, not a color. These are the fill patterns you 
normally associate with the paint bucket in MacPaint, not the eigtit 
colors of Classic QuickDraw. You can experiment with colors by 
using a call to PaintRect (). 

I 

Linesinit () starts off by hiding the cursor. Next, it seeds the 
random number generator with the current date (a la Mondrian). 
Finally, it generates the first line of the flying line, draws it, then 
generates the rest of the lines and draws them. 

/ ** **************** Lineslnit ********************** / 

void Lineslnit( void ) 

short i ; 

HideCursor() ; 
GetDateTime ( (unsigned long * ) ( &randSeed ) ) ; 

RandomRect( &(gLi nes( 0 ]) ); 

DrawLine ( 0 ) ; 

for ( i =l; i<kNumLines; i++ ) 

gLines( i ] = gLines[ i-1 ] ; 
RecalcLine ( i ) ; 

DrawLine( i ); 

Main Loop () sets up a loop that falls through when the mouse 
button is clicked. At the end of the loop, the menu bar height is 
restored. If you don't do this, you won't be able to pick from the menu 
bar when you exit the program. Oops! (If by accident, you don't reset 
the menu bar height, it won't come back when you return to the 
Finder. Restart your Mac to reset the menu bar height.) 
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Inside the loop, the program erases and redraws each line in the 
FlyingLine. It erases lines by redrawing them in exactly the same 
position. Because the pen mode is set to patXor, this has the effect of 
erasing the line. Thus, the first call to DrawLine () in MainLoop () 
erases the last line in the gLines array. This simulates the line 
moving across the screen. 

/****************** MainLoop ***********************/ 

void MainLoop( void ) 

short i; 

while ( ! Button() ) 

DrawLine( kNumLines - 1 ); 
for ( i=kNumLines-1; i>O; i­

gLines [ i) = gLines[ i-1 ]; 
RecalcLine( 0 ); 
DrawLine( 0 ); 

MBarHeight = gOldMBarHeight; 

You've seen this routine in Mondrian: 

/****************** RandomRect *********************/ 

void RandomRect( Rect *rectPtr) 

WindowPtr window; 

window= FrontWindow(); 

rectPtr->left =Randomize( window->portRect.right 
- window->portRect.left ); 

rectPtr->right =Randomize( window->portRect.right 
- window->portRect.left ); 

rectPtr->top = Randomize( window->portRect.bottom 
- window->portRect.top ); 

rectPtr->bottorn =Randomize( window->portRect.bottom 
- window->portRect.top ); 
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Another routine you've seen before: 

/****************** Randomize **********************/ 

short Randomize( short range 

long randomNurnber; 

randomNumber =Random(}; 

if ( randomNumber < 0 } 
randomNumber *= -1; 
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return( (randomNurnber * range) I kRandomUpperLimit ) ; 

ReCalcLine () determines where to draw the next line: 

/****************** RecalcLine *********************/ 

void RecalcLine( short i } 

WindowPtr window; 

window= FrontWindow(); 

gLines[ i ) .top += gDeltaTop; 
if ( ( gLines[ i ) .top < window->portRect.top ) I I 

( gLines[ i ) .top > window->portRect.bottom ) 

gDeltaTop *= -1; 
gLines[ i ) .top += 2*gDeltaTop; 

gLines[ i ) .bottom+= gDeltaBottom; 
if ( ( gLines[ i ) .bottom< window->portRect.top ) I I 

( gLines[ i ) .bottom> window->portRect.bottom ) ) 

gDeltaBottom *= -1; 
gLines[ i ].bottom+= 2*gDeltaBottom; 

gLines[ i ] .left += gDeltaLeft; 
if ( ( gLines[ i ] .left < window->portRect.left ) I I 



126 

_J 

Macintosh C Programming Primer 

( gLines[ i ) .left > window->portRect.right ) ) 

gDeltaLeft *= -1; 
gLines[ i ) .left += 2*gDeltaLeft; 

gLines[ i ) .right+= gDeltaRight; 
if ( ( gLines [ i ] . right < window->portRect. left ) I I 

( gLines[ i ) .right > window->portRect.right ) 

gDeltaRight *= -1; 
gLines[ i ) .right += 2*gDeltaRight; 

DrawLine () draws line number i, using the coordinates stored in 
gLines [ i J. Because the pen mode is set to patXor, this may 
actually have the effect of erasing the line. 

/****************** DrawLine **********************~/ 

void DrawLine( short i ) 

MoveTo( gLines[ i ) .left, gLines[ i ) .top ); 
LineTo( gLines[ i) .right, gLines[ i) .bottom); 

In Review 

Whew! We've covered a lot in this chapter. We examined the basic 
Macintosh drawing model, QuickDraw, and showed you how to use 
many of the QuickDraw Toolbox routines. Now, you can read the 
QuickDraw chapter in Inside Macintosh, Volume I. Experiment with 
the programs presented here and try using some of the other 
QuickDraw routines. They're just as easy to use as the ones already 
covered. 

Now that you understand how the Mac draws to the screen, you're 
ready to learn how the Mac interacts with users. Chapter 4 looks at 
the Event Manager-the manager that stage-directs operations. 



Events 

In this chapter, you'll learn about 
Events, the Macintosh mechanism 

for describing user actions to 
applications. When the mouse button 

is clicked or a key is pressed, the 
operating system lets your program 

know by queueing an event. 

4 
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ON THE MACINTOSH, the interaction enjoyed by users is more flexible 
than with any other computer. You can stop in the midst of writing a 
paper to do a quick spreadsheet, dial a phone, access a database, or 
play a game. The Mac lets you do what you want to do, when you 
want to do it. This is one of the guiding principles behind the 
Macintosh design. 

The flip side of this wonderful, easy-to-use, empowering environ­
ment is that you, as a developer, have to support it. In the previous 
chapter, the programs you wrote responded to a mouse click. In this 
chapter, you'll write programs that respond to a variety of user 
actions. These actions, such as clicking on the mouse button or typing 
on the keyboard, are known as events. 

Understanding Events 

Keeping track of events can be a pretty complicated operation. Put 
yourself in the place of a Mac application: When the mouse button is 
pressed, what do you do? If users click on the menu bar, they expect a 
pull-down menu to appear. If the click was in a window, they may 
want to select the window, bringing it to the front. They may want to 
resize the window or drag it to a new location on the screen. They may 
be trying to highlight some text, or select a portion of a picture. 

A piece of the Mac Toolbox, known as the Event Manager, makes 
it easy for you to handle user actions. 

The Event Manager 

The Event Manager continually captures information about each 
keystroke and mouse click the user makes. It puts information about 
each action into an EventRecord. As more actions occur, additional 
EventRecords are created and joined to the first, forming an event 
queue as shown in Figure 4.1. 

129 
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Windows dragged, 
resized, zoomed, 
closed, opened, 
etc. 

Keys 
depressed 

Disk [g] 
inserted - . 

Mouse Down 
Ke Down 

• • • 
Disk Inserted - . 
Macintosh 
Application 

Figure 4.1 The Event Queue. 

Mouse button iai 
depressed, bJi 
mouse moved 

The event queue is a FIFO (First In, First Out) queue: The event at 
the front of the queue is the oldest event in the queue. As you can 
see in Figure 4.1, different types of events live together in the same 
event queue. All events, no matter what their type, pass under the 
watchful eye of the Event Manager. 

l 
Let's take a look at the different kinds of events reported by the 

Event Manager. 

Event Types 

The Event Manager handles 15 distinct events (V:249): 

• nullEvent: This event is queued when the Event Manager has no 
other events to report. 

• mouseDown: rnouseDown events are queued whenever the mouse 
button is pressed. Note that the button doesn't have to be released 
for the event to qualify as a rnouseDown. 

• mouseUp: rnouseUps are queued whenever the mouse button is 
released. 

• keyDown: keyDown events are queued every time a key is pressed. 
Like mouse Downs, keyDowns are queued even if the key has not yet 
been released. 
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• keyUp: keyUps are queued whenever a key is released. 
• autoKey: autoKey events are queued when a key is held down for 

a certain length of time (beyond the a utoKey threshold). Usually, 
an autoKey event is treated just like a keyDown. 

The autoKey threshold represents the time from the first keyDown 
until the autoKey event is generated. The default value is 16 ticks 
(sixtieths of a second). The autoKey rate is the interval between 
autoKeys. The default a utoKey rate is 4 ticks. The user can 
change both of these in the keyboard control panel. Their values 
are stored in the system global variables KeyThresh and 
KeyRepThresh. 

..::. ..::. 

• updateEvt: updateEvts are queued whenever a window needs 
redrawing. They are always associated with a specific window. This 
usually happens when a window is partially obscured and the 
obstruction is moved, revealing more of the window, as shown in 
Figure 4.2. 

• diskEvt: di skEvts are queued whenever a disk is inserted into a 
disk drive, or when an action is taken that requires a volume to be 
mounted. 

• activateEvt: act ivateEvts are associated with windows. An 
activateEvt is queued whenever a window is activated (ma de to 
come to the front) or deactivated (replaced as the front-most window 
by another window). 

B11clc Window B11clc Window 

Figure 4.2 The window titled Front Window is moved to the right, leaving 
Back Window in need of updating. 
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Figure 4.3 shows the three-part sequence that occurs when one 
window is activated and another deactivated. Notice that while 
there may be more than one inactive window, there are never two 
active windows. 

--· Bock Window 

Figure 4.3 Back Window is selected, an activateEvt is generated to deac­
tivate Front Window, and an activateEvt is generated to activate Back 
Window. The front-most window is the one with the lines in the title bar. 

Figure 4.4 shows what happens when a partially obscured window 
is brought to the front, covering the window that once covered it. As 
soon as the mouse button is clicked, a pair of activateEvts are 
generated, first to deactivate the front window and then to activate 
the back window. Once the back window moves to the front, an 
updat e Evt is generated, asking your application to fill in the 
previously obscured portion of the window. The right-most panel in 
Figure 4.4 shows the finished product. 

l 

• networkEvt: networkEvts are no longer used. 
• driverEvt: driverEvts are used by device drivers to signal special 

conditions. They (and device drivers in general) are beyond the 
scope of this book. 

• applEvt, app2Evt, app3Evt: These events can be defined by your 
application. The use of application-defined events is discouraged by 
Apple in System 7. 
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Figure 4.4 Back Window is selected, an activateEvt is generated to deac­
tivate Front Window, an activateEvt is generated to activate Back Window, 
and an updateEvt is generated to redraw Back Window. 

• osEvt (formerly known as app4Evt ) : The system will post an 
osEvt just before it moves your application into the background 
(suspends it) and just after it brings your application back to the 
foreground (resumes it). You can also set your application up to 
receive mouseMoved events. mouseMoved events are posted when 
the user moves the cursor outside a predefined region (such as a 
text-editing window) or back in again. When your application 
receives a mouseMoved event, it can change the cursor to one appro­
priate to that region. We'll discuss osEvts in more detail later in 
this chapter. 

A New Structure for Macintosh 
Programming (Part 1) 

In Chapter 3, we presented a primitive Macintosh application model 
that looked like this: 

main() 

Toolboxlnit (); 
Otherlnits (); 
DoPrimeDirective(); 
while (!Button() ); 

First, the application model took care of any program-specific initial­
ization, such as loading windows or pictures from the resource file. 
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Next, the model performs its "prime directive." For example, in the 
case of ShowPICT, the prime directive was drawing a PICT in the 
application's window. Finally, the model waits for the mouse button to 
be pressed. 

Since this kind of program doesn't react to anything that users do 
except clicking the mouse button, we need a better model. 

The new model does things a little differently: 

main ( ) 
{ 

ToolBoxinit (); 
Other!ni-cs(); 

EventLoop(); 

EventLoop( 
{ 

EventRecord event; 

gDone 
while 

false; 

gDone == false ) 

if WaitNextEvent( everyEvent, &event, 
sleepValue, mouseRgn ) ) 

DoEvent( &event); 

DoEvent( EventRecord *eventPtr 
{ 

switch ( eventPtr->what 

case mouseDown: 
HandleMouseDown(); 
break; 

case keyDown: 
HandleKeyDown(); 
break; 
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This model starts the same way as the basic model, with calls to the 
initialization routines. 

The difference in the new model lies in the call of EventLoop (). 
EventLoop () contains the main event loop. The main event loop is 
part of the basic structure of any Mac program. Each time through the 
loop, your program retrieves an event from the event queue and 
processes the event. 

Eventually, some event will cause DoEvent () to set gDone to true, 
and the program will end. This typically is the result of a mouseDown 
in the menu bar (selecting Quit from the File menu) or a keyDown 
(typing the key sequence 3€ Q ). 

The most critical Event Manager routine is called Wai tNextEvent (). 
To find out what events have been sent to your application, call 
WaitNextEvent () from within a loop. 

Boolean WaitNextEvent( short eventMask, EventRecord 
*event, long sleep, RgnHandle 
mouseRgn ); 

Every time it is called, Wai tNextEvent () retrieves an event from 
the event queue, passing the results back to your application. 

Calling WaitNextEvent() 

The first parameter to WaitNextEvent () is an event mask, used to 
limit the types of events your program will handle. Figure 4.5 con­
tains a list of predefined event mask constants. If your program needs 
only mouseDowns and keyDowns, for example, you might use the 
following call: 

EventRecord event; 

WaitNextEvent( (mDownMask 
mouseRgn }; 

keyDownMask), &event, sleep, 

In this case, WaitNextEvent () will return only mouseDown, 
keyDown, or nullEvent information. As you'll remember, 
nullEvents are just the Mac OS telling you that nothing happened, 
so nullEvents are never masked out. To handle all possible events, 
pass the predefined constant everyEvent as the eventMask 
parameter. Inside Macintosh recommends you use everyEvent as 
your event mask in all of your applications unless there's a specific 
reason not to. 
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mDownMask = 2 
mUpMask=4 
keyDownMask = 8 
keyUpMask = 16 
autoKeyMask = 32 
updateMask = 64 
diskMask = 128 
activMask = 256 
highLevelEventMask = 1024 
osMask = -32768 

Figure 4.5 Event Masks. 
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The second parameter of WaitNextEvent () is event, declared as 
an EventRecord. Here's EventRecord's type definition: 

typedef struct EventRecord 
{ 

short what; 
long message; 
long when; 

Point where; 
short modifiers; 

Let's look at each of the fields: 

• what: What type of event just occurred? Was it a nul lEvent, 
keyDown,rnouseDown,orupdateEvt? 

• message: This part of the EventRecord is specific to the event. 
For keyDown events, the message field contains information about 
the actual key that was pressed (the key code) and the character 
that key represents (the character code). For activateEvts and 
updateEvts, the message field contains a pointer to the affected 
window. 

• when: When did the event occur? The Event Manager tells you, in 
ticks, when the system was last turned on (or restarted). 

• where: Where was the mouse when the event occurred? This 
information is specified in global coordinates (see Chapter 3). 

• modifiers: This part of the EventRecord describes the state of the 
mouse button and the modifier keys (the Shift, Option, Control, 
Command, and Caps Lock keys) when the event occurred. 
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The third parameter to WaitNextEvent () is the sleep parameter. 
sleep is a long integer that specifies the amount of time (in t icks) 
your application is willing not to perform any background processing 
while waiting for an event. 

lll 
sleep should be set to MAXLONG (defined in the #include file 
Values . h) if your application doesn't need to do things in the 
background. If you pass a value of OL for sleep, you're telling 
WaitNextEvent () to hog the processor, which is not a neighborly 
thing to do. 

The fourth parameter to WaitNextEvent () is the mouseRgn 
parameter, used to simplify cursor tracking. If your application requires 
different cursors, depending on which part of the screen the cursor is in, 
the mouseRgn parameter may be helpful. With it, you can specify the 
screen region appropriate to the current cursor. Whenever the mouse is 
outside the region appropriate to the current cursor, the Event 
Manager queues up a mouseMoved event. When your program receives 
the mouseMoved event, you change the region to the one that the new 
mouse position is within, then pass it as a parameter to the next 
WaitNextEvent () call. If your program doesn't need more than one 
cursor region, or if you plan to keep track of the different regions 
yourself, just pass nil in the mouseRgn parameter. 

l 
Calling WaitNextEvent () with a sleep value of 60 and a 
mouseRgn of nil is exactly equivalent to calling SystemTask () 
and GetNextEvent () using earlier versions of the Mac OS. 

Once you have retrieved an event with Wai tNextEvent () , you 
dispatch it to the appropriate procedure. For example, if the user clicked 
the mouse button, DoEvent () calls a HandleMouseDown () routine 
designed to handle mouseDown events. When a keyDown occurs, call 
HandleKeyDown () .You get the idea. 
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DoEvent( EventRecord *eventPtr 

switch ( eventPtr->what 

case mouseDown: 
HandleMouseDown(); 
break; 

case keyDown: 
HandleKeyDown(); 
break; 

Our first program in this chapter will show you this process in detail. 

Apple Events 

Now that you've seen the event-handling process, there is one more 
event that needs discussing: the Apple event. An Apple event is a 
special event that allows your application to communicate with other 
applications, such as the Finder. 

You see Apple events in action all the time. For example, when you 
double-click on a document icon in the Finder, the Finder launches the 
application that created the document. Once the application is open 
(or, if it was already open), the Finder sends the application an Apple 
event, asking it to open the specified document. When you ask the 
Finder to print a document (by clicking on the document icon and 
selecting Print), the Finder sends an Apple event to the appropriate 
application, asking it to print the specified document. 

There are four Apple events that your application must support. 
Together, these are known as the required Apple Events. They are 
kAEOpenApplication, kAEOpenDocuments, kAEPrintDocuments, 
and kAEQuitApplication. kAEOpenApplication asks your appli­
cation to perform whatever functions it normally performs when it 
first starts up. kAEOpenDocuments and kAEPrintDocuments ask 
your application to open or print a specified document. Finally, 
kAEQuitApplication asks your program to close all open documents 
and quit. 

Your programs, at a minimum, will need to understand how to 
handle these four required Apple events. To do this, we'll need to 
adjust the event loop model presented earlier. 
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Programming (Part 2) 

Our original event loop model was based on the value in the 
EventRecord's what field. If event . what contains a mouseDown, we 
call the function HandleMouseDown () . If event . what contains a 
keyDown , jump to some code that handles a keyDown. 

The new model adds a new twist. Before you enter the main event 
loop, you'll tell the Event Manager which Apple events you plan to 
handle, and which routines you plan to handle them with. You might 
pair up the Apple event AEOpenApplication with the routine 
DoAEOpen ( ) . Once you assign a routine to an Apple event, the Event 
Manager takes over. From then on, whenever that Apple event occurs, 
the Event Manager automatically calls the routine you assigned to 
that Apple event. A routine assigned to a particular Apple event is 
known as an Apple event handler. 

Use the routine AEinstallEventHandler () to pair up an Apple 
event with its handler. Since, at the very least, you'll handle the four 
required Apple events, you'll call AEi nstallEventHandler () 
at least . four times. We'll get to the specifics of calling 
AEinstallEventHandler () shortly. 

Once you've installed your Apple event handlers, you'll enter the 
main event loop. Once inside, you'll process events as usual, using the 
value in event . what to determine your next course of action. In 
addition to the 15 events presented above, a sixteenth event constant 
has been added. 

Whenever an Apple event occurs, the Event Manager places the 
constant kHighLevelEvent in event . what . When this happens, all 
you do is pass the event on to the routine AEProcessAppleEvent () . 
AEProcessAppleEvent () automatically calls the event handler 
you've installed for that Apple event. 

Why kHighLevelEvent? In general, the 15 events described 
earlier are known as low-level events. Low-level events tend to be 
physical in nature (a mouse is clicked, a key is pressed) and 
describe the relationship between the user and your application. 
High-level events, on the other hand, are designed to support 
communication between applications. Apple events are a subset of 
high-level events. Once you get the hang of Apple event program­
ming, you might want to take a crack at designing your own high­
level event protocol. To learn more about high-level events, take a 
look at (Vl:S-8). 

.;:. l 
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Here's the final version of the new event loop model: 

main() 
{ 

Old main() 

ToolBoxinit () ; 
Otherinits (); 

EventLoop(); 

New main(), with Apple Events 

main() 
{ 

ToolBoxinit(); 
Otherinits (); 

l Eventinit (); 

EventLoop(); 

] 

Eventinit () gets called before the event loop is entered. It 
contains one call to AEinstallEventHandler () for each Apple event 
your program handles. 

Event Ini t () 
{ 

err= AEinstallEventHandler( kEventClass, 
kAppleEventID, 
nameOfAEProc, 
ref Con, 
isSysternAE ); 

• 
• 
• 
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Event Loop () is the same as before. 

EventLoop () 
{ 

EventRecord event; 
gDone false; 
while ( gDone == false 
{ 

if WaitNextEvent( everyEvent, &event, 
sleepValue, mouseRgn ) ) 

DoEvent( &event); 
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The first thing DoEvent () does is check to see if the event is an 
Apple event. Ifso, it passes the event on to AEProcessAppleEvent (). 
Assuming you've already installed a handler for this event, 
AEProcessAppleEvent () will call your handler for you. If the event 
wasn't an Apple event, DoEvent ( ) handles the event as it did before. 

Old Event Loop New Event Loop with Apple Events 

DoEvent( EventRecord *eventPtr ) DoEvent( EventRecord *eventPtr ) 

{ { 
switch ( eventPtr->what ) switch ( eventPtr->what ) 

{ { 

case rnouseDown: case kHighLevelEvent: 
HandleMouseDown(); AEProcessAppleEvent 
break; ( eventPtr ) ; 

break; 
case keyDown: 

HandleKeyDown(); case mouseDown: 
break; HandleMouseDown(); . break; . case keyDown: . 

} HandleKeyDown(); 
} break; . . . 

} 
} 
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Calling AEinstallEventHandler() 

To install a handler for an Apple event , you call 
AEinstallEventHandler() : 

OSErr AEinstallEventHandler( AEEventClass theAEEventClass , 
AEEventID theAEEventID , 
EventHandlerProcPtr handler , 
long handl erRefcon , Boolean 
isSysHandler ); 

The first parameter, theAEEventClass , specifies the class of 
events your handler will handle. All Apple events are grouped into 
classes according to functionality. For example, the four required Apple 
events all belong to the same class, known as the core event class. 
When installing a handler for one of the required Apple events, pass 
the predefined constant kCoreEventClass as theAEEventClass. 

Within an event class, the event ID serves to distinguish one type of 
Apple event from another. The constants kAEOpenApplication, 
kAEOpenDocuments, kAEPrintDocuments,and kAEQui tApplicat ion 
are the event IDs for the four required Apple events. You'll pass one of 
these as the second parameter to AEinstallEventHandler () . These 
#defines represent the 4-byte values ' oapp ', ' odoc ' , ' pdoc ' , and 
' quit ', respectively. 

The third parameter is a function pointer, the name of the function 
you wrote to handle this particular type of Apple event. The fourth 
parameter is a reference constant for use by your handler (we just 
pass a value of OL, since we don't make any special use of this 
parameter). The last parameter is a Boolean that is true if your 
handler will be used by the operating system, false otherwise. 
Typically, isSystemAE is set to false . 

If you find yourself getting a little confused at this point, don't worry, 
that's normal. You're trying to absorb a lot in one take. Keep on 
reading. By the time you get through the first program, the concepts 
will fall into place. 

l 
Now that you've been through the Event Manager in detail, let's 

look at some code that implements the new model. The next section 
describes EventTracker, a program that displays the inner workings 
of the Event Manager. 



_J EventTracker 

EventTracker uses a WIND resource to create a new window, then 
enters the main event loop. As events occur, EventTracker describes 
them in the window, drawing one line of text for each event. 

EventTracker: 

• Initializes the EventTracker window. 
• Calls Gestalt() to see if Apple events are available. If not, an 

appropriate message is drawn in the EventTracker window. 
• Continually retrieves events from the event queue, displaying a text 

string describing each event as it occurs. A mouseDown in the 
window's close box causes EventTracker to exit. 

Resources 

Create a folder called EventTracker inside your Development 
folder. Next, launch ResEdit and click the mouse to bring up the Open 
File dialog box. Click on the New button. When the New File dialog 
box appears, create a resource file named Event Tracker .1t. rsrc 
inside the Event Tracker folder. 

Creating a WIND Resource 

EventTracker requires a single WIND resource. Select Create New 
Resource from the Resource menu. When prompted for a resource 
type, enter WIND and click the OK button. A WIND editing window will 
appear. Edit your WIND to match the specifications shown in Figure 
4.6. If you don't see the Height: and Width: fields, select Show 
Height & Width from the WI ND menu. Be sure to select the second 
window type from the left in the WIND editor's top row. 

Next, select Set 'WI ND' Characteristics ... from the WI ND menu 
and set the Window title: field to OS Euents. Next, select Get 
Resource Info from the Resource menu and set the WIND's 
resource ID to 128. Close the window displaying the WIND resource. 

You've finished creating the resources you'll need for EventTracker. 
Select Quit from the File menu and save your changes. 

143 
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WIND "Euent List" ID s 128 from EuentTracker.n.rsrc 

Top:~ Height:~ 

Left:~ Width:~ 

[][] 
Color: ®Default 

0 Custom 

O Initially uislble 

181 Close boH 

Figure 4.6 EventTracker's WIND resource. 

Setting Up the Project 

Now, start up THINK C. When prompted, creatE; a new project inside 
the Event Tracker folder. Call the project Event Tracker . 7t . Select 
New from the Fi le menu to create a new source code file. Type in the 
following code: 

#include <AppleEvents . h> 

#include <GestaltEqu.h> 

hnclude <Values . h> 

#define kBaseResID 128 
#defin e kMoveToFront (WindowPtr ) - lL 
#define kSleep MAXLONG 

#define kLeftMargin 4 

#define kRowStart 285 
#define kFontSize 9 

#define kRowHe i ght (kFontSize + 2 ) 
#define kHorizon talOf f set 0 

#define kGestaltMa sk lL 
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/*************/ 
I* Globals */ 
/*************/ 

Boolean gDone; 

/***************/ 
/* Functions */ 
/***************/ 

void 
void 
void 
void 
void 
pascal OSErr 

ToolBoxinit( void); 
Windowinit( void); 
Event!nit( void); 
EventLoop( void); 
DoEvent( EventRecord *eventPtr ); 
DoOpenApp( AppleEvent theAppleEvent, 
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pascal OSErr 

pascal OSErr 

pascal OSErr 

void 
void 

AppleEvent reply, long refCon ); 
DoOpenDoc( AppleEvent theAppleEvent, 

AppleEvent reply, long refCon ); 

DoPrintDoc( AppleEvent theAppleEvent, 
AppleEvent reply, long refCon ); 

DoQuitApp( AppleEvent theAppleEvent, 
AppleEvent reply, long refCon ); 

DrawEventString( Str255 eventString ); 
HandleMouseDown( EventRecord *eventPtr ); 

/******************************** main *********/ 

void main( void ) 

ToolBoxinit(); 
Windowinit(); 
Eventinit(); 

EventLoop(); 

/*********************************** ToolBoxinit */ 

void ToolBoxinit( void ) 

InitGraf( &thePort ); 
Ini tFonts () ; 
InitWindows(); 
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InitMenus () ; 
TEinit (); 
InitDialogs( nil); 
InitCursor(); 
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/******************************** Windowinit *********/ 

void Windowinit( void) 

WindowPtr window; 
Rect windRect; 

window GetNewWindow( kBaseResID, nil, kMoveToFront ); 

if window == nil 

SysBeep( 10 ); /* Couldn't load the WIND 

resource! ! ! *I 
ExitToShell (); 

SetPort( window ); 
TextSize( kFontSize ); 

ShowWindow( window); 

/******************************** Eventinit *********/ 

void Eventinit( void) 

OSErr err; 
long feature; 

err= Gestalt( gestaltAppleEventsAttr, &feature); 

if ( err != noErr ) 

else 

DrawEventString( "\pProblem in calling Gestalt!" ); 
return; 
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if ( ! ( feature & ( kGestaltMask << 
gestaltAppleEventsPresent ) ) ) 

DrawEventString 
( 

11 \pApple events not available!" ); 

return; 

err = AEinstallEventHandler ( kCoreEventClass, 

kAEOpenApplication, DoOpenApp, OL, false); 

if err != noErr ) DrawEventString 
"\pkAEOpenApplication Apple event not available!" ); 

err = AEinstallEventHandler( kCoreEventClass, 

kAEOpenDocuments, DoOpenDoc, OL, false); 

if err != noErr ) DrawEventString 

"\pkAEOpenDocuments Apple event not available!"); 

err= AEinstallEventHandler( kCoreEventClass, 

kAEPrintDocuments, DoPrintDoc, OL, false); 

if err !; noErr } DrawEventString 
"\pkAEPrintDocuments Apple event not available!" ); 

err= AEinstallEventHandler( kCoreEventClass, 
kAEQuitApplication, DoQuitApp, OL, false); 

if err != noErr ) DrawEventString 
"\pkAEQuitApplication Apple event not available!"}; 

/******************************** EventLoop *********/ 

void EventLoop( void 

EventRecord event; 

gDone 
while 

false; 
gDone == false ) 

if ( WaitNextEvent( everyEvent, &event, 
kSleep, nil ) } 

DoEvent( &event ); 
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/*else DrawEventString( "\pnullEvent" );*/ 
/* Uncomment the previous line for a burst of 

flavor! *I 

/************************************* DoEvent */ 

void DoEvent( EventRecord *eventPtr 

switch ( eventPtr->what ) 

case kHighLevelEvent: 

case 

DrawEventString( "\pHigh level event: " ); 
AEProcessAppleEvent( eventPtr ); 
break; 
mouseDown: 

DrawEventString( "\pmouseDown" ) ; 

HandleMouseDown( eventPtr ) ; 

break; 
case mouseUp: 

DrawEventString( "\pmouseUp" ) ; 

break; 
case keyDown: 

DrawEventString( "\pkeyDown" ) ; 

break; 
case keyUp: 

DrawEventString( "\pkeyUp" ) ; 

break; 
case autoKey: 

DrawEventString( "\pautoKey" ) ; 

break; 
case updateEvt: 

DrawEventString( "\pupdateEvt" ); 
BeginUpdate( (WindowPtr)eventPtr->message ); 
EndUpdate( (WindowPtr)eventPtr->message ); 
break; 

case diskEvt: 

DrawEventString( "\pdiskEvt" ); 
break; 

case activateEvt: 

DrawEventString( "\pactivateEvt" ); 
break; 
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case networkEvt: 
DrawEventString( "\pnetworkEvt" ); 

break; 

case driverEvt: 
DrawEventString( "\pdriverEvt" ); 

break; 

case applEvt: 
DrawEventString( "\papplEvt" ); 

break; 

case app2Evt: 
DrawEventString( "\papp2Evt" ); 

break; 

case app3Evt: 
DrawEventString( "\papp3Evt" ); 

break; 

case osEvt: 
DrawEventString( "\posEvt: "); 
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if ( (eventPtr->message & suspendResumeMessage) 

== resumeFlag ) 

Drawstring( "\pResume event" ); 

else 
Drawstring( "\pSuspend event" ); 

break; 

/************************************* DoOpenApp */ 

pascal OSErr DoOpenApp( AppleEvent theAppleEvent, 
AppleEvent reply, long refCon 

Drawstring( "\pApple event: kAEOpenApplication" ); 

/************************************* DoOpenDoc */ 

pascal OSErr DoOpenDoc( AppleEvent theAppleEvent, 
AppleEvent reply, long refCon 

Drawstring( "\pApple event: kAEOpenDocuments" ); 



150 Macintosh C Programming Primer 

/************************************* DoPrintDoc */ 

pascal OSErr DoPrintDoc( AppleEvent theAppleEvent, 
AppleEvent reply, long refCon 

Drawstring( "\pApple event: kAEPrintDocuments" ); 

/************************************* DoQuitApp */ 

pascal OSErr DoQuitApp( AppleEvent theAppleEvent, 

AppleEvent reply, long refCon 

Drawstring( "\pApple event: kAEQuitApplication" ); 

/************************************* DrawEventString */ 

void DrawEventString( Str255 eventString ) 

RgnHandle 
WindowPtr 

tempRgn; 
window; 

window= FrontWindow(); 
tempRgn = NewRgn(); 

ScrollRect( &window->portRect, kHorizontalOffset, 
-kRowHeight, tempRgn ); 

DisposeRgn( tempRgn ); 

MoveTo( kLeftMargin, kRowStart ); 
Drawstring( eventString ); 

/************************************* HandleMouseDown */ 

void HandleMouseDown( EventRecord *eventPtr ) 

WindowPtr window; 
long thePart; 

thePart FindWindow( even~Ptr->where, &window); 

switch ( thePart ) 
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case inSysWindow 

SysternClick( eventPtr, window); 
break; 

case inDrag : 
DragWindow( window, eventPtr->where, 

&screenBits.bounds ); 
break; 

case inGoAway 
gDone = true; 
break; 

Running EventTracker 
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Save your source code inside the EventTracker folder as 
Event Tracker. c. Select Rdd from the Source menu to add 
Event Tracker. c to the project (don't forget to add MacTraps, as 
well). The Project window should now look like Figure 4.7. 

EuentTracker.11' 
Name obj size 

[.~~;,;~~~::~.~: ............................................. ~ .. & 

Figure 4.7 Project window for EventTracker. 

There's one more thing you'll need to do for the EventTracker 
project before you run it. You'll need to create a ' s I ZE ' resource. The 
'SIZE' resource tells the operating system how well your application 
interacts with the outside world. Can your program run in the 
background? Is it 32-bit compatible? Will it handle Apple events? 

While most resources are created using ResEdit, THINK C will 
generate this resource for you. To create it, select Set Project 
Type ... from THINK C's Project menu. You should see the dialog 
box in Figure 4.8. 
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@ Application 

O Desk Accessory 

0 Deuice Driuer 

0 Code Resource 

Partition (K) ~ 

SIZE Flags~ lseco I 

(( OK J) 
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File Type I APPL 

Creator I Prmr 

0 Far CODE 

0 Far DATA 

[gJ Separate STRS 

Cancel ) 

Figure 4.8 Set Project Type ... dialog box. 

Click on the pop-up menu area to the right of S I Z E FI a gs in the 
dialog box. If you hold the button down, you'll see the menu in Figure 
4.9. Set the check marks as shown and click on 0 K to save your 
changes. 

When you set those flags, you're telling the Mac OS that 
EventTracker uses OSEvts and Apple events. The •SIZE • 
resource flags will be discussed in more detail in Chapter 8 . 

../ MultiFinder - Rware 

../Background Null Euents 

../Suspend & Resume Euents 

Background Only 
Get FrontClicks 
Accept ChildDiedEuents 

../ 32-Bit Compatible 

../ HighleuelEuent- Rware 
Accept Remote HighleuelEuents 
Stationery- Rware 

Figure 4.9 SIZE Flags. 
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Now you're ready. Select Run from the Project menu. Click Yes 
when asked to Bring the project up to date?. If everything went 
well, the EventTracker window should appear on the desktop. 

Figure 4.10 shows how the EventTracker window should look: 

D OS Euents 

activateEvt 
High level event : Apple event : kAEOpenApplication 
updateEvt 

Figure 4.10 Project window for EventTracker. 

It should already list three events: 

• act ivateEvt : This event occurs when you make the window 
visible with ShowWindow (). 

• High level event: Apple event: kAEOpenApplication: 
Whenever the Finder launches an application, it sends the appli­
cation a kAEOpenApplication Apple event. 

• updateEvt : When the Window Manager creates a window, it draws 
the window, then generates an updateEvt for the window. 

l 
When the Wind0w Manager draws a window, it first draws the 
window frame. The window frame includes the border, as well as a 
drag region, zoom box, and a close box, if appropriate. Next, it 
generates an updateEvt for the window, asking the application to 
draw the window contents. 
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Press the mouse button in the middle of the EventTracker window. 
Now release the mouse button. You should see a mouseDown and then 
a mouseUp event. Next, click on another application, or click on the 
desktop to bring the Finder to the foreground. The EventTracker 
window will be deactivated and placed in the background; it should 
display an osEvt: Suspend event. Click on the EventTracker win­
dow again. The window will be brought to the front; it should display 
an osEvt: Resume event. 

Experiment with some of the other events. Hold down a key for a 
few seconds (autoKey), or insert a diskette (diskEvt). When you're 
done experimenting, click on EventTracker's close box to exit the 
program. 

Let's look at the EventTracker code. 

Walking Through the EventTracker Code 

EventTracker starts with a few #includes. The file 
<AppleEvents. h> has the Apple event declarations we'll need. 
<GestaltEqu. h> is necessary to call Gestalt(), an important 
Toolbox routine that we'll discuss in the code. <Values. h> contains a 
number of useful constants; the only one we're using in EventTracker 
is the #define for MAXLONG used in WaitNextEvent (}. 

#include <AppleEvents.h> 
#include <GestaltEqu.h> 

#include <Values.h> 

Some of the #defines should be familiar. We'll discuss each con­
stant as it appears in the code: 

#define kBaseResID 128 
#define kMoveToFront (WindowPtr)-lL 
#define kSleep MAX LONG 

#define kLeftMargin 4 

#define kRowStart 285 
#define kFontSize 9 

#define kRowHeight (kFontSize + 2) 
#define kHorizontalOf f set 0 

#define kGestaltMask lL 
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gDone is checked each time through the main event loop. If any­
thing sets gDone to true, the program exits. 

Boolean gDone; 

Here are the EventTracker prototypes: 

void 
void 
void 
void 
void 
pascal 

pascal 

pascal 

pascal 

void 
void 

OSErr 

OSErr 

OS Err 

OS Err 

ToolBoxinit( void); 
Windowinit( void); 
Eventinit( void); 
EventLoop( void); 
DoEvent( EventRecord *eventPtr ); 
DoOpenApp( AppleEvent theAppleEvent, 

AppleEvent reply, long refCon ); 
DoOpenDoc( AppleEvent theAppleEvent, 

AppleEvent r~ply, long refCon ); 

DoPrintDoc( AppleEvent theAppleEvent, 
AppleEvent reply, long refCon ); 

DoQuitApp( AppleEvent theAppleEvent, 
AppleEvent reply, long refCon ); 

DrawEventString( Str255 eventString ); 
HandleMouseDown( EventRecord *eventPtr ); 

EventTracker's main () function starts by initializing the Toolbox 
and executing the window initialization routine. Next, it calls 
Eventinit () to install the event handlers for the four required Apple 
events. Finally, EventTracker enters the event loop by calling 
EventLoop (). 

/******************************** main *********/ 

void main( void ) 

ToolBoxinit(); 
Windowinit(); 
Event!nit (); 

EventLoop(); 
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ToolBoxinit () is the same as before. 

/*********************************** ToolBoxinit */ 

void ToolBoxinit( void) 

InitGraf( &thePort ); 
InitFonts(}; 
InitWindows(); 
Ini tMenus () ; 
TEini t () ; 
InitDialogs( nil); 
InitCursor(); 

Wi~dowinit () starts by loading a window from the resource file. 

void Windowinit( void) 

WindowPtr window; 
Rect windRect; 

window GetNewWindow( kBaseResID, nil, kMoveToFront ); 

If the WIND resource isn't found, the program beeps and exits. If this 
happens, check the name of your resource file. 

if ( window == nil 

SysBeep ( 10 ) ; 

ExitToShell (); 

/* Couldn't load the WIND 
resource! ! ! *I 

The window is made the current port, and the text size is set to 
kFontSize. 

SetPort( window); 
TextSize( kFontSize ); 

Finally, ShowWindow () makes the window visible. 

ShowWindow( window}; 
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Eventrni t () , the routine which installs the Apple event handlers, 
starts with a call to Gestalt(). Gestalt() is passed a constant 
gestaltAppleEventsAttr that is defined in GestaltEqu. h. The 
parameter returned by Gestalt(), feature, contains information 
about hardware or software features on your Macintosh, specifically 
information about Apple events. If Gestalt () returns an error, the 
request for this information has not been granted. In this case, you can 
assume that Apple events are not available and return to main (). 

/******************************** Eventinit *********/ 

void Eventinit( void) 

OSErr err; 
long feature; 

err= Gestalt( gestaltAppleEventsAttr, &feature ); 

if ( err != noErr ) 

DrawEventString( "\pProblem in calling Gestalt!" ); 

return; 

If Gestalt () succeeds, feature defines the level of support your 
Macintosh has for Apple events. feature is compared with another 
#define from GestaltEqu. h to determine if Apple events are 
available. If Apple events aren't available, use DrawEventString () 
to display that information in the window. 

else 

if ( ! ( feature & ( kGestaltMask << 
gestaltAppleEventsPresent ) ) ) 

DrawEventString 
( "\pApple events not available!" ) ; 

return; 
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Next, install an event handler for the kAEOpenApplication event 
(' oapp' ). If an error occurs, DrawEventString () displays an error 
string in the Event Tracker window. Otherwise, DoOpenApp () will 
automatically get called each time EventTracker receives a 
kAEOpenApplication event. 

err = AEinstallEventHandler( kCoreEventClass, 
kAEOpenApplication, DoOpenApp, OL, false); 

if ( err != noErr ) DrawEventString 
( "\pkAEOpenApplication Apple event not available!" ) ; 

The kAEOpenDocuments event ( 'odoc ')is paired with the proce­
dure DoOpenDoc () , 

err= AEinstallEventHandler( kCoreEventClass, 

kAEOpenDocuments,DoOpenDoc, OL, false); 
if ( err != noErr ) DrawEventString 

( "\pkAEOpenDocuments Apple event not available!" ); 

The kAEPrintDocuments event (' odoc') is paired with the proce­
dure DoPrintDoc (), 

err = AEinstallEventHandler( kCoreEventClass, 
kAEPrintDocuments DoPrintDoc, OL, false); 

if err != noErr ) DrawEventString 
( "\pkAEPrintDocuments Apple event not available!" ); 

and the kAEQuitApplication event ('quit') is paired with the 
procedure DoQui tApp (). 

err = AEinstallEventHandler( kCoreEventClass, 

kAEQuitApplication, DoQuitApp, OL, false); 
if err != noErr ) DrawEventString 

"\pkAEQuitApplication Apple event not available!"); 

Event Loop () starts by initializing gDone. Then, while gDone is 
false, WaitNextEvent () is called. If no event was available, 
WaitNextEvent () will generate a nullEvt and return false. If you 
uncomment the call to DrawEventString (),you'll get an idea of how 
frequently this happens. Otherwise, DoEvent () is called to process 
the event. 
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Gest alt () looks like this: 

err= Gestalt ( OSType select orCode , long 
&response ); 
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To use Gestalt (), you pass it a selector code in the first 
parameter that checks for the availability of a specific feature. In the 
second parameter, Gestalt () returns a response that you can 
then interpret and use. 

Selector codes have different suffixes, each of which signals a 
different type of response. 

Suffix 

At tr 

Count 

Table 

Type 

Meaning 

Response consists of 32 bitflags that must be com­
pared against constants defined in Gestalt . h. 

Response is the total of the kind of type specified. 

Response is the base address to a table. 

Response is an index describing a particular type 
of feature. 

Version Response is a version number. 

See Inside Macintosh Volume VI, 3-35 to 3-53 for more information 
about Gestalt () . 

/* * *************** * ** ****** **** ** EventLoop ******** */ 

void EventLoop( void ) 

Event Record event ; 

gDone f alse ; 
while gDone == false ) 

if ( WaitNextEvent ( everyEvent , &event , 
kSleep , nil ) ) 
DoEvent( &event ) ; 
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/*else DrawEventString( " \pnul lEvent " );*/ 
/* Uncomment the previous line for a burst of 

flavor ! *I 

nullEvents are used in the program WorldClock in the next 
chapter; they offer an excellent opportunity to deal with such things 
as cursor tracking and internal housekeeping. 

DoEvent () uses eventPtr->what to pass control to the appropriate 
handler. If the event is an Apple event, the string High level event : 
is drawn in the window, and AEProcessAppleEvent () is called. 
AEProcessAppleEvent () passes the Apple event to the event handler 
installed in Eventrnit (). At this point, the only Apple event you'll see 
is the kAEOpenApplication Apple event sent by the Finder when the 
application started up. 

/****** **** *************************** DoEvent * / 

void DoEvent( EventRecord *eventPtr 

switch ( eventPtr->what ) 

case kHighLevelEvent : 
DrawEventString( " \pHigh level event : " ); 
AEProcessAppleEvent( eventPtr ); 
break ; 

If the mouse button has been clicked, or keys have been depressed, 
the appropriate string is drawn. In addition, HandleMouseDown () is 
called when a mouseDown has been detected. 

case mouseDown : 
DrawEventString( " \pmouseDown " ); 
HandleMouseDown( eventPtr ) ; 
break ; 

case mouseUp : 
DrawEventString ( " \pmouseUp " ) ; 
break ; 
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case keyDown : 
DrawEventString( " \pkeyDown " ); 
break ; 

case keyUp : 
Dr awEventString( " \pkeyUp " ); 
break ; 

case autoKey : 
DrawEventString ( " \pautoKey " ) ; 
break ; 
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If there's an updateEvt, the EventTracker window needs t o be 
redrawn. Since you're not concerned with maintaining t he window 
contents in this program, just call BeginUpdate ( ) and EndUpdate () 
to remove the updateEvt from the event queue. 

If you were te cemment out the calls to BeginUpdate () and 
En dUpdate (), you'd get an unending stream of updateEvts for 
the window. The Window Manager, thinking you were ignoring the 
ones you'd already retrieved, would just keep generating them. 

case updateEvt : 
DrawEventString( " \pupdateEvt " ) ; 
BeginUpdate( (W i ndowP tr)eventPtr- >message ); 
EndUpdate( (WindowPtr)eventPtr->message ) ; 

break ; 

Continue drawing the event strings in the window. 

case diskEvt : 
DrawEventString( " \pdiskEvt " ); 
break ; 

case activateEvt : 
DrawEven tString ( " \pactivateEv t " ) ; 
break ; 

case networkEvt: 
DrawEven tString ( " \pnetworkEvt " ) ; 
break; 

case driverEvt : 
DrawEventString( " \pdriverEvt " ) ; 
b r eak ; 
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case applEvt: 

DrawEventString( "\papplEvt" ); 

break; 

case app2Evt: 

DrawEventString( "\papp2Evt" ); 

break; 

case app3Evt: 

DrawEventString( "\papp3Evt" ); 

break; 

Finally, if there's an osEvt, call Drawstring () to display the 
mode of the event. Resume event is displayed in the window if 
EventTracker has been brought to the foreground, and Suspend 
event ifEventTracker has been sent to the background. 

case osEvt: 

DrawEventString( "\posEvt: "); 

if ( ( eventPtr->rnessage & 

suspendResumeMessage ) == resumeFlag 

Drawstring( "\pResume event" ); 

else 

Drawstring( "\pSuspend event" ); 
break; 

Next are the handlers for the four required Apple events. Each 
routine handles the exciting job of drawing a text description of itself 
in the EventTracker window. 

/************************************* DoOpenApp */ 

pascal OSErr DoOpenApp( AppleEvent theAppleEvent, 

AppleEvent reply, long refCon 

Drawstring( "\pApple event: kAEOpenApplication" ); 

/************************************* DoOpenDoc */ 

pascal OSErr DoOpenDoc( AppleEvent theAppleEvent, 

AppleEvent reply, long refCon 

Drawstring( "\pApple event: kAEOpenDocuments" ); 
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/************************************* DoPrintDoc */ 

pascal OSErr DoPrintDoc( AppleEvent theAppleEvent, 
AppleEvent reply, long refCon 

Drawstring( "\pApple event: kAEPrintDocuments" ); 

/************************************* DoQuitApp */ 

pascal OSErr DoQuitApp( AppleEvent theAppleEvent, 
AppleEvent reply, long refCon 

Drawstring( "\pApple event: kAEQuitApplication" ); 

DrawEventString () positions and draws the text strings 
in the window. First, FrontWindow () returns a pointer to the 
EventTracker window. 

/************************************* DrawEventString */ 

void DrawEventString( Str255 eventString ) 

RgnHandle 
WindowPtr 

tempRgn; 
window; 

window= FrontWindow(); 

Then, ScrollRect () scrolls the contents of the current Graf Port 
within the rectangle specified in the first parameter. The rectangle is 
scrolled to the right by the number of pixels specified in the second 
parameter (kHorizontalOff set, which is O; we're just scrolling up, 
not across) and down by the number of pixels specified in the 
third parameter (-kRowHeight). Because you specified a negative 
kRowHeight, the contents of the window scroll up. 

tempRgn = NewRgn(); 
ScrollRect( &window->portRect, kHorizontalOffset, 

-kRowHeight, tempRgn ); 

DisposeRgn( tempRgn ); 
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The last parameter to ScrollRect () is a RgnHandle, or a handle 
to a region. Regions are collections of drawn lines, shapes, and 
curves, as shown in Figure 4.11 (we discussed them briefly in 
Chapter 3). After the pixels in the rectangle are scrolled, 
ScrollRect () fills the vacated area of the rectangle with the 
GrafPort 's background pattern. These new areas are collected 
into the region handled by updateRgn (Figure 4.12). 

l 

Figure 4.11 A region. 

updateRgn 
(filled with bkPat 

Figure 4.12 Front Window's updateRgn after ScrollRect 
(&r , 10 , 20 , updateRgn ). 
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Many programs use this region as a guide to redrawing the window 
so that they don't have to redraw the entire window. This is 
especially useful if your window is extremely complex and takes a 
long time to redraw. In that case, a handle to the window's 
updateRgn is passed to ScrollRect <). Whenever the Window 
Manager detects that a window's updateRgn is nonempty. the 
Window Manager generates an updateEvt for the window. As part 
of its processing, BeginUpdate () sets the specified window's 
updateRgn to the empty region. Since we're not redrawing 0ur 
window in response to an updateEvt (yet), EventTracker just 
disposes of the tempRgn. 

-

MoveTo ( ) positions the QuickDraw pen in the bottom left-hand 
corner of the scrolled window. Finally, Drawstring() draws the 
string describing the event in the window. 

MoveTo( kLeftMargin , kRowStart ) ; 
Drawstring( eventString ); 

Now let's look at the HandleMouseDown () routine, where all the 
action is. 

Handling mouseDown Events 
in EventTracker 

When you receive a mouseDown event , the first thing to do is find out 
which window the mouse was clicked in. Do this by calling the Toolbox 
routine FindWindow () . FindWindow () takes, as input, a point on the 
screen. It then returns, in the parameter window, a WindowPt r t o the 
window containing the point. In addition, FindWindow ( ) returns an 
integer part code that describes the part of the window in which the 
point was located. 

Once you have your part code, compare it to the predefined Toolbox 
part codes. (You can find a list oflegal part codes in 1:287.) 

/*************** ** **** ************* *** HandleMouseDown */ 

void HandleMouseDown ( Event Record *eventPtr ) 

WindowPtr 
long 

window ; 
thePart ; 
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thePart = FindWindow( eventPtr->where, &window); 

switch ( thePart ) 

The part code inSysWindow means that the mouse was clicked in a 
system window, very likely a desk accessory. (Because EventTracker 
doesn't support desk accessories, you probably won't see any 
inSysWindow mouseDowns.) In this case, pass the event and the 
WindowPtr to the system so that it can handle the event. Do this with 
the Toolbox routine SystemClick (). 

case inSysWindow 
SystemClick( eventPtr, window); 
break; 

The part code inDrag indicates a mouse click in the window's drag 
region. Handle this with a call to the Toolbox routine DragWindow (). 
DragWindow () needs a WindowPtr (the point on the screen where the 
mouse was clicked), and a boundary rectangle. DragWindow () will 
allow the user to drag the window anywhere on the screen as long as 
it's within the boundary rectangle. Use screenBits .bounds, which 
will let you drag the window anywhere on the desktop. 

case inDrag : 
DragWindow( window, eventPtr->where, 

&screenBits.bounds ); 
break; 

The part code inGoAway indicates a mouse click in the close box of 
the window. gDone is set to true, so that EventTracker quits. Quitting 
an application by clicking in the close box isn't exactly kosher, but we'll 
need menus to quit the right way. You'll see them in Chapter 5. 

case inGoAway : 
gDone == true; 
break; 
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Building the EventTracker Application 

Since you'll need EventTracker later in this chapter as a standalone 
application, let's build it now. Open the EventTracker project and 
select the Set Project Type ... menu item in the Project menu. 
When the dialog is displayed, type P rmr into the Creator field, as 
shown in Figure 4.13. 

® Rpplication 

O Desk Rccessory 

O Deuice Driuer 

O Code Resource 

Partition (K) ~ 

SIZE Flags~ jsaco I 

OK J) 

File Type I RPPL 

Creator 

0 Far CODE 

0 Far DHTR 

181 Separate STRS 

Cancel 

Figure 4.13 Changing the Creator. 

Now select the Build Application ... menu item in the Project 
menu. As shown in Figure 4.14, name the application Event Tracker 
and click on the Sau e button. 

Hang onto your EventTracker application-you'll need it later in 
this chapter. 

I a EuentTracker ... , 

D Et~(mHrn( k•~r ,c 
D E t~enHr<1d<t~r :rt 
D i: t~<rn1 fr<1< i<t~r, 'J'! ,rHc 

Saue application as: 

181 Smart link 

~ c:::iBubbles 

( E:j•~c1 ) 

(Desktop ) 

ll Saue ll 
Cancel 

Figure 4.14 Building the EventTracker application. 
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Figuring out how to properly redraw a window when it has been 
obscured by other windows can be tricky. You see this demonstrated in 
Updater, the program in the next section. 

Updater: The Return of ShowPICT 

Chapter 3's ShowPICT program showed you how to draw a PICT 
resource in a window. As soon as you clicked the mouse, the program 
exited. Our next project is a little more ambitious. 

Updater starts with two PICT resources, drawn in two separate 
windows. Updater allows you to drag, resize, and zoom each of the 
windows. Click on the back one, it moves to the front. Updater also 
demonstrates proper handling of update and activate events. 

Building Updater 

Create a folder called Updater inside your Development folder. Next, 
launch ResEdit and click the mouse to bring up the Open File dialog 
box. Click on the New button. When the New File dialog box 
appears, open the Updater folder and create a resource file named 
Updater. 7t. rsrc inside the Updater folder. 

Updater Resources 

Updater needs two WIND resources. Select Create New Resource 
from the Resource menu. When prompted for a resource type, enter 
WIND and click the OK button. A WIND editing window will appear. 
Edit your WIND to match the specifications shown in Figure 4.15. Be 
sure to select the third window type from the left in the WIND editor's 
top row. 

Next, select Set 'WI ND' Characteristics ... from the WI ND menu 
and set the Window title: field to PICT 128. If necessary, select Get 
Resource Info from the Resource menu and set the WIND's 
resource ID to 128. 

Create a second WIND resource in the same way, using the 
specifications in Figure 4.16. Set the title of this window to PI CT 129 
and the resource ID to 129. 
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Top: !Du I Height: ~ 

Left:~ Width:~ 

Figure 4.15 First window for Updater. 

Top: IHmMI Height: ~ 

Left:~ Width: ~ 

Figure 4.16 Second window for Updater. 

Color: @ Default 
O Custom 

D Initially visible 

l8] Close boH 

Color: @ Default 
O Custom 

D Initially visible 

l8] Close boH 
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Finally, you'll add two PICTs to your resource file. It's easiest to 
copy and paste each one directly from the Scrapbook into 
Updater. 7t . rsrc, as we did in Figure 4.17. Make sure the PICT 
resource IDs are 128 and 129. 
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Updater. 'If .rs re 

PICT W'IND 

PI CTs from Updater. 'If .r s re 

Figure 4.17 PICTS for Updater. 

1·······,··-·······-···············-·······-····-·-·-····-···-1 

I, 
I 
i ' • 

129 

When you've finished with the two PICT resources, save the resource 
file and quit ResEdit. It's time to code! 

Creating the Updater Project 

Start up THINK C. When prompted, create a new project inside the 
Updater folder. Call the project Updater . 7t. Select New from the 
Fi le menu to create a new source code file, and type in the code below: 

#include <Values . h> 

#define kBaseResID 
#define kMoveToFront 

#define kScrollbarAdjust 

#define kLeaveWhereitis 
#define kNormalUpdates 

#define kMinWindowHeight 
#define kMinWindowWidth 

/*************/ 
/* Gl obals * / 

/*************/ 

Boolean gDone ; 

128 

(Wi ndowPtr ) - lL 

( 16- 1 ) 

fa l se 

true 

so 
80 
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/***************/ 
/* Functions */ 
/***************/ 

void 
void 
void 
void 
void 
void 
void 

ToolBoxinit( void); 
Windowinit( void); 
EventLoop( void); 
DoEvent( EventRecord *eventPtr ); 
HandleMouseDown( EventRecord *eventPtr ); 
DoUpdate( EventRecord *eventPtr ); 
DoActivate( WindowPtr window, Boolean 

becomingActive ); 

I 
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void 
void 

DoPicture ( WindowPtr window, PicHandle pictur'e !) ; 
CenterPict( PicHandle picture, Rect *destRect~t~ ); 

/******************************** main *********/ 

void main( void 

ToolBoxinit(); 
Windowinit (); 

EventLoop(); 

/*********************************** ToolBoxinit */ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
InitFonts(); 
InitWindows(); 
InitMenus(); 
TEinit (); 
InitDialogs( nil); 
InitCursor(); 

/******************************** Windowinit ******** 

void Windowinit( void 

WindowPtr window; 
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window= GetNewWindow( kBaseResID, nil, kMoveToFront ); 

if ( window == nil 

SysBeep( 10 ); 

ExitToShell (); 

/* Couldn't load the WIND 
resource!!! */ 

SetWRefCon (window, (long)kBaseResID ); 
ShowWindow( window); 

window= GetNewWindow( kBaseResID+l, nil, kMoveToFront); 

if ( window == nil 

SysBeep ( 10 ) ; 

ExitToShell (); 

/* Couldn't load the WIND 
resource! ! ! *I 

SetWRefCon window, (long) ( kBaseResID+l ) ); 
ShowWindow( window); 

/******************************** EventLoop *********/ 

void EventLoop( void 

EventRecord event; 

gDone 
while 

false; 
gDone == false ) 

if ( WaitNextEvent( everyEvent, &event, MAXLONG, 
nil ) ) 

DoEvent( &event ); 
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/************************************* DoEvent */ 

void DoEvent( EventRecord *eventPtr ) 

Boolean becomingAct i ve; 

switch ( eventPtr->what 

case mouseDown: 
HandleMouseDown( eventPtr ); 

break; 

case updateEvt: 
DoUpdate( eventPtr ); 

break; 
case activateEvt: 

becomingActive (eventPtr->modif iers & 
activeFlag) == activeFlag ); 

DoActivate( (WindowPtr)eventPtr->message, 
becomingActive ); 

break; 

/************************************* HandleMouseDown */ 

void HandleMouseDown( EventRecord *eventPtr ) 

WindowPtr 
short int 

Graf Ptr 
long 

window; 
thePart; 
oldPort; 
windSize; 
growRect; Re ct 

thePart FindWindow( eventPtr->where, &window ) ; 

switch thePart ) 

case inSysWindow 
SystemClick( eventPtr, window); 

break; 
case inContent: 

SelectWindow( window); 
break; 



174 Macintosh C Programming Primer 

case inDrag : 
OragWindow{ window, eventPtr->where, 

&screenBits.bounds ); 
break; 

case inGoAway 
if { TrackGoAway{ window, eventPtr->where ) ) 

gDone = true; 
break; 

case inGrow: 
growRect.top = kMinWindowHeight; 
growRect.left = kMinWindowWidth; 
growRect.bottom = MAXSHORT; 
growRect.right = MAXSHORT; 

windSize = GrowWindow( window, 
eventPtr->where, &growRect ); 

if ( windSize != 0 ) 

GetPort( &oldPort ); 
SetPort{ window); 
EraseRect( &window->portRect ); 
SizeWindow{ window, LoWord( windSize ), 

HiWord( windSize ), kNormalUpdates ); 
InvalRect{ &window->portRect ); 
SetPort{ oldPort ); 

break; 

case inZoomin: 
case inZoomOut: 

if ( TrackBox( window, eventPtr->where, 
thePart 

GetPort( &oldPort ); 
SetPort( window); 
EraseRect{ &window->portRect ); 
ZoomWindow( window, thePart, 

kLeaveWhereitis ); 
InvalRect( &window->portRect ); 
SetPort( oldPort ); 

break; 
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/************************************* DoUpdate */ 

void DoUpdate( EventRecord *eventPtr ) 

short 
PicHandle 
WindowPtr 

pictureID; 
picture; 
window; 

window= (WindowPtr)eventPtr->message; 

BeginUpdate( window); 
pictureID = GetWRefCon (window); 
picture= GetPicture( pictureID ); 

if ( picture == nil 

SysBeep( 10 ); 

ExitToShell (); 

/* Couldn't load the PICT 
resource!!! */ 

DoPicture( window, picture); 
EndUpdate( window); 

/************************************* DoActivate */ 

void DoActivate( WindowPtr window, Boolean 
becomingActive 

DrawGrowicon( window); 

/******************************** DoPicture *********/ 
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void DoPicture( WindowPtr window, PicHandle picture 

Re ct 
Graf Ptr 
RgnHandle 

drawingClipRect, windowRect; 
oldPort; 
tempRgn; 

GetPort( &oldPort ); 
SetPort( window); 
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tempRgn = NewRgn(); 
GetClip( tempRgn ); 
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EraseRect( &window->portRect ); 

DrawGrowicon( window); 

drawingClipRect = window->portRect; 
drawingClipRect.right -= kScrollbarAdjust; 
drawingClipRect.bottom -= kScrollbarAdjust; 

windowRect = window->portRect; 
CenterPict( picture, &windowRect ); 
ClipRect( &drawingClipRect ); 
DrawPicture( picture, &windowRect ); 

SetClip( tempRgn ); 
DisposeRgn( tempRgn ); 
SetPort( oldPort ); 

/****************** CenterPict ********************/ 

void CenterPict( PicHandle picture, Rect *destRectPtr 

Rect windRect, pictRect; 

windRect = *destRectPtr; 
pictRect = (**(picture)) .picFrame; 
OffsetRect( &pictRect, windRect.left - pictRect.left, 

windRect.top - pictRect.top); 
OffsetRect( &pictRect, (windRect.right -

pictRect.right)/2, (windRect.bottom -
pictRect.bottom)/2); 

*destRectPtr = pictRect; 

Running Updater 

Now that your source code is in, you're ready to run Updater. Save 
your source code in the Updater folder as Updater . c. Select Rd d 
from the Source menu to add Updater. c to the project (don't forget 
to add MacTraps, as well). Select Run from the Project menu. When 
asked to Bring the project up to date? click Yes. Two new 
windows should appear, each displaying a PICT resource, as shown in 
Figure 4.18. 
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Figure 4.18 The two Updater windows. 

Updater demonstrates just how much the Window Manager does for 
you. For starters, the Window Manager draws each window, starting 
with the window frame. The window frame includes the border, as well 
as a drag region, zoom box, and a close box, if appropriate. Next, it gen­
erates an updateEvt, asking Updater to draw the window contents. 

Try clicking in a window's zoom box. Clicking the zoom box should 
vary the window size between the maximum size of your monitor and 
the last size you used. The picture should remain centered in the 
window. Resize a window by clicking and dragging the grow box. 

As you play with Updater, notice that no matter how you manip­
ulate the window by dragging it or resizing it, the contents are always 
redrawn properly. Let's take a look at the code and see how it's done. 

Walking Through the Updater Code 

Updater starts with #defines, some of them the regular bunch of 
suspects. We'll discuss each constant as it appears in the code: 

#include <Va l ues.h> 

#define kBaseRes ID 
#define kMoveToFro nt 

#defin e kScrollbarAdjust 
#de fine kLeaveWhereitis 
#define kNormalUpdates 

#define kMinWi ndowHeight 
#define kMinWindowWidth 

128 
(WindowPtr )-11 

(1 6- 1 ) 
false 
true 

50 
80 
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As we saw before, gDone is initialized to false and checked each 
time through the main event loop. If gDone is set to true, the pro­
gram exits. 

/*************/ 
/* Globals */ 
/*************/ 

Boolean gDone; 

Next come the prototypes for the Updater routines. 

/***************/ 
/* Functions */ 
/***************/ 

void ToolBox!ni t ( void ) ; 
void Window!nit( void); 
void EventLoop ( void ) ; 
void DoEvent( EventRecord *eventPtr ); 
void HandleMouseDown( EventRecord *eventPtr ); 
void DoUpdate( EventRecord *eventPtr ); 
void DoActivate( WindowPtr window, Boolean 

becomingActive ); 
void DoPicture( WindowPtr window, PicHandle picture); 
void CenterPict( PicHandle picture, Rect *destRectPtr ); 

Updater's main procedure starts by calling ToolBoxini t () and 
the window initialization routine. Next, Updater enters the main 
event loop by calling EventLoop (). 

/******************************** main *********/ 

void main ( void ) 

ToolBoxinit(); 
Windowlnit (); 

EventLoop(); 
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Here's the familiar Toolboxinit (), 

/************ ** ********************* ToolBoxinit */ 

void ToolBoxinit( void) 

InitGraf( &thePort ) ; 
Ini tFont s () ; 
InitWindows( ); 
I n itMenus( ); 
TEI nit () ; 
InitDialogs( nil ) ; 
InitCursor() ; 
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Windowinit () starts by loading a WIND resource to create a new 
window. If the resource could not be loaded, beep once, then exit. 

/** ****** ***** **** **** ********** * Windowinit***** ****/ 

void Windowi nit ( void 
{ 

WindowPtr window; 
window= GetNewWindow( kBaseResID, nil , kMoveToFront ) ; 

if ( window == nil 

SysBeep ( 10 ) ; 

ExitToShell (); 

/* Couldn ' t load t he WIND 
resource! ! ! * I 

Next, we'll tuck away the resource ID of the PI CT we want drawn in 
this window. Later, when it comes time to draw the window's contents, 
we'll retrieve this ID and draw the PICT. 

The Window Manager reserves a cache of 4 bytes for your own 
personal use as part of each window you create. To place a value in 
those 4 bytes, call SetWRefCon (), passing it a WindowPtr and a 
long. To retrieve the value, call GetWRefCon (). 

SetWRefCon ( window , (l ong) kBaseResID ) ; 

The refCon, short for reference constant, is found in many 
Toolbox data structures. lt's just a place where you can stash some 
information away safely. The refCon is an invaluable tool. Take 
advantage of it! 
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Once the reference constant is in place, make the window visible. 

ShowWindow( window); 

The same thing is done for the second window, except that we use a 
different window resource and reference constant. 

window = GetNewWindow( kBaseResID+l, nil, 
MoveToFront ); 

if ( window == nil 

SysBeep( 10 ); 

ExitToShell (); 

I* Couldn't load the WIND 
resource!!! */ 

SetWRefCon (window, (long) ( kBaseResID+l) ); 
ShowWindow( window); 

EventLoop () loops on DoEvent () until gDone is set to true. 

void EventLoop( void ) 

EventRecord event; 

gDone 
while 

false; 
gDone == false ) 

if ( WaitNextEvent( everyEvent, &event, MAXLONG, 
nil ) ) 

DoEvent( &event); 

As before, DoEvent () starts with a call to Wai tNextEvent (). 
Unlike EventTracker, however, Updater handles only rnouseDown, 
update, and activate events. 

void DoEvent( EventRecord *eventPtr ) 

Boolean becomingActive; 

switch ( eventPtr->what 
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case mouseDown : 
HandleMouseDown( eventPtr ) ; 
break; 

case updateEvt : 
DoUpdate( eventPtr ) ; 
break ; 
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Although we don't take advantage of it in this program, the Boolean 
becomingActive plays a key role in proper activateEvt handling. 
The event's activeFlag is set (and becomingActive set to true) if 
the activateEvt is in response to a window becoming active (moving 
to the front). If the window is being deactivated, becomingActive will 
be set to false. 

l 
Do you need becomingActive? You do if your windows change as 
they activate or deactivate. For example, if you write on a word pro­
cessor, you'll want the front-most window to feature a blinking text 
cursor, and highlighted text. As a window activates, you'll turn on 
these features. As the window deactivates, you'll turn them back off. 

case activateEvt : 
becomingActive 

II ! 

(eventPtr - >modifiers & 
activeFlag) == 
activeFlag ) ; 

DoActivate( (WindowPtr)eventPtr->message, 
becomingActive ); 

break ; 

DoUpdate () starts by retrieving a wi ndowPtr from the event 
structure. As you can see from the code, the Event Manager stores a 
pointer to the affected window in the EventRecord's message field. 

void DoUpdate( EventRecord *eventPtr ) 

short 
PicHandle 
WindowPtr 

pictureID ; 
picture ; 
window ; 

window= (WindowPtr ) eventPtr- >message ; 
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Then, Begin Update () tells the Event Manager that you're about 
to take care of the condition that caused the update. 

BeginUpdate( window) ; 

Now it's time to use that reference constant that we stored safely 
away in InitWindows (). GetWRefCon () is used to retrieve the 
re f Con. 

pictureID = GetWRefCon (window) ; 

Call GetPicture () to load the PICT resource. If the PICT could 
not be loaded, beep once, then exit. 

picture= GetPicture ( pictureID ) ; 

if ( picture == nil 

SysBeep( 10 ) ; 

ExitToShell () ; 

/ * Couldn ' t load the PICT 
resource ! ! ! * I 

If the PICT loaded OK, pass it to the DoPicture () routine to 
display it. 

DoPicture( window, picture) ; 

If the picture doesn't show up in one or both of the windows, check 
your resource files. Most likely, one of the PICT resources is 
messed up, or the resource ID is wrong. It's also possible that the 
PICT may not load if there is not enough memory available. If you 
suspect this is the case, try a smaller picture. 

l 

Finally, EndUpdate () tells the Mac to empty the window's update 
region. 

EndUpdate( window) ; 
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Every window has an update region associated with it. When a 
previously covered section of a window is uncovered, the uncovered 
area is added to the window's update region. The Window Manager 
is constantly on the lookout for windows with non-empty update 
regions. When it finds one, it generates an updateEvt for that 
window. BeginUpdate () , as part of its processing, replaces the 
update region of the specified window with the empty region. The~e­
fore, if you don't call Begin Update (), you'll never empty the win­
dow's update region, and the Window Manager will never stop 
generating updateEvts for the window. 

Figure 4.19 shows how these regions relate to each other: Before 
BeginUpdat e () empties the update region, it replaces the visible 
region of the window (called the v i sRgn) with the intersection of the 
visRgn and the update region. The application then redraws the 
contents of the window. If it wants to, it can use this newly cropped 
visRgn to help reduce the amount of drawing necessary. For now, 
you'll just redraw the entire contents of the window. Finally, 
EndUpdat e () is called. EndUpdate () replaces the original version 
of the visRgn. A call to Begi nUpdate () without a corresponding 
call to EndUpdate () will leave your window in an unpredictaele 
state. When your program is in this state, it should not drive or 
operate heavy machinery. 

VisRgn ~ ~ ~ ~ 
Update 
Region L2J ~ L[J rm 

Before bottom After bottom window is After After 
window is selected selected. but before Begi nUpdate () EndUpdat e () 

~lf~nUpdate () is is called is called 

I 

l 
Figure 4.19 BeginUpdate () in action. 
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DoActivate () is simple by comparison. DrawGrowicon () redraws 
the grow box and the empty scroll bar areas. The grow box looks 
different depending on whether the window was activated or 
deactivated (Figure 4.20). DrawGrowicon () is smart enough to draw 
the grow box correctly. 

void DoActivate( WindowPtr window, Boolean 
becomingActive 

DrawGrowicon( window); 

Figure 4.20 The grow box, activated and deactivated. 

Handling mouseDown Events in Updater 

As we did in EventTracker, call FindWindow () to find out if the mouse 
was clicked in a window and, if so, which part of which window the 
click was in. 

void HandleMouseDown( EventRecord *eventPtr ) 

WindowPtr 
short int 
Graf Ptr 
long 
Re ct 

thePart 

window; 
thePart; 
oldPort; 
windSize; 
growRect; 

FindWindow( eventPtr->where, &window); 

As before, inSysWindow means the mouse was clicked in a system 
window, very likely a desk accessory. (Because Updater doesn't 
support desk accessories, you probably won't see any inSysWindow 
rnouseDowns, but you will see them in Chapter 5). 
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switch ( thePart ) 
{ 

case inSysWindow 
SysternClick( eventPtr, window); 
break; 
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The inContent part code represents the part of the window in 
which you draw. When you detect a mouse click inContent, call 
Select Window (). If the mouse click was not in the front-most win­
dow, Select Window() deactivates the front-most window and 
activates the clicked-in window. A call to Select Window () usually 
results in a pair of acti vateEvts. 

case inContent: 
SelectWindow( window); 
break; 

inDrag indicates a mouse click in window's drag region. Call 
DragWindow () with screenBits .bounds, which lets you drag the 
window anywhere you want. 

case inDrag : 
DragWindow( window, eventPtr->where, 

&screenBits.bounds ); 
break; 

A click in the close box of either window will result in gDone's being 
set to true. This will cause the program to exit. As we said earlier, 
this isn't the proper way to exit a Mac program, but we'll do a better 
job in Chapter 5. 

case inGoAway 
if ( TrackGoAway( window, eventPtr->where ) ) 

gDone = true; 
break; 

A click in the grow region is handled by a call to GrowWindow (). 
GrowWindow () allows the user to resize the specified window, limited 
by the fields in the Rect growRect. The top and left fields specify 
the minimum window height and width allowed. GrowWindow () won't 
allow the user to shrink the window beyond these values. bottom and 
right specify the maximum height and width. By setting these fields 
to MAXSHORT, you're allowing users to grow the window as big as 
possible, limited only by the size of their monitors. 
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case inGrow: 
growRect.top = kMinWindowHeight; 
growRect.left = kMinWindowWidth; 

growRect.bottom = MAXSHORT; 

growRect.right = MAXSHORT; 

GrowWindow () returns a long integer composed of two words 
(2 bytes each) that define the number of pixels the window will grow 
or shrink in each direction. These words are passed to SizeWindow (), 
causing the window to be resized accordingly. The last parameter to 
SizeWindow () tells the Window Manager to accumulate any newly 
created content region into the update region. This means the Window 
Manager will generate an update event whenever the window is made 
either taller or wider. 

windSize = GrowWindow( window, 

eventPtr->where, &growRect ) ; 

if ( windSize != 0 ) 

GetPort( &oldPort ); 
SetPort( window); 

EraseRect( &window->portRect ); 

SizeWindow( window, LoWord( windSize ), 

HiWord( windSize ), kNormalUpdates ); 

Next, we call InvalRect (), asking it to accumulate the entire 
content region into the update region. Here's why. When the window 
is resized, the picture will be redrawn, centered in the window. 
Because the picture is centered, its new position (in most cases) won't 
coincide with its old position. Our strategy? Erase the old picture and 
redraw it in its new position. 

Between calls to BeginUpdate () and EndUpdate (),the Window 
Manager limits drawing to the update regfon only. Without the call to 
InvalRect (), we'd be able to draw the picture only in the newly 
expanded area of the window. To really understand this important 
point, comment out the call to InvalRect (), then recompile and run 
Updater. When the windows appear, grow the front window about 100 
pixels in each direction. Experiment. When you're done, don't forget to 
uncomment the InvalRect () call. 

InvalRect( &window->portRect ); 
SetPort( oldPort ); 

break; 
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Updater's update event strategy is fairly simple. Use the routine 
InvalRect () to add the entire contents of the wind0w to the 
window's update Rgn, guaranteeing that an updateEvt will be 
generated whether or not the window was grown. When you plan 
your applications, spend some time working out an appropriate 
update strategy. If redrawing the contents of your windows will be 
fairly easy and won't take too long, you may want to use the 
InvalRect () approach. However, if the contents of your window 
are potentially complex (as is true of many drawing and CAD 
packages), you'll probably want to avoid the call to InvalRect () 
and, instead, use the shape of the update region to aid you in 
updating your window efficiently. 

If the mouse is clicked in the zoom box, respond by calling 
TrackBox (). TrackBox () will return true if the mouse button is 
released while the mouse is still in the zoom box. 

case inZoomin : 
case inZoomOu t : 

if ( TrackBox ( window , eventPtr->where, 
thePart ) ) 

Next, we save the old port and set the current port to window. 
Then, just as we did with GrowWindow (),we erase the contents of the 
window and call ZoomWindow () . 

GetPort( &ol dPort ) ; 
SetPort ( window); 
EraseRect( &window->portRect ); 

Zoomwindow ( ) zooms the window in or out, depending on the part 
code passed as a parameter. The constant kLeaveWhereitis tells 
zoomWindow () to leave the window in front if it was in front when the 
zoom box was pressed, and in back if the window was in back when 
the zoom box was pressed. Just as you did with SizeWindow () , call 
InvalRect () to guarantee that an updateEvt is generated When the 
window is zoomed in or out. Finally, reset the old Graf Port. 
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ZoomWindow( window, thePart , 
kLeaveWhereitis ); 

Inval~ect( &window->portRect ) ; 
SetPort ( oldPort ) ; 

break; 

DoPicture () draws the window contents, clipping the drawing so 
that the scroll bar and grow areas aren't overwritten. Start by saving a 
pointer to the current Graf Port in o ldPort so you can restore it when 
you're done drawing. Next, make window the current Graf Port so the 
picture will be drawn in the correct window: 

void DoPicture ( WindowPtr window , PicHandle picture 

Re ct 
Graf Ptr 
RgnHandle 

d rawingCl ipRect , windowRect ; 
oldPort ; 
tempRgn ; 

GetPort( &oldPor t ); 
SetPort( window ); 

Just as we squirreled away a copy of the current Graf Por t , we'll 
also save a copy of the current clip region to restore later. To avoid 
drawing on top of our scroll bars, we'll set the clip region to the win­
dow's content region, then shrink the height and width to account for 
the two scroll bars. 

First, call NewRgn (} to allocate memory for a minimum-sized region. 
GetClip (} resizes the region to accommodate the current clip region. 

tempRgn = NewRgn() ; 
GetClip ( tempRgn ); 

If you created a region in the shape of a star and used SetClip ( > 

to set the clip region to your star region, all drawing in that window 
would be clipped in the shape of a star. You can read more about 
regions in Inside Macintosh (1:141-142and1:166-167). 

_I_ 
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Next, erase the whole window with a call to EraseRect (). You've 
just erased the grow icon, so call DrawGrowicon () to redraw it. 

EraseRect( &window->portRect ); 

DrawGrowicon( window); 

Next, set up your clipping Rect, drawingClipRect, so that it 
excludes the right and bottom scroll bar areas (and, as a result, the 
grow area). Then, set windowRect to the drawingWindow portRect. 
You'll use windowRect as a parameter to CenterP ict (),where it will 
be adjusted to reflect the size of the picture, centered in the input Rect. 

drawingClipRect = window->portRect; 
drawingClipRect.right -= kScrollbarAdjust; 
drawingClipRect.bottom -= kScrollbarAdjust; 

windowRect = window->portRect; 
CenterPict( picture, &windowRect ); 

At this point, you have not changed the clip region of 
drawingWindow. To do this, call ClipRect () to set the clipping 
region to the rectangle defined by drawingClipRect. Now, draw the 
picture with DrawP icture (). 

ClipRect( &drawingClipRect ); 
DrawPicture( picture, &windowRect ); 

Finally, reset the ClipRect to the region saved in tempRgn, release 
the memory allocated to tempRgn, and set the current GrafPort :hack 
to the original setting. 

SetClip( tempRgn ); 
DisposeRgn( tempRgn ); 
SetPort( oldPort ); 

CenterPict () is the same as in Chapter 3's ShowPICT program: 

void CenterPict{ PicHandle picture, Rect *destRectPtr ) 

Rect windRect, pictRect; 

windRect 
pictRect 

*destRectPtr; 
{**{picture)) .picFrame; 
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OffsetRect ( &pictRect , wi ndRect . left - pictRect . left , 

windRect . top - 9ictRect . top) ; 

OffsetRect( &pictRect , (windRect . right -

pictRect . right) /2 , 
(windRect.bottom - pictRect . bottom) / 2) ; 

*destRectPtr = pictRect ; 

The first two programs of Chapter 4, EventTracker and Updater, 
demonstrated how you should handle the standard events generated 
by the Event Manager. The next program, EventTrigger, lets you 
send the required Apple events to EventTracker . 

EventTrigger: Sending Apple Events 

In EventTracker, you learned how to install an Apple event handler, a 
routine designed to respond to a specific Apple event. When you 
launched EventTracker, the only Apple event you saw was the 
kAEOpenApplication sent by the Finder. EventTrigger was designed 
to add a little more life to EventTracker. Each time you run it, 
EventTrigger sends the four required Apple events to EventTracker. If 
you keep an eye on the EventTracker window, you'll see the event 
handlers execute, one at a time, drawing the event name in the event 
window. 

EventTrigger and EventTracker demonstrate the basics of Apple 
event handling. For example, when EventTracker receives a 
kAEQuitApplication event, it doesn't quit. When it receives a 
kAEOpenDocuments Apple event, it doesn't open any documents. 
You'll learn a lot more about Apple events when you get to Chapter 8. 

Sending Apple Events 

To send an Apple event, you have to tell the Apple Event Manager 
where you'd like the event sent (the target address) and what type of 
event you'd like sent. Call the routine AECreateDesc () to create a 
descriptor record, a complete description of the target of your Apple 
event. Then call AECreateAppleEvent () to create the Apple event 
itself. Finally, call AESend () to pass the event on to EventTracker. 
Let 's look at each one of these routines in turn. 
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AECreateDesc() 

AECreateDesc () uses data describing the target application and 
creates a descriptor record used by other Apple Event Manager 
routines: 

OSErr AECreateDesc( DescType typeCode, Ptr dataPtr, 
Size dataSize, AEDesc &result}; 

The first parameter describes the receiver of the Apple event. Since 
we are sending an Apple event to an application, we'll use the type 
typeApplSignature. This tells the Apple Event Manager we'd like 
to send the event to an application having a particular signature, or 
creator ID. 

We'll pass the signature in the second parameter. When we built the 
standalone EventTracker application earlier in the chapter, we used 
Set Project Type ... to set the Creator to 'Prrnr'. To send an Apple 
event to EventTracker, we'll pass 'Prrnr' in AECreateDesc () 's 
second parameter. 

The third parameter is the number of bytes passed in the second 
parameter. The resulting descriptor record, the fourth parameter, is 
used by AECreateAppleEvent () in determining the target for the 
new Apple event. 

AECreateAppleEvent() 

AECreateAppleEvent () is used to create the Apple event itself. 

OSErr AECreateAppleEvent( AEEventClass theAEEventClass, 
AEEventID theAEEventID, 
AEAddressDesc target, short 
returnID, long transactionID, 
AppleEvent &result); 

To create an Apple event, specify the class and ID of the desired 
Apple event. For example, if you wanted to send an Apple event to print 
a document, you would use the event class kCoreEventClass and an 
event ID of kAEPrintDocurnents. The third parameter contains the 
target application information you got from AECreateDesc (). The 
fourth and fifth parameters are used to track the Apple event's progress 
toward the target application. The final parameter is the new Apple 
event. 

Once you have created an Apple event, you can send it by w~y of 
AESend (). 
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AESend() 

AESend () takes the Apple event you defined in 
AECreateAppleEvent () and sends it to the application targeted by 
AECreateDesc () . 

OSErr AESend( AppleEvent t heAppleEvent , AppleEvent &r eply , 
AESendMode sendMode , AESendPriority 
sendPriority , long timeOutinTicks; 
IdleProcPtr idleProc , EventFilterProcPtr 
filterProc) ; 

The first parameter is the Apple event you're sending. The second 
parameter is the Apple event reply that is received if a return reply 
has been requested. The third parameter, sendMode, allows you to 
request a return reply, or to specify the level of interaction you'd like to 
have with the target application. The fourth parameter is a flag that 
determines whether your request is put in the back of the event 
queue (kAENormalPriority) or a t the front of the event queue 
(kAEHighPriority). The fifth parameter, t imeOutinTicks , is the 
time in ticks (sixtieths of a second) that your application is willing to 
wait for a reply before giving up. The sixth parameter, idleProc, 
points to a procedure that should be called while you're waiting for a 
reply. The final parameter , filterProc, points to a procedure that 
can sort through Apple event return replies and decide which ones to 
process. 

Apple events are monstrously cool! Once you understand 
EventTracker and EventTrigger, go through the sample code in 
Chapter 8. Once you've conquered these, go out there and beg, 
borrow, or steal a copy of Inside Macintosh, Volume VI, and read 
through Chapter 6. 

Master Apple events-it's the right thing to do. l 
Now that you've looked at the routines that allow you to send Apple 

events, let's make it work in code. 

The EventTrigger Algorithm 

EventTrigger is the last program in this chapter. It demonstrates how 
you can send Apple events from one application to another. EventTrigger 
consists of six steps: 
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• Initializes the Toolbox and tests for Apple events. 
• Creates, describes, and sends the kAEOpenApplication Apple 

event. 
• Creates, describes, and sends the kAEOpenDocuments Apple event. 
• Creates, describes, and sends the kAEPrintDocuments Apple event. 
• Creates, describes, and sends the kAEQuitApplication Apple 

event. 
• Quits. 

Setting Up the EventTrigger Project 

Start by creating a new project folder, called EventTrigger, inside 
your Development folder. EventTrigger has no user interface and 
needs no resources, so start up THINK C. When prompted, create a 
new project inside the EventTrigger folder. Call the project 
Event Trigger .1t. Select New from the File menu to create a new 
source code file. Type the code listing in and save the file inside the 
Event Trigger folder as Event Trigger. c. Select Rdd (not Rdd ... ) 
from the Project menu to add Event Trigger. c to the project (don't 
forget MacTraps). 

Here's the source code for EventTrigger: 

#include <AppleEvents.h> 
#include <GestaltEqu.h> 

#define kGestaltMask lL 

/***************/ 
/* Functions */ 
/***************/ 

void ToolBoxinit( void); 
void Eventsinit( void}; 
void SendEvent( AEEventID theAEEventID ); 

/******************************** main *********/ 

void main( void 

ToolBoxini t () ; 
Eventsini t () ; 

SendEvent( kAEOpenApplication ); 
SendEvent( kAEOpenDocuments ); 
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SendEvent( kAEPrintDocuments ); 
SendEvent( kAEQuitApplication ); 

/*********************************** ToolBoxinit */ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
InitFonts () ; 
InitWindows(); 
InitMenus (); 
TEini t () ; 
InitDialogs( nil); 
InitCursor(); 

/*********************************** Eventsinit */ 

void Eventsinit( void 

long 
OS Err 

feature; 
err; 

err= Gestalt( gestaltAppleEventsAttr, &feature); 

if ( err != noErr ) 

SysBeep ( 10 ) ; 
Exit To Shell () ; 

/* Error calling Gestalt!!! */ 

if ( ! ( feature & ( kGestaltMask << 
gestaltAppleEventsPresent ) ) ) 

SysBeep( 10 ); /* AppleEvents not supported!!! */ 
Exit To Shell() ; 
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/******************************** SendEvent *********/ 

void SendEvent( AEEventID theAEEventID ) 

OS Err 
AEAddressDesc 
OS Type 
AppleEvent 

appSig = 'Prmr'; 

err; 
address; 
appSig; 
appleEvent, reply; 

err= AECreateDesc( typeApplSignature, (Ptr) (&appSig), 
(Size)sizeof( appSig ), &address); 

err AECreateAppleEvent( kCoreEventClass, 
theAEEventID, &address, 
kAutoGenerateReturnID, lL, 
&appleEvent ); 

err AESend( &appleEvent, &reply, kAENoReply + 
kAECaninteract, kAENormalPriority, 
kAEDefaultTimeout, nil, nil); 

Running EventTrigger 

Now that your source code is entered, you're ready to run EventTrigger. 
First, however, double-click on the EventTracker standalone appli­
cation you built at the beginning of this chapter. When both the 
EventTracker OS window and the EventTrigger project window are 
displayed-but not overlapping-select Run from the Project menu. 
THINK C will start the compilation process. Figure 4.21 shows the 
result. If you like, run EventTrigger several times. You won't hurt 
anything. Each time you run it, four new event strings should appear 
in the EventTracker window. 
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EuentTrigger.n 
N.ame 

... ~~-".!."..~.!'.:' ....................... -................. ....... !'.~~.~ .. 

os Euents 

activateEvt 
High level event: Apple event : kAEOpenApplication 
updateEvt 
osEvt : Suspend event 
High level event: Apple event : kAEOpenApplieation 
High level event : Apple event: kAEOpenDocuments 
High level event : Apple event: kAEPrintDocuments 
High level event: Apple event: kAEOuitApplication 

Figure 4.21 EventTrigger sends Apple events to EventTracker. 

Some things to look for if EventTracker isn't getting its messages. 
Check your code again closely. Each parameter in the Apple event 
functions must be just right for this to work. If they look right and 
EventTrigger still doesn't work, try recompiling EventTracker, and 
make sure the creator in the Set Project Type ... dialog is set 
to • Prrnr ' . Of course, if EventTracker is not actually running, 
EventTrigger will never succeed. Apple events can be sent only to 
applications that are already running. 

If you don't have eneugh memory to run THINK C, your project, 
and EventTracker at the same time, build EventTrigger as a 
standalone application first. Then quit THINK C, launch 
EventTracker, and then EventTrigger. 

..:.:. 

Now, let's take a look at the code. 

Walking Through the EventTrigger Code 

EventTrigger starts with the #includes for Apple events and 
Gesta l t ( ) , as was done in EventTracker: 
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iinclude <AppleEvents.h> 
tinclude <GestaltEqu.h> 

#define kGestaltMask lL 

EventTrigger has only three functions: 

void 
void 

void 

ToolBoxinit( void); 
Eventsinit( void); 
SendEvent( AEEventID theAEEventID ); 
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main () calls ToolBoxini t () , as always. Then it checks to see if 
your Mac supports Apple events by calling Eventsinit (). If Apple 
events are supported, call SendEvent (), once for each of the four 
required Apple events. 

/******************************** main *********/ 

void main( void 

ToolBoxinit(); 
Eventsinit(); 

SendEvent( kAEOpenApplication ); 
SendEvent( kAEOpenDocuments ); 

SendEvent( kAEPrintDocuments ); 

SendEvent( kAEQuitApplication ); 

Here's a familiar face. 

/*********************************** ToolBoxinit */ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
InitFonts(); 
InitWindows(); 
InitMenus(); 
TEinit(); 
InitDialogs( nil); 
InitCursor(); 
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Eventsinit () calls Gestalt (),as in EventTracker, to make sure 
that both Gestalt() and Apple events are up and running on your 
Mac. If there is a problem, instead of displaying the error string as in 
EventTracker, you just beep and quit. 

/*********************************** Eventslnit */ 

void Eventslnit( void 

long feature; 
OSErr err; 

err= Gestalt( gestaltAppleEventsAttr, &feature ); 

if ( err != noErr ) 

SysBeep( 10 ); /* Error calling Gestalt!!! */ 
ExitToShell (); 

if ( ! ( feature & ( kGestaltMask << 
gestaltAppleEventsPresent ) ) ) 

SysBeep( 10 ); /* Apple events not 

supported! ! ! *I 
ExitToShell (); 

SendEvents () calls AECreateDesc (), AECreateAppleEvent (), 
and AESend () to send the Apple event with the ID specified in 
theAEEventID. The event is sent to the application with the creator 
ID 'Prrnr'. 

void SendEvent( AEEventID theAEEventID ) 

OS Err 
AEAddressDesc 
OS Type 
AppleEvent 

appSig = 'Prrnr'; 

err; 
address; 
appSig; 
appleEvent, reply; 

err= AECreateDesc( typeApplSignature, (Ptr) (&appSig), 
(Size)sizeof( appSig ), &address); 
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err AECreateAppleEvent( kCoreEventClass , 
theAEEventID , &address, 

kAutoGene rateReturnID , 11, &appleEvent ) ; 

err AESend( &appleEvent , &reply , kAENoReply + 

kAECan i nteract , kAENormalPriority, 
kAEDefaultTimeout , nil , n i l ) ; 

I I 

The definitive reference on Apple events is the Apple Event Registry, 
available from APDA. See Chapter 9 for information about APDA. 

In Review 

At the heart of every Macintosh application is the main event loop. 
Mac applications are built around this loop. Each pass through the 
main event loop consists of the retrieval of an event from the event 
queue and the processing of the event. 

Apple events are events that are sent and received between appli­
cations. Macintosh applications are expected to respond to the four 
required Apple events: kAEOpenApplication, kAEOpenDocuments , 
kAEPrintDocuments, and kAEQuitAppl icat i on. In Chapter 8, you'll 
learn about the required Apple events in more detail. 

The Window Manager plays an important role in the handling of 
events by generating updateEvts as a means of getting the appli­
cation to draw (or update) the contents of a window. In addition, 
Window Manager routines, such as FindWindow (), offer a mech­
anism for linking an event to a window. 

In Chapter 5, you'll learn all about menus. You'll learn how to 
design and implement regular menus, hierarchical menus, and pop-up 
menus. 



Menu 
Management 

This chapter explains the techniques 
you'll need to know to add menus to 
your programs. We'll show you how 

to create MBAR and MENU resources that 
specify your program's menus, then use 

those resources to bring 
the menus to life. 

5 



THE EARLIEST MACINTOSH incarnations offered a single choice when it 
came to menus: the classic, pull-down menu-the strip at the top of 
the screen with options that, when clicked on, displayed the possibili­
ties available to each program (Figure 5.1). When Apple rolled out the 
Macintosh SE and the Mac II, the situation changed for the better 
with two additional menu types: the hierarchical menu and the 
pop-up menu. We'll discuss and illustrate both. But first, let's look at 
the standard parts of all menu systems. 

(I) [i) ., 

N•~ UJ t>rn~j1~~1~:1:-.. -:--. --ji:~w~o~rl~d~C~lo~c!k~. n~iiiii 
0ft<lJI Pro j<H L. e obj siz:e 

Windows 

Close Project Tnps o O 
Close & Compact !~£1_oc_k~-·----__ _!! 

Set Project Type ... 
Remoue Objects 

.......................................................................... 

Bring Up To Date 3GU 
Check Link 3GL 
Build Library ... 
Build Application ... 

Figure 5.1 The pull-down menu. 

Menu Components 

Before we get into the details of menu implementation, let's discuss 
the parts that make up a menu. Figure 5.2 shows the components of 
the Macintosh pull-down menuing system. The menu bar displayed at 
the top of the Mac screen is normally 20 pixels high. All menu text is 
drawn using the system font and size (usually 12-point Chicago). 

203 
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I Menu Titles I 

I __ /-
1 Menu Bar I 

• Edit Uiew U~lH:>t Special 
New Folder KN 
OtH:>l\ ,lt'O 
Prtnt ,l~P 

Close Window KW Command-key Equiualent 

t;•:>t lnto ))(' l 
Strnrin~j ... ----- Dimmed Menu I tern 
0Ut)Ut;<l1 <~ ))('0 
M•~k•:> nm~s 
Put t~umt.~ ,lt'V 

Menu ltem----Find .•• 
Find Again Ellipsis 

Page Setup ••• 
Print Window ••• 

Figure 5.2 Macintosh menu components. The ellipsis ( .•. ) following a menu 
item indicates that further information is required to complete the command. 

The menu bar is made up of menu titles, each of which corre­
sponds to an individual menu. The ti, File, and Edit menus are found 
in most Macintosh applications. A menu's title is dimmed, or disabled, 
when none of its options is available. 

Menu items are the choices available in a given menu. When the 
mouse is clicked in a menu's title in the menu bar, the menu title is 
inverted and the menu itself appears below the inverted title. The 
menu lists each of the menu's items. 

Take a good look at Figure 5.2. In this figure, the mouse was 
clicked in the File menu title, causing the file menu to appear. The 
characters 38N to the right of the New folder item are together 
known as a Command-key Equivalent. 

If the mouse is dragged over a menu item, the item is highlighted. 
In Figure 5.3, the Paste item in the Edit menu is highlighted. If the 
mouse button is released while an item is highlighted, that item is 
selected, and the application takes the action associated with that 
item. 

Like menu titles, individual items may also be disabled (dimmed). 
An icon or a check mark can be placed to the left of an item's text. The 
font and size of the item may be varied; Command-key equivalents 
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Undo 

cut sgu 
Copy OOC 

Show Clipboard 

Figure 5.3 The Finder's Edit menu with the Paste item selected. 

may be placed to the right of a menu item. If a menu item list becomes 
too long for the screen, which is not uncommon on the smaller Macs, 
the last item that would normally be seen is replaced with a down­
ward-pointing arrow (T). If the user drags the mouse cursor down 
farther, more menu items will scroll into view. 

The S menu is different in several respects from the other menus 
in the menu bar. By convention, the first item in the S menu is used 
by your application to display information (an about box) describing 
itself. The remaining menu items list the files found inside the Apple 
Menu Items folder inside your System Folder (Figure 5.4). For the 
most part, you'll only need to worry about the first item in the S 
menu (the Rb out item). With some help from your application, 
System 7 will handle the rest of the S menu for you. 

Let's take a look at some of the other available menu types. 

About THINK C ••. 

mill Calculator 
~CD Remote 
tp Chooser 
~ Control Panels 
~ MacPaint 2.0 alias 
~Note Pad 
\ ResEdit alias 
00 Scrapbook 

Figure 5.4 The S menu. 
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The Hierarchical Menu 

The hierarchical menu was added to the Toolbox in 1987. It was 
needed for the new, complex programs that had become available for 
the Mac. As more bells and whistles were added to Mac applications, 
it became harder to find a place for them on the menu bar. Hierar­
chical menus allow a programmer to attach an entire menu to a single 
menu item. For example, Figure 5.5 shows a regular pull-down menu 
sporting two hierarchical menu items. When a hierarchical menu item 
is highlighted, its associated submenu appears to its right. You can 
then select an item from the submenu. 

Hierarchical menu items always have a small, right-pointing 
triangle (~) on their right side. 

Figure 5.5 The menu of styles appears when the Style hierarchical menu 
item is selected. 

The Pop-up Menu 

The pop-up menu is the only menu that ca'n be placed anywhere on 
the screen. This menu is similar to a pull-down menu, except that 
pop-up menus can be placed inside windows, dialog boxes, even on the 
desktop. 

A pop-up menu appears when a mouseDown occurs in an area 
defined by an application. This area is known as the pop-up 
rectangle. Once the pop-up menu appears, the user can select an 
item just as they would from a pull-down menu. When the mouse 
button is released, the selection is processed. 

The pop-up menu in Figure 5.6 appears in THINK C's Hdd ••• dialog 
box. The down-pointing triangle (on the right), the menu text, and the 
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lesi Mac Libraries ,.. , 

Figure 5.6 This pop-up menu label is from THINK C's Add ... dialog box. 

1-pixel drop shadow (below and to the right) are important pop-up 
menu elements. This pop-up is in its inactive state, the state it's in 
before the user clicks on it. 

The icon representing the open folder on the left side of the pop-up 
menu in Figure 5.6 shows that you can add any graphic elements 
you like to your pop-up. The down-pointing triangle, the pop-up 
menu text, and the drop shadow are drawn for you by the Toolbox. 
Any other elements are your responsibility. 

l 
I I 

Frequently, the text in an inactive pop-up incorporates the last 
item selected from the pop-up. For example, Figure 5.7 shows the pop­
up menu from Figure 5.6 in its active state. Notice that the pop-up 
text in Figure 5.6 corresponds to the item highlighted in Figure 5. 7. 

A more traditional pop-up menu is demonstrated in this chapter's 
WorldClock program. WorldClock displays the current time in a 
window and refreshes the time once every second. The pop-up menu 
shown in Figure 5.8 allows you to select a time zone. Selecting 
Moscow, for example, tells WorldClock to display the current time in 
Moscow. 

t5J Mac: Libraries 

61 THINK C 5.0 Folder 

61 Deuelopment 

~Hard Driue 

ml Desktop 

Figure 5. 7 The same pop-up after the mouse button was clicked. 
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_J 

lime Zone: I New York .., I 

Figure 5.8 WorldClock's pop-up menu. 

Notice that the pop-up in Figure 5.8 contains a down-pointing 
triangle, a 1-pixel drop shadow, and text showing the last selection 
made from the pop-up (New York). In addition, this pop-up has a 
title, text that does not appear in the pop-up menu itself. Typically, a 
pop-up's title ends in a colon (:). Figure 5.9 shows this pop-up menu in 
its active state. 

Figure 5.9 Making a selection from WorldClock's pop-up menu. 

By the end of this chapter, you'll know how to add pull-down, 
hierarchical, and pop-up menus to your programs. 

Adding Menus to Your Programs 

The Toolbox's Menu Manager provides everything you'll need to add 
menus to your programs. Although you can create all your menus 
from scratch, the usual approach is to base your menus on resources, 
just as you did for windows. 

For pull-down menus, you'll create a MENU resource for each of your 
program's menus. You'll also need an MBAR resource to link all your 
MENUs into a single menu bar. As you'll see in the following pages, 
ResEdit allows you to render your menus in complete detail. You can 
link one MENU to another MENU ' s item to create a hierarchical menu. 
You can customize your menus, adding color, styled text, icons, and 
special symbols (such as a check mark) to individual items or, in the 
case of color, to the entire menu itself. 

Pop-up menus require just a bit more work. In addition to the MENU 
resource that defines the pop-up's menu, you'll need to create a CNTL 
resource that defines the pop-up's bounding rectangle and outside 
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label text. As you'll see in the next chapter, the CNTL resource plays a 
big role in the Toolbox. In addition to pop-up menus, the CNTL 

resource is used to define scroll bars, push buttons, radio buttons, and 
more. For the moment, we'll stick with the pop-up CNTL. 

World Clock 

The best way to learn about the Menu Manager is to see it in action. 
With that in mind, we present WorldClock, a program that combines 
pull-down, hierarchical, and pop-up menus. As mentioned earlier, 
WorldClock displays the current time in a window and refreshes the 
time once every second. 

Just as every Macintosh application should, WorldClock supports 
the standard S, File, and Edit menus. The S menu is fully func­
tional, giving you access to all the items you normally expect to see in 
the S menu. The File menu contains a single item, Quit. 

WorldClock's Edit menu contains the minimum standard set of 
Edit commands (Figure 5.10). While you may want to add commands 
to the bottom of the Edit menu, you'll always want to support the 
items listed in Figure 5.10. The uniformity of the Edit menu across 
Mac applications is one of the many reasons Macintosh applications 
are so easy to use. 

In addition to the standard S, File, and Edit menus, WorldClock 
supports a Special menu. The Special menu has two hierarchical 
submenus, which allow you to change the clock's font and style. 

Finally, WorldClock uses a pop-up menu that allows you to specify 
the current time zone. 

Undo 3€2 

Cut 3€H 
Copy 3€C 
Paste 3€U 
Clear 

Figure 5.10 WorldClock's Edit menu. 
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The WorldClock Algorithm 

WorldClock uses the same basic event-loop structure as the programs 
presented in Chapter 4. Here's how WorldClock works: 

• Initializes the WorldClock window; 
• Creates the menu bar by loading the MBAR and MENU resources; 
• Enters the event loop, refreshing the clock window once every 

second. 

Resources 

Create a folder called WorldClock inside your Development folder. 
Next, launch ResEdit and, when the Jack-in-the-box appears, click 
the mouse to bring up the Open File dialog box. Click on 
the New button. When the New File dialog box appears, navigate 
into the WorldClock folder and create a resource file named 
WorldClock .1t. rsrc in the WorldClock folder. 

Creating the MBAR Resource 

Select Create New Resource from ResEdit's Resource menu. 
When prompted for a resource type, type MBAR, then click 0 K (be sure 
to spell MBAR exactly as it appears, in all upper-case letters). An MBAR 

editing window will appear. We'll need to add four menus to this 
menu bar, one for each menu title that appears in the menu bar itself: 
S, File, Edit, and Special. Notice that the two hierarchical menus 
(Font and Style) and the pop-up menu are not part of the MBAR 

resource. We'll deal with those later. 
Click on the row of asterisks (*) that appears in the window. A 

rectangle will appear around them to show they are selected (Figure 
5.11). Select Insert New Field(s) from the Resource menu. A field 
labeled Menu res ID will appear underneath the first* row, and a 
second * row will appear beneath the new field. Click inside the 
Menu res ID field and type 128. This represents the resource ID of 
the first MENU in the menu bar. We'll create the MENU resources after 
we finish with the MBAR. 

Next, click on the second * row and again select Insert New 
Field(s) from the Resource menu. A second field and a third* row 
will appear. Type 129 in the second field. Click on the third* row and 
select Insert New Field(s) from the Resource menu. A third field 
and a fourth* row will appear. Type 130 in the third field. OK, one 
more time. Click on the fourth* row and select Insert New Field(s) 
from the Resource menu. A fourth field and a fifth* row will appear. 
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D MBRR ID 128 from WorldClock.11.rsrc 

a of menus 0 

11 ) ***** 

i 

11 

1: Ii 

Figure 5.11 An MBAR editing window. 

Type 131 in the fourth field. Your MBAR resource should look like the 
one in Figure 5.12. 

Click on the close box of the MBAR editing window. Next click on the 
close box of the MBAR listing window. The only window left open 
should be the window labeled Wo rldClock. 7t. rsrc. 

=o MBRR ID 128 from WorldClock.11.rsrc 

a of menus 4 

1) ***** 
Menu res ID I 128 

2) ***** 

Menu res ID I 129 

3) ***** 

Menu res ID I 130 

4) ***** 

Menu res ID I 131 

5) ***** 

Figure 5.12 The completed MBAR resource. 
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Creating the MENU Resources 

Next, we'll create the seven MENU resources used by WorldClock. Why 
seven? We'll need one each for the .S, File , Edit , and Special menus, 
one for each of the two hierarchical menus-Font and Style-and 
one more for the pop-up menu. 

Select Create New Resource from ResEdit's Resource menu. 
When prompted for a resource type, enter MENU and click OK. A MENU 

editing window will appear, similar to the one in Figure 5.13. We'll 
start by editing the .S MENU. 

MENU ID = 128 from WorldClock.n.rsrc 

Entire Menu: 181 Enabled 

0 s (Rpple menu) 

Figure 5.13 A new MENU editing window. 

Color 

Title: I l 
I tern TeHt Default: I l 
Menu Background: D 

Click on the .S (Apple menu) radio button on the right side of the 
window. Notice that the title of the menu on the left side of the win­
dow changed to the .S character. Now, hit the return key. The editor 
will move on to the first item in this MENU. Notice that the field 
labeled Title: has changed to TeHt:. Click in the TeHt: field and type 
the text About WorldClock .... 

Notice that the Enabled check box has been checked for you. This 
makes the item selectable. If the Enabled check box was not checked, 
the item would appear dimmed in the menu and would not be 
selectable. 

Type a return to move to the next item. Click on the (separator 
line) radio button to turn this second item into a separator line. 
Notice that the Enabled check box is not checked. This means that 
the separator will not be selectable. This is normal for separator lines. 
Leave the Enabled check box unchecked for this item. 
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:o MENU "Apple" ID 128 from WorldClock.11.rsr c 

[!]_ Selected I tern: O Enable d 
About WorldClock... 0 

TeHt: 0 l I l 
@ ........... (separator line) 1 

Color 

D has Submenu TeHt : I I 
Cmd- Key: D IJ I 

izy Mark: J None ..- IJ I 
'---~~~~~~~~~-'--"-' 

Figure 5.14 The completed S MENU. 

At this point, your MENU should look like the MENU in Figure 5.14. 
To try out your new MENU, click on the S on the right side of the menu 
bar. The menu that appears should have two items in it. The first 
item, Rbout WorldClock ... , should be selectable. The second item, 
the separator line, should not be selectable. 

Next, select Get Resource Info from the Resource menu. Make 
sure the ID: field says 128. Close the Resource Info window. Now 
select Edit Menu & MOH ID ... from the MENU menu. Make sure 
the Menu ID: field says 128 and that the MDEF ID: field says 0, then 
click OK . 

Unlike most resources, a menu's resource ID is part of the menu 
data structure itself. For example, a WindowRecord doesn't contain 
a WIND resource ID. The Menu Info data structure uses the MENU ' s 
ID to link an application's menus together. That's why a ~NU ' s 
resource ID appears in two different places and can be set to two 
different values-once in the Get Resource Info window and once in 
the Edit Menu & MOH ID ••• dialog box. 

Always make these two values agree. 
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Close the MENU editing window. You should see the MENU picker 
window (the window listing each of the MENU resources in this file). 
Select Create New Resource from the Resource menu. A new 
MENU editing window will appear. Without clicking the mouse, type 
the word File. Notice that your text appears in the Title: field. Hit a 
return and type the word Quit. Don't type a return after the Quit . 
Click the mouse in the Cmd-Key: field and type the letter Q. This 
tells the Menu Manager to associate the Command-key sequence S€Q 
with this item. 

To try out this menu, click on the File menu on the right side of the 
menu bar. Compare your results with Figure 5.15. Notice the S€Q that 
appears to the right of the Quit item. 

~"'' Quit SCQ I 
Figure 5.15 Testing the File menu in ResEdit. 

Finally, ensure that the resource ID for this MENU is set to 129. 
Make sure you check this by way of both the Get Resource Info 
and the Edit Menu & MDEF I 0 ... menu items. 

Close the MENU editing window. You should see the MENU picker 
window (this time it should show two MENUs). Select Create New 
Resource from the Resource menu. A new MENU editing window 
will appear. Enter Edit in the Title: field. 

Hit a return and type the word Undo. Before returning, type the 
letter 2 in the Cmd-Key field. Hit a return and click on the 
(separator line) radio button. The Enabled check box should not 
be checked for this item. 

Hit a return and type the word Cut. Type the letter Hin the Cmd­
Key field. Hit a return and type the word Copy. Type the letter C in 
the Cmd-Key field. Hit a return and type the word Paste. Type the 
letter U in the Cm d-K e y field. Hit one last return and type the word 
Clear. The command Clear doesn't have a Command-key equivalent. 

To try out this menu, click on the Edit menu on the right side of the 
menu bar. Compare your results with Figure 5.16. 

Make sure the resource ID for this MENU is set to 130. Check this by 
way of both the Get Resource Info and the Edit Menu & MDEF 
ID ..• menu items. 

Close the MENU editing window. You should see the MENU picker 
window (this time it should show three MENUs). Select Create New 
Resource from the Resource menu. A new MENU editing window 
will appear. Enter Special in the Title: field. 
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Undo ~2 

Cut ~H 

Copy ~c 

Paste ~u 
Clear 

Figure 5.16 Testing the Edit menu in ResEdit. 

Hit a return and type the word Font. Click on the has Submenu 
checkbox. Once the checkbox is checked, a new field, ID:, will appear. 
This field contains the resource ID of the MENU to appear as a sub­
menu. Enter 100 in the ID: field. We'll create MENU 100 in a minute. 

-' 

Submenu IDs are limited to values between O and 255. We use 100 
as the base resource ID for hierarchical menus. Accordingly, MENU 

IDs from 100 to 127 are reserved for hierarchical MENUS. If you 
need more than 28 submenus, or if you just don't like starting with 
100, feel free to use your own numbering scheme. Just make sure 
you keep your submenu IDs between O and 255. 

TI T 

Once the ID: field is filled in, type a return and type the word 
Style. Once again, check the has Submenu checkbox. Enter 101 in 
the I D: field. 

To try this menu, click on the Special menu on the right side of the 
menu bar. Compare your results with Figure 5.17. Notice the right­
pointing triangles to the right of both the Font and Style items. 

l 
One reason the appropriate submenus don't appear when the Font 
and Style menus are selected in the sample Special menu is that 
we haven't created them yet. An even better reason is that ResEdit 
doesn't show the submenus in its sample menus. To see the 
submenus, you'll have to wait until WorldClock is complete. Don't 
worry, they'll be there. 

II I 
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Font ~ 
Style ~ 

Figure 5.17 Testing the Special menu in ResEdit. 

Make sure the resource ID for the Special MENU is set to 131. 
Check this by way of both the Get Resource Info and the Edit 
Menu & MOEF I 0 ••. menu items. 

Close Special's MENU editing window. You should see the MENU 
picker window (this time it should show four MENUs). Select Create 
New Resource from the Resource menu. A new MENU editing 
window will appear. Enter Font in the Title: field. 

You won't add any items to the Font MENU at this point. One of the 
first things WorldClock will do is ask the Menu Manager to add a list 
of all available fonts to this menu. This will allow WorldClock to keep 
up with whatever fonts are installed on the machine it's being run on. 

Click on the Font menu on the right side of the menu bar. Compare 
your results with Figure 5.18. Kind of boring, huh? 

•1n.11 
Figure 5.18 Testing the Font menu in ResEdit. At this point, the Font 
menu has no items. 

Make sure the resource ID for the Font MENU is set to 100. Select 
Get Resource Info from the Resource menu and Edit Menu & 
MOEF I 0 ••• from the MENU menu. You'll need to make the change in 
both places. Don't forget! 

Close Font's MENU editing window. You should see the MENU picker 
window (this time it should show five MENUS). Select Create New 
Resource from the Resource menu. A new MENU editing window 
will appear. Enter Style in the Title: field. 

Hit a return and type the word Plain. Hit another return and type 
the word Bold. Select Bold from ResEdit's Style menu. Be sure to 
select Bold from ResEdit's Style menu and not from the fake Style 
menu ResEdit builds for you. The word Bold should appear Bold, 
and the Style menu's Bold item should have a check mark (v') next 
to it. 

Hit a carriage return and type the word Italic. Select Italic from 
ResEdit's Style menu. The word "Italic" should change to I ta/ic. Hit 
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another return and type Underline. Select Underline from ResEdit's 
Style menu. 

Hit return and type Outline. Select OOooUDDliil@ from ResEdit's Style 
menu. One more to go. Hit return and type Shadow. Select Sh ado w 
from ResEdit's Style menu. Compare your Style menu with the one 
shown in Figure 5.19. 

Plain 
Bold 
Italic 
Underline 
mrnnnumm 
'1UJm[lml!U 

Figure 5.19 Testing the Style menu in ResEdit. 

Make sure the resource ID for the Sty I e MENU is set to 101. Select 
Get Resource Info from the Resource menu and Edit Menu & 
MDEF ID .•• from the MENU menu. Make the change in both places! 

The last MENU we'll create is for the pop-up menu of time zones that 
will appear in the clock window. Close Style's MENU editing window. 
You should see the MENU picker window (this time it should show six 
MENUs). Select Create New Resource from the Resource menu. A 
new MENU editing window will appear. Enter Time Zone in the Title: 
field. 

Hit a carriage return and type the word Current. Hit a second 
return and type the text New York. Hit a third return and type 
Moscow. Hit a fourth return and type Ulan Bator. Compare your 
Time Zone menu with the one shown in Figure 5.20. 

Current 
New York 
Moscow 
Uhm Bator 

Figure 5.20 Testing the Time Zone menu in ResEdit. 
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Make sure the resource ID for the Time lone pop-up MENU is set 
to 132. Select Get Resource Info from the Resource menu and 
Edit Menu & MDEF ID ••• from the MENU menu. Remember that the 
pop-up MENU uses resource ID 132. We'll need this information when 
we create our next resource. 

Creating a Pop-up Menu CNTL Resource 

Prior to System 7, pop-up menus were somewhat difficult to imple­
ment. For starters, you had to draw the pop-up label, making sure the 
label reflected the current value of the pop-up. When a mouseDown 
occurred, you had to calculate whether said click occurred within the 
boundaries of the label. If so, you had to invert the label, then call a 
Toolbox function to bring the menu to life. Next, you had to reinvert, 
then update the label to reflect its new value. In a nutshell, pop-up 
menus were a lot of work. 

System 7 changed all that by working with the Control Manager 
to create a pop-up menu control. On the Mac, a control is a device that 
can change between a range of values. You've seen Macintosh controls 
before. Scroll bars, push buttons, check boxes, and radio buttons are 
all examples of controls. Push buttons, check boxes, and radio buttons 
are known as simple controls. They can take on one of two values: 
ON or OFF. A scroll bar can take on many values, depending on its 
initial settings. We'll get into the details of the Control Manager later 
in the book. For now, we just need to know enough to implement the 
new pop-up control. 

Just as a WIND resource is used as a template to create a window, a 
CNTL resource is used to create a control. Back in ResEdit, close the 
MENU window and the MENU picker window, leaving only the window 
labeled WorldClock. 7t. rsrc. Select Create New Resource from 
the Resource menu. Specify the resource type CNTL and click OK. A 
CNTL editing window will appear. Fill in the CNTL fields exactly as 
specified in Figure 5.21. 

The BoundsRect field specifies the top, left, bottom, and right sides 
of the pop-up menu rectangle. The Control Manager will draw the pop­
up menu and title inside the rectangle. The Value field specifies how 
the title should appear in relation to the pop-up box itself. A Value of 
0 indicates that the pop-up title will appear in the system font, drawn 
on the left side of the pop-up. 

The Visible field determines whether the control is initially 
visible or hidden, just as it does in the WIND resource. The Max field 
specifies the portion of the BoundsRect to be allocated to the pop-up 
title. In this case, the left side of the pop-up box will appear 70 pixels 
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D CNTL ID 128 from WorldClock.TT.rsrc 

BoundsRec t IB1ll5 1165 I I 1ao llliD & 

Ual ue lo 

Uisi ble @ True O False 

Max 70 

Min 132 

Proc lO 1008 

RefCon 0 

Ti tie Time Zone : 

-0 
~ 

Figure 5.21 Specifications for the pop-up CNTL. 

from the left edge of the BoundsRect. The pop-up t itle, Time Zone:, 
will be drawn, left-justified , in those 70 pixels. 

The Min field should look familiar to you. It contains the resourc~ 
ID of the pop-up MENU resource. The ProcID serves the same purpose 
as in the WIND resource-it determines the type of control being 
specified. In this case, 1008 corresponds to the pop-up menu cont rol. 

The Re fCon field can be used by your application as a 4-byte 
scratchpad area. For now, specify a value of 0. Finally, the Title field 
is used to draw the pop-up menu's title text. Remember to include the 
colon (:) at the end of your title. 

Finally, select Get Resource Info from the Resource menu and 
set the CNTL's resource ID to 128. When you're done, close the 
resource info window, the CNTL editing window, and the CNTL picker 
window, leaving only the window labeled WorldClock . n. rs rc. 

I I 

For more information on the pop-up menu control, check out pages 
3-16 through 3-19 of Inside Macintosh, Volume VI. These pages 
describe the pop-up control in detail, listing all of the important 
constants and data structures. 

I 

T 
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Creating a WIND Resource 

The last resource you'll create is the WIND resource used as a template 
to create the clock window. Select Create New Resource from the 
Resource menu. When prompted for a resource type, enter WIND and 
click OK. A WIND editing window will appear. Edit your WIND to match 
the specifications shown in Figure 5.22. Be sure to select the fourth 
window type from the left in the WIND editor's top row. 

~O WIND ID = 128 from WorldClock.rr.rsrc 

Top: l!0j1 I Height: ~ 

Left:~ Width: ~ 

[][] 
Color: @ Default 

O Custom 

D I nitiolly uisible 

D Close boH 

Figure 5.22 WorldClock's WIND resource specifications. 

Next, select Set 'WI NO' Characteristics ... from the WI NO menu 
and set the Window title: field to WorldClock. Finally, select Get 
Resource Info from the Resource menu and set the WIND's 
resource ID to 128. 

That's it! Your resource file should consist of one CNTL, one MBAR, 
seven MENUS, and one WIND. Select Quit from the File menu and save 
your changes. 

Setting Up the Project 

Launch THINK C and create a new project named WorldClock . 7t in 
the WorldClock folder, where you created your resource file. Add 
MacTraps to the project. Next, creat e a new source code file, save it as 
WorldClock . c, and add it to the project. Here's the source code for 
WorldClock . c: 
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#include <Packages.h> 
#include <GestaltEqu.h> 

#define kBaseResID 128 
#define kMoveToFront (WindowPtr)-lL 

#define kUseDefaultProc (void *)-lL 

#define kSleep 20L 

#define kLeaveWhereitis false 

#define kincludeSeconds true 

#define kTicksPerSecond 60 

#define kSecondsPerHour 3600L 

#define kAddCheckMark true 

#define kRemoveCheckMark false 

#define kPopupControlID kBaseResID 

#define kNotANormalMenu -1 

#define mApple kBaseResID 

#define iAbout 1 

#define mFile kBaseResID+l 

#define iQuit 1 

#define mFont 100 

#define mStyle 101 

#define iPlain 1 

#define iBold 2 

#define iitalic 3 

#define iUnderline 4 

#define iOutline 5 

#define iShadow 6 

#define kPlainStyle 0 

#define kExtraPopupPixels 25 

#define kClockLeft 12 

#define kClockTop 25 

#define kClockSize 24 

#define kCurrentTimeZone 1 

#define kNewYorkTimeZone 2 
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#define kMoscowTimeZone 

#define kUlanBatorTimeZone 

3 

4 

#define TopLeft( r) 

#define BottomRight( r) 

(*(Point*) &(r).top) 

(*(Point *) &(r) .bottom) 

#define IsHighBitSet( longNum 

#define SetHighByte( longNum ) 

#define ClearHighByte( longNum ) 

{longNum >> 23) & 1 
longNum I= OxFFOOOOOO 

longNum &= OxOOFFFFFF 

/*************/ 

/* Globals */ 

/*************/ 

Boolean 

short 

Style 

Re ct 

gDone, gHasPopupControl; 

gLastFont = 1, gCurrentZoneID 

gCurrentStyle = kPlainStyle; 

gClockRect; 

kCurrentTimeZone; 

/***************/ 

/* Functions */ 

/***************/ 

void 

void 

void 

void 

void 

void 

void 

void 

void 

void 

void 

void 

void 

void 

long 

ToolBoxinit( void); 

Windowinit( void); 

MenuBarinit( void); 

EventLoop{ void); 

DoEvent( EventRecord *eventPtr ); 

HandleNull{ EventRecord *eventPtr ); 

HandleMouseDown( EventRecord *eventPtr ); 

SetUpZoomPosition( WindowPtr window, short 

zoominOrOut ); 

HandleMenuChoice( long menuChoice ); 
HandleAppleChoice( short item); 

HandleFileChoice( short item); 

HandleFontChoice( short item); 

HandleStyleChoice( short item); 

DoUpdate( EventRecord *eventPtr ); 

GetZoneOffset( void); 
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I 
I 

/**************************** main *****************t*1**/ 

void main( void 

ToolBoxini t () ; 
Windowinit(); 

MenuBarinit(); 

EventLoop(); 

/****************** ToolBoxinit *********************/ ! 

I 
void ToolBoxlnit( void 

InitGraf( &thePort ); 
InitFonts(}; 

InitWindows (); 

InitMenus () ; 
TEini t () ; 
InitDialogs( nil); 

InitCursor(); 

i I 
/****************** Windowinit *********************1~~ 

I 

void Windowlni t ( vo.id 

WindowPtr window; 
i 

1

1 i 
kMoveToFront ) ; 

: I 

window = GetNewWindow( kBaseResID, nil, 

if ( window == nil 

SysBeep( 10 ); /* Couldn't load the WIND 
resource ! ! ! *I 

ExitToShell (); 

SetPort( window); 
TextSize( kClockSize ); 
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gClockRect = window->portRect; 

ShowWindow( window); 

/****************** MenuBarlnit ***********************/ 

void MenuBarinit( void ) 

Handle 

MenuHandle 
ControlHandle 

OS Err 
long 

menuBar; 

menu; 

control; 

myErr; 

feature; 

menuBar GetNewMBar( kBaseResID ); 
SetMenuBar( menuBar ); 

menu= GetMHandle( mApple ); 

AddResMenu( menu, 'DRVR' ) ; 

menu= GetMenu( mFont ); 

InsertMenu( menu, kNotANormalMenu ); 
AddResMenu( menu, 'FONT' ) ; 

menu= GetMenu( mStyle ); 

InsertMenu( menu, kNotANormalMenu ); 

Checkltem( menu, iPlain, true); 

DrawMenuBar(); 

HandleFontChoice( gLastFont ); 

myErr =Gestalt( gestaltPopupAttr, &feature ); 

gHasPopupControl ((myErr == noErr) && (feature & 
(1 << gestaltPopupPresent))); 

if gHasPopupControl 

control= GetNewControl( kPopupControlID, 
FrontWindow() ); 
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/****************** EventLoop ***********************/ 

void EventLoop( void 

EventRecord event; 

gDone false; 

while ( gDone == false ) 
{ 

if ( WaitNextEvent( everyEvent, &event, kSleep, 

nil) ) DoEvent( &event); 

else 

HandleNull( &event); 

/****************** DoEvent ***********************/ 

void DoEvent( EventRecord *eventPtr ) 

char theChar; 

switch ( eventPtr->what 

case mouseDown: 

HandleMouseDown( eventPtr ); 
break; 

case keyDown: 

case autoKey: 
theChar = eventPtr->message & charCodeMask; 

if ( (eventPtr->modifiers & cmdKey) != 0 } 

HandleMenuChoice( MenuKey( theChar) ); 

break; 

case updateEvt: 
DoUpdate( eventPtr ); 

break; 
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/****************** HandleNull ***********************/ 

void HandleNull( EventRecord *eventPtr 

static long lastTime = O; 

if ( (eventPtr->when I kTicksPerSecond) > lastTime ) 

InvalRect( &gClockRect ); 
lastTime = eventPtr->when I kTicksPerSecond; 

/***************** HandleMouseDown **********************/ 

void HandleMouseDown( EventRecord *eventPtr ) 

WindowPtr 
GrafPtr 

whichWindow; 
oldPort; 
thePart; 
menuChoice; 
control; 
ignored; 

short 
long 
ControlHandle 
short 

thePart FindWindow( eventPtr->where, &whichWindow ); 
switch ( thePart ) 
{ 

case inMenuBar: 
menuChoice = MenuSelect( eventPtr->where ); 
HandleMenuChoice( menuChoice ); 
break; 

case inSysWindow: 
SystemClick( eventPtr, whichWindow ); 
break; 

case inContent: 
SetPort( whichWindow ); 
GlobalToLocal( &eventPtr->where ); 

if FindControl( eventPtr->where, 
whichWindow, &control ) ) 

ignored= TrackControl( control, 
eventPtr->where, 
kUseDefaultProc ); 
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gCurrentZoneID GetCtlValue( control); 

break; 
case inDrag: 

DragWindow( whichWindow, eventPtr->where, 
&screenBits.bounds ); 

break; 
case inZoornin: 
case inZoomOut: 

if ( TrackBox( whichWindow, eventPtr->where, 
thePart ) ) 

SetUpZoomPosition( whichWindow, thePart ); 
ZoornWindow( whichWindow, thePart, 

kLeaveWhereitis ); 

break; 

/****************** SetUpZoornPosition ****************/ 

void SetUpZoornPosition( WindowPtr window, short 
zoominOrOut ) 

WindowPeek 
WStateData 
Re ct 
Boolean 
short 

wPeek; 
*wStatePtr; 
windowRect; 
isBig; 
deltaPixels; 

wPeek (WindowPeek) window; 
wStatePtr = (WStateData *) *(wPeek->dataHandle); 

windowRect = window->portRect; 
LocalToGlobal( &TopLeft( windowRect) ); 
LocalToGlobal( &BottomRight( windowRect ); 

wStatePtr->stdState = windowRect; 
wStatePtr->userState = wStatePtr->stdState; 

if ( gHasPopupControl ) 
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else 
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isBig (windowRect.bottom - windowRect.top) > 
(gClockRect.bottom - gClockRect.top); 

if ( isBig ) 
deltaPixels 

else 
-kExtraPopupPixels; 

deltaPixels = kExtraPopupPixels; 

if ( zoominOrOut == inZoomin ) 
wStatePtr->userState.bottom += deltaPixels; 

else 
wStatePtr->stdState.bottom += deltaPixels; 

SysBeep( 20 ); 

/***************** HandleMenuChoice *********************/ 

void HandleMenuChoice( long menuChoice ) 

short 
short 

menu; 
item; 

if ( menuChoice != 0 ) 

menu 
item 

HiWord( menuChoice ); 
LoWord( menuChoice ); 

switch ( menu ) 

case mApple: 
HandleAppleChoice( item); 
break; 

case mFile: 
HandleFileChoice( item); 
break; 

case mFont: 

HandleFontChoice( item); 
break; 

case mStyle: 
HandleStyleChoice( item); 
break; 
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Hili teMenu ( 0 ) ; 

I 

I 
I 

/**************** HandleAppleChoice *******************~*/ 

I 
void HandleAppleChoice( short item ) 

MenuHandle 
Str255 
short 

appleMenu; 
accName; 
accNumber; 

switch item ) 

case iAbout: /* We'll put up an about box 
chapter.*/ 

SysBeep( 20 ); 
break; 

default: 
appleMenu = GetMHandle( mApple ); 
Getitem( appleMenu, item, accName ); 
accNumber = OpenDeskAcc( accName ); 
break; 

I 

I 

I 

I 

next 

I 

I 

/***************** HandleFileCho1ce ****************** **/ 

void HandleFileChoice( short item ) 

switch ( item ) 
{ 

case iQuit 
gDone = true; 
break; 

/***************** HandleFontChoice ***************** ***/ 

void HandleFontChoice( short item ) 
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short 
Str255 
MenuHandle 

fontNumber; 
fontName; 
menuHandle; 
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menuHandle GetMHandle( mFont ); 

Checkitem( menuHandle, gLastFont, kRemoveCheckMark ); 
Checkitem{ menuHandle, item, kAddCheckMark ); 

gLastFont = item; 

Getitem( menuHandle, item, fontName ); 
GetFNum( fontName, &fontNumber ); 

TextFont{ fontNumber ); 

/***************** HandleStyleChoice ********************/ 

void HandleStyleChoice( short item ) 

MenuHandle menuHandle; 

switch( item ) 
{ 

case iPlain: 
gCurrentStyle kPlainStyle; 
break; 

case iBold: 
if ( gCurrentStyle & bold ) 

gCurrentStyle bold; 
else 

gCurrentStyle I= bold; 
break; 

case iitalic: 
if ( gCurrentStyle & italic ) 

gCurrentStyle italic; 
else 

gCurrentStyle I= italic; 
break; 

case iUnderline: 
if ( gCurrentStyle & underline ) 

gCurrentStyle -= underline; 
else 
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gCurrentStyle I= underline; 
break; 

case iOutline: 
if ( gCurrentStyle & outline ) 

gCurrentStyle outline; 

else 
gCurrentStyle I= outline; 

break; 
case iShadow: 

if ( gCurrentStyle & shadow ) 
gCurrentStyle shadow; 

else 
gCurrentStyle I= shadow; 

break; 

menuHandle = GetMHandle( mStyle ); 

Checkltem( menuHandle, iPlain, gCurrentStyle 

kPlainStyle ) ; 
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Check!tem( menuHandle, iBold, gCurrentStyle & bold ) ; 

Check!tem( menuHandle, iltalic, gCurrentStyle & 

italic ) ; 

Checkltem( menuHandle, iUnderline, gCurrentStyle 

underline ) ; 

Checkltem( menuHandle, iOutline, gCurrentStyle & 

outline } ; 

Check Item( menuHandle, iShadow, gCurrentStyle & 

shadow } ; 

TextFace( gCurrentStyle ); 

/****************** DoUpdate ***********************/ 

void DoUpdate( EventRecord *eventPtr ) 

WindowPtr 
Str255 
unsigned long 

window; 
timeString; 
curTimeinSecs; 

window= (WindowPtr)eventPtr->message; 

&' 
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BeginUpdate( window); 

GetDateTirne ( &curTirneinSecs ); 
curTirneinSecs += GetZoneOffset(); 

IUTirneString( (long)curTirneinSecs, kincludeSeconds, 
tirneString ); 

EraseRect( &gClockRect ); 
MoveTo( kClockLeft, kClockTop ); 
Drawstring( tirneString ); 

DrawControls( window); 

EndUpdate( window); 

/****************** GetZoneOffset ***********************/ 

long GetZoneOffset( void) 
{ 

MachineLocation 
long 

loc; 
delta, defaultZoneOffset; 

ReadLocation( &loc ); 
defaultZoneOffset = ClearHighByte 

( loc.grntFlags.grntDelta ); 

if ( IsHighBitSet( defaultZoneOffset ) 
SetHighByte( defaultZoneOffset ); 

switch ( gCurrentZoneID ) 
{ 

case kCurrentTirneZone 
delta = defaultZoneOffset; 
break; 

case kNewYorkTirneZone : 
delta = -SL * kSecondsPerHour 
break; 

case kMoscowTirneZone : 
delta = 3L * kSecondsPerHour; 
break; 

case kUlanBatorTirneZone : 
delta = 8L * kSecondsPerHour; 
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break; 

delta -= defaultZoneOffset; 

return delta; 

Running WorldClock 

Now that your source code is in, you're ready to run WorldClock. Save 
your changes, then select Run from the Project menu. When asked 
to Bring the project up to date, click Yes. If everything went 
well, the WorldClock menus should appear in the menu bar and' the 
WorldClock window should appear on the desktop. The current time 
should appear in the WorldClock window (Figure 5.23), updating once 
every second. 

WorldClock ~= 

9:46:91 HM 

Figure 5.23 WorldClock in action. 

Four menus should appear in the menu bar: S, File, Edit, :and 
Special. The first item under the S menu should read Rb~ut 
WorldClock •••. When you select this item, you should hear a beep (or 
whatever your system is using for a beep sound). Try selecting another 
item from the S menu. Desk accessories and, under System 7, other j 
menu items should behave normally. 

Next, pull down the Special menu. Two hierarchical menu items, 
Font and Style, should appear. When you highlight the Font item, a 
submenu listing all of the currently available fonts should appear. The 
first font should have a check mark ( ../) next to it. Select a different 
font from this menu. The font in the clock window should change to 
match the selected font. Also, if you pull down the Font submenu 
again, the selected font should now have a check mark next to it. 

Pull down the Style submenu. A check mark should appear next to 
the Plain item. Select Bold, then select ®ooUUOIID@. The text in1 the 
clock window should appear bold and outlined. Also, check m~rks 
should appear next to the Bo Id and ®ooUUllUil® items in the Style 
submenu. Select Bo Id again. The check mark next to it should 
disappear and the clock's style should change accordingly. Select 
@ooUDlloo@ again. The check mark next to @oo@Ooo@ should disappear 
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and, since there are no other styles selected, a check mark should 
appear next to the Plain style. 

If things didn't go as planned, double-check each of the WorldClock 
resources, as well as the source code in worldClock . c. Make 
sure your project and resource files are named correctly. 

l 
Now, let 's test out the pop-up menu. Click on the zoom box in the 

upper right corner of the clock window. The window should grow 
longer, revealing a pop-up menu in the bottom half. The pop-up menu 
should say Current, as it does in Figure 5.24. 

WorldClock 0~ 

11: 12:49 AM 
lime Zone: I Current ...,. I 

Figure 5.24 The WorldCJock window with a pop-up menu. 

If the window beeps at you and refuses to change size, WorldClock 
could not find the pop-up menu control. Are you running System 7? 
If not, go out and get yourself a copy. While not everyone in the 
world will be running System 7, as a developer, you owe it to your­
self to always run the most recent version of the operating system. 

Click on the pop-up menu. Notice the check mark next to Current . 
Select New York. The time in the clock window tells you what time it 
is in New York. 

Does the time difference make sense to you? For example, if you 
are in the United States, on the East Coast, the Current time 
should be the same as New York time. If not, your Macintosh may 
be set to the wrong time zone. To fix this, run the Map Control Panel 
that comes with the Macintosh system software (Figure 5.25). Click 
on the map (drag left or right if you have to) on your current location 
and click the Set button. 

Finally, type 3€ 0 to quit WorldClock. 
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_J 

Longitude 

Time Zone 

mi O 

Figure 5.25 The Map control panel. 

Walking Through the WorldClock Code 

WorldClock starts with a pair of #includes. The file Packages . h 
contains the declarations you'll need to call IUTimeString () . 
Gestal tEqu . h is necessary to call Gestalt () . 

#include <Packages . h> 

#include <GestaltEqu . h > 

Several of these #defines should be familiar to you. Those that 
a ren't should become clear from the sections of code in which they are 
used. 

#define kBaseResID 128 

#define kMoveToFront (WindowPtr)-11 

#define kUseDefaultProc (void *) - lL 

#define kSleep 201 

#define k1eaveWhereitis false 

#define kincludeSeconds true 

#define kTicksPerSecond 60 

#define kSecondsPe rHour 36001 
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#define kAddCheckMark true 
#define kRemoveCheckMark false 

#define kPopupControlID kBaseResID 
#define kNotANormalMenu -1 

A new naming convention is introduced in the next few #def in es. 
A #define used to represent the resource ID of a MENU starts with a 
lower-case m. A #define representing an item number starts with a 
lower-case i. 

#define mApple kBaseResID 
#define iAbout 1 

#define mFile kBaseResID+l 
#define iQuit 1 

#define mFont 100 

#define mStyle 101 
#define iPlain 1 
#define iBold 2 
#define iltalic 3 
#define iUnderline 4 
#define iOutline 5 
#define iShadow 6 

#define kPlainStyle 0 

#define kExtraPopupPixels 25 

#define kClockLeft 12 
#define kClockTop 25 
#define kClockSize 24 

#define kCurrentTimeZone 1 

#define kNewYorkTimeZone 2 
#define kMoscowTimeZone 3 
#define kUlanBatorTimeZone 4 

The macros TopLeft () and Bot tomRight () convert a Rect into a 
Point, either the top-left or bottom-right comer. 

#define TopLeft( r) 
#define BottomRight( r) 

(*(Point*) &(r).top) 
(*(Point*) &(r).bottom) 
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These three macros turn some hard-to-read, bit-manipulating code 
into simple functions. 

#define IsHighBitSet( longNum ) 
#define SetHighByte( longNum ) 
#define ClearHighByte( longNum ) 

(longNum >> 23) & 1 ) 
longNum I= OxFFOOOOOO 
longNum &= OxOOFFFFFF 

The global gDone is initialized to false but becomes true when 
Quit is selected from the File menu. gHasPopupControl is set to 
true if the special pop-up menu control definition procedure (the 
Toolbox function that knows how to work with pop-up CNTLs) is 
installed. ' 

Boolean gDone, gHasPopupControl; 

gLastFont specifies which item in the Font menu should have 
a check mark next to it; that is, which is the current font. 
gCurrentZoneID specifies which of the time zones in the pop-up 
menu was selected last. gCurrentStyle specifies the current style of 
the text in the clock window. gCurrentStyle can be a combination of 
several styles. It starts as the plain style. gClockRect will be set to 
the rectangle that needs to be updated once every second-a rectangle 
surrounding the clock but not including the pop-up menu. 

short 
Style 
Re ct 

gLastFont = 1, gCurrentZoneID = kCurrentTimeZone; 
gCurrentStyle = kPlainStyle; 
gClockRect; 

Next come WorldClock's function prototypes: 

void ToolBoxinit( void); 
void Windowinit( void); 
void MenuBarinit( void); 
void EventLoop( void); 
void DoEvent( EventRecord *eventPtr ); 
void HandleNull( EventRecord *eventPtr ); 
void HandleMouseDown( EventRecord *eventPtr ); 
void SetUpZoomPosition( WindowPtr window, short 

zoominOrOut ); 
void HandleMenuChoice( long menuChoice ); 
void HandleAppleChoice( short item ) ; 
void HandleFileChoice( short item); 
void HandleFontChoice( short item); 
void HandleStyleChoice( short item); 
void DoUpdate( EventRecord *eventPtr ); 
long GetzoneOffset( void); 
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main () initializes the Toolbox, sets up the clock window, initializes 
the menus, and enters the event loop. 

/**************************** main **********************/ 

void main( void 

ToolBoxini t () ; 
Windowinit(); 

MenuBarinit(); 

EventLoop(); 

ToolBoxinit () should be familiar by now: 

/****************** ToolBoxinit *********************/ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
InitFonts(); 

Ini tWindows () ; 

InitMenus(); 

TEini t () ; 
InitDialogs( nil); 
InitCursor(); 

Windowinit () starts by loading the WIND resource used as a basis 
for the clock window. 

/****************** Windowinit ***********************/ 

void Windowinit( void) 

WindowPtr window; 

window= GetNewWindow( kBaseResID, nil, kMoveToFront ); 

As before, if the WIND resource isn't found, the program beeps and 
exits. If this happens, check the name of your resource file. 

if ( window == nil ) 
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SysBeep ( 10 ) ; 

Exit ToShell () ; 

/* Couldn't load the WIND 
resource!!! */ 

239 

Once loaded, the window is made the current port and the text size 
is set to 24. As an experiment, try creating a giant clock. Start by 
changing kClockSize to 72. You'll need to change the WIND's height 
and width, as well as the Bounds Re ct of the pop-up CNTL. 

SetPort( window); 
TextSize( kClockSize ); 

Next, gClockRect is set to the window's bounding Rect. To 
update the time once every second, WorldClock erases gClockRect, 
then draws the new time. This happens in the function DoUpdate (). 

gClockRect = window->portRect; 

Finally, Windowini t () makes the window visible. 

ShowWindow( window); 

MenuBarini t () starts by calling GetNewMBar () to load the MBAR 
resource. GetNewMBar () loads each of the MENUS specified in the 
MBAR resource, creating a data structure known as a menu list. 
GetNewMBar () returns a Handle to the menu list. 

The menu list Handle returned by GetNewMBar () is passed to 
SetMenuBar (). SetMenuBar () copies the specified menu list into 
the master menu list for your application. If you wanted to offer 
several different menu bar configurations for your application (a la 
Microsoft Word), you'd use SetMenuBar () to switch between them. 

/****************** MenuBarinit ***********************/ 

void MenuBarinit( void) 

Handle 
MenuHandle 
ControlHandle 
OSErr 
long 

menuBar; 
menu; 
control; 
myErr; 
feature; 

menuBar GetNewMBar( kBaseResID ); 
SetMenuBar( menuBar ); 
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GetMHandle () takes a MENU resource ID and returns a Handle to 
that MENU's data in the menu list . If the specified MENU is not in the 
menu list , GetMHandle () returns nil. This call to GetMHandle () 
returns a Handle to the S menu: 

menu = GetMHandl e ( mApple ); 

AddResMenu () adds the names of all resources of a given type to 
the specified menu. In this case, we ar e asking AddResMenu () to add 
all resources of type ' DRVR ' to the S menu: 

AddResMenu( menu , ' DRVR ' ); 

In the days before System 7, the only items you'd find in ans menu 
would be an About HHH .•• item, a separator line, and a list of desk 
accessories. Since desk accessories come packed into resources 
of type ' DRVR ' , AddResMenu () was used to add the names of all 
available desk accessories to the s menu. 

Though System 7 opened up the s menu to more than just DAs, 
the techniques used for DA handling work fine for all types of s 
menu items. 

I 

The Font and Style menus require a slightly different strategy. 
While the S, File , Edit , and Special menus appear in the menu bar, 
the Font and Style menus only appear as submenus. If we included 
the Font and Style menus in the MBAR resource, the words Font and 
Style would appear as fifth and sixth titles in the menu bar, right 
alongside the other four. 

The solution here is to load the two hierarchical menus into the 
menu list by hand, marking each as a nonmenu bar menu. 
GetMenu () loads the specified MENU into memory, but does not add 
the menu to the menu list. 

menu= Get Menu( mFont ); 

InsertMenu () adds the menu to the menu list, and normally adds 
it to the menu bar. By passing -1 as the second parameter, we're 
telling InsertMenu () to mark t he menu as hierarchical, so it won't 
appear in the menu bar. 

InsertMenu( menu , kNotANormalMenu ); 
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This call to AddResMenu () adds the names of all the 'FONT' 
resources to the end of the specified menu. Since the Font MENU was 
empty to begin with, we've created a menu made up completely of font 
names. 

AddResMenu( menu, 'FONT' ); 

The same basic technique was used for the Style MENU, though no 
font names were added. In this case, the function Check Item () was 
called to place a check mark next to the first item in the Style menu, 
Plain. 

menu= GetMenu( mStyle ); 
InsertMenu( menu, kNotANormalMenu ); 
Checkitem( menu, iPlain, true); 

Next, DrawMenuBar () draws the menu bar. Call DrawMenuBar () 
any time you make a change to the menu titles in the menu bar~ If 
you're just changing a menu's item, there's no need to call 
DrawMenuBar (). 

DrawMenuBar(); 

HandleFontChoice (), defined below, handles a selection from the 
Font menu. In this case, we've simulated a selection of the first font 
in the Font menu (gLastFont was initialized to 1). 

HandleFontChoice( gLastFont ); 

We first used Gestalt() to check for the availability of 
AppleEvents in Chapter 4. In this case, we're checking to see if the 
pop-up control mechanism is available. The global gHasPopup­
Cont rol is set to true if the pop-up control mechanism is installed. 

myErr =Gestalt( gestaltPopupAttr, &feature ); 

gHasPopupControl = ((myErr == noErr) && (feature & 

(1 << gestaltPopupPresent))); 

If the pop-up control is available, call GetNewControl () to load 
the CNTL from the resource file. GetNewControl () takes tlwo 
parameters. The first specifies the resource ID of the CNTL. The 
second specifies the window in which the control should be displayed. 
Since WorldClock uses only one window, it's safe to assume that 
Front Window () will return the correct one. 
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At this point, we won't get into too much detail on the ins and outs 
of the Control Manager. For now, focus on the steps you'll need to take 
to add a System 7-savvy pop-up menu to your own applications. We'll 
get to the Control Manager in Chapter 6. 

if ( gHasPopupControl ) 
control; GetNewControl( kPopupControlID, 

FrontWindow() ); 

Event Loop () is almost the same as the version found in the first 
two programs in Chapter 4. The difference lies in the handling of the 
Boolean value returned by Wai tNextEvent (). In Chapter 4, a 
false return value was ignored. If there are no events pending in the 
event queue, Wai tNextEvent () returns a null event in the event 
parameter and returns a value of false. In the case of a null event, 
we pass the event on to a function called HandleNull (), which is 
covered a little bit further on in this chapter. 

/****************** EventLoop ***********************/ 

void EventLoop( void ) 

Event Record event; 

gDone ; false; 

As mentioned earlier, gDone will be set to true when Quit is 
selected from the File menu. 

while ( gDone ;; false 
{ 

if ( WaitNextEvent( everyEvent, &event, kSleep, 
nil ) ) 

DoEvent( &event ); 
else 

HandleNull( &event); 

DoEvent () is similar to the version presented in Chapter 4. The 
field eventPtr->what tells you what type of event is being processed. 
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/****************** DoEvent ***********************/ 

void DoEvent( EventRecord *eventPtr) 

char theChar; 

switch eventPtr->what 

In the case of a mouseDown, pass the event on to HandleMouse­
Down (). 

case mouseDown: 

HandleMouseDown( eventPtr ); 
break; 

A keyDown is generated as soon as a key is pressed. An autoKey is 
generated when a key is held down longer than the autoKey 
threshold (stored in the system global KeyThresh). The fields in the 
EventRecord are the same in either case. 1 

In a keyDown or autoKey event, the lowest byte of the message 
field contains the character code of the pressed key. For exampl~, if 
the a key were pressed, the low byte of the message field contains an 
ASCII 'a'. This value is placed in theChar. · 

case keyDown: 
case autoKey: 

theChar = eventPtr->message & charCodeMask; 

If the Command key (38) was pressed when the event occurred, 
pass theChar to MenuKey (). MenuKey () looks through the menu list 
to find which menu item, if any, had the Command-key equivalent 
corresponding to theChar. For example, if theChar held an ASCII 
'Q' or 'q' (case is not distinguished), MenuKey () would locate the 
File menu's Quit item. 

If it finds a matching item, MenuKey () highlights the menu's title, 
then returns a 4-byte value containing the menu ID (high 2 bytes) and 
the item number (low 2 bytes). As you11 see in HandleMouseDown () , 
this is exactly what happens when you call MenuSelect (). 

if ( (eventPtr->modifiers & cmdKey) != 0 
HandleMenuChoice( MenuKey( theChar) ); 

break; 
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If an updateEvt occurs, pass the event on to Do Update (}. 

case updateEvt: 
DoUpdate( eventPtr ); 
break; 

HandleNull (} gets called whenever Wai tNextEvent () is called 
and there are no events in the queue. The static variable last Time 
is just like a global variable in that it keeps its value even after 
HandleNull (} exits. We11 use it to buffer the time stored in the field 
eventPt r->when. The EventRecord's when field tells you exactly 
when the event occurred. The time is described in ticks ( 60ths of a 
second) since system startup. 

/****************** HandleNull ***********************/ 

void HandleNull( EventRecord *eventPtr 

static long lastTime ; 0; 

By dividing the number of ticks since startup by 60, we calculate 
the number of seconds since startup. Skip down a few lines and you'll 
see that we buffer the number of seconds since startup in last Time. 
The if statement checks to see if the number of seconds has changed 
since the last time the clock was updated. If so, we use InvalRect () 
to force an update on the clock area of the window, then save the time 
in last Time. 

if ( (eventPtr->when I kTicksPerSecond) > lastTime ) 

InvalRect( &gClockRect ); 
lastTime = eventPtr->when I kTicksPerSecond; 

HandleMouseDown (} handles all rnouseDown events. 

/**********~****** HandleMouseDown *********************/ 

void HandleMouseDown( EventRecord *eventPtr ) 

WindowPtr 
Graf Ptr 

whichWindow; 
oldPort; 
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short 
long 
ControlHandle 
short 

thePart; 
menuChoice; 
control; 
ignored; 
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Just as we did in Chapter 4, we use FindWindow () to determine in 
which window, and which area within the window, the mouseDown 
occurred. 

thePart = FindWindow( eventPtr->where, &whichWindow ); 
switch ( thePart ) 

If the mouseDown was in the menu bar, call the function 
MenuSelect (). MenuSelect () takes the mouse's location ~ a 
parameter and tracks the mouse, pulling down menus and 
highlighting items until the mouse button is released. If an item is 
selected from a menu, MenuSelect () will leave the menu's title 
highlighted, just as MenuKey () did earlier. MenuSelect () also 
returns the same 4-byte value as MenuKey () , with the menu ID in 
the upper 2 bytes and the item number in the lower 2 bytes. This 
value is passed on to HandleMenuChoice (), described below. · 

case inMenuBar: 
menuChoice = MenuSelect( eventPtr->where ); 
HandleMenuChoice( menuChoice ); 
break; 

When a mouseDown occurs in a system window (most likely a desk 
accessory), call SystemClick () to handle the event properly. ' 

case inSysWindow: 
SystemClick( eventPtr, whichWindow ); 
break; 

If the mouseDown occurred in the window's content region, first 
make sure it's the current port, then convert the location from glbbal 
to the local coordinates of the window. ' 

case inContent: 
SetPort( whichWindow ); 
GlobalToLocal( &eventPtr->where ); 

Next, use FindControl () to determine whether the mouseOown 
was in the pop-up menu control (the only control inside the clock 
window's content region). If the mouseDown was in a control, call 
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TrackControl (). In the case of the pop-up menu control, 
TrackControl () inverts the title, pops up the menu, and highlights 
items until the mouse button is released. 

Once the mouse button is released, call GetCtl Value() to get the 
control's current value. In this case, the control's value corresponds to 
the number of the last item selected from the pop-up. This value is 
stored in gCurrentZoneID. 

You'll learn more about GetCtl Value () in Chapter 6. 

if ( FindControl( eventPtr->where, 
whichWindow, &control ) 

ignored= TrackControl( control, 
eventPtr->where, 
kUseDefaultProc ); 

gCurrentZoneID = GetCtlValue( control ); 

break; 

If the mouseDown was in the drag region, call DragWindow () to 
drag the window around the screen. 

case inDrag: 
DragWindow( whichWindow, eventPtr->where, 

&screenBits.bounds ); 
break; 

If the mouseDown was in the zoom box, start by calling 
TrackBox () to animate the zoom box. If the cursor was in the zoom 
box when the mouse button was released, TrackBox () returns true. 

case inZoomin: 

case inZoomOut: 
if ( TrackBox( whichWindow, eventPtr->where, 

thePart ) ) 

In that case, call SetUpZoomPosition () to set up the window's 
zoomed-in and zoomed-out coordinates, then call ZoomWindow () to 
alternate between the clock window and the clock and pop-up menu 
window positions. 

SetUpZoomPosition( whichWindow, thePart ); 
ZoomWindow( whichWindow, thePart, 

kLeaveWhereitis ); 
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break; 

SetUpZoomPosition () takes advantage of a little-known Macin­
tosh feature, the zoom state rectangles. When a WindowRecord is 
created, the Window Manager checks to see if the window contains a 
zoom box. If so, a Handle to a pair of Rects is embedded in 1the 
WindowRecord. These Rects correspond to the position of ,the 
window as it toggles between the user and standard state. 

Typically, the standard state represents the size and position of1the 
window as it first appears. The user state corresponds to the window's 
size and position after the user starts mucking with it, dragging it 
around the screen, and changing its size. The zoom box allows the 
user to toggle between these two states. 

WorldClock interprets these two states in a slightly different 
manner. One state corresponds to the position and size of the window 
as SetUpZoomPosition () gets called. The other state corresponclS to 
the same position, but differs in the height of the window. If the 
window currently displays the clock only, the other state corresponds 
to the window displaying both the clock and pop-up menu. This will 
become clearer in a bit. 

/****************** SetUpZoomPosition ****************/ 

void SetUpZoomPosition( WindowPtr window, short 

WindowPeek 
WStateData 
Re ct 
Boolean 
short 

zoominOrOut ) 

wPeek; 
*wStatePtr; 
windowRect; 
isBig; 
deltaPixels; 

For starters, we need to cast the WindowPtr to the type 
WindowPeek. Take a look at the declaration of the WindowRecord on 
(1:276). A WindowPtr is defined to be a GrafPtr, a pointer to a 
GrafPort. This means that a WindowPtr only allows you access to 
the fields within the port field of the WindowRecord. On the other 
hand, a WindowPeek is defined as a pointer to a WindowRecord. By 
casting the WindowPtr to a WindowPeek, we gain access to the rest of 
the fields within the WindowRecord. . 

wPeek = (WindowPeek) window; 
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Next, we set wStatePtr to point to the two Rects embedded in the 
WindowRecord's DataHandle. Since a Handle is a pointer to a 
pointer, we set wStatePtr to *DataHandle. 

As we've stated before, there's more to handl es than meets the 
eye. Volume II of the Primer goes into detail on the proper usage of 
handles. 

wStatePtr = (WStateData *) *(wPeek- >dataHandle) ; 

Next, the window's portRect is copied into windowRect . At this 
point, windowRect is in the window's local coordinates. The two 
macros TopLeft () and BottomRight () (defined at the top of the 
file) are used along with Local ToGloba l () to convert the Rect from 
local to global coordinates. Although it looks kind of funky, this 
method is fully approved by Apple. 

windowRect = windo w- >portRect ; 
LocalToGlobal ( &TopLeft( windowRect ) ) ; 
LocalToGlobal ( &BottomRight( windo wRect ) ) ; 

Next, both stdState and userState are set to the globalized 
windowRect . 

wStatePtr->stdState = windowRect ; 
wStatePt r - >userState = wStatePtr- >stdState ; 

If the pop-up menu control mechanism is installed, is Big is set to 
true if the window is set to "clock and pop-up menu" size, false 
otherwise. 

if ( gHasPopupControl 

isBig = (windowRect . b ottom - windowRect . top ) > 
(gClockRect . bottom - gClockRect . t op ) ; 

If the window is big, a click in the zoom box should make it shorter. 
If the window is small, a click in the zoom box should make it longer. 

if ( isBig ) 
deltaPixels 

else 
deltaPixels 

-kExtraPopupPixels ; 

kExtraPopupPixels; 
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The parameter zoominOrOut tells us whether we're zoomed in, 
about to zoom out, or zoomed out, about to zoom in. This is the same 
as asking: are we in the user state, or are we in the standard state? 
Use this info to set the destination state to the correct length. 

if ( zoominOrOut == i nZoomin ) 

wStatePtr- >userState . bottom += deltaPixels ; 

else 
wStatePt r - >stdState . b ottom += deltaPixels ; 

If the pop-up menu control mechanism is not installed, call 
SysBeep (). This is a clue that you are trying to run this program 
under an old operating system. 

It's important to note that WorldClock will run under pre-System 7 
operating systems. Its System 7 specific features will be disabled, 
but it will not crash and burn. If possible, do the same for your 
programs. 

l 

else 
SysBeep( 20 ) ; 

HandleMenuChoice () starts by unpacking the 4-byte value 
passed to it into two shorts. 

/***************** HandleMenuCho ice ************* ******* */ 

void HandleMenuChoice ( long menuChoice ) 

short 

short 

menu ; 

item; 

if ( menuChoice != 0 ) 

me nu gets the high 2 bytes and item gets the low 2 bytes. 
Hi Word () and LoWord () are both Toolbox functions. 
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HiWord( menuChoice ); 
LoWord( menuChoice ); 

Next, the i tern is passed to the appropriate handler for the speci­
fied menu. 

switch ( menu ) 

case mApple: 
HandleAppleChoice( item); 
break; 

case mFile: 
HandleFileChoice( item); 
break; 

case mFont: 
HandleFontChoice( item); 
break; 

case mStyle: 

HandleStyleChoice( item); 
break; 

Once the menu command is processed, HiliteMenu () is called to 
uninvert any inverted menu titles. 

HiliteMenu( O ); 

For now, if the About WorldClock ... item is selected, we'll just 
beep. Chapter 6 builds a proper about box for its application. 

/***************** HandleAppleChoice ********************/ 

void HandleAppleChoice( short item ) 

MenuHandle 
Str255 
short 

appleMenu; 
accName; 
accNumber; 

switch ( item ) 

case iAbout: /* We'll put up an about box next 
chapter.*/ 

SysBeep( 20 ); 
break; 
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If another item is selected, it is treated as if it were a desk 
accessory. Get Item () converts the MenuHandle and item number to 
the item name, embedded in a Pascal string. Next, OpenDeskAcc () is 
called to launch the DA. 

default: 
appleMenu = GetMHandle( mApple ); 
Getitem( appleMenu, item, accName ); 
accNumber = OpenDeskAcc( accName ); 
break; 

HandleFileChoice () sets gDone to true if Quit was selecte& 

/***************** HandleFileChoice *********************/ 

void HandleFileChoice( short item ) 

switch ( item ) 
{ 

case iQuit 
gDone = true; 
break; 

HandleFontChoice () uses Check Item () to remove the check 
mark from the last font selected and then add the check mark to the 
font just selected. 

/***************** HandleFontChoice ******************~**/ 

void HandleFontChoice( short item ) 

short 
Str255 
Menu Handle 

menuHandle 

fontNumber; 
fontName; 
menuHandle; 

GetMHandle( mFont ); 

Checkitem( menuHandle, gLastFont, kRemoveCheckMark ); 
Checkitem( menuHandle, item, kAddCheckMark ); 
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Next, gLast:Font is updated to reflect this latest font selection. 

gLastFont ; item; 

Getitem () is called to get a Pascal string with the new font's 
name in it. This string is passed to GetFNum (),which turns the font 
name into a number. Finally, the font number is passed to 
TextFont () to set the port's font, used the next time the clock is 
redrawn. 

Get!tem( menuHandle, item, fontName ); 
GetFNum( fontName, &fontNumber ); 

TextFont( fontNumber ); 

HandleStyleChoice () uses the item selected from the Style 
menu to update gCurrentStyle. gCurrentStyle is a bitmap con­
taining a bit for each possible style. gCurrentStyle has a value of 0 
(kPlainStyle) if no styles are set. 

/***************** HandleStyleChoice ********************/ 

void HandleStyleChoice( short item ) 

MenuHandle menuHandle; 

switch ( item ) 
{ 

case iPlain: 
gCurrentStyle 

break; 
kPlainStyle; 

For each style, if the style's bit is currently set, the bit must be 
cleared. If the bit is cleared, it must be set. 

case iBold: 
if ( gCurrentStyle & bold ) 

gCurrentStyle bold; 
else 

gCurrentStyle I= bold; 
break; 

case iitalic: 
if ( gCurrentStyle & italic ) 

gCurrentStyle -= italic; 
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else 

gCurrentStyle I= italic; 

break; 

case iUnderline: 

if ( gCurrentStyle & underline ) 

gCurrentStyle underline; 
else 

gCurrentStyle I= underline; 
break; 

case iOutline: 
if ( gCurrentStyle & outline ) 

gCurrentStyle outline; 

else 

gCurrentStyle I= outline; 

break; 

case iShadow: 

if ( gCurrentStyle & shadow ) 
gCurrentStyle shadow; 

else 

gCurrentStyle I= shadow; 

break; 
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Once the proper bit has been adjusted, Checkitem () is us~d to 
place or remove the check mark next to each style, depending on 
whether the style's bit is set or cleared. ' 

menuHandle = GetMHandle( mStyle ); 

Checkltem( menuHandle, iPlain, gCurrentStyle 

kPlainStyle ); 

Checkitem( menuHandle, iBold, gCurrentStyle & bold); 
Checkltem( menuHandle, iitalic, gCurrentStyle & 

italic ) ; 

Checkitem( menuHandle, iUnderline, gCurrentStyle & 
underline); 

Checkitem( menuHandle, iOutline, gCurrentStyle & 
outline); 

Checkitem( menuHandle, iShadow, gCurrentStyle & 
shadow); 

Finally, gCurrentStyle is used to set the text style for the clock 
window. 
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TextFace( gCurrentStyle ); 

DoUpdate () handles the clock window's updateEvts. 

/****************** DoUpdate ***********************/ 

void DoUpdate( EventRecord *eventPtr 

WindowPtr 
Str255 
unsigned long 

window; 
timeString; 
cur TimeinSecs; 

First, the WindowPtr is pulled out of the EventRecord' s 
message field. Next, BeginUpdate () is called. 

window = (WindowPtr)eventPtr->message; 

BeginUpdate( window); 

GetDateTime () is called to retrieve the current time in seconds. 
GetZoneOff set () returns the number of seconds needed to adjust 
for a change in time zones. 

GetDateTime ( &curTimeinSecs ); 
curTirneinSecs += GetZoneOffset(); 

IUTirneString () converts curTirneinSecs to a Pascal string. 
IUTirneString () determines the string's format from International 
Resource 1 (I:500). Basically, the International Resources enable your 
programs to run on any Macintosh, in any country, without change. In 
this case, the time in the clock window will appear in a form that 
makes sense for the current country. 

IUTimeString( (long)curTimeinSecs, kincludeSeconds, 
timeString ); 

To draw the time, the old time is first erased. Next, the pen is 
moved to the proper location, and the time string is drawn. 

EraseRect( &gClockRect ) ; 
MoveTo( kClockLeft, kClockTop ); 
Drawstring( timeString ); 



Menu Management 255 

Next, DrawControls () is called to draw the controls for this 
window. Since the only control in this window is the pop-up menu 
control, this has the effect of updating the pop-up menu label. 

DrawControls( window) ; 

As always, every call to BeginUpdate () must be matched with a 
call to EndUpdate () . 

EndUpdate( window ); 

GetZoneOffset () calls the System 7 utility ReadLocation () 
M :14:49) to fetch information about this Mac's geographic location . 

....!.. 

Apple designed the Macintosh with the global marketplace in mind. 
For example, the first Macintosh Toolbox came equipped with the 
International Utilities Package, designed to give programmers 
access to country-specific number, currency, date, and time formats. 

With the introduction of System 6.07, Apple added another 
element to its globalization strategy. ReadLocation () and 
Wri teLocation () join the International Utilities as part of the 
Script Manager. A script is a language-specific writing system, such 
as Japanese, Arabic, or Hebrew. By working with the Script 
Manager, you can design programs that can easily be ported to 
countries using different script systems. If you plan on developing for 
the global market, Volume VI, Chapter 14 of Inside Macintosh is a 
must read. 

For now, we'll focus on the part of the Script Manager that lets 
you access information regarding your Macintosh's geographic 
location and time zone. 

ll 
I I 

/***** ****** ******* GetZoneOffset *******************'***/ 

long GetZoneOffset( void ) 
{ 

MachineLocation 
long 

loc ; 
delta , defaultZoneOffset ; 
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ReadLocation () retrieves the current geographic and time-zone 
information from parameter RAM. 

Parameter RAM (or P-RAM) is a portion of memory, backed up by a 
battery, used to store long-term information about your Macintosh. 
For example, when you use the General Control Panel to edit the 
current time, you are actually editing a location in P-RAM. Since P­
RAM rs backed up by a battery, you don't have to reset the time 
every time you power off your Mac. 

l 
ReadLocation( &loc ); 

The next few lines demonstrate the proper method for calculating 
the time-zone offset, the number of seconds the clock needs to be 
adjusted to make up for any differences in time zone. 

defaultZoneOff set = ClearHighByte 
( loc . gmtFlags . gmtDelta ) ; 

if ( IsHighBitSet( defaultZoneOffset ) 
SetHighByte( defaultZoneOffset ) ; 

delta is set to the number of seconds needed to make up for a 
difference in time zone of the requested city. 

switch ( gCurrentZoneID ) 
{ 

case kCurrentTimeZone 
delta = defaultZoneOffset; 
break; 

case kNewYorkTimeZone : 
delta = - SL * kSecondsPerHour 
break; 

case kMoscowTimeZone : 
delta = 3L * kSecondsPerHour; 
break; 

case kUlanBatorTimeZone : 
delta = BL * kSecondsPerHour ; 
break ; 
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Next, delta is offset to adjust for the current time zone, then 
returned. 

delta -= defaultZoneOffset; 

return delta; 

Variants 

There are several interesting things you can do with WorldClock. As 
suggested earlier, try changing the clock's size. You'll need to change 
the font size and you'll also need to adjust the size of the clock window 
and the position of the pop-up menu. 

Try adding a few more cities to the WorldClock pop-up menu. To 
maximize WorldClock's effectiveness, pick a city in each of the world's 
24 time zones. 1 

Next, make WorldClock run in the background. To see why, run 
WorldClock. Then, with WorldClock still running, bring another 
program to the foreground. You may have to move the WorldClock 
window around to see this effect but, when you get things set up right, 
you should notice that the clock window stops updating when it is in 
the background. This is because WorldClock is not set up to receive 
Background Null Events. 

To change this, Quit WorldClock and, once back in THINK C, select 
Set Project Type ••• from the Project menu. Next, click on the 
SI 2E flags pop-up menu and select Background Null Euants 
(Figure 5.26). Click OK . 

../ Multifinder-Aware 

../Background Null Euents 
Suspend & Resume Euents 

Background Only 
Get FrontClicks 
Accept ChildDiedEuents 

../ 32-Bit Compatible 
Hi g hleu e IEue n t-Aware 
Accept Remote HighLeuelEuents 
Stationery-Aware 

Figure 5.26 The pop-up menu from the Set Project Type ... dialog. 
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Now when you run WorldClock, your program will receive null 
events, even when it is in the background. The s I ZE resource, which 
you just modified, is discussed in detail in Chapter 8. 

In Review 

Menus are an intrinsic part of the Macintosh interface. Designing 
them correctly allows you to take advantage of the familiarity of users 
with standard Mac menus. The standard pull-down menu does the job 
for many applications, and hierarchical and pop-up menus bring 
freshness to the interface. 

In Chapter 6, you'll learn about another essential part of the Mac 
interface: creating and controlling dialog boxes. While you're there, 
you'll also look at one of the newest managers on the Macintosh: the 
Process Manager. 



Working with 
Dialogs 

Dialogs present a list of alternatives for 
the user to choose from. Alerts are 
simplified dialogs, used to report 

errors and give warnings to the user. 
Chapter 6 discusses both of these, 

along with the Notification Manager, 
Apple's background notification 

mechanism, and the Process Manager, 
which can be used to launch other 

applications. 

6 



DIALOGS ARE AN important part of the Macintosh interface; they 
provide a friendly, standardized way of communicating and receiving 
feedback from the user. Some dialogs ask questions of the user, or 
offer the user the opportunity to modify current program parameters 
(Figure 6.1). Some dialogs are the direct result of a user menu 
selection. For example, when you select Print .•. from within an 
application, the Print Job dialog appears (Figure 6.2). 

Name: I Dr. Beuerly Crusher 

Cancel ) fi~( ;;;;;;;;;;;;OiiiiK ~» 

Figure 6.1 "What's your name?" dialog box. 

LoserWriter " Intelligence NT" 7 .1 n Print B 
Copies:Ll Poges: ®All 0 From: CJ To: CJ ( Cancel ] 

Couer Poge: ® No O First Poge O Lost Poge 

Poper Source:® Poper Cossette O Monuol Feed 

Print: ® Block & White O Color/Groyscole 

Destination: ® Printer O Postscript® File 

Figure 6.2 Print Job dialog box. 

l 

By convention, menu items that spawn dialog boxes always end 
with an ellipsis ( ••• ). For example, the Print ... item on the File 
menu brings up a print dialog box. 

J 
Another important part of the Mac interface is the alert 

mechanism. Alerts (Figure 6.3) are simplified dialogs, used to report 
errors and give warnings to the user. From a programmer's point of 
view, alerts are simple to implement, but not as flexible as dialogs. 
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There's not enough 
memory to edit another 
document. 

I OK D 

Figure 6.3 An alert. 

Chapter 6 also introduces two other Toolbox managers: the first is 
the Notification Manager, which provides a method for programs 
not currently in the foreground to notify the user of an important 
event. The second is the Process Manager, which allows you to 
launch other applications from your own application. 

How Dialogs Work 

Dialog boxes combine a window with a list of dialog items. The user 
clicks on some items (such as the 0 K button) and types text into others 
(editable text field). Still other items are provided for information 
purposes only. Clicking on these items has no effect. 

Dialogs are based on two resources, the DLOG and the DITL. Much 
like a WIND resource, the DLOG serves as a template for the dialog 
window. The D ITL resource contains the dialog item list, a list of all 
items that appear in the dialog window. As you'll see when we get to 
our program, ResEdit provides everything you'll need to create these 
resources. 

Typical dialog items include check boxes, radio buttons, and push 
buttons. These items are known as controls. In addition, static text 
fields, editable text fields, PICTs, and ICONS may also be part of an 
item list (Figure 6.4). By convention, most dialog boxes offer an OK 
button, which saves your changes, and a Cancel button, which gives 
users a chance to back out without saving their changes. 
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l Static TeHt J l Pop-up Menu Control J l [ Radio Button ] 
I 

LaserWriter Page Setup l 7.1 n OK ll 
Poper: ® US Letter O A4 Letter 
v~ us Legal 0 BS Letter 0 I Tabloid • I (Cancel ) 

/ Reduce or 1Hmil% Printer Effects: (Options) 
Enlarge: 181 Font Substitution? 
Orientation 181 TeHt Smoothing? 

-~ 
r--(81 Graphics Smoothing? 

I g Foster Bitmap Printing? 
I 

[ Selected Radio Button J Lr check BoH [ Button J 

l Editable TeHt J [ Checked Check BoH J 

Figure 6.4 Dialog items in a Page Setup ..• dialog box. 

Dialog Items: Controls 

Controls are one of the most important types of dialog items. Controls 
exist in at least two different states. For example, the check box can be 
checked or unchecked (Figure 6.5). Although controls may be defined 
by the program designer, four types of controls are already defined in 
the Toolbox. They are buttons, check boxes, radio buttons, and 
dials. 

These controls fall under the jurisdiction of the Control Manager, 
which handles the creation, editing, and use of controls. 

D Uirtual Reality 

181 Cheese Fries 

Cancel ) B~[ iiiiiiiiiiiiiiiOiiiiiK iiiiiiiifi'D 

Figure 6.5 Checking a check box. 
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Buttons 

The classic example of a button is the OK button found in most dialog 
boxes (Figure 6.6). When the mouse button is released with the cursor 
inside the button, the button's action is performed. For example, 
clicking an OK button might start a print job or save an application's 
data. 

Scale selection ~ 3 

Cancel ) n OK ll 

Figure 6.6 The button. 

Those of you familiar with HyperCard should note the similarity 
between HyperCard buttons and Toolbox buttons. Toolbox buttons 
are rounded-corner rectangles, whereas HyperCard buttons have 
more variation in shape and appearance. 

Check Boxes 

Check boxes are generally used to set options. For example, you might 
use a check box to determine whether the user wants sound turned on 
or off in an application (Figure 6. 7). 

Play Options: 

D Sound on 

fZ] Engage proto-driue 

Cancel ) n OK ll 

Figure 6. 7 Check box example. 
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Radio Buttons 

Radio buttons are similar to check boxes in function, in that they also 
are generally used to set options or choices in a dialog box. Figure 6.8 
shows some radio buttons. The difference between radio buttons and 
check boxes is that the choices displayed in radio buttons are mut ually 
exclusive. Radio buttons appear in sets, and only one radio button in a 
set may be on (or highlighted) at any given time (Figure 6.9). 

Measure in: 

@inches 
O centimeters 

can ce I ) fi"=( -=-0--K ~D 

Figure 6.8 Radio button example. 

Dials 

Dials are different from other controls: They display and supply 
qualitative instead of off/on information. Two familiar dial controls 
predefined in the Toolbox are the pop-up menu control you saw in the 
previous chapter, and the scroll bar (Figure 6.10), which is an 
integral part of many Mac application windows. In Chapter 7, we'll 
show you how to set up a scroll bar. 

Your Order: 

® Hamburgers 
® French Fries 
®Coca-Cola 

n OK )J 

Wrong Way: radio buttons 
should indicate mutually 

exclusive options. 

Figure 6.9 Radio button pointers. 

How much do you make? 

O I make a lot of money 
O I make enough money 
®Got a nickel? 

([ OK )J 

Right Way: only one of these 
choices would reasonably be 

picked. 
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Scrolling Pictures 

Downtown Office Occupancy Rate 
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111111 
1111 11 

1982 1983 1984 1985 

Figure 6.10 Scroll bar example (from Pager in Chapter 7). 

Other Dialog Items 

Controls represent one type of dialog item. You can also display 
pictures (using a PICT resource, as shown in Figure 6.11) and icons 
(resource type ICON) in a dialog box. You can also add static and 
editable text fields, as well as user items, to your dialogs. A user item 
designates a rectangle in the dialog window's local coordinates. 
Typically, you'll use a user item as a placeholder, marking an area in 

Please register: 

Name: -----+-+ ...... Static TeKt 

I Bill Gates 

Organization: 

IMicrosof~ 

( Cancel J ([ OK D 

Button Editable Te Kt 

Figure 6.11 Other dialog items. 
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the dialog for a nonstandard dialog item. For example, your program 
might use a user item as a guide for placing a scrolling list created on 
the fly. 

Not all dialogs are alike. For example, some dialogs force you to 
respond to them before you can go on with your program. Others don't. 
Some let you drag the dialog window around the screen. Some don 't. 
Let's take a look at some of these different dialog types. 

Modal Dialogs 

A modal dialog is one to which the user must respond before the pro­
gram can continue. Modal dialogs are used for decisions that must be 
made immediately. They represent the vast majority of dialog boxes. 

The Macintosh is generally a modeless machine. This means that 
most of the operations performed by an application are available to 
the user most of the time. For example, most of the operations 
performed by THINK C are available through pull-down menus. 
Modal dialogs come into play when you must focus the user's 
attention on a specific task or issue. Alerts are always modal. Dialog 
boxes aren't. 

The Modal Dialog Algorithm 

To create a modal dialog, first load the dialog (including the dialog's 
item list) from the resource file using GetNewDialog () . Then, make 
the dialog window visible Uust as you would a new window). Next, 
enter a loop, first calling ModalD i a l o g () to find out which item the 
user selected, then processing that item. When an exit item (such as 
OK or Cancel) is selected, exit the loop. 

Modeless Dialogs 

Modeless dialogs act more like regular windows; they appear to the 
user like any other window and can be brought to the front with a 
mouse click, or even dragged around the screen. Whereas modal 
dialogs require an immediate response from the user, modeless dialogs 
may be set aside until they are needed. The algorithms used to 
implement modal and modeless dialogs are quite different. 
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The Modeless Dialog Algorithm 

To implement a modeless dialog, start by loading the dialog and mak­
ing it visible (as was done with the modal dialog). When an event is 
returned by Wai tNextEvent (), pass it on to I sDialogEvent () . If 
IsDialogEvent () returns false, the event is not related to the 
dialog and should be handled normally. Otherwise, the event should 
be passed to DialogSelect (). DialogSelect () returns a pointer to 
the dialog box whose item was selected, as well as the number of the 
item selected by the user. Process the item as you would with 
ModalDialog (). 

There's actually a third kind of dialog: the movable modal dialog 
box. Despite its name, a movable modal dialog is a window, not a 
dialog box. You create a movable modal by passing 
movableDBoxProc in your call to NewWindow () . To make a 
movable modal behave like a dialog box, you'll need to restrict user 
actions-for example, by beeping if the user clicks on another 
window, instead of bringing that window to the front. Figure 6.12 
shows a movable modal dialog you probably see every day. 

Copy 

Items remaining to be copied: 3 

Writing: Picture 1 copy 

Stop 

Figure 6.12 A movable modal dialog box. 

To learn more about movable modal dialogs, see Chapter 3-15 in 
Volume VI of Inside Macintosh. 

Adding Dialogs to Your Programs 

In this section, we'll show you how to build modal dialog boxes through 
the use of DLOG and DITL resources. Although we could have created 
the dialog structure in THINK C instead, we chose to emphasize the 
resource-based approach. 
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We'll show you how to create DLOG and DITL resources when we 
get to the Reminder program later in the chapter. 

I 

As was stated in the dialog algorithm, to implement a dialog box in 
your application, load your dialog box resources, then loop around 
ModalDialog (), responding to clicks in the dialog box window. 

Here's an outline of the procedure. First, set up #defines that 
correspond with the important items in your DITL. You'll want a 
#define for each DITL item that you want to track or change. As 
you'll see in a minute, the #define constant matches the item's DITL 
number. For example, if you designed a DITL with an OK button as 
item 1, a Cancel button as item 2, two radio buttons as items 3 and 4, 
and three check boxes as items 5, 6, and 7, you'd need these #def ines: 

#define iFirstRadio 3 

#define iSecondRadio 4 

#define iFirstCheckbox 5 

#define iSecondCheckbox 6 

#define iThirdCheckbox 7 

#define kOn 1 

#define kOff 0 

You'll use kOn and kOff when you turn a radio button or a check 
box on or off. As you construct your dialog item #defines, you'll find it 
helpful to turn on ResEdit's Show Item Numbers feature. Figure 
6.13 shows a sample DITL with item numbering turned on. 

Once your #defines are in place, load your DLOG and DITL 
resources by calling GetNewDialog (): 

dialog = GetNewDialo g( kDialogResID , nil , kMoveToFro n t ) ; 

Now, init ialize each of your controls. Use GetDitem () to retrieve a 
handle to a control item. Then use Set Ct 1 Value () to set the buttons, 
radio buttons, and check boxes to their initial values. For example, the 
following code will fill the first radio button and clear the second radio 
button in the dialog box described above: 
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GetDitem( dialog, iFirstRadio, &itemType, &itemHandle, 
&itemRect ); 

SetCtlValue( itemHandle, kOn ); 
GetDitem( dialog, iSecondRadio, &itemType, &itemHandle, 

&itemRect ); 
SetCtlValue( itemHandle, kOff ); 

§0§ o ITL ID = 1 29 from Rem in ~ 

lwhe@J ._! __ 3"1l ... !'-0_0_3aj,..!
1
_n_M_'aj_.6 

JMessagm_ 

'Sample reminder 

ID Play Soultzj 
ID Rotate 1Cl!zj 

, 
[D LaunULJ<None Selected>@ 

[ Can celaj[ __ O_K_Llj_t ,_____. _. 

Figure 6.13 Sample DITL. To see this in ResEdit, select Show Item 
Numbers in the D ITL menu. 

iFirstRadio and iSecondRadio correspond to the dialog's two 
radio button items. The first radio button will be set to kOn 
(highlighted), the second to kOff (Figure 6.14). 

D First CheckboH ®First Radio Button 

D Second CheckboH O Second Radio Button 

D Third CheckboH 
Cancel ) n OK D 

Figure 6.14 Sample radio buttons initialized. 
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Here's some code to initialize the three check boxes described 
earlier. The code fragment clears the first check box and checks the 
second and third check boxes (Figure 6.15). 

GetDitem( dialog , iFirstCheckBox, &itemType , &itemHandle , 
&itemRect ) ; 

SetCtlValue( itemHandle , kOff) ; 
GetDitem ( dialog , iSecondCheckBox, &itemType , &itemHa ndle , 

&itemRect ); 
SetCtlValue( itemHandle , kOn ); 
GetDitem( dialog , iThirdCheckBox , &itemType , &itemHandle , 

&itemRect ); 
SetCtlValue ( ite mHandle , kOn ) ; 

D First CheckboH 

rgJ Second CheckboH 

rgj Third CheckbOH 

® First Radio Button 

O Second Radio Button 

Cance I ) ~'liiii( iiiiiiiiio .. K ~D 

Figure 6.15 Sample check boxes initialized. 

Once your controls are initialized, you still have some housekeeping 
to do. If you plan on drawing in the dialog box with QuickDraw (which 
you might want to do with a user item procedure-see the tech 
block below), make the dialog the current port by passing the 
DialogPtr to Set Port (): 

SetPort ( dialog ); 

You can pass a DialogPtr to any routine that accepts a 
WindowPtr. In many ways, a dialog acts just like a window. 

l 
The Dialog Manager allows you to associate a drawing procedure 
with a particular user item. The procedure is then called whenever 
the item needs updating. Inside Macintosh is not particularly helpful 
on the topic of user items, so look at Tech Note #34 for details on 
implementing them in your programs. 

-"- l l 
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SetDialogDefaultitem () allows you to specify a dialog's 
default item (usually the OK button). This function automatically 
draws the thick, rounded rectangle around the default item. 
SetDialogCancel Item () allows you to specify a dialog's cancel item. 
After this call is made, typing 3€ . automatically selects the specified 
cancel item. Finally, SetDialogTr acksCursor ( ) enables the Dialog 
Manager to tie the i-beam cursor to any editable text items in a dialog. 
The #defines ok and cancel are set to 1 and 2, respectively, by the 
Dialog Manager, so it's a good idea to make sure that your OK button 
is item number 1 and your Cancel button item number 2. 

SetDialogDefaultitem { dialog , ok ) ; 
SetDialogCancelitem{ dialog , cancel ) ; 
SetDialogTracksCursor{ dialog, true ) ; 

Finally, make the dialog visible by calling ShowWindow ( ) . You're 
now ready to call Moda!Dial og () to handle the events that occur in 
the dialog window. 

ShowWindow { dial og ); 

When you create your DLOG in ResEdit, make sure the Uisible box 
is unchecked. That way, if you load your dialog at the beginning of 
your program, it won't appear until you're ready. 

I 

In a manner somewhat similar to Wai t NextEvent ( ) , you con­
tinuously loop, calling Moda!Dialog () on each go-around, until 
dialogDone gets set to true . 

dialogDone = false ; 
while ( ! dialogDone 
{ 

ModalDialog{ nil, &itemHit ); 

switch ( itemHit 

case ok : 
case cancel : 

dialogDone = true ; 
break ; 

case kFirstRadio : 
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HandleRadio( kFirstRadio ) ; 
break ; 

case iThirdCheckBox : 

HandleRadio( iThi rdCheckBox ); 
break; 

DisposDialog ( dialog ); 
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Dialog items are either enabled or disabled. If an item is disabled, 
ModalDialog () will not report mouse clicks in the item. In general, 
clicking ICONs and PICTs in a dialog box has no special significance, so 
disable both of these types of items. 

When the user clicks in an enabled item, call a routine to handle 
the click. When the user clicks either the OK or Cancel button, the 
dialog loop exits and the dialog window is disposed. 

To change the state ofa control, call HiliteControl () : 

HiliteControl( ControlHandle theControl , short hiliteState ) ; 

To enable a control, call HiliteControl () with a hiliteState ofO. 
To disable the control, set hili teSta te to 254. 

Disabling a control gives the control a dimmed appearance. When 
you get to the program in this chapter, we'll call HiliteControl ( j 
to enable and disable the OK button in a dialog box. It's important t<i> 
discriminate between the state of a control (whether it is enabled or 
disabled) and the value of the control. 

-'" J J 
Static text and editable text fields are also usually disabled, 

although you may change them in response to other events. For 
example, a timer might display the time in minutes or seconds, 
depending on the value of a set of radio buttons (Figure 6.16). If the 
Seconds radio button is clicked, the static text field could read 
Seconds. If the Minutes radio button is clicked, the static text field 
could be changed to read Minutes. Use t he routines Get I Text () and 
Set I Text () to read and set the values of static text fields. 
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ITJ Seconds 

@Seconds 

0 Minutes 

OK 

--tt--i{ Static TeHt J 

Figure 6.16 Changing static text. 

ParamText () allows you to create a set of four default strings that 
can be substituted in your static text fields. To specify them, call 
ParamText () with four St r255s: 

ParamText( "\pPinkn , " \pBelshazzarn , 
" \pFuture hazy , try latern , " \pAltarian dog biscuits " ) ; 

From now on, whenever the strings "O, "1, "2, or "3 appear 
in a static text item, they will be replaced by the appropriate 
ParamText () parameter. Pa r amText () is used in Chapter 7's error­
handling routines. 

You can store ParamText () strings in your resource file as 
resources of type ' STR ' or inside a single ' STR# ' resource, then 
read the strings in with GetResource () or Get Stri ng () , and 
finally, pass them to ParamText () . If, during the course of running 
your program, you decide to change the values of your strings, you 
can write them back out to the resource file with 
Wr iteRe s ource () . This is a little tricky, but it gives you a great 
way to store program defaults. Look at Chapter 7's ResWriter 
project for an example on how that's done. 

l 

GetIText () and SetIText () can also be used to modify the 
contents of an editable text field. Here's an example: 

GetDitem( dialog , kTextField , &itemType, &itemHandle , 

&itemRect ) ; 
GetIText( itemHandle , myString) ; 

Set !Text ( i temHandle , " \pl have been replaced ! ! ! " ) ; 
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First, GetDitem () is called to retrieve a handle to the item with 
item number kTextField. Next, GetIText () uses that handle to 
retrieve the current string, storing it in the Str255 variable 
myString. Finally, a new text string is copied to the item. It's impor­
tant to note that you don't have to call GetIText () before you call 
SetIText (). 

The last three arguments to GetDitem () are placeholders. That is, 
they won't always be used, but you always need to provide a 
variable to receive the values returned. In the previous example, 
itemHandle was used, but itemType and itemRect were not. 

Like ICONS and PICTs, editable and static text items should be 
disabled so that mouse clicks are not reported. In the case of editable 
text fields, the dialog manager handles the mouse click for you. 

Now that you've got the scoop on dialogs, let's take a look at alerts. 

Working with Alerts 

Alerts are very much like dialogs: You build them using ResEdit, and 
they consist of a window and a dialog item list. However, alerts are 
self-contained and can be invoked with a single line of code. Whereas 
ModalDialog () is called repeatedly inside a loop, the alert procedures 
are called once. Each alert routine takes care of its own housekeeping. 

There are three standard types of alerts: note alerts, caution alerts, 
and stop alerts (Figure 6.17). Note alerts have an informative tone 
and are an easy way to tell the user something. Caution alerts tell 
the user that the next step taken should be considered carefully, as it 
may lead to unexpected results. Stop alerts indicate a critical situa­
tion, such as a fatal error, that must be brought to the user's attention. 

Each alert exists in stages. The first time an alert is presented, it is 
a stage 1 alert; the second time, a stage 2 alert; the third time, a stage 
3 alert; the fourth and subsequent times, a stage 4 alert. You can 
design your alerts so that stage 1 alerts are silent but stage 2, 3, and 4 
alerts beep when the alert is presented. You can also specify whether 
or not the alert is presented at different stages. 
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Another fine program from the 
Mac C Programming Primer! 
©1992, D. Mark & c. Reed!!! 

n OK Jl 

The computer has now 
checkmated you 38 times in a 
row. Perhaps you should 
take up backgammon ••. 

Ue.( ~G~ee!!!!!! ~)J 

Tri-Dimensional Desktop 
Professional Uersion 2.01 a 
requires 84 megabytes of 
RRM. Please purchase and 
install immediately. 

n Rargh!, 

Figure 6.17 Note, caution, and stop alerts. 

The Alert Algorithm 

Build your alert with ResEdit by creating an ALRT and a DITL 
resource. Unlike regular dialogs, the only type of control that belongs 
in an alert DI TL is a button. The alert algorithm is as follows: 

• Load and present the alert with a call to StopAlert (), 
NoteAlert (),or CautionAlert (). 

• Use the value returned from each of these functions to determine 
which item was hit (that is, which button was pressed). 

Adding Alerts to Your Program 

Unlike a dialog, an alert is implemented with a single call to the 
appropriate alert function. For example: 

itemHit = StopAlert( kAlertID, nil); 
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StopAlert (), NoteAlert () ,and CautionAlert () each take t he 
same parameters and return the same thing, a short indicating the 
number of the item clicked on to dismiss the alert. If the alert offered a 
choice of three buttons, for example, the return value would indicate 
which button was clicked. 

The first parameter to each of the three alert routines is the ALRT 
resource ID. The second parameter is an optional pointer to a filter 
procedure. Typically, you'll pass nil as the second parameter. 

When you go about making your own dialogs or alerts, you should 
be familiar with Apple's user interface guidelines, which contain 
specific suggestions for placing and nalliling (among other things) 
dialog items. Place dialog and alert elements as shown in Figure 
6.18. 

Disregard Apple's user 
interface guidelines at your 
peril! 

Cancel ) K OK Il 

Figure 6.18 Proper dialog item placement. 

In a properly 0esigned dialog, the OK button is in the lower right 
corner. If a Cancel button exists, place it to the left of the OK 
button. Everything you need to properly design a dialog or alert is ilil 
Inside Macintosh, Volume VI , Chapter 2. Pay special attention to 
Figure 2-20 on page 2-29. 

Though you'll find lots of dialogs and alerts that don't follow the 
guidelines, proceed at your own risk-the User Interface Police 
know where you live .... 

That's about it for alerts. Time to look at the next manager in this 
chapter: the Notification Manager. 
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The Notification Manager 

The Notification Manager contains calls that allow applications 
running in the background to communicate with the user. 

How the Notification Manager Works 

The Notification Manager alerts the user that an application running 
in the background requires the user's attention. There are five 
standard ways your application can signal the user: 

1. You can place a small diamond-shaped mark ( +) next to the 
notifying application's item in the current application menu. The 
current application menu is located on the far right of the menu bar 
(Figure 6.19). 

Hide Finder 
Hide Others 
Show HH 

~ Canuas™ 3.0 
../ ~ Finder 
~Microsoft Word 

·~Reminder 
[j} THINK C 5.0 
q;g, THINK Reference 

Figure 6.19 ( +) mark beside the notifying application. 

2. You can rotate the current application menu's icon with another 
icon. Figure 6.20 shows how a notification using a bell-shaped icon 
would look if THINK C was the current application. 

Figure 6.20 Rotating icons in the Notification Manager (THINK C is in the 
foreground). 
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I 
In System 6, applications are listed under the desk accessories in 
the s menu. Therefore, the(+) mark shows up under the s menu 
Also, notification icons rotate with the s icon, not the application 
icon. 

I 

3. You can play a system alert sound, or a sound from a ' snd 
resource. 

4.You can display an alert box with a short message. 
5.You can execute a response procedure of your own choosing. 

The PrintMonitor application that comes with the Mac's system 
software offers a good demonstration of these techniques. If the 
PrintMonitor encounters an error while trying to print a document, it 
notifies you using the Notification manager. 

If you don't use System 7, or System 6 with MultiFinder, the 
Notification Manager's functionalism will be limited, as you cannot 
run your application in the background. 

Using the Notification Manager 

To create a notification, you'll fill in a notification request data 
structure (we'll get to the data structure later in this section). Use the 
request to specify how the user should be notified, using some 
combination of the five mechanisms described above. 

Once the request is filled in, pass it to the Notification Manager by 
calling NMinstall () : 

OsErr NMinstall( QElemPtr nmReqPt r ) ; 

nmReqPtr is a pointer to your notification request. NMinstall () 
places your request on the notification queue. Once your request is 
in the notification queue, it becomes fair game for the Mac operating 
system (Mac OS). The Mac OS constantly scans the notification queue. 
Once it finds a request, it notifies the user in the manner indicated. 
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Once the user is notified, use NMRemove ( ) to remove the 
notification from the Notification queue: 

OsErr NMRemove ( QElemPtr nmReqPtr ); 

Before you call NMRemove ( ) , you must make a decision. Do you just 
want to pass a message on to the user, or do you want the user to 
bring your application to the foreground? 

To pass a message on to the user, create a notification with an alert 
containing your message. When you set up the notification data 
structure (described below), mark it as auto-removing. This tells the 
Notification Manager to automatically call NMRemove ( ) for you as 
soon as the notification completes. 

To ask the user to bring the notifying application to the foreground, 
use a rotating icon and a + mark in the application menu, in addition 
to any other mechanisms you'd like. In your application, you'll call 
NMRemove ( ) as soon as you receive a resume event. At this point, your 
application is in the foreground and can interact with the user. 

Both NMinstall () and NMRemove () make use of a QElemPtr, a 
pointer to a notification data structure. The next section details that 
structure. 

The Notification Manager Structure 

Each call to the Notification Manager makes use of the NMRec data 
structure: 

typdef struct NMRec 
{ 

QElemPtr qLink /* the next queue entry */ 
short qType /* queue type */ 

short nmFlags /* reserved */ 

long nmPrivate /* reserved */ 
short nmReserved /* reserved */ 
short nmMark /* Application ID to mark in 

S menu */ 
Handle nmicon /* handle to small icon */ 
Handle nmSound /* handle to sound record */ 
StringPtr nmStr /* string to appear in 

alert */ 

ProcPtr nmResp /* pointer to response 
routine */ 

long nmRefCon /* for application use */ 
NMRec; 
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Here's an explanation of the NMRec fields: 

• qLink, qType, nmFlags, nmPrivate, and nmReserved are either 
reserved or contain information about the notification queue; you 
won't adjust these values. 

• nrnMark: If nrnMark is 0, the ( •) will not be displayed in the 
application menu when the notification occurs; if nrnMark is 1, the 
application that is making the notifying call receives the mark. If 
you want a desk accessory to be marked, use the refnurn of the desk 
accessory. Drivers should pass 0. 

• nrnicon: If nmicon is nil, no icon is used; otherwise, a handle to 
the small icon (' SICN' resource) to be used should be placed h,ere. 
The handle does not need to be locked, but must be nonpurge~ble. 
Do this by making sure the 'SICN' resource's Purge able: check 
box is unchecked. 

• nmSound: if nmSound is O, no sound is played; -1 will result in the 
system sound being played. To play an 'snd ' sound resource, put 
a handle to the resource here. As with the small icon, the 'snd ' 
resource handle need not be locked, but it must be nonpurgeable. 

• nmS tr contains the pointer to the text string to be used in the alert 
box. Set nrnStr to nil for no alert box. Do not dispose of the strlng 
until the notification is removed. 

• nmResp is a pointer to a response procedure that gets called once 
the notification is complete M:24-9). If you set nmResp to -lL, the 
request is automatically removed from the notification queue once 
the notification is complete. 

You'll see the Notification Manager in action in the Reminder pro­
gram later in this chapter. For more information on the Notific~tion 
Manager, see Chapter 26 in Volume VI of Inside Macintosh. ' 

The Process Manager 

The Process Manager is responsible for keeping track of the applica­
tions (or processes) that are currently running. The part of the 

I 

Process Manager we're interested in is the LaunchApplication () 
routine, which lets you start up another application from within your 
own program. You'll see an example of this in Reminder, later in· this 
chapter. 

Here's the calling sequence for LaunchApplication (): 

Os Err LaunchApplication( LaunchPBPtr LaunchParams ); 
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LaunchApplication () describes a specific application to the 
Process Manager, which then launches it. LaunchParams is a pointer 
to a data structure of type LaunchParamBlockRec, which specifies 
the application to be launched: 

struct LaunchParamBlockRec 

unsigned long reservedl; /* reserved */ 

unsigned short reserved2; /* reserved */ 

unsigned short launchBlockID; /* extended 
block */ 

unsigned long launchEPBLength; /* length of 
block */ 

unsigned short launchFileFlags; /* Finder flags 
of 
application */ 

LaunchFlags launchControlFlags; /* launch option */ 

FSSpecPtr launchAppSpec; /* location of 
application *I 

ProcessSerialNumber launchProcessSN; /* returned psn */ 
unsigned long launchPreferredSize; /* launch preferred 

size */ 

unsigned long launchMinimumSize; /* launch minimum 
size */ 

unsigned long launchAvailableSize; /* launch available 
size */ 

AppParametersPtr launchAppParameters; /* high-level 
event */ 

} ; 

Here's an explanation of the LaunchParamBlockRec fields: 

• reservedl and nmPri vate are reserved by Apple; don't adjust 
these values. 

• launchBlockID and launchEPBLength: are used to describe 
the LaunchParamBlockRec structure to the Mac OS. Pass 
extendedBlock in launchBlockID, and extendedBlockLen in 
launchEPBLength for all notifications. 

• launchFileFlags: returns the Finder flags from the application 
you have selected. The Finder flags refer to information the Finder 
uses to categorize an application; they are the same flags you set in 
the EventTracker program in Chapter 4. You'll learn more about 
the Finder flags in Chapter 8. 

• launchControlFlags: you can specify how you want the appli­
cation launched by passing the appropriate value. The constants 
you can pass are: 
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en um 

} ; 

launchContinue = Ox4000, 
launchNoFileFlags = Ox0800, 
launchUseMinimum = Ox0400, 
launchDontSwitch = Ox0200, 
launchinhibitDaemon = Ox0080 

launchContinue should be set if you want your application to 
continue executing after launching the specified application. 
launchNoFileFlags should be used if you want to pass your own 
Finder flag information to the application to be launched, instead of 
using the launching application's Finder flags. launchUseMinimum 
will try to use the minimum memory size recommended by the 
application you're trying to launch. launchDontSwitch launches 
the application in the background. Finally, launchinhibitDa~mon 
should be set if you don't want to launch a background-only appli­
cation (like the Backgrounder application in your System Folder). 

• launchAppSpec tells LaunchApplication () the location of the 
application you are launching. It does that with a pointer to a struc­
ture of type FSSpec. For now, that's all you need to know about this 
structure; you'll learn more about the FSSpec structure in the 
OpenPICT program in Chapter 7. ' 

• launchProcessSN returns a unique serial number for the app,lica­
tion you are launching. You can use it to check the status of the 
application: for example, whether it's still running, or how much 
memory it's using. 

• launchPreferredSize and launchMinimumSize return the 
specified application's preferred and minimum memory require­
ments. 

• If there is not enough memory to launch the application, 
launchAvailableSize specifies how much memory is availab~e. 

• launchAppParameters allows you to specify the first high-level 
event sent to the launched application. If you pass nil, the 
standard kAEOpenApplication Apple event will be sent. 

The next section lists and describes Reminder, the biggest and most 
complex program in this book. Reminder will show you how to put 
together all the pieces we've talked about so far: dialogs, alerts, events, 
menus, the Notification Manager, and the Process Manager. 
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Reminder 

In this chapter, you looked at the Dialog Manager, the Notification 
Manager, and the Process Manager. Our next program, Reminder, 
combines dialogs, alerts, notifications, and application launching into 
a surprisingly powerful application. Reminder allows you to send 
messages to yourself at specific times. Each reminder consists of some 
combination of a text string, a sound, and a launched application. 
Reminder can keep track of multiple reminders, so you can send as 
many messages to yourself as you like. 

As you saw in WorldClock, Reminder supports the standard S, 
File, and Edit menus. The S menu is fully functional, giving you 
access to all the items you normally expect to see in the S menu. The 
File menu (Figure 6.21) contains three items: New Reminder, which 
allows you to create a new reminder, Stop Rem in de r, which allows 
you to cancel reminders by selecting them from the attached 
hierarchical menu, and Quit. 

New Reminder... XN 
Stop Reminder ., 

Quit XQ 

Figure 6.21 Reminder's File menu. 

Reminder's Edit menu contains the minimum standard set of Edit 
commands (Figure 6.22). 

Undo XZ 

Cut OOH 
Copy XC 
Paste XU 
Clear 

Figure 6.22 Reminder's Edit menu. 
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The Reminder Algorithm 

Reminder uses the same event-loop structure presented in the last few 
chapters. Here's how Reminder works: 

• Initialize the Toolbox. 
• Initialize Reminder's menus. 
• Enter the event loop, checking once a second to see if any reminders 

need to be displayed. 
• If a reminder's time has come up, put the reminder into the 

Notification Manager's queue. 

Resources 

Create a folder called Reminder inside your Development folder. 
Next, launch ResEdit and click the mouse to bring up the Open file 
dialog box. Click on the New button. When the New file dialog 'box 
appears, navigate into the Reminder folder and create a resource file 
nained Reminder. 7t. rsrc inside the Reminder folder. 

Creating the MBAR Resource 

Select Create New Resource from ResEdit's Resource menu. 
When prompted for a resource type, type MBAR, then click the: 0 K 
button. An MBAR editing window will appear. We'll need to add three 
menus to this menu bar, one for each menu title that appears inj the 
menu bar itself: S, file, and Edit. As you saw in WorldClock, I the 
hierarchical menu Reminder is not part of the MBAR resource. ' 

As you did in WorldClock, click on the row of asterisks (*) that 
appear in the MBAR window and select Insert New f ield(s) from the 
Resource menu to add each field. Add the three menu resource IDs 
shown in Figure 6.23 to the MBAR resource. 

Click on the close box of the MBAR editing window. Then click on the 
close box of the MBAR window. You should be back to the 
Reminder. 7t. rsrc window. 
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=o MBAR ID - 128 from Reminder: rr.rsrc 

c of menus J 

1) ***** 

Menu res ID I 128 

2) ***** 

Menu res ID I 129 

J) ***** 

Menu res ID I 1 JO 

4) ***** 

t-

Figure 6.23 Completed MBAR resource. 

Creating the MENU Resources 

Next, let's create the four MENU resources that Reminder uses. Select 
Create New Resource from ResEdit's Resource menu. When 
prompted for a resource type, enter MENU and click the OK button. A 
MENU editing window will appear, similar to the one in Figure 6.24. 
We'll start by editing the S MENU. 

MENU ID = 131 from Aeminder:rr.rsrc 

Entire Menu: 181 Enabled 

0 .S (Apple menu) 

Figure 6.24 A new MENU editing window. 

Color 

Title: I I 
Item TeHt Default: J I 
Menu Background: D 

Click on the S (Apple menu) radio button on the right side of the 
window. Notice that the title of the menu on the left side of the 
window changed to the s character. Now, hit the return key. The 
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editor will move on to the first item in this MENU. Notice that the field 
labeled Title: has changed to TeHt: . Click in the TeHt: field and type 
the text About Reminder .... 

Notice that the Enabled check box has been checked for you. This 
makes the item selectable. If the Enabled check box was not checked, 
the item would appear dimmed in the menu and would not be 
selectable. 

Hit the return key to move to the next item. Click on the 
(separator line) radio button to turn this second item into a 
separator line. Notice that the Enabled check box is not checked. This 
means that the separator will not be selectable. This is nor mal for 
separator lines. Leave the Enabled check box unchecked for this item. 
Your MENU should look like Figure 6.25. 

MENU "Apple" ID = 128 from Reminder.11.rsrc 

[!l.slAlblolultlRlelmlinldlelrl .. I. ···M I :::::·:~l-te_m_= _____ D_E_n_ab_1_ed~ 
I 
! 
i 
; 

® ........... (separator line) 

Color 

i D hos Submenu 
l 
l 
l 
i 

Tettt: I I 
Cmd-Key: 0 I I 

-0' I Mork: I None ...,. II I 

Figure 6.25 The completed S MENU. 

Next, select Get Resource Info from the Resource menu. Make 
sure the I 0: field says 128. Close the Resource Info window. Now 
select Edit Menu & MOH I 0 ... from the MENU menu. Make sure the 
Menu ID: field says 128 and the MOH ID: field says 0, then click the 
OK button. 

l 
It's critical to make sure that your MENU'S resource ID and the value 
in the Menu ID: field in the Edit Menu & MOH ID ... dialog box 
agree. Make sure you check this for each one of Reminder's MENU 

resources. 

l l 
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Close the MENU editing window. You should see the MENU picker win­
dow (the window listing each of the MENU resources in this file). Select 
Create New Resource from the Resource menu. A new MENU 

editing window will appear. Without clicking the mouse, type the word 
File. Notice that your text appears in the Title: field. Hit a return and 
type the words New Remind er ••• without hitting a return afterward. 

Click the mouse in the Cmd-Key: field and type the letter N. This 
tells the Menu Manager to associate the command-key sequence 3€N 
with this item. Hit a return and type the words Stop Reminder 
without hitting a return afterward. Click the mouse in the has 
Sub menu check box. Then, click the mouse in the ID: field that 
appears and type in the number 103. This tells the Menu Manager to 
associate MENU 103 with this item. When this item is selected, the 
MENU with resource ID 103 will appear as a hierarchical submenu. 

Hit a return again to enter the next menu item: just click in the 
(separator line) radio button to put a separator line in the third 
item. Hit return again and enter the word Quit; Click in the Cmd­
K e y field and type the letter Q. 

To try out this menu, click on the File menu on the right side of the 
menu bar. Compare your results with Figure 6.26. Notice the .. that 
appears to the right of the Stop Reminder item. 

New Reminder... 3€N 
Stop Reminder ~ 

Quit OOQ 

Figure 6.26 Testing the File menu in ResEdit. 

Finally, make sure the resource ID for this MENU is set to 129. 
Check this using both the Get Resource Info and the Edit Menu & 
MDEF ID ••• menu items. 

Close the MENU editing window. You should see the MENU picker 
window (this time it should show two MENUS). The next MENU 
resource you'll enter is the Edit menu resource. If you have already 
built the Edit MENU for Chapter 5's WorldClock project, open 
WorldClock. 7t. rsrc and copy MENU resource 130 into this project. 
Otherwise, just follow along for the next four paragraphs. 

Select Create New Resource from the Resource menu. A new 
MENU editing window will appear. Enter Edit in the Title: field. 

Hit a return and type the word Undo. Before you hit a return, type 
the letter Z in the Cmd-Key field. Hit a return and click on the 
(separator line) radio button. The Enabled check box should not be 
checked for this item. 
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Hit a return and type the word Cut. Type the letter Hin the Cmd­
Key field. Hit a return and type the word Copy. Type the letter C in 
the Cmd-Key field. Hit a return and type the word Paste. Type the 
letter U in the Cm d-K e y field. Hit one last return and type the word 
Clear. Clear doesn't have a command-key equivalent. 

To try out this menu, click on the Edit menu on the right side of the 
menu bar. Compare your results with Figure 6.27. 

Undo 3€2 

Cut 3€H 
Copy 3€C 
Paste 3€U 
Clear 

Figure 6.27 Testing the Edit menu in ResEdit. 

Make sure the resource ID for this MENU is set to 130. Check this 
with both the Get Resource Info and the Edit Menu & MDEF ID ... 
menu items. 

Close the MENU editing window. You should see the MENU picker 
window (this time it should show three MENUs). Select Create New 
Resource from the Resource menu. A new MENU editing window 
will appear. Enter Hours in the Title: field. 

Hit a return and type the word Hours. Then, enter the menu items 
as shown in Figure 6.28. 

MENU ID = 100 from Reminder. n .rsrc 

1 
2 
3 
4 
5 
6 
7 
8 
9 
10 
11 
12 

i 

o ! 
~--------~~ 1 

Entire Menu: 181 Enabled 

Title: @ l._H_o_u_rs _______ __.. 

0 s (Apple menu) 

Color 

Title: I I 
Item TeHt Default: l!!!!!I) 
Menu Background: D 

Figure 6.28 The Hours menu in ResEdit (elongated for clarity). 



290 Macintosh C Programming Primer 

To try out this menu, click on the Hours menu on the right side of 
the menu bar. Compare your results with Figure 6.29. 

Make sure the resource ID for the Hours MENU is set to 100. Check . 
this through both the Get Resource Info and the Edit Menu & 
MDEF ID ... menu items. 

Close the Hours MENU editing window. You should see the MENU 

picker window (this time it should show four MENUS) . Select Create 
New Resource from the Resource menu. A new MENU editing 
window will appear. Enter Minutes in the Title: field. 

Hit a return and type the word Minutes. Then add the items to the 
Minutes MENU as shown in Figure 6.30. 

To try out this menu, click on the Minutes menu on the right side 
of the menu bar. Compare your results with Figure 6.31. 

1 
2 
3 
4 
5 
6 
7 
8 
9 
10 
11 
12 

Figure 6.29 Testing the Hours menu in ResEdit. 

05 
10 
15 
20 
25 
30 
35 
40 
45 
50 
55 

MENU ID = 101 from Reminder. T1 .rsrc 

Ill 
!i!l!i 

Entire Menu: ~ Enabled 

0 s (Apple menu) 

Co lor 

Title: I I 
Item TeHt Default: I I 
Menu Background: D 

Figure 6.30 The Minutes menu in ResEdit (elongated for clarity). 
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00 
05 
to 
15 
20 
25 
30 
35 
40 
45 
50 
55 
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Figure 6.31 Testing the Minutes menu in ResEclit. 

Close the Minutes MENU editing window. You should see the MENU 
picker window (this time it should show five MENUs). Select Cr eate 
New Resource from the Resource menu. A new MENU editing 
window will appear. Enter RM/PM in the Title: field. 

Hit a return and type RM/PM. Then add the items to the RM/ PM 
MENU as shown in Figure 6.32. 

To try out this menu, click on the RM / PM menu on the right side of 
t he menu bar. Compare your results with Figure 6.33. 

MENU ID = 102 from Reminder.n.rsrc 

' 
IMlllR~MlilllfiL_~~~~~~0~1 

PM l 
! 

I 
! 
! 
I 
' i 
! 

o i 

Entire Menu: ~Enabled 

Title: @ ~1 ·~~ 
0 a (Apple menu) 

Color 

m1e: I I 
Item TeHt Defimlt: j I 
Menu Background: D 

Figure 6.32 The AM /PM menu in ResEdit (elongated for clarity). 
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Figure 6.33 Testing the RM/ PM menu in ResEdit. 

Close the MENU editing window. You should see the MENU picker 
window (this time it should show six MENUs). Select Create New 
Resource from the Resource menu. A new MENU editing window 
will appear. Enter Reminders in t he Title: field. 

Hit a return and type the word Reminders. The window should 
look like Figure 6.34. 

MENU ID = 1 03 from Reminder. Tl' .rs re 

I 
~------,-0~ i 

I 
I 

Entire Menu: [8J Enabled 

Title: @ fr.ii .P.i. !i!ii!ij~ 

0 s (Rpple menu) 

Color 

Title: I I 

J I tern TeHt Default: I I 
Menu Background: D 

Figure 6.34 The Reminders menu in ResEdit. 

You won't add any items to the Reminders MENU at this point. 
This menu will be used in Reminder to list all of the reminders 
currently in the queue. For this reason, the menu will have to be 
generated on the fly. 

Click on the Reminders menu on the right side of the menu bar. 
Compare your results with Figure 6.35. 

Make sure the resource ID for the Reminders MENU is set to 103. 
Select Get Resource Info from the Resource menu and Edit 
Menu & MOEF ID ... from the MENU menu. 

Close the Reminders MENU editing window. You should see the 
MENU picker window (this time it should show seven MENUs). Finally! 
You're done with MENUS! 
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Reminders 

Figure 6.35 Testing the Reminders menu in ResEdit. 

Creating Pop-up Menu CNTL Resources 

WorldClock featured a pop-up menu control that allowed you to find 
out the time in four different cities. This time you'll create three pop­
up menus that allow you to specify the exact time of a reminder in 
hours, minutes, and A.M./P.M. 

Back in ResEdit, close the MENU window and the MENU picker 
window, leaving only the window labeled Reminder . 7t. rsrc. Select 
Create New Resource from the Resource menu. Specify the 
resource type CNTL and click on the OK button. A CNTL editing window 
will appear. Fill in the CNTL fields exactly as specified in Figure 6.36. 

The BoundsRect field specifies the top, left, bottom, and right of 
the pop-up menu rectangle. This control does not have a title, so just 
leave the Ualue field, which specifies how the title should be drawn, 
at 0. The Uisible field determines whether the control is initially 
visible or hidden, just as it does in the WIND resource. The MaH field 
specifies the portion of the BoundsRect to be allocated to the pop-up 
title. As there is no title for this popup, MaH is set to 0 and the Title 
field should be left blank. For Min, enter the resource ID for the MENU 

to be used: 100. For ProclD, enter the proclD for a pop-up menu: 
1008. You won't be using the RefCon, so set it to 0. 

~o CNTL ID 128 from Reminder. n .rsrc 

BoundsRect 113 1159 1~1109 llliD ~ 

IJalue lo 
IJisible @True O False 

Max lo 

Min I 100 
ProclO I rooB 

Ref Con lo 
Title [I J 

Figure 6.36 Specifications for the Hours pop-up CNTL. 
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Finally, select Get Resource Info from the Resource menu and 
set the CNTL's resource ID to 128. When you're done, close the resource 
info window and the CNTL editing window. Two more CNTLs to go! 

Select Create New Resource from the Resource menu again. 
Specify the r esource type CNTL and click on the OK button. Another 
CNTL editing window will appear. Fill in the CNTL fields exactly as 
specified in Figure 6.37. Next, set the CNTL's resource ID to 129. Close 
the CNTL windows. 

=o CNTL ID - 129 from Reminder. T1 .rsrc 

BoundsRect 11 3 IEJl 33 l~lliD ~ 

Uolue lo I 
Ui s ible @True 0 False 

Mox 0 
Min 101 
ProclO 1008 
Ref Con 0 
Ti tie l J 

Figure 6.37 Specifications for the Minutes pop-up CNTL . 

Select Create New Resource from the Resource menu one 
more time. Specify the resource type CNTL and click on the OK button. 
The final CNTL editing window will appear. Fill in the CNTL fields as 
shown in Figure 6.38. Next, set the CNTL's resource ID to 130. 

Close the CNTL window and the CNTL picker window, leaving only 
the window labeled Reminder . 7t. rsrc . 
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=o CNTL ID - 1 30 from Reminder. n .rsrc 

BoundsRect @=] §:=J ~ ~ lli!J 
Va lue lo I 
Vis ible 

Ma x 

Min 

Proc lO 

Ref Con 

Title l 

® True O False 

0 

102 

1008 

0 

J 

Figure 6.38 Specifications for the RM / PM pop-up CNTL. 

Creating a DITL Resource 

295 

The next resources you'll create are the DITL resources that define 
dialog items for dialogs. Select Create New Resource from the 
Resource menu. When prompted for a resource type, enter DITL and 
click the OK button. The DITL editing window that appears should 
look something like Figure 6.39. 

s File Edit Resource Window DITL Alignment 

Reminder. n .rsrc J 
Ii' ':'F.'1] _[]CE J ~11 
ll Dills from Reminder.n.r 

10 :::o~ o ITL ID 128 from Reminder. n .rsn 
·1====1==--------------==11 8 Button 

[ [8:1 Check Box 

@ Radio Button 
q § Co ntrol 

T: Stetic Text 

.__ ________ .....,.. ______ _._l:IgLE.~:;.t:!.~~:~::::::·~ 

& Icon 
··············· ·······-········"·········· 

H 
I. Pictu re 

l]J User Item 

Figure 6.39 DITL editing window. 
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The DITL editor is a bit different from other ResEdit editors you've 
seen before. To create a new dialog item, you'll use the dialog item tool 
palette that appears to the right of your blank DITL. The first DITL 
you'll build contains the items that make up the About box for 
Reminder. Let's start by putting an OK button at the bottom of the 
DITL. To do this, click on the Button tool in the tool palette, dragging 
a new button into the DITL window (Figure 6.40). 

[81 Check Box 

@ Radio Button 

(;] Control 

T: Static Text 

:Ia~:~~~:t::!.~:~~~:::::::: 
& Icon 

la Picture 

lillfil User Item 

Figure 6.40 Putting a button into the DI TL. 

When you release the mouse button, the button dimensions are 
displayed as a moving marquee (sometimes known as the "marching 
ants"). To name and accurately locate the button, double-click on it. 
The Edit DITL item #1 window will appear. Enter OK in the TeHt: 
field and the correct dimensions of the button as shown in Figure 6.41. 
If the Height and Width fields don't appear, select Show Height & 
Width from the Item menu. 

~i§O Edit Dill i tem #1 from Reminder: rr.rsrc 

TeHt: 

Button ,.. I 

[81 Enabled Top: l._7_3 _ __, 

Left: 1223 

Figure 6.41 Putting a button into the DITL. 

Height: ~I 2_0_~ 

Width: l._6_0 _ __, 
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Click in the close box to close the Edit DI TL item U window. 
Next, add a static text item to your DITL by dragging it from the 
Static TeHt tool in the palette window to the middle of the DITL 
window, as shown in Figure 6.42. 

Il o Ill 1 o = 128 from Reminder. TI' .rsn = mmiimm;;:iiii:::::gg;;m:;;;;:m 
8 Button 

[8J Check Box 

@ Radio Button 

!;) Control ............................................ 
T: Static Text OK 

..._ ______________ ..... _l::n.:::r.~~:~::!.~:~~::::::::: 
& Icon 

I .. Picture 

EillJ User Item 

Figure 6.42 Adding a static text item to the DITL. 

As you did with the OK button, double-click in the Static Te Ht item 
to set up its size and text, as shown in Figure 6.43. 

Edit Dill item #2 from Reminder.n.rsrc 

Te Kt: 

Static TeHt ,.. I 

D Enabled 

Rnother fine program from the Mac c 
Programming Primer! ©1992, D. Mark 
& C. Reed!!!I 

Top: ._I 1 _ ___, 

Left: ~17_3_~ 

Height:J ._ 4_8 _ _, 

Width: 1210 

Figure 6.48 Specifications for the static text item. 

Close the Edit DITL item #2 window by clicking in the close box. 
If you entered the information correctly, your DITL should look like 
Figure 6.44. If the DITL window isn't quite the same shape as the one 
shown in Figure 6.44, don't worry. If you like, grab the small grow box 
in the bottom right corner, stretching the DI TL window to a more 
workable size. Remember, the dialog and alert window information is 
provided by the DLOG and ALRT resources, not by the DITL. 
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,.cg Dill "Rbout" ID = 128 from Remind§§ 

Rnother fine program from thl1! 
Mac C Programming Primer! 
©1992, D. Mark & c. Reed! 11 

Figure 6.44 Your first DITL. 

OK Lg __. 

Finally, select Get Resource Info from the Resource menu and 
set the DITL's resource ID to 128 and its name to About . When you're 
done, close the resource info and DITL editing windows, leaving only 
the DITL picker window. 

Now that you've done the About box DITL, let's do the DI TL that is 
shown when you want to create a new reminder. Select Create New 
Resource from the Resource menu. The next DITL editing window 
will appear. This DITL will consist of 12 items. The first one is the OK 
button: Drag a button from the button tool, then double-click on it to 
set it to the specifications in Figure 6.45. 

§0 Edit Dill item #1 from Reminder:rr.rsrc 

TeHt: I' 
Button .,.. I . 

~-------------~ 

~Enabled Top: 1198 

Left: I 159 

Figure 6.45 OK button specifications. 

Height: I 20 
~-~ 

Width: 160 
~-~ 

The next item is the Cancel button: Drag a button from the button 
tool, then double-click on it to set it to the specifications in Figure 6.46. 
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Edit D ITL item #2 from Reminder. 11 .rs re 

Te Ht: 

Button ..., I 

18! Enabled Top: 1~1-98_~ 

Left: .__I a_6 _ __. 

Figure 6.46 Cancel button specifications. 

Height: ~I 2_0_~ 

Width: .__16_0 _ __, 
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Next, some static text: Drag a field from the static text tool, then 
double-click on it to set it to the specifications in Figure 6.47. 

§0 Edit DITL item #3 from Reminder.n.rsrc 

Te Ht: 

Static TeHt ..., I 

D Enabled Top:I .__ 1_6 _ __, 

Left:!.__ 1_3 _ __, 

Figure 6.47 DITL item #3. 

Height:!.__ 1_4 _ __. 

Width: .__I 4_2 _ __, 

Now to place the three pop-up menu controls that we created 
earlier. Drag a Control item from the tool palette, then double-click on 
it and set to the specifications in Figure 6.48. 

§0 Edit DITL item #4 from Reminder.Tr.rsrc 

Resource ID: 

Control ..., I 

18! Enabled Top: .__I 1_3 _ __, 

Left: .__I 6_o _ __. 

Figure 6.48 DITL item #4, the first popup. 

Height: 20 

Width: 50 
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Drag another Control item from the tool palette, then double-click 
on it and set it to the specifications in Figure 6.49. 

§0 Edit Dill item #5 from Reminder.TJ.rsrc 

Resource ID: 

Control Tl 

181 Enobled Top: 1~1_3_~ 

Left: ~I 1_1 _1 ~ 

Figure 6.49 DITL item #5, the second popup. 

Height: 20 

Width: 50 

Drag a third Control item from the tool palette, then double-click on 
it and set it to the specifications in Figure 6.50. 

§0 Edi t Dill item #6 from Reminder.TJ.rsrc 

Resource ID: 

Control ...,.I 

181 Enobled Top: ._I 1_3 _ __.. 

Left: 1~1_62_~ 

Figure 6.50 DITL item #6, the third popup. 

Height: 20 

Width: 54 

Another static text item: Drag a Static Text field from the tool 
palette, then double-click on it and set it to the specifications in Figure 
6.51. 

An editable text item: Drag an Edit Text field from the tool palette, 
then double-click on it and set it to the specifications in Figure 6.52. 

Now for the check boxes: Drag a check box onto your window and 
set it to the specifications in Figure 6.53. 
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g0 Edit DITL item #7 from Reminder.n .rsrc 

Te Kt : 

Static TeKt ... I 

0 Enabled Top: ._I 4_a _ _. 

Left: ._I 1_3 _ _. 

Figure 6.51 DITL item #7. 

Height: ~I 1_a_~ 

Width: ._I 6_4 _ _. 

g0 Edit DITL item #8 from Reminder.n.rsrc 

TeKt: 

Edi t TeKt ... 1 

0 Enabled 

Sample reminder 

Top: ._l6_a _ _. 

Left: ._I 1_3 _ _. 

Figure 6.52 DITL item #8. 

Height: ._I 4_4 _ _. 

Width: 1200 

g0 Edit DITL item #9 from Reminder.n.rsrc 

TeKt: Play Sound 

Check BoH ... I 

181 Enabled Top: I 126 
~-~ 

Left: ~11_3_~ 

Figure 6.53 DITL item #9, the first check box. 

Height: ~I 1_a_~ 

Width: ~19_3_~ 
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Ditto for the next two check boxes in Figures 6.54 and 6.55. 

§0 Edit DITL item # IO from Reminder: rr.rsrc 

Te Ht: 

Check BOH ... 1 

[8] Enabled 

Rotate I con 

Top: I 145 

Left : ._I 1_3 _ _. 

Figure 6.54 DITL item #10. 

Height: ._I 1_a _ _. 

Width: L--19_9 _ _, 

§0 Edit DITL item # 11 from Reminder: rr.rsrc 

Te Ht: 

Check BoH ,.. I 

[81 Enabled Top: 1164 

Left: l.._1_3 _ _, 

Figure 6.55 DITL item #11. 

Height: ._I 1_a _ _, 

Width: l.._7_3 _ _, 

Now for the dialog item you've all been waiting for: the last one! 
Drag a Static Text field from t he tool palette and set it to the 
specifications in Figure 6.56. 

§0 Edit DITL item # 12 from Reminder.Tl.rsrc 

TeHt: 

Static TeHt ,.. I 

[8] Enabl ed Top: i 165 

Left: ._I B_6_-' 

Height: L--11_6 _ _, 

Width: I 129 

F igure 6.56 DITL item #12 (The last DITL item-whew!). 
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Your o I TL and Figure 6.57 should look pretty much the same. If the 
pop-up menus didn't show up, check your CNTL resources and make 
sure they were input correctly. If any element seems out of place, you 
probably just dropped a digit; double-click on the recalcitrant element 
and check your figures. 

§0§ D Ill "New Reminder" ID • ~ 

~I 1 '§JI oo"@! AM§ 

!Messa gm_ 
remple reminder j 
ID Play Soulizj 
ID Rotate I CL@ 
(0 Launill)<None Selected> L!zj 

[ Cancelaj ( OK LY 
::. 

Figure 6.57 The Reminder DI TL. 

Finally, select Get Resource Info from the Resource menu and 
set the DITL's resource ID to 129 and its name to New Reminder. 
When you're done, close the resource info and DITL editing windows, 
leaving only the window labeled Reminder. 7t. rsrc. 

That's it for DITLs, but you still have a few more resources to set 
up. If you're feeling that ResEdit spelled backward looks like Satan, 
perhaps you should take a short break before continuing. Whether you 
stop at this point or not, select Saue from the File menu in ResEdit to 
save all the work you just did. 

At this point, you've created two DI TLs, seven MENUs, one MBAR and 
three CNTLs: doughty work from doughty coders. Let's forge ahead and 
add the resources that the DITLs are created for: the ALRT and DLOG 
resources. 

Creating an ALRT Resource 

The next resource you'll create is the ALRT resource, which acts as a 
template for alerts, much like WIND resources do for windows. Select 
Create New Resource from the Resource menu. When prompted 
for a resource type, enter ALRT and click the OK button. An ALRT 
editing window will appear. Use the ALRT specifications in Figure 6.58 
to customize your ALRT. Make sure you enter 128 in the D ITL ID: field. 
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This links this ALRT with the items in DITL 128 which you created 
earlier. 

Top: jiu I Height: ~ 

Left:~ Width:~ 

Figure 6.58 A new ALRT resource. 

Color: ® Default 
0 Custom 

Dill ID: J._1_2_a _ _, 

Select Get Resource Info from the Resource menu and set the 
ALRT's resource ID to 128 and its name to Rbout. Close the 
Resource Info window. 

To preview the alert, select the Preuiew at Full Size menu item 
in the RLRT menu. You should see the alert window as shown in 
Figure 6.59. As you've probably noticed, the alert icon didn't appear 
and the bold rounded rectangle never appeared around the OK button. 
The alert icon is filled in automatically by whichever routine you call 
to bring up the alert. A different icon will be drawn, depending on 
whether the alert is a note, caution, or stop alert. The ring around the 
OK button is drawn automatically by the Dialog Manager as soon as 
the alert is drawn on the screen. Click anywhere on the screen to 
dismiss the preview window. 

Another fine program from the 
Mac C Programming Primer! 
©1992, D. Mark & C. Reed!!! 

OK 

Figure 6.59 Preview of the Rbout Reminder ..• alert. 
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One more thing to do before you finish the alert. System 7 allows 
you to automate the placement of all windows, including those created 
for dialogs and alerts. To use this feature, select Auto Position •.. 
from the ALRT menu. When the Auto Position ••• dialog box appears, 
use the pop-up menus to select Alert Position on the Main Scr,en, 
as shown in Figure 6.60. When Reminder brings up this alert, it. will 
automatically be placed in the appropriate position on the screen. 

Automatically Position the Window 
(Works only with System 7 .0 or later.) 

Alert Position .,.. I On Main Screen 

Cancel n OK D 

Figure 6.60 Auto-positioning your alert. 

..-1 

Click 0 K to dismiss the Auto Position... window. Then close the 
ALRT edit window and the ALRT picker window. Time to build. the 
DLOG resource. 

Creating a DLOG Resource 

The next resource you'll create is the D LOG resource, which acts as a 
template for the dialog window. All ALRT windows should be closed at 
this point, leaving only the window labeled Renlinder. 7t. rsrc. Select 
Create New Resource from the Resource menu. When prompted 
for a resource type, enter DLOG and click the OK button. A DLOG 
editing window will appear. Before you do anything else, enter 129 in 
the D Ill ID: field. This links the DLOG to the proper DITL. If you 
didn't do this, the DLOG would display the About alert's DITL. Use the 
DLOG specifications in Figure 6.61 to complete your DLOG. Make sure 
you select the eighth icon from the left in the DLOG editor's top row. 
This selects the standard dialog window type. 
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![0 DLOG "New Reminder" ID ; 129 from Reminder:rr .rs re 

Top: llu I Height: ~ 

Left:~ Width:~ 

Figure 6.61 A new DLOG resource. 

Color: ® Default 
O Custom 

Dill ID: 1~1_29_~ 

O Initially uisible 

O Close boH 

Select Get Resource Info from the Resource menu and set the 
DLOG's resource ID to 129 and its name to New Reminder. Close the 
Resource Info window. 

To preview the dialog, select the Preuiew at Full Size menu item 
in the DLOG menu. You should see the alert window as shown in 
Figure 6.62. This time, the ring around the OK button gets drawn at 
run-time, once we call SetDi alogDefaultitern (). Click anywhere 
on the screen to dismiss the preview window. 

When: ._I __ T ..... l._I _o_O_T ..... 11,._R_M_T_,I 

Message: 

I Sample reminder 

0 Play Sound 
O Rotate Icon 

O Launch: <None Selected> 

[ Cancel ) OK 

Figure 6.62 Preview of the New Reminder DLOG. 
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One more thing to do before you finish the DLOG. Just as you did 
with the alert, select Ruto Position ... from the DLOG menu. When 
the Ruto Position ... dialog box appears, use the pop-up menus to 
select Center on the Main Screen, as shown in Figure 6.63. When 
Reminder brings up this alert, it will automatically be placed in the 
appropriate position on the screen. 

Rutomatically Position the Window 
(Works only with System 7 .o or later.) 

.__c_e_n_t_e_r _______ ...,.~lon Main Screen 

Cancel n OK 

Figure 6.63 Auto-positioning your dialog. 

Click OK to dismiss the Ruto Position ... window. Then close! the 
DLOG edit window and the DLOG picker window. One more resource to 
go! 

Creating a SICN Resource 

The final (honest) resource you need for the Reminder project is a 
SICN, or small icon resource. This is the icon that will be rotated with 
the Rpplication menu when your notification occurs. Starting with 
the window labeled Reminder .1t. rsrc, select Create New 
Resource from the Resource menu. When prompted for a resource 
type, enter SICN and click the OK button. The SICN editing window 
that appears should look like Figure 6.64. 

As you can see, the s I CN editor is rather like a simple black and 
white paint program. On the left, you have some standard paint tdols. 
In the upper right, your s I CN is displayed as it will appear on ·.the 
desktop. The icon we built for Reminder is shown in Figure 6.65. Use 
it, or create another masterpiece. 
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Figure 6.64 SICN editing window . 

•• • •• • • • •• • • • • • • • • • • • • •• • • • • • • • • • • • • •••••••••••• • • •••••••••••• 
·==· 

Figure 6.65 The Reminder SICN. 
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When you're done with the SICN, select Get Resource Info ••. in 
the Resource menu and make sure the resource ID is set to 128. 
Close the s I CN editing window and the s I CN picker window. 

Your resource file should consist of three CNTLs, one MBAR, seven 
MENUs, one ALRT, one DLOG, and one SICN. Congratulations on 
surviving the Reminder resource death march! Select Quit from the 
File menu and save your changes: It's time to code! 

Setting Up the Project 

Launch THINK C and create a new project named Reminder . 7t in 
the Reminder folder, where you created your resource file. Add 
MacTraps to the project. Next, create a new source code file, save it as 
Reminder. c, and add it to the project. 
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Here's the source code for Reminder. c: 

#include <Notification.h> 
#include <Processes.h> 
#include <Aliases.h> 

#define kBaseResID 128 
#define kMoveToFront (WindowPtr)-lL 
#define kSleep 3600L 
#define kLeaveWhereitis false 
#define kUseDefaultProc (void *) -lL 

#define kNotANormalMenu -1 

#define mApple kBaseResID 
#define iAbout 1 

#define mFile kBaseResID+l 
#define iSetReminder 1 

#define iCancelReminder 2 
#define iQuit 4 

#define mHours 100 
#define mMinutes 101 
#define mAMorPM 102 
#define mReminders 103 

#define kDialogResID kBaseResID+l 

#define iHoursPopup 4 

#define iMinutesPopup 5 
#define iAMorPMPopup 6 

#define iMessageText 8 

#define iSoundCheckBox 9 

#define iRotateCheckBox 10 
#define iLaunchCheckBox 11 

#define iAppNameText 12 

#define kOn 1 
#define kOff 0 

#define kMarkApp 1 
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#define kAM 
#define kPM 
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1 

2 

#define kMinTextPosition 0 

32767 #define kMaxTextPosition 

#define kDisableButton 255 
0 #define kEnableButton 

typedef struct 
{ 

QElem 

NMRec 
FSSpec 
short 
short 
Boolean 
Str255 
Str255 
short 
Boolean 
Boolean 
ReminderRec, 

/***************/ 
/* Functions */ 
/***************/ 

void 
void 
void 
void 
void 
void 
void 
void 
void 

ReminderPtr 

void 

queue; 
notify; 
file; 
hour; 
minute; 
launch; 
alert; 
menuString; 
menu Item; 
dispose; 
wasPosted; 
*ReminderPtr; 

ToolBoxinit( void); 
MenuBarinit( void); 
EventLoop( void); 
DoEvent( EventRecord *eventPtr ); 
HandleNull( void); 
HandleMouseDown( EventRecord *eventPtr ); 
HandleMenuChoice( long menuChoice ); 
HandleAppleChoice( short item); 
HandleFileChoice( short item); 

HandleDialog( void); 

GetFileName( StandardFileReply *replyPtr ); 
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pascal 

pascal 

void 

void 
void 

reminder); 

ReminderPtr 
ReminderPtr 
ReminderPtr 
notifyPtr ); 

ReminderPtr 

ReminderPtr 
minute); 

ReminderPtr 

void 
short 
void 

void 

void 
void 

void 

void 
ReminderPtr 

void 

811 

LaunchResponse( NMRecPtr notifyPtr ); 
NormalResponse( NMRecPtr notifyPtr ); 

CopyDialogToReminder( DialogPtr dialog, 

ReminderPtr 

GetFirstReminder( void); 

GetNextReminder{ ReminderPtr reminder); 
GetReminderFromNotification{ NMRecPtr 

FindReminderOnMenu( short menu!tem ); 
FindReminderToPost{ short hour, short 

FindReminderToDispose( void); 

SetupReminderMenu( void); 
CountRemindersOnMenu( void); 
RenumberTrailingRerninders( ReminderPtr 

reminder); 

InsertReminderintoMenu( ReminderPtr 

reminder); 
ScheduleReminder( RerninderPtr reminder); 
PostReminder( RerninderPtr reminder); 

DeleteReminderFromMenu( ReminderPtr 
reminder ) ; 

DeleteReminder( ReminderPtr reminder); 
DisposeReminder( ReminderPtr reminder:); 

I 

ConcatString( Str255 strl, Str255 str2); 

/* see tech note 304 */ 
pascal OSErr SetDialogDefaultitem(DialogPtr theDialog, 

short new!tem) 
= { Ox303C, Ox0304, OxAA68 }; 

pascal OSErr SetDialogCancelitem(DialogPtr theDialog, 
short new!tem) 

= { Ox303C, Ox0305, OxAA68 }; 
pascal OSErr SetDialogTracksCursor(DialogPtr theDialog, 
Boolean tracks) 

= { Ox303C, Ox0306, OxAA68 }; 



312 

/*************/ 
/* Globals */ 
/*************/ 

Boolean 
QHdr 

gDone; 
gReminderQueue; 
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/******************************** main *********/ 

void main( void 

ToolBoxinit(); 
MenuBarinit(); 

EventLoop(); 

/*********************************** ToolBoxinit */ 

void ToolBox!nit( void) 

InitGraf( &qd.thePort ); 
Ini tFonts () ; 
InitWindows (); 
Ini tMenus () ; 
TE!nit (); 
InitDialogs( nil); 
InitCursor (); 

/*********************************** MenuBarinit */ 

void MenuBarinit( void 

Handle 
MenuHandle 

menuBar; 
menu; 

menuBar = GetNewMBar( kBaseResID ); 
if ( menuBar == nil ) 
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SysBeep( 20 ); 
ExitToShell (); 

SetMenuBar( menuBar ); 

menu= GetMenu( mReminders ); 
InsertMenu( menu, kNotANormalMenu ); 

menu= GetMHandle( mApple ); 
AddResMenu( menu, 'DRVR' ); 

DrawMenuBar(); 

/*********************************** EventLoop */ 

void EventLoop( void ) 

EventRecord event; 

gDone false; 

while ( gDone == false ) 
{ 

if ( WaitNextEvent( everyEvent, &event, 
GetCaretTime(), nil) ) 

DoEvent( &event ); 
else 

HandleNull(); 

/*********************************** DoEvent */ 

void DoEvent( EventRecord *eventPtr) 

char theChar; 

switch ( eventPtr->what 

313 
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case mouseDown: 

HandleMouseDown( eventPtr ); 

break; 

case keyDown: 

case autoKey: 

theChar = eventPtr->message & charCodeMask; 
if ( (eventPtr->modifiers & cmdKey) != 0 ) 

HandleMenuChoice( MenuKey( theChar) ); 
break; 

/****************** HandleNull **********************/ 

void HandleNull( void ) 

unsigned long 

DateTimeRec 

ReminderPtr 

time; 

dateTime; 

theReminder; 

GetDateTime( &time); 

Secs2Date( time, &dateTime ); 

theReminder = FindReminderToPost( dateTime.hour, 

dateTime.minute ); 
while ( theReminder ) 

PostReminder( theReminder ); 

DeleteReminderFromMenu( theReminder ); 

theReminder = FindReminderToPost ( dateTime.hour, 

dateTime.minute ); 

theReminder = FindReminderToDispose(); 
while ( theReminder ) 

DisposeReminder( theReminder ); 

theReminder = FindReminderToDispose (); 
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/****************** HandleMouseDown *******************/ 

void HandleMouseDown( EventRecord *eventPtr ) 

WindowPtr 
short 
long 

window; 
thePart; 
menuChoice; 

thePart FindWindow( eventPtr->where, &window ) ; 
switch ( thePart ) 
{ 

case inMenuBar: 
SetupReminderMenu(); 
menuChoice = MenuSelect( eventPtr->where ); 
HandleMenuChoice( menuChoice ); 
break; 

case inSysWindow: 
SystemClick( eventPtr, window); 
break; 

/****************** SetupReminderMenu *******************/ 

void SetupReminderMenu( void ) 

MenuHandle f ileMenu; 
short items; 

fileMenu GetMenu( mFile ); 
items= CountRernindersOnMenu(); 
if ( items ) Enableitem( fileMenu, iCancelReminderJ,; 
else Disableitern( fileMenu, iCancelRerninder); 

/****************** HandleMenuChoice *******************/ 

void HandleMenuChoice( long rnenuChoice ) 
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short menu; 
short item; 
ReminderPtr reminder; 

if ( menuChoice != 0 ) 

menu HiWord( menuChoice ); 
item LoWord( menuChoice ); 

switch menu ) 

case mApple: 
HandleAppleChoice( item); 
break; 

case mFile: 
HandleFileChoice( item); 
break; 

case mReminders: 
reminder= FindReminderOnMenu( item); 
if ( reminder ) 

DeleteReminder( reminder); 
break; 

HiliteMenu ( 0 ) ; 

/****************** HandleAppleChoice *******************/ 

void HandleAppleChoice( short item ) 

MenuHandle 
Str255 
short 

appleMenu; 
accName; 
accNumber; 

switch item ) 

case iAbout: 
NoteAlert( kBaseResID, nil); 
break; 

default: 
appleMenu = GetMHandle( mApple ); 
Get!tem( appleMenu, item, accName ); 
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accNumber 
break; 
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OpenDeskAcc( accName ); 

/****************** HandleFileChoice *******************/ 

void HandleFileChoice( short item ) 

ReminderPtr reminder; 

switch ( item ) 
{ 

case iSetReminder: 
reminder= HandleDialog(); 
if ( reminder ) 

ScheduleReminder( reminder); 
break; 

case iQuit : 
gDone = true; 
break; 

/****************** GetFirstReminder ********************/ 

ReminderPtr GetFirstReminder( void ) 

return( (ReminderPtr)gReminderQueue.qHead ); 

/******************* GetNextReminder ********************/ 

ReminderPtr GetNextReminder( ReminderPtr reminder 

return( (ReminderPtr)reminder->queue.qLink ); 
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/****************** FindReminderOnMenu ******************/ 

ReminderPtr FindReminderOnMenu( short menuitem ) 

ReminderPtr theReminder; 

theReminder = GetFirstReminder(); 

while ( theReminder ) 
{ 

if ( theReminder->menuitem == menu!tem ) 

break; 

theReminder = GetNextReminder( theReminder); 

return( theReminder ); 

/***************** FindReminderToPost *******************/ 

ReminderPtr FindReminderToPost( short hour, short minute ) 

ReminderPtr theReminder; 

theReminder = GetFirstReminder(); 
while ( theReminder ) 

if ( (!theReminder->wasPosted) 

&& (theReminder->hour <= hour) 

&& (theReminder->minute <= minute) 

break; 

theReminder = GetNextReminder (theReminder); 

return( theReminder ); 

/***************** FindReminderToDispose ****************/ 

RerninderPtr FindReminderToDispose( void 
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ReminderPtr theReminder; 

theReminder = GetFirstReminder (); 
while ( theReminder ) 
{ 

if { theReminder->dispose 
break; 

theReminder = GetNextReminder (theReminder); 

return( theReminder ); 

/***************** InsertReminderintoMenu ***************/ 

void InsertReminderlntoMenu( ReminderPtr reminder ) 

short 
MenuHandle 

reminderMenu 

itemBefore; 
reminderMenu; 

GetMenu( mReminders ); 

itemBefore = CountRemindersOnMenu(); 

InsMenuitem( reminderMenu, reminder->menuString, 
itemBefore ); 

reminder->menuitem itemBefore + 1; 

/******************* CountRemindersOnMenu *************~*/ 

short CountRemindersOnMenu( void ) 

MenuHandle reminderMenu; 

reminderMenu = GetMenu( mReminders ); 

return( CountMitems( reminderMenu) ); 
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/******************* DeleteReminderFromMenu *************/ 

voidDeleteReminderFromMenu( ReminderPtr reminder ) 

MenuHandle reminderMenu; 

reminderMenu = GetMenu( mReminders ); 
RenumberTrailingReminders( reminder); 
DelMenuitem( reminderMenu, reminder->menuitem ); 
reminder->menuitem = 0; 

/***************** RenumberTrailingReminders ************/ 

void RenumberTrailingReminders( ReminderPtr reminder ) 

short count; 

count reminder->menuitem; 
reminder= GetNextReminder( reminder); 
while ( reminder ) 
{ 

if (reminder->menuitem != 0) 
reminder->menultem = count++; 

reminder= GetNextReminder( reminder); 

/****************** ScheduleReminder ********************/ 

void ScheduleReminder( ReminderPtr reminder 

Enqueue( &reminder->queue, &gReminderQueue ); 
InsertReminderintoMenu( reminder); 
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/****************** PostReminder ************************/ 

void PostReminder( ReminderPtr reminder ) 

reminder->notify.nmRefCon = (long)reminder; 
reminder->wasPosted = true; 
NMinstall( &reminder->notify ); 

/****************** DeleteReminder **********************/ 
i 

void DeleteReminder( ReminderPtr reminder ) 

if ( reminder->menuitem ) 
DeleteReminderFromMenu( reminder); 

reminder->dispose = true; 

/*************** DisposeReminder ************************/ 

ReminderPtr DisposeReminder ( ReminderPtr reminder ) 

ReminderPtr next; 

if (reminder->menuitem) 
DeleteReminderFromMenu( reminder); 

next= (ReminderPtr)reminder->queue.qLink; 
Dequeue( &reminder->queue, &gReminderQueue ); 
DisposePtr( (Ptr)reminder ); 
return( next); 

/******************************** GetFileName 

void GetFileName( StandardFileReply *replyPtr 

SFTypeList 
short 

typeList; 
numTypes; 

*******/ 
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typeList[ 0 ] 
numTypes = 1; 

I APPL I; 

StandardGetFile( nil, numTypes, typeList, replyPtr ); 

/******************************** HandleDialog *********/ 

ReminderPtr HandleDialog( void ) 
{ 

DialogPtr 
Boolean 
short 
Handle 
Handle 
Handle 
Handle 
Re ct 
Str255 
StandardFileReply 
ReminderPtr 

dialog = GetNewDialog( 

ShowWindow( dialog); 
SetPort( dialog); 

dialog; 
dialogDone = false; 
itemHit, itemType; 
textitemHandle; 
itemHandle; 
okitemHandle; 
launchitemHandle; 
itemRect; 
itemText; 
reply; 
reminder; 

kDialogResID, nil, 
kMoveToFront ); 

reminder= (ReminderPtr)NewPtr( sizeof 

reminder->menuitem = 0; 
reminder->dispose = false; 
reminder->wasPosted = false; 

( ReminderRec) ); 

SetDialogDefaultitem( dialog, ok ); 
SetDialogCancelitem( dialog, cancel); 
SetDialogTracksCursor( dialog, true); 

GetDitem( dialog, iMessageText, &itemType, 
&textitemHandle, &itemRect ); 

GetDitem( dialog, ok, &itemType, &okitemHandle, 
&itemRect ); 

GetDitem( dialog, iLaunchCheckBox, &itemType, 
&launchitemHandle, &itemRect ); 
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Sel!Text( dialog, iMessageText, kMinTextPosition, 
kMaxTextPosition ); 

while ( ! dialogDone ) 

Get!Text( textitemHandle, itemText ); 

if ( itemText[ 0 ] ;= 0 && 

else 

!GetCtlValue( (ControlHandle) 
launchitemHandle ) } 

HiliteControl( (ControlHandle)okitemHandle, 
kDisableButton }; 

HiliteControl( (ControlHandle}okitemHandle, 
kEnableButton }; 

ModalDialog( nil, &iternHit ); 

switch ( iternHit 

case ok: 
case cancel: 

dialogDone = true; 

break; 
case iSoundCheckBox: 
case iRotateCheckBox: 

GetDitern( dialog, itemHit, &itemType, 
&itemHandle, &itemRect }; 

SetCtlValue( (ControlHandle)itemHandle, 
! GetCtlValue( (ControlHandle) 

itemHandle} ); 

break; 
case iLaunchCheckBox: 
case iAppNameText: 

if ( ! GetCtlValue( (ControlHandle) 
launchitemHandle ) ) 

GetFileName( &reply); 
if ( reply.sfGood ) 

SetCtlValue( (ControlHandle) 
launchitemHandle, kOn ); . 

reminder->file = reply.sfFile; 
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else 
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GetDitem( dialog, iAppNameText, 

&itemType,&itemHandle, 
&itemRect ); 

SetIText( itemHandle, 
reminder->file.name ); 

SetCtlValue( (ControlHandle) 

launchitemHandle, kOff ); 
GetDitem( dialog, iAppNameText, 

&itemType,&itemHandle, 
&itemRect ); 

SetIText( itemHandle, 
"\p<Not Selected>" ); 

break; 

if ( itemHit == cancel ) 

DisposePtr( (Ptr)reminder ); 
reminder = nil; 

else 

CopyDialogToReminder( dialog, reminder); 

DisposDialog( dialog); 

return( reminder); 

/********************************* CopyDialogToReminder */ 

void CopyDialogToReminder( DialogPtr dialog, 
ReminderPtr reminder) 

short 
Re ct 
Handle 
Str255 
Menu Handle 
short 
long 

itemType; 
iternRect; 
itemHandle; 
string; 
menu; 
val; 
tmp; 
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GetDitem( dialog, iMessageText, &itemType, 
&itemHandle, &itemRect ); 

!325. 

GetIText( itemHandle, reminder->alert ); 
reminder->notify.nmStr = (StringPtr)&reminder->alert; 

GetDitem( dialog, iSoundCheckBox, &itemType, 
&itemHandle, &itemRect ); 

if ( GetCtlValue( (ControlHandle)itemHandle ) 
reminder->notify.nmSound 

else 

(Handle) -lL; 

reminder->notify.nmSound = nil; 

GetDitem( dialog, iRotateCheckBox, &itemType, 
&itemHandle, &itemRect ); 

if ( GetCtlValue( (ControlHandle)itemHandle ) ) 
reminder->notify.nmicon 

else 

GetResource( 'SICN', 
kBaseResID ); 

reminder->notify.nmicon = nil; 

GetDitem( dialog, iLaunchCheckBox, &itemType, 
&itemHandle, &itemRect ); 

if ( reminder->launch = GetCtlValue( 
(ControlHandle)itemHandle ) 

reminder->notify.nmResp &LaunchResponse; 

else 
reminder->notify.nmResp &NormalResponse; 

GetDitem( dialog, iHoursPopup, &itemType, &itemHandle, 
&itemRect ); 

val= GetCtlValue( (ControlHandle)itemHandle ); 
NumToString( (long) val, string); 
StringToNum (string, &tmp ); 
reminder->hour = tmp; 

reminder->menuString[O] = O; 
ConcatString( reminder->menuString, string); 
ConcatString( reminder->menuString, "\p:" ); 

GetDitem( dialog, iMinutesPopup, &itemType, 
&itemHandle, &itemRect ); 

val= GetCtlValue( (ControlHandle)itemHandle ); 
menu= GetMHandle( mMinutes ); 
Getitem( menu, val, string); 
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StringToNum (string, &tmp ); 
reminder->minute = tmp; 

ConcatString( reminder->menuString, string); 
ConcatString( reminder->menuString, "\p "); 

GetDitem( dialog, iAMorPMPopup, &iternType, 
&itemHandle, &itemRect ); 

val= GetCtlValue( (ControlHandle)itemHandle ); 

if ( val == kPM ) 
reminder->hour += 12; 

menu= GetMenu ( mAMorPM ); 
Getitem( menu, val, string); 
ConcatString( reminder->menuString, string); 

reminder->notify.qType = nmType; 
reminder->notify.nmMark = kMarkApp; 

/************************** ConcatString ************/ 

void ConcatString( Str255 strl, Str255 str2) 

short i; 

for (i=strl[O];i<str2[0]+strl[O];i++) 

strl[i+l]=str2[i-str1[0]+1]; 

strl[O)=i; 

/************************** NormalResponse ************/ 

pascal 
{ 

void Norma!Response( NMRecPtr notifyPtr ) 

ReminderPtr reminder; 
OSErr err; 

reminder GetReminderFromNotification( notifyPtr ); 
err= NMRemove( notifyPtr ); 
reminder->dispose = true; 
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/************************** LaunchResponse *******/ 

pascal 
{ 

void LaunchResponse( NMRecPtr notifyPtr 

LaunchParamBlockRec 
OSErr 

launchParams; 
err; 

FSSpec 

ReminderPtr 
Boolean 
Boolean 

reminder 

f ileSpec; 
reminder; 
isFolder; 
wasAlias; 

GetReminderFromNotification( notifyPtr ); 

f ileSpec = reminder->f ile; 

err = ResolveAliasFile( &fileSpec, true, &isFolder; 
&wasAlias ); 

launchParams.launchBlockID = extendedBlock; 
launchParams.launchEPBLength = extendedBlockLen; 

launchParams.launchFileFlags = O; 
launchParams.launchControlFlags = launchContinue + 

launchNoFileFlags; 
launchParams.launchAppSpec = &fileSpec; 

launchParams.launchAppParameters = nil; 

if ( LaunchApplication( &launchParams ) ) SysBeep( 20 ); 

err= NMRemove( notifyPtr ); 

reminder->dispose = true; 

/********************** GetReminderFromNotification *****/ 

ReminderPtr GetReminderFromNotification( NMRecPtr 
notifyPtr 

return (ReminderPtr) notifyPtr->nmRefCon; 
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Running Reminder 

Now that your source code is in, you're about ready to run Reminder. 
Like EventTrigger in Chapter 4 and WorldClock in Chapter 5, you 
should set up the SIZE flags first. To do this, select Set Project 
Type... from the Project menu. Set the flags as shown in Figure 
6.66. 

® Rpplication 

O Desk Rccessory 

O Oeuice Driuer 

O Code Resource 

Partition (K) ~ 

./ MultiFinder-Rware 

./Background Null Euents 
lseool 

.~ .. ~~·~·~·~·~-~·-·~···~·~·~·~·~·~-·-~·~·~·~-~~ ............................ M 

File Type I RPPL I 
Creator l'fl'"I 

0 Far CODE 

0 Far ORTH 

0 Separate STRS 

( Cancel J 
Background Only Id' 
6et FrontClicks l==============!.I 
Accept ChildDiedEuents 

32-Bit Compatible 
HighleuelEuent-Rware 
Accept Remote HighleuelEuents 
Statlonery-Rware 

Figure 6.66 Setting the s I ZE flags. 

Save your changes, then select Run from the Project menu. When 
asked to Bring the project up to date? click Yes. If everything 
went well, the Reminder menus should appear in the menu bar. Let's 
look at each one in turn. First, examine the menu. It should display 
the Rbout Reminder ... menu item at the top, and the remainder of 
the menu items below (Figure 6.67). 

As with WorldClock, all menu items are fully available in 
Reminder. Select the Rbout Reminder ••. menu item in the menu. 
You should see the alert you created earlier (Figure 6.68). 

Now, examine the File menu. It should look like Figure 6.69, with 
only the New Reminder and Quit menu items enabled. 
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Rb out Reminder ••• 

~ Rlarm Clock 
H Battery 
; Calculator 
'P Chooser 
~ Control Panels 
(@)Key Caps 
i;:J Note Pad 
~Puzzle 
m Scrapbook 

Figure 6.67 Reminder's Apple menu. 

Rnother fine program from the 
Mac C Programming Primer! 
©1992, D. Mark & C. Reed!!! 

Figure 6.68 The About Reminder ••. alert. 

New Reminder... 38N 
S1 OJl H<~min<hff ~ 

· Quit 380 

Figure 6.69 Reminder's File Menu. 
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The Edit Menu should be completely disabled (Figure 6.70). 
The Edit menu will be enabled if a desk accessory is used or if the 

Reminder dialog is open, as you'll see in a moment. 
If everything seems to be working OK, select New Reminder ... 

from the File menu. You should see the dialog box shown in Figure 
6. 71, centered on the monitor. 

[ ut :)(:!{ 

[ O!)!J :)(:[ 

Pos1 (~ :)(:!J 

[ h~Of 

Figure 6.70 Reminder's Edit Menu (disabled). 

When: I T II OOT II RMT I 

Message: 

0 Play Sound 

O Rotate Icon 

O Launch: <None Selected> 

( Cancel l n OK D 

Figure 6.71 Reminder in action. 

Reminder is ready to do some work for you. Let's start by looking at 
the three pop-up menus at the top of the dialog box. If you click on the 
Hour, the Minute and the AM / PM pop-up menus in turn, you should 
see the menu items shown in Figure 6. 72. 
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../ 1 ../00 L;J 2 05 M 
3 10 
4 15 
5 20 
6 25 
7 30 
8 35 
9 40 
10 45 
11 50 
12 55 

Figure 6. 72 Reminder 's pop-up menus. 

...!. 

If things didn't go as planned, check the Reminder resources, as 
well as the source code in Reminder. c . Make sure your project 
and resource files are named correctly. Since this is the longest of 
all the Primer projects, it's possible you introduced a bug 
somewhere along the way. Check everything carefully. 

Use the popups to select a time for this reminder. Suppose it is 9:40 
P.M. (prime time for programmers). Enter a test reminder for 11 P.M. as 
shown in Figure 6.73. 

Click OK. Now go to the File menu and select Stop Notification. 
Keep the mouse down to examine the hierarchical menu. It should 
display one reminder for 11 P.M. (Figure 6.74). Select the 11 P.M. menu 
item. This will cancel the notification. 

Enter a test reminder and set the time for just after whatever the 
current time is. In this example, the current time is 9:47 P.M. Set the 
first pop-up menu to 9 , the second pop-up menu fo 50, and the third 
pop-up menu to PM. The dialog box should look like Figure 6.75. 
Notice that the Play Sound and Rotate Icon check boxes are 
checked. Also notice the important reminder in the Message: field. 



332 Macintosh C Programming Primer 

When: I 11 • II OD• II PM• I 

Message: 

D Play Sound 
D Rotate I con 
D Launch: <None Selected> 

( Cancel ) ([ OK D 

Figure 6.73 The first reminder. 

Figure 6.74 A reminder is set for 11 P.M. 

When: I 9...,.11 so ... fl PM...,. I 

Message: I Pizza break!!! 

181 Play Sound 

181 Rotate I con 
D Launch: <None Selected> 

( Cancel ) ([ OK }J 

Figure 6.75 Making a test reminder. 
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Once you've set the text and pop-up menus, click on the 0 K button 
to set the reminder. Now, try starting another application (we'll• run 
Microsoft Word). At the appointed time, your Mac should beep,• and 
the alert shown in Figure 6.76 should appear. If you look carefully, 
you'll see the s I CN you designed rotating back and forth with your 
application's icon. Figure 6.76 shows our bell SICN. 

~ Hie t:dit !Hew ln~ert rornrnt F'ont rool~ Ulindou1 

9:50:15 PM I 
All Work and No Play 

lliJ Pizza breaklll 
IO . 

..!.. • 

All work c 
All work c 
All work c 
All work c 
All work c 
All work c 
All work 11 

[I OK JJ 
All work 11 v w 

All work end no play makes jack a dull boy. 1.

1
!!,!.i

1
;
1

1
,i_:l.

11

i_: 

All work end no play makes jack c dull boy. 
Al!_ work end no play makes ~ack c dull bo~.1 ~ 

[P"aj_e 748 IQL Ji1milii1!11mMMH1!iWJiil!li!]l!l~~i!!IJO l2J 

@i) 
Trash 

Figure 6.76 Making a test reminder. 

Now, let's see what happens when you set multiple reminders. Use 
New Reminder... to set four reminders for some time after the 
current time. In our example, we'll set up reminders for 11:20 P.M., 
11:30 P.M., 11:40 P.M., and 11:50 P.M. Once you've completed entering 
the reminders, select the Stop Notification menu item in the File 
menu again. It should look something like Figure 6. 77. 

11:20 PM 
11 :30 PM 
11 :40 PM 
11 :50 PM 

Figure 6.77 Four reminders set after 11 P.M. 
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Next, create a new reminder. This time, click on the Launch 
Rpplication check box. The standard Open File dialog will appear 
(Figure 6.78). Use this dialog to select any application you like. 

Go ahead and select an application (we selected EventTracker). 
When you click on the Open button, the name of the application is 
placed in the Reminder dialog box (Figure 6.79). 

If you accept the reminder, your application will be launched at the 
appropriate time. 

Finally, type the Command key equivalent 38Q to quit Reminder. 
Typing 3€Q is equivalent to selecting Quit from Reminder's File menu. 

I a 4.3 - EuentTrigger • I G::::1 Erehwon 

<.3~ EuentTracker m 
Desktop 

( Cancel ) 

n Open D 

Figure 6. 78 Looking for an application to launch. 

When: ._I __ .... _ll,._o_o_ .... _.ll._n_M_..-.... 1 

Sample reminder 
I Message: 

D Play Sound 

D Rotate I con 

18) Launch: EuentTracker 

( Cancel ) n OK D 

Figure 6.79 Using Reminder to launch an application. 
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Walking Through the Reminder Code 

Let's take a look at the Reminder code. We'll focus on the Toolbox 
issues and not so much on the Reminder algorithm. 

Reminder. c includes three special files you'll need in order to use 
the Notification and Process managers, and to resolve file aliases 
when Reminder launches an application. 

#include <Notification.h> 
#include <Processes.h> 
#include <Aliases.h> 

We'll address the #defines as they occur in the code. 

#define kBaseResID 128 
#define kMoveToFront (WindowPtr)-lL 
#define kSleep 3600L 
#define kLeaveWhereitis false 
#define kUseDefaultProc (void *) -11 

#define kNotANormalMenu -1 

#define mApple kBaseResID 
#define iAbout 1 

#define mFile kBaseResID+l 

#define iSetReminder 1 

#define iCancelReminder 2 

#define iQuit 4 

#define mHours 100 
#define mMinutes 101 
#define mAMorPM 102 
#define mReminders 103 

#define kDialogResID kBaseResID+l 

#define iHoursPopup 4 

#define iMinutesPopup 5 

#define iAMorPMPopup 6 

#define iMessageText 8 
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#define iSoundCheckBox 9 

#define iRotateCheckBox 10 

#define iLaunchCheckBox 11 

#define iAppNameText 12 

#define kOn 1 
#define kOf f 0 

#define kMarkApp 1 

#define kAM 1 
#define kPM 2 

#define kMinTextPosition 0 

#define kMaxTextPosition 32767 

#define kDisableButton 255 
#define kEnableButton 0 

We'll use the ReminderRec structure to hold all the data associated 
with the New Reminder ... dialog. Each field will be explained as it is 
used. Remember that ReminderPtr is declared as a pointer to a 
ReminderRec. Quite a few of Reminder's routines either take a 
ReminderPtr as a parameter or return a ReminderPtr. 

typedef struct 
{ 

QElem 
NMRec 
FSSpec 
short 
short 
Boolean 
Str255 
Str255 
short 
Boolean 
Boolean 
ReminderRec, 

queue; 
notify; 
file; 
hour; 
minute; 
launch; 
alert; 
menuString; 
menuitem; 
dispose; 
wasPosted; 
*ReminderPtr; 

Lots of function prototypes ... 
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/***************/ 
/* Functions */ 
/***************/ 

void 
void 
void 
void 
void 
void 
void 
void 
void 

ReminderPtr 

void 

pascal 
pascal 

void 

void 
void 

ReminderPtr 
ReminderPtr 
ReminderPtr 

ReminderPtr 
ReminderPtr 

ReminderPtr 

void 
short 
void 

void 

void 
void 
void 

ToolBoxinit( void); 
MenuBarinit( void); 
EventLoop( void); 
DoEvent( EventRecord *eventPtr ); 
HandleNull( void); 
HandleMouseDown( EventRecord *eventPtr ); 
HandleMenuChoice( long menuChoice ); 
HandleAppleChoice( short item); 
HandleFileChoice( short item); 

HandleDialog( void); 

GetFileName( StandardFileReply 
*replyPtr ); 

LaunchResponse( NMRecPtr notifyPtn ); 
NormalResponse( NMRecPtr notifyPtr ); 

CopyDialogToReminder( DialogPtr dialog, 
ReminderPtr reminder); 

GetFirstReminder( void); 
GetNextReminder( ReminderPtr reminder); 
GetReminderFromNotification( NMRecPtr 

notifyPtr ); 

FindReminderOnMenu( short menuitem ); 
FindReminderToPost( short hour, 

short minute); 
FindReminderToDispose( void); 

SetupReminderMenu( void); 
CountRemindersOnMenu( void); 
RenumberTrailingReminders( ReminderPtr 

reminder); 
InsertReminderintoMenu( ReminderPtr 

reminder); 
ScheduleRerninder( ReminderPtr reminder); 
PostReminder( ReminderPtr reminder); 
DeleteReminderFromMenu( ReminderPtr 

reminder); 
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void 
ReminderPtr 

void 

Macintosh C Programming Primer 

DeleteReminder( ReminderPtr reminder); 
DisposeReminder( ReminderPtr reminder); 

ConcatString( Str255 strl, Str255 str2); 

These three routines were explained earlier in the chapter. THINK 
C 5 did not include these declarations in the Dialog Manager 
#include file, so we've included them here. If your version of THINK 
C comes with these declarations built in, just delete the duplicate 
declarations below. 

/* see tech note 304 */ 
pascal OSErr SetDialogDefaultitem(DialogPtr theDialog, 

short newltem) 
= { Ox303C, Ox0304, OxAA68 }; 

pascal OSErr SetDialogCancelltem(DialogPtr theDialog, 
short newltem) 

= { Ox303C, Ox0305, OxAA68 }; 
pascal OSErr SetDialogTracksCursor(DialogPtr theDialog, 

Boolean tracks) 
= { Ox303C, Ox0306, OxAA68 }; 

gDone plays its normal role. gReminderQueue is a pointer to the 
reminder queue. We'll use some of the operating system utilities to 
create and maintain a queue of reminders. The routine Enqueue () 
places a queue element at the end of the queue, and the routine 
Dequeue ( ) removes an element from the queue. As you'll see, 
Reminder uses these routines to keep track of individual 
Reminde rRecs. 

/*************/ 
/* Globals */ 
/*************/ 

Boolean 
QHdr 

gDone; 
gReminderQueue; 

main () initializes the Toolbox and the menu bar, then enters the 
main event loop. 
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/******************************** main *********/ 

void main( void 

ToolBoxinit(); 
MenuBarinit(); 

EventLoop(); 

ToolBoxinit () looks the same as ever. 

/*********************************** ToolBoxinit */ 

void ToolBoxinit( void) 

InitGraf( &qd.thePort ); 
InitFonts (); 
InitWindows(); 
InitMenus (); 
TEinit (); 
InitDialogs( nil); 
InitCursor(); 
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MenuBarini t () loads the MBAR resource. If the resource couldn't 
be loaded, beep once, then exit. 

/*********************************** MenuBarinit */ 

void MenuBarinit( void ) 

Handle 
MenuHandle 

menuBar; 
menu; 

menuBar = GetNewMBar( kBaseResID ); 
if ( menuBar == nil 

SysBeep( 20 ); 
ExitToShell (); 
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Once the MBAR is loaded, it is made current. Next, the mRerninders 
popup is installed in the menu list and marked as kNotANorrnalMenu. 
Next, the Apple menu is built and the menu bar is drawn. 

SetMenuBar( menuBar ); 

menu= GetMenu( mReminders ); 
InsertMenu( menu, kNotANormalMenu ); 

menu= GetMHandle( mApple ); 
AddResMenu( menu, 'DRVR' ); 

DrawMenuBar(); 

EventLoop () calls WaitNextEvent () to retrieve an event from 
the event queue. Interestingly, the same routines we'll use to manage 
the reminder queue are used by the Event Manager to manage the 
event queue. 

/*********************************** EventLoop */ 

void EventLoop( void ) 

Event Record event; 

gDone false; 

while gDone === false ) 

if ( WaitNextEvent( everyEvent, &event, 
GetCaretTime(), nil ) ) 

DoEvent( &event); 
else 

HandleNull (); 

Since we aren't supporting any windows, the list of handled events 
is fairly small. 



Working with Dialogs 341 

/*********************************** DoEvent */ 

void DoEvent( EventRecord *eventPtr ) 

char theChar; 

switch ( eventPtr->what 

mouseDowns are handled by HandleMouseDown () . If the 
Command key was down when they occurred, keyDowns and 
autoKeys are translated into a menu selection by MenuKey (), then 
passed on to HandleMenuChoice (). 

case rnouseDown: 
HandleMouseDown( eventPtr ); 
break; 

case keyDown: 
case autoKey: 

theChar = eventPtr->rnessage & charCodeMask;
1 

if ( (eventPtr->rnodifiers & crndKey) != 0 ) 
HandleMenuChoice( MenuKey( theChar) ); 

break; 

HandleNull () gets called every time a null event is returned by 
Wai tNextEvent () . HandleNull () starts by retrieving the current 
hour and minute, passing these on to FindReminderToPost (). 
FindReminderToPost () walks through the reminder queue, looking 
for a reminder whose time has come. If such a reminder is found, 
FindReminderToPost () returns a pointer to it. ' 

/****************** HandleNull **********************/ 

void HandleNull( void) 

unsigned long 
DateTirneRec 
ReminderPtr 

time; 
dateTirne; 
theRerninder; 

GetDateTirne( &time); 
Secs2Date( time, &dateTirne ); 

theReminder = FindRerninderToPost( dateTime.hour, 
dateTime.minute ); 
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In that case, PostReminder () is called, passing the reminder on to 
the Notification Manager. Next, DeleteReminderFromMenu () is 
called to delete the reminder from the hierarchical menu. Finally, 
FindReminderToPost () is called again, to see if any other reminders 
are ready for posting. 

while ( theReminder 
{ 

PostReminder( theReminder ); 
DeleteReminderFromMenu( theReminder ); 
theReminder = FindReminderToPost ( dateTime.hour, 

dateTime.minute ); 

Next, the same process is repeated, using the routine 
FindReminderToDispose(). FindReminderToDispose() steps 
through the queue, looking for reminders that either have been 
deleted (by way of the Stop Notification menu) or have been to the 
Notification Manager and have completed their notification. 

theReminder = FindReminderToDispose(); 
while ( theReminder ) 

DisposeReminder () calls Dequeue () to remove the specified 
reminder from the reminder queue, then disposes of the memory 
allocated for the reminder's data structure. 

DisposeReminder( theReminder ); 
theReminder = FindReminderToDispose (); 

HandleMouseDown () calls FindWindow () to find which window 
the mouseDown was in. 

/****************** HandleMouseDown ********************/ 

void HandleMouseDown( EventRecord *eventPtr ) 

WindowPtr 
short 
long 

window; 
thePart; 
menuChoice; 
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thePart = FindWindow( eventPtr->where, &window); 
switch ( thePart ) 
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If the mouseDown was in the menu bar, call 
SetupReminderMenu () to enable the Stop Reminder menu if there 
is at least one current reminder. Then call MenuSelect () and pass 
the selected menu on to HandleMenuChoice (). · 

case inMenuBar: 
SetupReminderMenu(); 
menuChoice = MenuSelect( eventPtr->where ); 
HandleMenuChoice( menuChoice ); 

break; 

If the mouseDown was inSysWindow, pass the event on to 
SystemClick (). 

case inSysWindow: 
SystemClick( eventPtr, window); 
break; 

SetupReminderMenu () gets a handle to the File menu from 
GetMenu (), then calls CountRemindersOnMenu () to find out how 
many items are currently on the hierarchical menu. 

/******************** SetupReminderMenu *****************/ 

void SetupReminderMenu( void ) 

MenuHandle fileMenu; 
short items; 

fileMenu GetMenu( mFile ); 
items= CountRemindersOnMenu(); 

If the hierarchical menu contains at least one item, enable the File 
menu's Stop Reminder item, else disable the menu item. ! 

if (items) Enableitem( fileMenu, iCancelReminder); 
else Disableitem( fileMenu, iCancelReminder); 
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HandleMenuChoice () passes the selected item on to 
HandleAppleChoice () or HandleF ileChoice () if the selection 
was from one of those two menus. 

/****************** HandleMenuChoice ********************/ 

void HandleMenuChoice( long menuChoice ) 

short menu; 
short item; 
ReminderPtr reminder; 

if ( menuChoice != 0 ) 

menu HiWord( menuChoice ); 
item LoWord( menuChoice ); 

switch ( menu ) 

case mApple: 
HandleAppleChoice( item); 
break; 

case mFile: 
HandleFileChoice( item); 
break; 

If the selection was from the hierarchical menu, 
FindReminderOnMenu () is called to turn the menu item into a 
ReminderPtr. If a reminder was found, DeleteReminder () is called 
to delete it from the queue. 

case mReminders: 
reminder= FindReminderOnMenu( item); 
if ( reminder ) 

DeleteReminder( reminder); 
break; 

HiliteMenu( 0 ); 

HandleAppleChoice () handles all selections in the Apple menu. 
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/****************** HandleAppleChoice *******************/ 

void HandleAppleChoice( short item ) 

MenuHandle 
Str255 
short 

appleMenu; 
accName; 
accNumber; 

switch item ) 

If the Hbout Reminder ... item is selected, NoteAlert () is called 
to display the alert we built earlier. Otherwise, OpenDeskAcc () is 
called to open the appropriate item in the Apple menu. 

case iAbout: 
NoteAlert( kBaseResID, nil); 
break; 

default: 
appleMenu = GetMHandle( mApple ); 
Getitem( appleMenu, item, accName ); 
accNumber; OpenDeskAcc( accName ); 
break; 

If the New Reminder ... item is selected from the File menu, 
HandleDialog () is called to bring up the dialog box designed earlier. 

/****************** HandleFileChoice *****************~**/ 

void HandleFileChoice( short item ) 

ReminderPtr reminder; 

switch ( item ) 
{ 

case iSetReminder: 
reminder= HandleDialog(); 

HandleDialog () returns a ReminderPtr if the OK button was 
clicked. In that case, the reminder is passed on to 
ScheduleReminder () to be placed on the reminder queue. 
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if ( reminder ) 
ScheduleReminder( reminder); 

break; 

If Quit was selected, gDone is set to true, allowing Reminder to 
exit. 

case iQuit : 
gDone :;;;; true; 
break; 

GetFirstRerninder () returns the first element on the reminder 
queue. 

/******************** GetFirstReminder ******************/ 

ReminderPtr GetFirstReminder( void ) 

return( (ReminderPtr)gReminderQueue.qHead ); 

GetNextRerninder () takes a pointer to a queue element and 
returns the next element on the queue. 

/******************** GetNextReminder *******************/ 

ReminderPtr GetNextReminder( ReminderPtr reminder 

return( (ReminderPtr)reminder->queue.qLink ); 

FindRerninderOnMenu () steps through the reminder queue, 
comparing the rnenuitern field of each RerninderRec with the 
specified rnenu!tern. If a match is found, a pointer to that reminder is 
returned. 

/******************** FindReminderOnMenu ****************/ 

ReminderPtr FindReminderOnMenu( short menuitem ) 

ReminderPtr theReminder; 
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theReminder = GetFirstReminder(); 
while ( theReminder ) 
{ 

if ( theReminder->menuitem == menuitem ) 
break; 

theReminder = GetNextReminder( theReminder ); 

return( theReminder ); 
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F indReminderToPost () steps through the queue, looking for a 
reminder which has not yet been posted (passed on to the Notific~tion 
Manager) and whose time has passed or equalled the hour

1 

and 
minute specified in the parameters. 

/******************** FindReminderToPost ****************/ 

ReminderPtr FindReminderToPost( short hour, short minute 

ReminderPtr theReminder; 

theReminder = GetFirstReminder(); 
while ( theReminder ) 
{ 

if ( (!theReminder->wasPosted) 
&& (theReminder->hour <= hour) 
&& (theReminder->minute <= minute) 

break; 
theReminder GetNextReminder (theReminder); 

If the entire queue was searched with no success, the last elements 
next item pointer (which is conveniently initialized to nil) will be 
re tum ed. 

return( theReminder ); 

FindReminderToDispose () walks through the reminder queue, 
returning the first reminder whose dispose flag is set to true. 
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/******************** FindRerninderToDispose *************/ 

RerninderPtr FindRerninderToDispose( void ) 

RerninderPtr theRerninder; 

theRerninder = GetFirstRerninder (); 
while ( theRerninder ) 
{ 

if ( theRerninder->dispose 
break; 

theRerninder = GetNextRerninder (theRerninder); 

return( theRerninder ); 

InsertReminderintoMenu () uses InsMenuitem () to insert the 
reminder's menuString in the hierarchical menu. The reminder's 
menuitem is set to indicate its position in the menu. 

/******************** InsertRerninderintoMenu ************/ 

void InsertRerninderintoMenu( RerninderPtr reminder ) 

short 
MenuHandle 

iternBefore; 
rerninderMenu; 

rerninderMenu = GetMenu( rnRerninders ); 

iternBefore = CountRernindersOnMenu(); 

InsMenuitern( rerninderMenu, rerninder->rnenuString, 
iternBefore ); 

rerninder->rnenuitern iternBefore + 1; 

CountRemindersOnMenu () returns the number of reminders on 
the hierarchical menu. 
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/********************* CountRemindersOnMenu *************/ 

short CountRemindersOnMenu( void } 

MenuHandle reminderMenu; 

reminderMenu = GetMenu( mReminders ) ; 

return( CountMitems( reminderMenu} }; 

DeleteReminderFromMenu () deletes a reminder from the 
hierarchical menu, calling RenumberTrailingReminders () i to 
update the remaining reminder's item numbers. Finally, :the 
menuitem field is set to 0, indicating that this reminder is no long~r in 
the hierarchical menu. 

/******************* DeleteReminderFromMenu *************/ 

void DeleteReminderFromMenu( ReminderPtr reminder ) 

MenuHandle reminderMenu; 

reminderMenu = GetMenu( mReminders ); 
RenumberTrailingReminders( reminder); 

DelMenuitem( reminderMenu, reminder->menuitem }; 
reminder->menuitem = 0; 

RenumberTrailingReminders () steps through the reminder 
I 

queue from the specified reminder through to the end, updating each 
reminder's menuitem field. Reminders whose rnenurtem field is s~t to 
0 are ignored. 

/***************** RenumberTrailingReminders ************/ 

void RenumberTrailingReminders{ ReminderPtr reminder 

short count; 

count reminder->menuitem; 
reminder= GetNextReminder{ reminder); 
while ( reminder } 
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if (reminder->menu!tem != 0) 
reminder->menu!tem = count++; 

reminder= GetNextReminder( reminder); 

ScheduleRerninder () places the specified reminder on the 
reminder queue and into the hierarchical menu. 

/***************** ScheduleReminder *********************/ 

void ScheduleReminder( ReminderPtr reminder ) 

Enqueue( &reminder->queue, &gReminderQueue ); 
InsertReminderintoMenu( reminder); 

PostRerninder () posts the reminder on the Notification Manager's 
queue using NMinstall (). Don't confuse the reminder queue with 
the Notification Manager's queue. As we explained earlier in the 
chapter, the Notification Manager routines work with a NMRec data 
structure, not a RerninderRec. 

/****************** PostReminder ************************/ 

void PostReminder( ReminderPtr reminder ) 

The RerninderRec struct has a NMRec embedded in it. A pointer to 
the reminder is placed in the NMRec's nrnRefCon field for later 
retrieval. The reminder's wasPosted flag is set to true and the 
NMRec is passed to NMinstall (). 

reminder->notify.nmRefCon = (long)reminder; 
reminder->wasPosted = true; 
NMinstall( &reminder->notify ); 

DeleteRerninder () first checks the reminder's menuitem flag to 
see if the reminder is in the hierarchical menu. If so, 
DeleteRerninderFrornMenu () is called. Either way, the reminder's 
dispose flag is set to true, marking the reminder for later disposal. 
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/****************** DeleteReminder **********************/ 

void DeleteReminder( ReminderPtr reminder ) 

if ( reminder->menuitem ) 
DeleteReminderFromMenu( reminder); 

reminder->dispose = true; 

DisposeReminder () deletes the reminder from the menu, if 
appropriate. The next reminder in the list is stored in the variable 
next for later returning. Next, the reminder is removed from the 
reminder queue using Dequeue () . Finally, the memory allocated for 
the reminder is freed up with a call to DisposePtr (). · 

/*************** DisposeReminder **********************~*/ 

ReminderPtr DisposeReminder( ReminderPtr reminder ) 

ReminderPtr next; 

if (reminder->menuitem) 
DeleteReminderFromMenu( reminder); 

next= (ReminderPtr)reminder->queue.qLink; 
Dequeue( &reminder->queue, &gReminderQueue ); 
DisposePtr( (Ptr)reminder ); 
return( next); 

GetFileName () calls StandardGetFile () to ask the user to 
select an application file. A complete description of this routine is 
found in Chapter 7's OpenPICT program. Reminder uses the selected 
application when the Launch: check box is checked. 

/******************************** GetFileName 

void GetFileName( StandardFileReply *replyPtr 

SFTypeList typeList; 
short numTypes; 

typeList[ 0 = 'APPL'; 
numTypes = 1; 

*******/ 
I 
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StandardGetFile( nil, numTypes, typeList, replyPtr ); 

Perhaps one of the most important routines in this program and one 
of the longest, HandleDialog () implements the New Reminder ... 
dialog box. 

/******************************** HandleDialog *********/ 

ReminderPtr HandleDialog( void ) 
{ 

DialogPtr 
Boolean 
short 
Handle 
Handle 
Handle 
Handle 
Re ct 
Str255 
StandardFileReply 
ReminderPtr 

dialog; 

dialogDone = false; 
itemHit, itemType; 
textitemHandle; 
itemHandle; 
okitemHandle; 
launchitemHandle; 
itemRect; 
itemText; 
reply; 
reminder; 

First, the DLOG and DITL are loaded by the call to 
GetNewDialog (). Next, the dialog is made visible and the current 
port. 

dialog GetNewDialog( kDialogResID, nil, 
kMoveToFront ); 

ShowWindow( dialog); 
SetPort( dialog); 

Next, a ReminderRec is allocated and initialized. 

reminder = (ReminderPtr)NewPtr sizeof 

ReminderRec) ); 
reminder->menuitem = 0; 
reminder->dispose = false; 
reminder->wasPosted = false; 
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These three routines were discussed earlier in the chapter. 

SetDialogDefaultitem( dialog, ok ); 
SetDialogCancelitem( dialog, cancel); 
SetDialogTracksCursor( dialog, true); 

The first call to GetDitern () places a handle to the editable text 
field in textiternHandle. The second call loads a handle to the! OK 
button in okiternHandle. The third call places a handle to 1 the 
Launch: check box in launchiternHandle. SelIText () makes sure 
the entire text string in the editable text field is selected when the 
dialog box first appears. 

GetDitem( dialog, iMessageText, &iternType, 
&textiternHandle, &itemRect ); 

GetDitern( dialog, ok, &iternType, &okiternHandle, 
&itemRect ); 

GetDitern( dialog, iLaunchCheckBox, &iternType, 
&launchiternHandle, &iternRect ); 

Sel!Text( dialog, iMessageText, kMinTextPosition, 
kMaxTextPosition ); 

When the dialog loop is first entered, GetIText () is called, placing 
the text from the editable text field into iternText. 

while ( ! dialogDone ) 
{ 

GetIText( text!ternHandle, iternText ); 

If the editable text field was empty and the Launch: check bqx is 
unchecked, call HiliteControl () to dim the OK button, else enable 
·the OK button. 

if iternText[ 0 ] == 0 && 

else 

!GetCtlValue( (ControlHandle) 
launchiternHandle ) ) 

HiliteControl( (ControlHandle)okitemHandle, 
kDisableButton ); 

HiliteControl( (ControlHandle)okiternHandle, 
kEnableButton ); 

I 

Call ModalDialog (),retrieving the item acted upon by the user in 
the variable it ernH it. 



354 Macintosh C Programming Primer 

ModalDialog( nil, &itemHit ); 

switch ( iternHit ) 

If itemHit is the ok or cancel, drop out of the dialog loop. 

case ok: 
case cancel: 

dialogDone 
break; 

true; 

If the Play Sound or Rotate Icon check boxes were hit, reverse 
their values, checking an unchecked box or unchecking a checked box. 

case iSoundCheckBox: 
case iRotateCheckBox: 

GetDitem( dialog, iternHit, &iternType, 
&iternHandle, &itemRect ); 

SetCtlValue( (ControlHandle)iternHandle, 
! GetCtlValue 

(ControlHandle)itemHandle) ); 
break; 

If either the Launch: check box or the static text string bearing the 
launched application's name was hit, check the value of the Launch: 
check box. 

case iLaunchCheckBox: 
case iAppNameText: 

if ( ! GetCtlValue 
( (ControlHandle)launchitemHandle ) ) 

If the check box is unchecked, call GetFileName () to get an 
application file name. If the user didn't hit the Cancel button when 
prompted for an application name, copy the application name into the 
iAppNameText static text string. As we stated earlier, the File 
Manager and StandardGetF i le () are covered in Chapter 7's 
OpenPICT program. 

GetFileName( &reply); 
if ( reply.sfGood ) 
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SetCtlValue( (ControlHandle) 
launchitemHandle, kOn ); 

reminder->file = reply.sfFile; 
GetDitem( dialog, iAppNameText, 

&itemType,&itemHandle, 
&itemRect ); 

SetIText( itemHandle, 
reminder->file.name ); 

If the Launch: check box was already checked, call 
SetCtlValue () to uncheck it. Next, call SetIText () to set the 
iAppNarneText static text item to "\p<Not Selected>". 

else 

SetCtlValue( (ControlHandle) 
launchitemHandle, kOff ); 

GetDitem( dialog, iAppNameText, 
&itemType,&itemHandle, 
&itemRect ); 

SetIText( itemHandle, 
"\p<Not Selected>"); 

break; 

Ifwe dropped out of the dialog loop because of a click in the Cancel 
button, de-allocate the reminder and set it to n i 1. Otherwise, call 
CopyDialogToRerninder () to copy the dialog fields into the 
RerninderRec. 

if ( itemHit == cancel ) 

DisposePtr( (Ptr)reminder ); 
reminder = nil; 

else 
CopyDialogToReminder( dialog, reminder); 
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Once that's done, call DisposDialog () to de-allocate any memory 
allocated for the dialog itself, then return. 

DisposDialog( dialog); 

return( reminder ); 

CopyDialogToReminder () copies the specified dialog's fields into 
the ReminderRec pointed to by reminder. 

/********************************* CopyDialogToRerninder */ 

void CopyDialogToRerninder( DialogPtr dialog, 
ReminderPtr reminder) 

short 
Re ct 
Handle 
Str255 
MenuHandle 
short 
long 

itemType; 
itemRect; 
itemHandle; 
string; 
menu; 
val; 
tmp; 

First, the message text is copied into the NMRec's nmStr field. 

GetDitem( dialog, iMessageText, &itemType, 
&iternHandle, &itemRect ); 

GetIText( itemHandle, reminder->alert ); 
reminder->notify.nmStr = (StringPtr)&reminder->alert; 

Next, the Play Sound check box determines whether a nil or a 
- lL is stored in the NMRec's nmSound field. 

GetDitem( dialog, iSoundCheckBox, &itemType, 
&itemHandle, &itemRect ); 

if ( GetCtlValue( (ControlHandle)itemHandle ) 
reminder->notify.nmSound (Handle)-11; 

else 

reminder->notify.nrnSound nil; 

The Rotate Icon check box determines whether the SICN resource 
is loaded into the nmicon field. 
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GetDitem( dialog, iRotateCheckBox, &itemType, 
&itemHandle, &itemRect ); 

if ( GetCtlValue( (ControlHandle)itemHandle ) ) 
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reminder->notify.nmicon GetResource( 'SICN', 
kBaseResID ); 

else 
reminder->notify.nmicon = nil; 

Next, the value of the Launch: check box is stored in the reminder's 
launch field. If the check box was checked, the function 
LaunchResponse () is set as the response procedure. Otherwise, the 
function NorrnalResponse () is set as the response procedure. Both 
are explained below. 

GetDitem( dialog, iLaunchCheckBox, &itemType, 
&itemHandle, &itemRect ); 

if ( reminder->launch = GetCtlValue( (ControlHandle) 
i temHandle ) ) 

reminder->notify.nmResp 

else 
reminder->notify.nmResp 

&LaunchResponse; 

&NormalResponse; 

Next, the current value of the iHoursPopup is converted to a 
short and stored in the reminder's hour field. 

GetDitem( dialog, iHoursPopup, &itemType, &itemHandle, 
! 

&itemRect ); 
val= GetCtlValue( (ControlHandle)itemHandle ); 
NumToString( (long) val, string); 
StringToNum (string, &tmp ); 

reminder->hour = tmp; 

Next, the hour string and a single character are concatenated to 
form the rnenuString field. 

reminder->menuString[O] = 0; 
ConcatString( reminder->menuString, string); 
ConcatString( reminder->menuString, "\p:" ); 

I 

Next, the same is done for the minute field. First, the short is 
constructed. 
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GetDitem( dialog, iMinutesPopup, &itemType, 
&itemHandle, &itemRect ) ; 

val= GetCtlValue( (ControlHandle)itemHandle ); 
menu= GetMHandle( mMinutes ); 
Getitem( menu, val, string); 
StringToNum (string, &tmp ); 
reminder->minute = tmp; 

Then, the string representation of the minute is concatenated onto 
the menuString. 

ConcatString( reminder->menuString, string); 
ConcatString( reminder->menuString, "\p "); 

Next, the RM/PM menu is dealt with. If the popup is set to PM, the 
hour is bumped up by 12. After that, the appropriate value is 
concatenated onto the menuString. 

GetDitem( dialog, iAMorPMPopup, &itemType, 
&itemHandle, &itemRect ); 

val= GetCtlValue( (ControlHandle)itemHandle ); 

if ( val == kPM ) 
reminder->hour += 12; 

menu= GetMenu ( mAMorPM ); 
Getitem( menu, val, string); 
ConcatString( reminder->menuString, string); 

Finally, the qType field is set to the type appropriate for the 
Notification Manager, and the nmMark field is set so the application 
menu will be marked when the Notification occurs. 

reminder->notify.qType = nmType; 
reminder->notify.nmMark = kMarkApp; 

ConcatString () copies str2 onto the end of strl. 

/************************** ConcatString ************/ 

void ConcatString( Str255 strl, Str255 str2) 

short i; 
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for (i=strl[OJ;i<str2[0J+strl[OJ;i++) 

strl[i+l]=str2[i-str1[0]+1]; 

strl [OJ =i; 

The NormalResponse () procedure is called by the Notific1;ttion 
Manager when the notification completes. AB is the case whenever 
declaring a routine that will be called by the Toolbox, :both 
NormalResponse () and LaunchResponse () are declared to be of 
type pascal. This ensures that all parameters are passed according to 
the Toolbox parameter-passing conventions, which differ from C's 
standard parameter-passing conventions. 

/************************** NormalResponse ************/ 

pascal void 
{ 

NormalResponse( NMRecPtr notifyPtr ) 

ReminderPtr reminder; 
OSErr err; 

NormalResponse () retrieves the original reminder pointer from 
the nmRefCon field, calls NMRemove () to remove the Notification from 
the notification queue, then marks the reminder for later disposal.; 

reminder= GetReminderFromNotification( notifyPtr ); 
err= NMRemove( notifyPtr ); 
reminder->dispose = true; 

LaunchResponse () also retrieves the original reminder pointer 
I 

from the nmRefCon field. 

/************************** LaunchResponse *******/ 

pascal void 
{ 

LaunchResponse( NMRecPtr notifyPtr ) 

LaunchParamBlockRec 
OS Err 
FSSpec 
ReminderPtr 
Boolean 
Boolean 

launchParams; 
err; 
fileSpec; 
reminder; 
isFolder; 
wasAlias; 

reminder GetReminderFromNotification( notifyPtr ); 
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The f ileSpec specifies the application file to be launched. 
ResolveAliasFile () converts an alias (if that's what the user 
selected) into the real, honest-to-gosh file that was aliased. 

fileSpec = reminder->file; 

err = ResolveAliasFile( &fileSpec, true, &isFolder, 
&wasAlias ); 

Next, the launchParams fields are initialized (as described in the 
earlier Process Manager discussion) and the application is launched. If 
a problem was encountered launching the application, SysBeep () is 
called. 

launchParams.launchBlockID extendedBlock; 
launchParams.launchEPBLength = extendedBlockLen; 
launchParams.launchFileFlags = 0; 
launchParams.launchControlFlags = launchContinue + 

launchNoFileFlags; 
launchParams.launchAppSpec = &fileSpec; 

launchParams.launchAppParameters = nil; 

if (LaunchApplication( &launchParams ) ) SysBeep 
( 20 ) ; 

Finally, NMRemove () is called to remove the Notification from the 
notification queue, and the reminder is marked for later disposal. 

err= NMRemove( notifyPtr ); 

reminder->dispose = true; 

GetReminderFromNotif ication () returns the value stored in 
the nmRefCon field. 

/************************* GetReminderFromNotification **/ 

ReminderPtr 
notifyPtr ) 
{ 

GetReminderFromNotification( NMRecPtr 

return (ReminderPtr) notifyPtr->nmRefCon; 
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In Review 

Like menus and windows, dialogs and alerts are an intrinsic part of 
the Macintosh interface. It is very important that you read through 
Apple's interface guidelines, found in Inside Macintosh, Volume iVI, 
Chapter 2. Get off to a good start by learning the proper way to design 
your interface elements. 

In Chapter 7, we'll address some of the programming issues we've 
not touched on yet, such as error handling, using the clipboard, file 
management, printing, and scrolling. We'll even take a brief sojourn 
into the Macintosh Sound Manager. I 

Congratulations! The toughest part of the book is behind you. 
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Congratulations! Now that you have 
the Macintosh interface under your 
belt, you're ready to add some more 
advanced Toolbox features to your 

programs. 

7 
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CHAPI'ER 7 PRESENTS six programs, each of which explores a new ·part 
of the Toolbox. The first program, ResWriter, shows you the proper 
way to load, modify, and then write a resource back out to ~our 
application's resource fork. I 

The second program, Pager, uses a scroll bar to scroll through a list 
of pictures. Next, the desk scrap, more commonly known as the 
Clipboard, is introduced. The Scrap Manager utilities that support cut, 
copy, and paste operations are discussed. The third program, ShowClip, 
uses these routines to display the current scrap in a window. 

1 

The fourth application, SoundMaker, takes advantage of System 7's 
built-in sound recording and playback features. The fifth application, 
OpenPICT, demonstrates the System-7-savvy method for opening and 
reading from a standard Macintosh file. OpenPICT uses the standard 
file mechanism to select a PICT file, reads in the picture, then draws 
the picture in a window. 

Chapter 7's final program, PrintPICT, loads a PICT from: the 
resource fork, then works with the Printing Manager to print thJ file 
on the currently selected printer. 1 

Writing Out Resources 
! 

So far, the relationship between programs and resources has been one 
way only. You've learned how to load a resource from the resource 
fork. Our next program, ResWriter, shows you how to change the 
resource and write it back out. 

The ability to change a resource and write it back out to, the 
resource file is extremely important. Suppose you wrote an application 
that used a WIND resource to determine the initial size and positidn of 
a window. Imagine that just before your program quit, you could 
record the current window size and position, writing over whatever 
values were currently stored in the WIND resource. This means that 
the next time the user opened your application, their last window 'Size 
and position will have been preserved. 

Res Writer 

ResWriter demonstrates the technique of loading, changing, and 
writing a resource back out. Though ResWriter works with a reso11rce 
of type 'STR ' , the same approach will work for any resource, as long 
as you know the format of the resource. A 'STR ' resource is stbred 
as a Pascal string-a length byte followed by that many bytes of text. 

365 
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You can find the format for most resource types in the pages of 
Inside Macintosh. For example, the format of the WIND resource is 
detailed on 1:302. 

Res Writer starts by loading a ' STR ' resource, like the one shown 
in Figure 7.1. ResWriter then copies the text string into an editable 
text field in a dialog box (Figure 7.2), then lets the dialog fly. When the 
dialog's OK button is pressed, any changes made to the text are 
written back out to the original ' STR ' resource. 

STR ID = 128 from ResWriter. TT .rs re 

The String 

Data $ 

Figure 7.1 ResWriter's ' STR ' resource. 

Edit this teHt: 

n OK Il ( Cancel ) 

Figure 7.2 Res Writer 's dialog box. 
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ResWriter Resources 

Create a new folder called ResWriter in the Development folder. 
Next, use ResEdit to create a new resource file called 
ResWriter . 7t . rsrc inside the ResWriter folder. Res Writer makes 
use of three resources: a DITL, a DLOG, and a ' STR ' . 

Select Create New Resource from the Resour ce menu and 
create a DITL resource. Use the specifications in Figure 7.3 to create 
the four items that make up your DITL. Finally, select Get Re source 
Info from the Resource menu, change the DITL's resource ID to 128 
and make sure the Purge ab I e check box is checked. 

!§0 Edit Dill item #1 from ResWriter.n.rsrc 

TeHt: I' 
Button ...,. I 

'--~~~~~~~~~~~~~~~ 

~ Enabled Top: l._1_0 _ _, 

Left: ~14_0_~ 

Height: .... I 2_0 _ __, 

Width: 160 
~-~ 

Edit Dill item #2 from ResWriter.n.rsrc 

Te Ht: 

Button ...,. I 

~ Enabled Top: ._I 1_0_ --' 

Left : 1120 

Height: ~I 2_0 _ _ 

Width: ~1 6_0 _ _ 
!§0 Edit Dill item #3 from ResWriter.n.rsrc 

TeHt: 

I 

I 

..... 1 Static TeHt 

O Enabled Top: le Height: 120 
Left: le Width: I 10e 

F igure 7.3 Specifications for the four items in DITL 128. 
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§lO Edit Dill item #4 from ResWriter.11.rsrc 

TeHt: I' 
Edit TeHt •I 

18] Enabled 

'----~~~~~~~~~~~~~~___. 

Top: ~13_5_~ 

Left: ._I 3_o _ _, 

Height: ~I 1_6_~ 

Width: l._t_60 _ _, 

Figure 7.3 Specifications for the four items in DI TL 128 (continued). 

After closing all the windows associated with your DITL, select 
Create New Resource from t he Resource menu and create a 
DLOG resource. Use the specifications in Figure 7.4 to create the DLOG. 
If the Bottom: and Right: fields don't appear in your DLOG editor, 
select Show Bottom & Right from the DLOG menu. Make sure you 
enter 128 in the Dill ID: field. Next, change the DLOG's resource ID to 
128 and make sure the Purgeable check box is checked. Finally, 
select Auto Posi tion ... from the DLOG menu and make sure the 
settings match those in Figure 7.5. 

DLDG ID • 128 from ResWriter.n.rsrc 

b]LJbCLJDDLJ• 

Top: llu I Bottom:~ 
Left: EJ Right:~ 

Color: @ Oefoult 
0 Custom 

DITL ID: ~I 1_2_0 _ _, 

O lnitiolly uisibl e 

O Close boH 

Figure 7.4 Specifications for the DLOG resource. 



Toolbox Potpourri 

Automatically Position the Window 
(Works only with System 7 .0 or later.) 

Center ..-Ion Main Screen 

Cancel ) ([ OK D 

Figure 7.5 The Auto Position •.• dialog box. 
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After closing all the windows associated with your DLOG, select 
Create New Resource from the Resource menu and create a 
' S TR ' resource. Be sure to include the space following the S TR when 
specifying the resource type. Use the specification in Figure 7 ~1 to 
create the 'STR '.Finally, change the resource ID of the 'STR ' to 
128 and make sure the Purgeob le check box is checked. 

Quit ResEdit, saving your changes. 

The ResWriter Project 

Go into THINK C and create a new project called ResWr i ter. 7t 

inside the ResWriter folder. Use Add ••• from the Source menu to 
add MacTraps to the project. 

Once MacTraps is added, open a new source code window and enter 
the program: 1

1 

#define kBaseResID 128 

#define kMoveToFront (WindowPtr)-lL 

#define iText 4 

#define kDisableButton 255 

#define kEnableButton 0 

#define kWriteTextOut true 

#define kDontWriteTextOut false 

#define kMinTextPosition 0 

#define kMaxTextPosition 32767 
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/***************/ 
/* Functions */ 
/***************/ 

void ToolBoxinit( void); 

Macintosh C Programming Primer 

Boolean DoTextDialog( StringHandle oldTextHandle ); 

pascal OSErr SetDialogDefaultitem( DialogPtr theDialog, 
short newitem) = { Ox303C, Ox0304, OxAA68 }; 

pascal OSErr SetDialogCancelitem( DialogPtr theDialog, 
short newitem ) = { Ox303C, Ox0305, OxAA68 }; 

pascal OSErr SetDialogTracksCursor( DialogPtr theDialog, 
Boolean tracks ) = { Ox303C, Ox0306, OxAA68 .} ; 

/**************************** main **********************/ 

void main( void ) 

StringHandle textHandle; 

ToolBoxinit(); 

textHandle = GetString( kBaseResID ); 

if ( textHandle == nil ) 
{ 

SysBeep( 20 ); 
ExitToShell (); 

if ( DoTextDialog( textHandle ) == kWriteTextOut 

ChangedResource( (Handle)textHandle ); 
WriteResource( (Handle)textHandle ); 

/****************** ToolBoxinit *********************/ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
InitFonts(); 
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InitWindows(); 
InitMenus(); 
TEini t () ; 
InitDialogs( nil); 
InitCursor(); 
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/****************** DoTextDialog *********************/ 

Boolean DoTextDialog( StringHandle textHandle ) 

DialogPtr 
Boolean 
short 
Handle 
Re ct 
Str255 

dialog 

dialog; 
done; 
itemHit, itemType; 
OKitemHandle, textitemHandle; 
itemRect; 
itemText; 

GetNewDialog( kBaseResID, nil, kMoveToFront ); 

GetDitem( dialog, ok, &itemType, &OKitemHandle, 
&itemRect ); 

GetDitem( dialog, iText, &itemType, &textitemHandle, 
&itemRect ); 

HLock( (Handle)textHandle ); 
SetIText( textitemHandle, *textHandle ); 
HUnlock( (Handle)textHandle ); 

Sel!Text( dialog, iText, kMinTextPosition, 
kMaxTextPosition ); 

ShowWindow( dialog); 
SetPort( dialog); 

SetDialogDefaultitem( dialog, ok ); 
SetDialogCancelitem( dialog, cancel); 
SetDialogTracksCursor( dialog, true); 

done = false; 
while ( ! done 

GetIText( textitemHandle, itemText ); 
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if ( itemText[ 0 ] == 0 ) 

else 

HiliteControl( (ControlHandle)OKitemHandle, 
kDisableButton ); 

HiliteControl( (ControlHandle)OKitemHandle, 
kEnableButton ); 

ModalDialog( nil, &itemHit ); 

done = ( (itemHit == ok) I I (itemHit cancel) ) ; 

if ( itemHit == ok ) 

else 

GetIText( textitemHandle, itemText ); 
SetHandleSize( (Handle)textHandle, 

(Size) (itemText [ 0 ] + 1) ) ; 

HLock( (Handle)textHandle ); 
GetIText( textitemHandle, *textHandle ); 
HUnlock( (Handle)textHandle ); 

DisposDialog( dialog); 

return( kWriteTextOut ); 

DisposDialog( dialog); 

return( kDontWriteTextOut ); 

Running ResWriter 

Once you've finished typing in the code, save it as ResWriter. c and 
add it to the project using Rdd from the Source menu. Next, select 
Run from the Project menu, clicking Yes to the question Bring the 
project up to date?. If the source code compiles correctly, a dialog 
box similar to that shown in Figure 7.6 should appear. 

Notice that the dialog's entire text string is highlighted. Hit the 
delete key, leaving the text field empty. Notice that the OK button gets 
dimmed. Type the string Rft er ResW rite r... and press the OK 
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Edit this teHt: 

Before Reslllriter ... 

n OK D ( Cancel ) 

Figure 7.6 ResWriter in action. 

Edit this teHt: 

After ResLUriter ... 

( OK D (Cancel ) 

Figure 7.7 ResWriter after the edited 'STR ' resource is retrieved. 

button. ResWriter will write your edited text string out to the 'STR ' 
resource and then exit. Run ResWriter again. The text you typed 
should appear in the dialog box (Figure 7. 7). 

Click OK to exit ResWriter. Let's take a look at the code. 

Walking Through the ResWriter Code 

As usual, Res Writer starts off with some #def in es. The first two 
should look familiar. 

#define kBaseResID 
#define kMoveToFront 

128 
(WindowPtr) -lL 

I 

i Text represents the item number of the dialog's textedit field. 
kDisableButton and kEnableButton represent the two values ~e11 
pass to HiliteControl () to either enable or disable the OK button. 
kWriteTextOut and kDontWriteTextOut represent the two possible 
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return values of DoTextDialog (). They'll tell us whether we need to 
write the 'STR ' resource back out. Finally, kMinTextPosit ion and 
kMaxTextPosition are used to force highlighting of all text in the 
textedit field in the call to Sell Text (). 

#define iText 4 

#define kDisableButton 255 
#define kEnableButton 0 

#define kWriteTextOut true 
#define kDontWriteTextOut false 

#define kMinTextPosition 0 
#define kMaxTextPosition 32767 

Next come ResWriter's function prototypes. 

/***************/ 
/* Functions */ 

/***************/ 

void 
Boolean 

ToolBoxinit( void); 

DoTextDialog( StringHandle oldTextHandle ); 

The three functions declared next are part of the System 7 Toolbox. 
Unfortunately, these declarations have not yet made their way into 
THINK C. If you are using a newer version of THINK C that contains 
these declarations, feel free to leave these out. 

SetDialogDefaultitem () allows you to specify a dialog's 
default item (usually the OK button). This function automatically 
draws the thick, rounded rectangle around the default item. 
SetDialogCancelitem () allows you to specify a dialog's cancel 
item. After this call is made, typing SC. (Command-period) 
automatically selects the specified cancel item. Finally, 
SetDialogTracksCursor ()enables the Dialog Manager to tie the 
I-beam cursor to any editable text items in a dialog. 

pascal OSErr SetDialogDefaultitem( DialogPtr theDialog, 
short newitem ) = { Ox303C, Ox0304, OxAA68 }; 

pascal OSErr SetDialogCancelitem( DialogPtr theDialog, 
short newitem ) = { Ox303C, Ox0305, OxAA68 }; 
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pascal OSErr SetDialogTracksCursor( DialogPtr theDialog, 
Boolean tracks ) = { Ox303C, Ox0306, OxAA68 }; 

main () starts with a call to ToolBoxini t () . 

/**************************** main ********************~*/ 

void main( void} 

StringHandle textHandle; 
ToolBoxini t (} ; 

Next, GetString () is called to retrieve the 'STR ' resource with 
resource ID kBaseResID. GetString () returns a handle to a 'STR ' 
resource, just as GetPicture () returns a handle to a PICT resource. 

textHandle = GetString( kBaseResID ); 

If the 'STR ' resource wasn't found, ResWriter beeps once, $en 
exits. If this happens, chances are either your resource file wasn't 
found or your ' STR ' resource had the wrong ID. 

if ( textHandle == nil } 

SysBeep( 20 }; 
ExitToShell (); 

i 

Next, DoTextDialog () gets called, bringing up the ResWnter 
dialog. If DoTextDialog () returns a value of kWri teTextOut, 

1 

the 
resource will be written out. The rules for writing out a resource: are 
simple. First, call ChangedResource () to mark the resource as 
changed. WriteResource () will write the resource back out only if it 
was marked as changed. 

if ( DoTextDialog( textHandle ) == kWriteTextOut 

ChangedResource( (Handle)textHandle ); 
WriteResource( (Handle}textHandle ) ; 
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Whenever you call one of the Resource Manager Toolbox routines, 
it's a good idea to follow it up with a call to ResError () . 
ResError () checks the status of the last Resource Manager 
function called and returns an appropriate status message. The 
meaning of the status message depends on the function called. 

As you develop an error-handling strategy for your program, 
you'll want to incorporate the possible errors returned by 
ResError () . To find out more, read Inside Macintosh, Volume I, 
Chapter 5. 

ToolBoxinit () remains the same as in earlier programs. 

/****** ******* ** *** ToolBox init *********************/ 

void ToolBoxinit ( void 

InitGraf( &t heP ort ) ; 
InitFonts() ; 
InitWi ndows (); 

InitMenus () ; 
TEinit () ; 

InitDialogs( nil ) ; 

InitCursor(); 

DoTextDialog () handles the Res Writer dialog. 

/ ****************** DoTextDialog ********************* / 

Boolean DoTextDialog( StringHandle textHandle ) 
{ 

DialogPtr 
Boolean 
short 

Handle 

Re ct 
Str255 

dialog ; 

done; 
itemHit , itemType ; 

OKitemHandle , textitemHandle ; 
itemRect ; 
itemTe x t; 

First, GetNewDialog () is called to load the DLOG resource. 

dialog= GetNewDialog( kBaseResID , nil , kMoveToFront ); 
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Next, GetDitern () is used to retrieve a handle to the OK button 
and textedit field items, placing the handles in the variables 
OKitemHandle and text IternHandle. 

GetDitem( dialog, ok, &itemType, &OKitemHandle, 
&itemRect ); 

GetDitem( dialog, iText, &itemType, &textitemHandle, 

&itemRect ); 

Next, textHandle, the handle to the 'STR ' resource, is locked. 
This is done so the handle can be singly dereferenced. Remen;iber, 
handles are pointers to pointers. If you ever want to singly derefetence 
a handle, make sure you lock it first! ! 

HLock( (Handle)textHandle ); 

Once locked, SetIText () is called to copy the text handled by 
text Handle to the item handled by text ItemHandle. Basically, this 
means that the text in the 'STR ' resource is copied into the dialog's 
textedit item. 

Set!Text( textitemHandle, *textHandle ); 
HUnlock( (Handle)textHandle ); 

Next, Sel!Text () is called to highlight the entire text string. 

Sel!Text( dialog, iText, kMinTextPosition, 
kMaxTextPosition ); 

Now that the dialog is properly set up, make it visible and m¥:e it 
the current port. 

ShowWindow( dialog); 
SetPort( dialog); 

Call the three functions described at the top of the file. 

SetDialogDefaultitem( dialog, ok ); 
SetDialogCancelitem( dialog, cancel); 
SetDialogTracksCursor( dialog, true); 

Next, enter the main dialog loop. At the top of the loop, retrieve the 
text in the textedit item, placing the text into the variable i ternText. 
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done = false ; 

while ( ! done 

GetIText( textitemHandle , itemText ) ; 

If the textedit field is empty, disable the OK button, otherwise 
enable the 0 K button. 

if ( itemText ( 0 ] == 0 l 
HiliteControl( (ControlHandle)OKitemHandle , 

kDisableBu tton ) ; 

else 
HiliteCont rol( (ControlHandle)OKitemHandle , 

kEnableButton ); 

Next, call ModalDialog (), using itemHit to determine if the OK 
or Cancel buttons were hit. Ifso, drop out of the loop. 

ModalDialog( nil , &itemHit ) ; 

done = ( (itemHit == ok) 1 1 (itemHit canc el) l; 

If the OK button was hit, GetIText () is called to retrieve the 
dialog's text, placing the string into the variable i temText . Note that 
this string may be a different length than the text in the original 
' STR ' resource. For example, the word "Before" requires 7 bytes, 
while the word "After" requires only 6 bytes. When the resource was 
first loaded, exactly the right amount of memory was allocated to hold 
the resource. Since the size of the text string may have changed, we'll 
use SetHandleSize () to force the handle to refer to a block of the 
proper size. The Memory Manager takes care of all the details. 

if ( itemHit == ok l 

GetIText( textitemHandle , itemText ) ; 
SetHandleSize( (Handle)textHandle , 

(Size) ( itemText [ C ] + 1) ) ; 

If you're working with a resource of a fixed size (such as an I CON), 
you won't need to call SetHandleSize (), since the resource will 
always be of the right size. On the other hand, if you're not sure 
whether a resource is of a fixed size, call setHandleSize () just 
to be safe. 

l 



Toolbox Potpourri 

_J 

379 

Now that we have a block of memory of the correct size, lock the 
resource handle, call GetIText () to load the text into the newly sized 
resource, and unlock the handle again. 

HLock( (Handle)textHandle ); 
GetIText( textitemHandle, *textHandle ); 
HUnlock( (Handle)textHandle ); 

Finally, dispose of the dialog and return the proper value. 

DisposDialog( dialog); 

return( kWriteTextOut ); 

If the Cancel button was hit, dispose of the dialog and return the 
appropriate value. 

else 

DisposDialog( dialog); 

return( kDontWriteTextOut ); 

The subject of handles and Macintosh memory managemetit in 
general is a complex one. To learn more, check out the Toblbox 
Techniques chapter in Volume II of the Mac Primer. 

Scroll Bars! We're Gonna Do Scroll Bars! 

Scroll bars are a common control used in Macintosh applications. 
This section shows you how to set one up to control paging between a 
series of pictures in a window. 

Making Use of Scroll Bars 

Scroll bars are a common control used in Macintosh applications 
(Figure 7 .8). The routines that create and control scroll bars are! part 

I 

of the Control Manager. The function NewCont rol () is used to create 
a new control: 
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Pager 

Figure 7.8 A Macintosh window with a scroll bar. 

• • 

pascal ControlHandle NewControl( WindowPtr theWindow , 

1111 

mm 

const Rect *boundsRect, ConstStr255Param ti t le , 

Boolean visible , short value, short min , short max, 

short procID,long refCon ); 

The parameter procID specifies the type of control to be created. To 
create a new scroll bar, pass the constant scrol l BarProc to 
NewContro l ( ) . Every scroll bar has a minimum, maximum, and 
current value. For example, a scroll bar may go from I to 20, and 
currently be at 10 (Figure 7.9). 

Position 1 

Thumb at Position 1 O 

Position 20 

Figure 7.9 Scroll bar positioning. 
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Once the scroll bar is created, call DrawControls () to draw it in 
your window: 

pasca l void DrawControls ( WindowPtr theWindow ) ; 

Since Window Manager routines, such as ShowWindow () and 
MoveWindow () , don't automatically redraw controls in a window, 
you'll want to call Drawcontrols () whenever the window receives 
an update event. 

Typically, when a mouseDown event occurs, FindWindow () gets 
called. Findwindow () returns a part code describing the part of the 
window in which the mouseDown occurred. If the mouseDown was 
inContent, call FindControl () : 

pascal short FindControl( Point thePoint, 
WindowPtr theWindow , ControlHandle *theControl ) ; 

Like FindWindow (), FindControl () returns a part code. This 
time, the part code specifies which part of the scroll bar was clicked in 
(Figure 7.10). Pass the part code returned by FindControl () to 
TrackCont rol (): 

pasca l short TrackCont r ol( ControlHandle theControl, 
Point thePoint , ProcPtr a ct ionProc); 

TrackControl () will perform the action appropriate to that part 
of the scroll bar. For example, if the mouseDown was in the thumb of 
the scroll bar, an outline of the thumb is moved up and down (or 
across) the scroll bar until the mouse button is released. Once 
TrackControl () returns, take the appropriate action, depending on 
the new value of the scroll bar. 

Next, let's look at Pager, a program that uses a scroll bar to page 
through a series of PICT resources. 
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up arrow 

i-------lllllll "page up" region 

thumb 

"page down" region 

down arrow 

Figure 7.10 Scroll bar anatomy. 

Pager 

Pager demonstrates the use of scroll bars in a Macintosh application. 
Here's the Pager algorithm: 

• The Toolbox is initialized. 
• A scroll bar is created, using the number of available PI CT 

resources to determine the maximum value of the scroll bar. 
• When a rnouseDown occurs in the scroll bar, Pager loads the 

appropriate PICT and displays the PICT in the window. 
• Pager quits when the close box is clicked. 

Pager also introduces a basic error-handling mechanism, the 
DoError () function. 

Pager Resources 

Create a folder called Pager inside your Development folder. Use 
ResEdit to create a new file called Pager. 7t. rsrc inside the Pager 
folder. Create a WIND resource according to the specifications in 
Figure 7.11. Select Set 'WIND' Characteristics ... from the WIND 
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§0 UJIND ID = 128 from Pager: rr.rsrc 
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Top: IU. I Bottom: ~ 

Left:~ Right: ~ 

Figure 7.11 Pager's WIND specifications. 
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menu, set the Window title: field to Scrolling Pictures, and click 
the OK button. Change the WIND's resource ID to 128 and check the 
purgeable check box. Close the windows associated with the WIND 
resource. 

Next, create a two-item DITL resource using the specifications in 
Figure 7.12. Be sure to enter the text " O (carat-zero) into the Sta tic 
TeHt item's TeHt: field. Our error-handling function will call 
ParamText () to substitute the current error message for the "O. 

Change the DITL's resource ID to 128 and check the purgeable 
check box. Close any windows associated with the DITL. 

Next, use the specifications in Figure 7.13 to create an ALRT 
resource. Make sure to set the 0 Ill ID: field to 128. Change the 
ALRT's resource ID to 128 and check the purgeable check box. Then, 
select Ruto Position ... from the RLRT menu, and set the left pop-up 
to Rlert Position and the right pop-up to Main Screen. Click the 
OK button, then close any windows associated with the ALRT. 
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Edit Dill item #1 from Pager:rr.rsrc 

Te Ht: 

Button ...,. I 

[8] Enabled Top: ._I a_6_~ 

Left: I 117 

Height: 120 
~-~ 

Width: ~16_0 __ 

Edit Dill item #2 from Pager.n.rsrc 

TeHt : 

Static TeHt 

!8l Enabled Top: ._Is_~ 

Le ft: ._I 6_7 _ ___. 

Height: ._I 6_6 _ ___, 

Width: I 216 

Figure 7.12 Specifications for Pager's DITL. Be sure to enter the text "O for 
the Static TeHt item. 

Top: IOu I Bottom: ~ 

Left: ~ Right: ~ 

Color: ® Defoult 
O Custom 

DITL ID: lt28 
~-~ 

Figure 7.13 Specifications for Pager's ALRT resource. 
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Finally, create some PICT resources from your favorite clip art and 
paste them into the Pager.1t.rsrc. Paste in as many as you like. 
Don't worry about changing resource IDs for the PICT resou~ces. 
Pager will display every available PICT, regardless of race, creed, or 
resource ID. When you're done, the resource window of 
Pager .1t. rsrc should look like Figure 7.14. 

Quit ResEdit, saving your changes. 

§0~ Pager.n.rsrc ~BJ§ 
0 

ALRT DITL PICT 

\>/IND 

Figure 7.14 Pager. 7t. rsrc, once all the resources have been created. 

The Pager Project 

Now you're ready to launch THINK C. Create a new project in the 
Pager folder. Call it Pager .1t. Use Rdd ... from the Source menu to 
add MacTraps to the project. 

Once MacTraps is added, open a new source code window and enter 
the program: I 

#include <Values.h> 

#define kBaseResID 
#define kMoveToFront 
#define kScrollBarWidth 
#define kNilActionProc 
#define kSleep 

128 
(WindowPtr)-lL 
16 
nil 
MAXLONG 
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#define kVisible 
#define kStartValue 
#define kMinValue 
#define kNilRefCon 
#define kEmptyTitle 

#define kEmptyString 
#define kNilFilterProc 

#define kErrorAlertID 

true 
1 

1 

OL 
"\p" 

"\p" 
nil 

kBaseResID 

/**************/ 
/* Globals */ 
/**************/ 

Boolean gDone; 

/***************/ 
/* Functions */ 
/***************/ 

void 
void 
void 
pascal 

ToolBoxinit( void); 
Windowlnit( void); 

SetUpScrollBar( WindowPtr window); 
void ScrollProc( ControlHandle theControl, 

partCode ); 
EventLoop( void); 
DoEvent( EventRecord *eventPtr ); 
HandleMouseDown( EventRecord *eventPtr ); 
UpdateWindow( WindowPtr window); 

short 

void 
void 
void 
void 
void 
void 

CenterPict( PicHandle picture, Rect *destRectPtr ); 
DoError( Str255 errorString, Boolean fatal); 

/**************************** main **********************/ 

void main( void 

ToolBoxinit(); 
Windowlni t () ; 

EventLoop(); 
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/****************** ToolBoxinit *********************/ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
InitFonts(); 
!nit Windows () ; 
InitMenus(); 
TEini t () ; 
InitDialogs( nil); 
InitCursor(); 

/******************************** Windowinit ********/ 

void Windowinit( void 

WindowPtr window; 

if ( ( window = GetNewWindow( kBaseResID, nil, 
kMoveToFront } nil 

DoError( "\pCan't Load WIND resource!", true); 

SetUpScrollBar( window); 

ShowWindow( window}; 
SetPort( window); 

I 

/********************************** SetUpScrollBar ******/ 

void SetUpScrollBar( WindowPtr window ) 

Rect vScrollRect; 

short 
Control Handle 

numPictures; 
scrollBarH; 

if ( ( numPictures = CountResources( 'PICT' ) ) <=.O) 
DoError( "\pNo PICT resources were found!", true); 
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vScrollRect = window->portRect; 

vScrollRect.top -= l; 
vScrollRect.bottom += 1; 
vScrollRect.left = vScrollRect.right -

kScrollBarWidth + 1; 
vScrollRect.right += 1; 

scrollBarH = NewControl( window, &vScrollRect, 
kEmptyTitle, kVisible, kStartValue, kMinValue, 
numPictures, scrollBarProc, kNilRefCon ); 

/********************************** ScrollProc *******/ 

pascal void ScrollProc( ControlHandle theControl, short 
partCode ) 

short 
WindowPtr 

maxCtlValue 
curCtlValue 
minCtlValue 

curCtlValue, maxCtlValue, minCtlValue; 
window; 

GetCtlMax( theControl ); 
GetCtlValue( theControl ); 
GetCtlMin( theControl ); 

window (**theControl) .contrlOwner; 

switch partCode ) 

case inPageDown: 
case inDownButton: 

if (. curCtlValue < maxCtlValue 

curCtlValue += 1; 
SetCtlValue( theControl, curCtlValue ); 
UpdateWindow( window); 

break; 
case inPageUp: 
case inUpButton: 

if ( curCtlValue > minCtlValue 

curCtlValue -= 1; 
SetCtlValue( theControl, curCtlValue ); 
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UpdateWindow( window); 

/****************** EventLoop ***********************/ 

void EventLoop( void ) 

Event Record event; 

gDone false; 

while ( gDone == false ) 
{ 

if ( WaitNextEvent( everyEvent, &event, kSleep, 
nil ) ) 

DoEvent( &event); 

/****************** DoEvent ***********************/ 

void DoEvent( EventRecord *eventPtr ) 

WindowPtr window; 

switch ( eventPtr->what 
{ 

case mouseDown: 
HandleMouseDown( eventPtr ); 
break; 

case updateEvt: 
window = (WindowPtr)eventPtr->message; 

BeginUpdate( window); 
DrawControls( window); 
UpdateWindow( window); 
EndUpdate( window); 
break; 
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/****************** HandleMouseDown *********************/ 

void HandleMouseDown( EventRecord *eventPtr ) 

WindowPtr 
short 
Point 

window; 
thePart; 
thePoint; 
theControl; Control Handle 

thePart = FindWindow( eventPtr->where, &window); 
switch ( thePart ) 
{ 

case inSysWindow 
SystemClick( eventPtr, window); 
break; 

case inDrag : 
DragWindow( window, eventPtr->where, 

&screenBits.bounds ); 
break; 

case inContent: 
thePoint = eventPtr->where; 
GlobalToLocal( &thePoint ); 

thePart = FindControl( thePoint, window, 
&theControl ); 

if theControl == 

((WindowPeek)window)->controlList 

if ( thePart == inThumb ) 

else 

break; 

thePart = TrackControl( theControl, 
thePoint, kNilActionProc ); 

InvalRect( &(window->portRect) ); 

thePart = TrackControl( theControl, 
thePoint, &ScrollProc ); 

case inGoAway 
gDone = true; 
break; 
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/********************************** UpdateWindow *******/ 

void UpdateWindow( WindowPtr window 

PicHandle 
Re ct 
RgnHandle 

currentPicture; 
windowRect; 
tempRgn; 

tempRgn = NewRgn(); 
GetClip( tempRgn }; 

windowRect = window->portRect; 
windowRect.right -= kScrollBarWidth; 
EraseRect( &windowRect ); 

ClipRect( &windowRect ); 

currentPicture = (PicHandle)GetindResource( 'PICT', 
GetCtlValue( ((WindowPeek}window)-> 

controlList ) } ; 

if ( currentPicture == nil 
DoError( "\pCan't Load PICT resource!", true); 

CenterPict( currentPicture, &windowRect ); 
DrawPicture( currentPicture, &windowRect ); 

SetClip( tempRgn ); 
DisposeRgn( tempRgn ); 

/****************** CenterPict ********************/ 

void CenterPict( PicHandle picture, Rect *destRectPtr 

Rect windRect, pictRect; 

windRect = *destRectPtr; 
pictRect = (**(picture)) .picFrame; 
OffsetRect( &pictRect, windRect.left - pictRect.left, 

windRect.top - pictRect.top); 

OffsetRect( &pictRect, (windRect.right -
pictRect.right)/2, (windRect.bottom -

pictRect.bottom)/2); 

*destRectPtr pictRect; 
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/ ***************** DoError ******************** / 

void DoError( Str255 errorString, Boolean fatal 

ParamText ( errorSt ring , kEmptySt r ing , kEmptyStr i ng , 
kEmptyString ) ; 

StopAlert( kError Al ertID , kNi l FilterProc ) ; 

if ( fatal 
Ex itToShell (); 

Running Pager 

Once you've finished typing in the code, save it as Pager . c and add it 
to the project using Add from the Source menu. Next, select Run from 
the Project menu, clicking Yes to the question Bring the project 
up to date?. If the source code compiles correctly, a scrolling window 
similar to the one shown in Figure 7.15 should appear. 

Drag the window around on the screen. Click on the arrows at each 
end of the scroll bar. Pager will scroll through your pictures one at a 
time. Click in t he gray paging regions. This will cause Pager to scroll 
as well. Click and drag the scroll bar's thumb. Releasing the thumb at 
the top of the scroll bar will move Pager to the first picture. Dragging 
the thumb to the bottom of the scroll bar will move Pager to the last 
picture. Any position in between will scroll to the appropriate picture. 

D Scrolling Pictures 

Downtown Office Occupancy Rate 
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17i7ss~iiiiiiii1i11111 
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Figure 7.15 Pager in action. 



Toolbox Potpourri 

_J 

393 

l 
You may have noticed a few unexpected pictures in your scrolling 
window. Here's why. 

Every application has access to resources from two different 
places: the resource fork of the application itself, and the resource 
fork of the system file. In addition, an application may use the 
Resource Manager to open additional resource files. When looking 
for a resource, the Resource Manager searches the most recently 
opened resource file first. 

l l 
When you're done admiring your handiwork, click on the close box 

to exit Pager. Let's take a look at the code. 

Walking Through the Pager Code 

Pager starts with a single #inc l ude. Va l ues . h contains the #define 
MAXLONG, defined as the largest possible long. We use MAXLONG 
to #define kSleep, maximizing our WaitNextEvent () sleep time. 
kBaseResID and kMoveToFront should look familiar. 
kScrollBarWidth defines the width of a scroll bar in pixels. 
kNilActionProc is passed to TrackControl () a bit later in the 
program. 

#include <Values . h> 

#define kBaseResID 

#define kMoveToFront 
#define kScroll BarWidt h 
#define kN i lAction Proc 
#defi ne kSleep 

128 

(WindowPtr) -11 
16 

nil 
MAX LONG 

The next five #defines are used in the call to NewControl () in 
the function SetUpScrollBar (). 

#defi ne kVisibl e true 

#defi ne kStartValue 1 

#define kMinVa l ue 1 

#define kNilRefCon OL 
#define kEmptyTi t l e " \p " 
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kEmptyString is used as a parameter to ParamText {) and 
kNilFilterProc and kErrorAlertID are used as parameters to 
StopAlert {). Both of these calls are made in t~e function 
DoError {). 

#define kEmptyString 
#define kNilFilterProc 

#define kErrorAlertID 

"\p" 
nil 

kBaseResID 

gDone plays its usual role, triggering the end of the main event 
loop. 

/**************/ 
/* Globals */ 
/**************/ 

Boolean gDone; 

Next come Pager's function prototypes. 

/***************/ 
I* Functions */ 
/***************/ 

void 
void 
void 
pascal 

ToolBoxinit( void); 
Windowinit( void); 
SetUpScrollBar( WindowPtr window); 

void ScrollProc( ControlHandle theControl, 
partCode }; 

EventLoop( void}; 
DoEvent( EventRecord *eventPtr ); 

HandleMouseDown( EventRecord *eventPtr ); 
UpdateWindow( WindowPtr window); 

short 

void 
void 
void 
void 
void 
void 

CenterPict( PicHandle picture, Rect *destRectPtr ); 
DoError( Str255 errorString, Boolean fatal); 

main() calls ToolBoxini t {) and Windowini t {), then enters the 
main event loop. 
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/**************************** main ********************~*/ 

void main( void 

ToolBoxini t () ; 
Windowlnit(); 

EventLoop(); 

Nope. Still looks the same. 

/****************** ToolBoxinit *********************/ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
InitFonts(); 
InitWindows(); 
Ini tMenus () ; 
TEini t () ; 
InitDialogs( nil); 
InitCursor(); 

I 

Windowinit () loads the WIND resource. If the resource wasn't 
found, an appropriate error message is passed to DoError () . Next, 
SetUpScrollBar () creates the Pager scroll bar. ShowWindow () 
makes the window visible, and Set Port () makes it the current port. 

/******************************** Windowlnit *********/ 

void Windowinit( void 

WindowPtr window; 

if ( ( window ; GetNewWindow( kBaseResID, nil, 
kMoveToFront ) nil 

DoError( "\pCan't Load WIND resource!", true ); 

SetUpScrollBar( window); 

ShowWindow( window); 
SetPort( window); 
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Set UpScrollBar () calls CountResources () to find out how 
many PICT resources are available. 

To work with PICTs in the current resource file only, use the functions 
CountlResources () and GetlindResource (), described in 
(IV:15). CountlResources () and GetlindResource () are iden­
tical to the functions CountResources () and GetindResource () 
in every other aspect. 

/* ***************** ****************SetUpScrollBar *******/ 

void SetUpScrollBar ( WindowPtr window ) 

Rect vScrollRect ; 
s hort 
Control Handle 

n umPictures ; 
scrollBarH; 

if ( ( numPictur es = CountResources( ' PICT ' ) ) <= 0 ) 
DoError( " \ pNo P I CT resources were found! ", true) ; 

If no PICT resources are available, DoError () is called. Otherwise, 
SetUpScrollBar () creates a Rect the proper size for the scroll bar, 
then creates the scroll bar with a call to NewControl () .The scroll bar 
is attached to window, bounded by vScrollRect. Since a scroll bar's 
title is never used, kEmptyTitle does the job adequately. 

The scroll bar ·will be visible and will range in value from 
kMinValue to numPictures, the number of available PICT resources. 
kStartValue is the initial value of the scroll bar and determines the 
initial position of the scroll bar thumb. scrollBarProc tells 
NewControl () to create a scroll bar, as opposed to some other type of 
control. The final parameter is a reference value available for your 
application's convenience. You can use these 4 bytes as scratch pad 
space. 

vScrollRect = window- >portRect ; 
vScrollRect . top -= l ; 
vScrollRect . bottom += l; 
vScrollRect . left = vScrol lRect . right -

kScrollBarWidt h + l; 
vScrollRect . right += l ; 



Toolbox Potpourri 397 

scrollBarH = NewControl( window, &vScrollRect, 
kEmptyTitle, kVisible, kStartValue, kMinValue, 
numPictures, scrollBarProc, kNilRefCon ); 

ScrollProc () gets called whenever a mouseDown occurs in the 
page-up, page-down, up-arrow, or down-arrow region of the scroll bar. 
As you'll see, our code doesn't call ScrollProc () directly. Instead, a 
pointer to the function ScrollProc () is passed as a parameter to 
TrackControl () after the mouseDown is detected. TrackContrc>l () 
will continue calling ScrollProc () as long as the mouse button 
remains down. 

/********************************** ScrollProc *******/ 

pascal void ScrollProc( ControlHandle theControl, short 1 

partCode ) 

short 
WindowPtr 

curCtlValue, maxCtlValue, minCtlValue; 
window; 

A handle to the scroll bar is passed in to ScrollProc () as i the 
parameter theControl. partCode indicates the scroll bar part 
currently being clicked on. 

maxCtlValue, curCtlValue, and minCtlValue are set to the 
maximum, current, and minimum values of theControl. window is 
set to the scroll bar's owning window, which happens to be Pager's 
only window. 

maxCtlValue 
curCtlValue 
minCtlValue 

GetCtlMax( theControl ); 
GetCtlValue( theControl ); 
GetCtlMin( theControl ); 

window = (**theControl) .contrlOwner; 

If the mouse click was inPageDown or inDownButton, increase!the 
value of the control by 1. If the mouse click was inPageUp or 
inUpBut ton, decrease the value of the control by 1. In either case, if 
the scroll bar's value was changed, UpdateWindow () is called to draw 
the current picture. 

switch ( partCode 
{ 

case inPageDown: 
case inDownButton: 
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curCtlValue < maxCtlValue 

curCtlValue += l ; 

SetCtlValue( theControl , curCtlValue ); 
UpdateWindow( window) ; 

break ; 

case inPageUp : 

case inUpButton : 
if ( curCtlValue > minCtlValue 

curCtlValue -= l ; 
SetCtlValue( theControl , curCtlValue ) ; 

UpdateWindow( window) ; 

User interface issue: Notice that if the scroll bar's thumb is at the top 
and you click the up arrow, nothing happens. This algorithm avoids 
the annoying "bouncing" effect of a scroll bar who's thumb is at the 
end of its travel. 

..::. . 
Event Loop ( ) works much the same as in earlier Primer programs. 

/************** ** ** EventLoop ********************* **/ 

void EventLoop( void ) 

EventRecord event ; 

gDone false ; 

while gDone == false ) 

if ( WaitNextEvent( everyEvent , &event , 

kSleep , nil ) ) 
DoEvent( &event ) ; 
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DoEvent () acts as a dispatcher for rnouseDown and updateEvts. 
rnouseDowns are handled by HandleMouseDown () . 

/****************** DoEvent ***********************/ 

void DoEvent( EventRecord *eventPtr) 

WindowPtr window; 

switch ( eventPtr->what 
{ 

case mouseDown: 
HandleMouseDown( eventPtr ); 
break; 

In the case of an updateEvt, BeginUpdate () is called. Then, all of 
the window's controls are redrawn via a call to DrawControls ().In 
this case, the Pager window has a single control, the scroll bar. Next, 
UpdateWindow () is called to draw the current picture. Finally, the 
update ends with the usual call to EndUpdate () . 

case updateEvt: 
window ; (WindowPtr)eventPtr->message; 

BeginUpdate( window); 
DrawControls( window); 
UpdateWindow( window); 
EndUpdate( window); 
break; 

HandleMouseDown () looks the same at the start: 

/****************** HandleMouseDown *********************/ 

void HandleMouseDown( EventRecord *eventPtr ) 

WindowPtr 
short 
Point 
ControlHandle 

window; 
thePart; 
thePoint; 
theControl; 
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thePart = FindWindow( eventPtr->where, &window); 
switch ( thePart ) 

case inSysWindow 
SystemClick( eventPtr, window); 
break; 

case inDrag : 
DragWindow( window, eventPtr->where, 

&screenBits.bounds ); 
break; 

The big change comes when a mouseDown occurs in the content 
region (inContent) of the Pager window. The mouseDown's location 
(eventPtr->where) is copied into a local variable (thePoint), then 
translated into the window's local coordinate system. 

case inContent: 
thePoint = eventPtr->where; 
GlobalToLocal( &thePoint ); 

The localized point is passed to FindControl (), which returns a 
handle to the selected control (in the parameter theControl) and a 
part code indicating what part of the control was selected. 

thePart = FindControl( thePoint, window, 
&theControl ) ; 

The WindowPeek field controlList is a handle to the first control 
in the window's control list. Since the Pager window contains only a 
single control, we can use this field to tell if the control found by 
FindControl () was indeed the scroll bar. 

if theControl == 
((WindowPeek)window)->controlList 

If theControl is your scroll bar, find out if it was in the thumb. If 
it was, call TrackControl () to drag an outline of the thumb up and 
down the scroll bar. When the thumb is released, force an update 
event, so the Pager window will be redrawn using the new control 
value. 
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if ( thePart == inThumb ) 

thePart = TrackControl( t heControl , 

thePoint , kNilActionProc ) ; 
InvalRect ( &(window->portRect) ) ; 

If any other part of the control was used, call TrackControl () 
with a pointer to ScrollProc ( ) . TrackControl ( ) maintains control 
until the mouse button is released. 

l 

When we pass the address of ScrollProc () to 
TrackControl () , we're asking TrackControl () te call 
ScrollProc ( ) directly. In this case, ScrollProc () is known as 
a call-back function. Whenever the Toolbox calls a call-back 
function, it uses the Pascal standards for passing parameters on the 
stack. That's why the pas cal keyword had to be used in 
ScrollProc ( ) 's declaration. 

Use a call-l:>ack with TrackControl () if you want to act on the 
control while the mouse button is still down, as in this case, where 
we continuously scroll while the mouse is down in the down arrow. If 
you pass nil as the call-back address, the control will animate, but 
its value will not change until the mouse button is released. 

1 

else 
thePart TrackControl( theControl, 

thePoint, &ScrollProc ) ; 

break; 
case inGoAway 

gDone = true; 
break; 

UpdateMyWindow () starts by creating a new region. The window's 
clip region is copied into this region using GetClip (). 
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/ *x******************************** UpdateWindow *******/ 

void UpdateWindow( WindowPtr window 

PicHandle 

Re ct 
RgnHandle 

currentPicture; 
windowRect ; 

tempRgn ; 

tempRgn = NewRgn() ; 

GetClip( tempRgn ) ; 

Then, the window's content region, minus the area covered by the 
scroll bar, is erased. 

windowRect = window- >portRect ; 

windowRect . right - = kScrollBarWidth ; 

EraseRect( &windowRect ) ; 

Next, the clip region is set to this adjusted rectangle. 

ClipRect( &windowRect ) ; 

After that, GetCtlValue () is used to retrieve the scroll bar's 
current value, which is used to load the appropriate PICT resource. 

For example, if there were 30 PICT resources available, the scroll 
bar would run from 1 to 30. If the current thumb setting was 10, the 
call to GetindResource () would return a handle to the tenth 
PICT resource. Since Getin dResou rce () returns a handle, you 
can use C's typecasting mechanism to convert it to a P i cHandle. 

Note that only one PICT at a time is ever loaded into memory. 
When the scroll bar's value changes, a replacement PICT is loaded, not 
an additional one. 

curre ntPicture (PicHandle)GetindResource( ' PI CT ', 
GetCtlValue ( ( (WindowPeek)window) - >controlList) ) ; 

If the PICT cannot be loaded, an appropriate message is passed to 
DoError () . Otherwise, the picture is centered and drawn, and the 
original clip region is restored. 
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If we hadn't limited the clip region, a large enough picture would 
have obscured the scroll bar. If the original clip region was not 
restored, any attempts to redraw the scroll bar (when its value 
changed, for example) would be clipped. Try itl 

T 
if ( currentPicture == nil ) 

DoError ( " \pCan ' t Load PICT resource ! ", true ) ; 

CenterPict( c ur rentPicture, &windowRect ) ; 
DrawPicture( currentPicture , &windowRect ) ; 

SetClip ( tempRgn ); 
DisposeRgn( t empRgn ) ; 

CenterPict () is the same as it ever was. 

/ ****************** CenterPict ******************** / 

void Cente rPict ( PicHandle p icture , Rect *destRectPtr 

Rect windRect , pictRect; 

windRect = *destRec t Pt r; 
pictRect = (** (picture)) . picFrame; 
OffsetRect( &pictRect , windRect . left - pictRect.lef t , 

windRect . top - pictRect.top) ; 

OffsetRect ( &pictRect , (windRect.right -
pictRect . right) /2 , (windRect . bottom -
pictRect . bottom) /2 ); 

*destRectPtr = pictRect ; 

DoError () takes two parameters. The first is the error string. 
DoError () will use ParamText () to place the error string into the 
alert brought up by StopAlert () . If the second parameter is true , 
DoError () will exit to the Finder. 
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We'll use DoError () throughout the rest of the chapter. Though 
DoError () is effective for our purposes, it represents a fairly 
simple error-handling strategy. As your programs get larger, you'll 
want to implement your own error-handling scheme. 

/***************** DoError ******************** / 

void DoError( Str255 errorString, Boolean fatal 

ParamText( errorString, kEmptyString , kEmptyString , 
kEmptyString ) ; 

StopAlert( kErrorAlertID, kNilFilterProc ) ; 

if ( fatal 
ExitToShell (); 

The Scrap Manager 

Whenever you use the Mac's copy, cut, or paste facilities, you're 
making use of the Scrap Manager. The Scrap Manager manages the 
desk scrap, more commonly known as the Clipboard. Our next 
program, ShowClip, will use the Scrap Manager Toolbox routines to 
open the Clipboard and display the contents in a window. 

Scrap Manager Basics 

Data copied to the desk scrap is stored in two basic flavors, TEXT and 
PICT. Data stored in TEXT format consists of a series of ASCII 
characters. Data stored in PICT format consists of a QuickDraw 
picture. ShowClip will handle both TEXT and PICT data types. 

The desk scrap normally resides in memory. If space is tight, 
however, the Scrap Manager can create a temporary file to write the 
scrap out to disk. 

The Scrap Manager consists of six routines: InfoScrap (), 
UnloadScrap (), LoadScrap() , ZeroScrap() , PutScrap() , and 
Get Scrap () . With the exception of InfoScrap (), each of these 
functions returns a long containing a result code (!:457). 
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When your application processes a Cut or Copy command, you'll 
want to write the cut or copied data to the desk scrap. You'll call 
ZeroScrap () to initialize the scrap, and Put Scrap () to load the 
data into the scrap. Similarly, you'll use GetScrap () to load data 
from the scrap in response to a Paste command. 

You can use InfoScrap () to find out if the scrap is currently 
resident in memory. If so, you can call UnloadScrap () to write the 
scrap back out to disk. Conversely, you can call LoadScrap () to load 
a disk-based scrap back into memory. 

Here's a little more detail on the six Scrap Manager routines. 

InfoScrap() 

InfoScrap () returns a pointer to a struct of type ScrapStuff: 

typedef struct 
{ 

long 
Handle 

ScrapStuff 

scrapSize; 
scrapHandle; 

int scrapCount; 
int scrapState; 
StringPtr scrapName; 
ScrapStuff, *PScrapStuff; 

A ScrapStuff struct contains information about the current scrap. 
The scrapSize field contains the actual size, in bytes, of the desk 
scrap. The scrapHandle field contains a handle to the desk scrap (if 
it currently resides in memory). The scrapCount field is changed 
every time ZeroScrap () is called (we'll get to ZeroScrap () later). 
The scrapState field is positive if the desk scrap is memory resident, 
zero if the scrap is on disk, and negative if the scrap has not yet been 
initialized. The scrapNarne field contains a pointer to the name of the 
scrap disk file (usually called the Clipboard file). 

UnloadScrap() and LoadScrap() 

If the scrap is currently in memory, UnloadScrap () copies the scrap 
to disk and releases the scrap's memory. If the scrap is currently disk­
based, UnloadScrap () does nothing. 

If the scrap is currently on disk, LoadScrap () allocates memory 
for the scrap and copies it from disk. If the scrap is currently memory 
resident, LoadScrap () does nothing. 
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Zero Scrap() 

If the desk scrap does not yet exist, zeroScrap () creates it in 
memory. If it does exist, ZeroScrap () clears it. As we mentioned 
before, ZeroScrap () always changes the scrapCount field of the 
ScrapStuff struct. 

PutScrap() 

Put Scrap () puts the data pointed to by source into the scrap: 

long PutScrap( long length, ResType theType, Ptr source 

The parameter length specifies the length of the data, and 
theType specifies its type (PICT or TEXT, for example). You must call 
ZeroScrap () immediately before each call to Put Scrap (). 

GetScrap() 

Get Scrap() resizes the handle hDest and stores a copy of the scrap 
in this resized block of memory: 

long GetScrap( Handle hDest, ResType theType, long *offset ) 

Specify the type of data you want to retrieve in the parameter 
theType. The offset parameter is set to the returned data's offset in 
bytes from the beginning of the desk scrap. Get Scrap () returns a 
long containing the length of the data in bytes. 

You can actually put and get data types other than TEXT and PICT 
to and from the scrap (I:461). For the most part, however, the TEXT 
and PICT data types should serve your needs. 

ShowClip 

ShowClip demonstrates scrap handling basics. If you use Cut or Copy 
to move some text or a picture to the scrap, ShowClip will display the 
cut or copied data in a window. ShowClip works like this: 

• Initializes the Toolbox. 
• Initializes a window. 
• Retrieves whatever data is in the scrap, drawing the data in the 

window. 
• Waits for a mouse click to exit. 

ShowClip also does error checking. It warns if the WIND resource is 
missing, or if the scrap is empty. 
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ShowClip Resources 

Create a folder called ShowClip inside your Development folder. Use 
ResEdit to create a new file called ShowClip .1t. rsrc inside the 
ShowClip folder. Since ShowClip uses the same error-handling 
mechanism as Pager, open the file Pager . n. rsrc and copy both the 
ALRT and the DITL resources, pasting them in ShowClip . n . rsrc. 

Next, create a WIND resource according to the specifications in 
Figure 7.16. Select Set 'WI ND' Characteristics ..• from the WI ND 
menu, set the Window title: field to Clipboard, and click the OK 
button. Change the WIND's resource ID to 128 and check the 
purgeable check box. Close the windows associated with the WIND 
resource. 

Quit ResEdit, saving your changes. 

WIND ID = 128 from ShowClip.n.rsrc 

LJbCLJDDLJ [][] 
Color: ® Default 

O Custom 

Top: !Ou I Bottom: ~ 

Left: ~ Right: ~ 

D Initially uisible 

D Close boH 

F igure 7.16 Specifications for the WIND resource. 

The ShowClip Project 

Now you're ready to launch THINK C. Create a new project in the 
ShowClip folder. Call it ShowClip . n. Use Add ... from the Source 
menu to add MacTraps to the project. 

Once MacTraps is added, open a new source code window and enter 
the program: 

#define kBaseResID 
#define kMoveToFront 

128 
(WindowPtr) - 11 
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#define kEmptyString 
#define kNilFilterProc 

#define kErrorAlertID 

/***************/ 
/* Functions */ 
/*****~*********/ 
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"\p" 
nil 

kBaseResID 

void 
void 
void 
void 
void 

ToolBoxinit( void); 
Windowinit( void); 
MainLoop( void); 

CenterPict( PicHandle picture, Rect *destRectPtr ); 
DoError( Str255 errorString, Boolean fatal); 

/****************** main ***************************/ 

void main( void 

ToolBoxinit(); 
Windowinit(); 
MainLoop(); 

/****************** ToolBoxinit *********************/ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
InitFonts(); 
InitWindows(); 
Ini tMenus () ; 
TEinit (); 
InitDialogs( nil); 
InitCursor(); 
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/****************** Windowlnit ***********************/ 

void Windowlnit( void 

WindowPtr window; 

window= GetNewWindow( kBaseResID, nil, kMoveToFront ); 

if ( window == nil ) 
I 

DoError( "\pCan't load the WIND resource!", truJ ); 

ShowWindow( window); 

SetPort( window); 

/******************************** MainLoop *********/ 

void MainLoop( void } 

Re ct 

Handle 

long 

WindowPtr 

clipHandle 

pictureRect; 

clipHandle; 

length, offset; 

window; 

NewHandle( 0 ); 

window= FrontWindow(); 

if ( ( length= GetScrap( clipHandle, 'TEXT', &offs~t 

) ) < 0 ) 

if ( GetScrap( clipHandle, 'PICT', &offset ) < 0 ) 

DoError( 

else 

"\pThere's no PICT and no text in the scrap; .. " 

, true}; 

pictureRect = window->portRect; 
CenterPict( (PicHandle}clipHandle, 

&pictureRect ); 

DrawPicture( (PicHandle)clipHandle, 

&pictureRect ); 
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else 
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HLock( clipHandle }; 

TextBox( *clipHandle, length, &(window->portRect), 
teJustLeft ); 

HUnlock( clipHandle }; 

while ( ! Button(} ) 

/****************** CenterPict ********************/ 

void CenterPict( PicHandle picture, Rect *destRectPtr 

Rect windRect, pictRect; 

windRect = *destRectPtr; 
pictRect = (**(picture }) .picFrame; 
OffsetRect( &pictRect, windRect.left - pictRect.left, 

windRect.top - pictRect.top); 
OffsetRect( &pictRect, (windRect.right -

pictRect.right)/2, 
(windRect.bottom -
pictRect.bottom)/2); 

*destRectPtr pictRect; 

/***************** DoError ********************/ 

void DoError( Str255 errorString, Boolean fatal 

ParamText( errorString, kEmptyString, kEmptyString, 
kEmptyString ); 

StopAlert( kErrorAlertID, kNilFilterProc ); 

if ( fatal 
Exit ToShell (); 
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Running ShowClip 

Once you've finished typing in the code, save it as ShcwClip . c and 
add it to the project using Rdd from the Source menu. Before you run 
the program, however, do a Cut or Copy operation on the 
ShowClip . c file, or copy a picture from the Scrapbook; otherwise, 
you'll get an alert telling you that the scrap is empty. Now, select Run 
from the Project menu, clicking Yes to the question Bring the 
project up to date?. ShowClip should bring up a window 
displaying the text or picture that you cut or copied (Figure 7 .17). 

#define kBaseRes ID 
#define kMoveToFront 

#define kEmptyStri ng 
#define kNi 1Fi1 terProc 

Clipboard 
128 

(Wi ndowPtr)- 1 L 

"\p" 
ni 1 

Figure 7.17 ShowClip in action. r1 
Quit by clicking the mouse. Take ShowClip out for a test drive. Try 

copying a color PICT and then running ShowClip. Try out some 
varying sizes and styles of text. Hmmm, color pictures seem to work 
all right, but all of the text appears in a single font, size, and style. 

Take a look at the code and you'll see why. 

Walking Through the ShowClip Code 

ShowClip starts with a subset of the #defines used in Pager . c. 

#define kBaseResID 
#define kMoveToFront 

128 
(WindowPtr)-lL 
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#define kEmptyString 

#define kNilFilterProc 

#define kErrorAlertID 
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"\p" 
nil 

kBaseResID 

As usual, each function is prototyped. 

/***************/ 
/* Functions */ 
/***************/ 

void 
void 
void 
void 
void 

ToolBoxinit( void); 
Windowinit( void); 
MainLoop( void); 
CenterPict( PicHandle picture, Rect *destRectPtr ); 
DoError( Str255 errorString, Boolean fatal); 

Just as in Pager, main() initializes the Toolbox, loads the window, 
then enters the main event loop. 

/****************** main ***************************/ 

void main( void 

ToolBoxinit (); 
Windowinit(); 
MainLoop{); 

There aren't any changes in ToolBoxinit (): 

/****************** ToolBoxinit *********************/ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
InitFonts(); 
InitWindows (}; 
InitMenus(); 
TEini t () ; 
InitDialogs( nil ); 
InitCursor(); 
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Windowinit () loads the WIND resource. If it can't be loaded, 
DoError () is called. 

/****************** Windowinit ***********************/ 

void Windowinit( void 

WindowPtr window; 

window= GetNewWindow( kBaseResID, nil, kMoveToFront ); 

if ( window == nil ) 
DoError( "\pCan't load the WIND resource!", true); 

ShowWindow( window); 
SetPort( window); 

MainLoop () is where the action is. You use NewHandle () (11:32) to 
create minimum-sized blocks of storage for your PICT or TEXTi data. 
Gets crap ( ) will resize these memory blocks for you, as needed. : 

/******************************** MainLoop *********/ 

void MainLoop( void ) 

Re ct pictureRect; 
Handle clipHandle; 
long length, offset; 
WindowPtr window; 

clipHandle NewHandle( 0 ) ; 

Since ShowClip has only a single window, we know• that 
Front Window () will return a pointer to it. 

window= FrontWindow(); 

The call to GetScrap () looks in the desk scrap for some TEX'!'. data. 
!fit can't find any, GetScrap () will return a negative result. 

if ( ( length= GetScrap( clipHandle, 'TEXT', &offset 
) ) < 0 ) 
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In that case, we'll call GetScrap () again, looking for some PICT 
data. If that fails, call DoError () with an appropriate message. 

if ( Get Scrap ( clipHandle , ' PICT ' , &offset ) < O ) 
DoError ( 

" \pThere ' s no PICT and no text in the scrap ... " 
, true ); 

If we found some PI CT data, center it and draw it in the ShowClip 
window. 

else 

pictureRect = window->portRect ; 

CenterPict ( (PicHandle)clipHandle , 

&pictu reRect ) ; 

DrawPicture (P icHandle) clipHandle , 

&pictureRect ) ; 

If we found the TEXT data in the scrap, lock clipHandle with 
Hloc k ( ) , then call Text Bo x ( ) to draw the text in the ShowClip 
window. After that, unlock the block with a call to clipHandle. 

else 

HLock( clipHandle ); 

TextBox ( *clipHandle , length , &(window- >portRect) , 

teJustLeft ) ; 
HUnlock( clipHandle ) ; 

Here's the answer to an earlier question. All text appears in a single 
font, size, and style, in part because all of ShowClip's text drawing 
is done via Te x t Box ( l . Even more important is the fact that TEXT 
data in the scrap has no special formatting information embedded 
with it. If you want to copy and paste formatted text, you'll have to 
create your own scrap type or, better yet, make use of some third 
party's predefined type. 
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Finally, wait for a mouse click to exit. 

while ( ! But ton() ) ; 

CenterPict () is the same routine you've used in the other Primer 
PICT drawing programs: 

/****************** CenterPict *******************~ / 

void CenterPict( PicHandle picture , Rect *destRectPtr 

Rect windRect, pictRect; 

windRect = *destRectPtr; 
pictRect = (**(picture )) . picFrame; 

OffsetRect( &pictRect, windRect . left - pictRect. left, 
windRect.top - pictRect . top) ; 

OffsetRect( &pictRect , (windRect . right -
pictRect . right) /2 , 

(windRect . bottom -
p ictRect.boctom)/2); 

*destRectPtr pictRect ; 

DoError ( ) is the same as the one foun d in Pager. 

/***************** DoError ******************** / 

void DoError( Str255 errorString, Boolean fatal 

ParamText( errorString, kEmptyString , kEmptyStr ing , 
kEmptyString ); 

StopAlert( kErrorAlertID , kNilFilterProc ) ; 

if ( fatal 
ExitToShell () ; 

For a more sophisticated example of proper desk scrap handling, 
check out the FormEdit program in Volume II of the Macintosh C 
Programming Primer. 
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The Sound Manager 

As anyone who's ever fired up a MacRecorder will agree, recording and 
playing back your own sounds on the Mac is fun. Nowadays, most 
Macs come with a built-in sound recording capability. System 7 
includes some Toolbox routines that, combined with the appropriate 
hardware, will allow you to play and record from within your own 
applications. Our next program will show you how. 

SoundMaker 

System 7's Sound Manager includes a new function called 
SndRecord (). SndRecord () puts up the dialog box shown in Figure 
7 .18, automating the process of recording sounds. To record a sound 
via SndRecord () , you'll need a Mac with sound recording hardware 
(either built in or by way of a third-party solution like MacRecorder). 

Once your Mac is suitably equipped, you're ready to program! 

a~OTim <]> 
Record Stop Pause Play ( Cancel ) 

( ) :02 Saue 
0 seconds :15 

Figure 7.18 Using SndRecord () to record a sound. 

SoundMaker Resources 

Sound.Maker makes use of two resources, the ALRT and DITL used by 
DoError (). Create a folder called SoundMaker inside your 
Development folder. Use ResEdit to create a new file called 
SoundMaker. 7t. rsrc inside the SoundMaker folder. Open the file 
Pager. 7t. rsrc and copy both the ALRT and the DITL resources, 
pasting them in SoundMaker. 7t. rsrc. 

Quit ResEdit, saving your changes. 
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The Sound.Maker Project 

Launch THINK C and create a new project in the SoundMaker folder. 
Call it SoundMaker .1t. Use Rdd ... from the Source menu to add 
MacTraps to the project. 

Once MacTraps is added, open a new source code window and enter 
the program: 

#include <Sound.h> 
#include <Soundinput.h> 

#include <GestaltEqu.h> 

Jfdef ine kBaseResID 

Jfdef ine kNilSoundChannel 
#define kSynchronous 

#define kEmptyString 

#define kNilFilterProc 

#define kErrorAlertID 

/***************/ 
/* Functions */ 
/***************/ 

128 

nil 

false 

"\p" 

nil 

kBaseResID 

void 

Handle 

void 

void 

ToolBoxinit( void); 

RecordSound( void); 
PlaySound( Handle soundHandle ); 

DoError( Str255 errorString, Boolean fatal); 

/**************************** main **********************/ 

void main( void ) 

Handle soundHandle; 
long feature; 

OSErr err; 

MaxApplZone (); 

ToolBoxinit(); 
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err= Gestalt( gestaltSoundAttr, &feature); 

if ( err != noErr ) 
DoError( "\pError returned by Gestalt!", true); 

if ( feature & (1 << gestaltHasSoundinputDevice) 

else 

soundHandle = RecordSound(); 
PlaySound( soundHandle ); 
DisposHandle( soundHandle ); 

DoError( "\pSound input device not available!!!", 
true); 

/****************** ToolBoxinit *********************/ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
Ini tFonts () ; 
InitWindows (); 
Ini tMenus () ; 
TEini t () ; 
InitDialogs( nil ); 
InitCursor(); 

/****************** RecordSound ***********************/ 

Handle RecordSound( void ) 

OSErr err; 
Point upperLeft; 
Handle soundHandle; 

SetPt( &upperLeft, 50, 50 ); 

soundHandle = nil; 

err = SndRecord( nil, upperLeft, siBestQuality, 
&soundHandle ); 
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if ( err == userCanceledErr ) 
DoError( "\pRecording canceled ... ", true); 

if ( err != 0 ) 
DoError( "\pError returned by SndRecord() ... ", 

true); 

return( soundHandle ); 

/****************** PlaySound ***********************/ 

void PlaySound( Handle soundHandle ) 

OSErr err; 

err = SndPlay( kNilSoundChannel, soundHandle, 

kSynchronous ); 

if ( err != noErr ) 
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DoError( "\pError returned by SndPlay() ... ", true); 

/***************** DoError ********************/ 

void DoError( Str255 errorString, Boolean fatal 

ParamText( errorString, kEmptyString, kEmptyString, 
kEmptyString ); 

StopAlert( kErrorAlertID, kNilFilterProc ); 

if ( fatal 
Exit To Shell () ; 

Running SoundMaker 

Once you've finished typing in the code, save it as SoundMaker. c and 
add it to the project using Rdd from the Source menu. Next, select 
Run from the Project menu, clicking Yes to the question Bring the 
project up to date?. If the source code compiles correctly, the 
sound recording dialog box, shown in Figure 7.18, will appear. 
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If an error message appears, your sound input device may not be 
set up correctly. To verify your sound input device, go to the Sound 
control panel and click on the Rdd •.• button. Once you can record a 
new sound in this control panel, your sound input hardware is set up 
properly. 

l 
When SoundMaker's record dialog box appears, click on the Record 

button to record a sound. You can pause and resume recording with 
the Pause button and stop recording with the Stop button. When 
you've recorded a sound, you can preview it using the Play button. 

When you're done playing, you have two choices. If you press the 
Saue button, the record dialog will exit, passing your sound back to 
SoundMaker. At this point, SoundMaker will play your recording back 
to you and then exit. 

If you press the Cancel button, SoundMaker will display a message 
telling you that the recording was canceled. Try some of these options. 
When you're done, let's walk through the code. 

Walking Through the SoundMaker Code 

SoundMaker starts with three #includes. Sound . h contains the 
definitions relating to the sound-playing function. Sound!nput . h 
contains the definitions relating to the sound-recording function. 
Finally, GestaltEqu . h contains the definitions needed to call 
Gestalt (). 

#include <Sound.h> 

#include <Soundinput . h> 
#include <GestaltEqu . h > 

You've seen most of these #defines before. kNilSoundChannel 
and kSynchronous are both used in the function PlaySound () 's call 
of SndPlay () . 

#define kBaseResID 

#define kNilSoundChannel 
#define kSynchronous 

128 

nil 
false 
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#define kEmptyString 
#define kNilFilterProc 

#define kErrorAlertID 

"\p" 
nil 

kBaseResID 

Here are the four function prototypes: 

/***************/ 
I* Functions */ 
/***************/ 

void 
Handle 
void 
void 

ToolBoxinit( void); 
RecordSound( void); 
PlaySound( Handle soundHandle ); 
DoError( Str255 errorString, Boolean fatal); 
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main () starts by calling MaxAppl Zone () , then initializing the 
Toolbox. MaxApplZone () (11:30) maximizes the amount of memory 
available to your application. Since we will be allocating a large block 
of memory when we record a sound, we'll want to start with the 
largest memory block we can. . 

/**************************** main **********************/ 

void main( void ) 

Handle soundHandle; 
long feature; 
OSErr err; 

MaxApplZone(); 
ToolBoxinit(); 

Next, we'll call Gestalt() to see if the Mac is equipped with a 
sound input device. 

err= Gestalt( gestaltSoundAttr, &feature ); 

if ( err != noErr ) 
DoError( "\pError returned by Gestalt!", true); 

if ( feature & (1 << gestaltHasSoundinputDevice) ) 
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If the sound input device is available, we'll call RecordSound () to 
bring up the sound recording dialog box. Then, we11 pass the recorded 
sound on to Play Sound () , demonstrating the proper way to play a 
recorded sound. If you wanted to, you could use the techniques in 
ResWriter (plus a call to AddResource (), (1:124)) to save the sound 
as a resource. Next, call DisposHandle () to free up the allocated 
memory. 

soundHandle = RecordSound(); 
PlaySound( soundHandle ); 
DisposHandle( soundHandle ); 

If the sound input device was not available, call DoError (). 

else 
DoError( "\pSound input device not available!!!", 

true); 

/****************** ToolBoxinit *********************/ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
InitFonts(); 
Ini tWindows () ; 
Ini tMenus () ; 
TEinit (); 
InitDialogs( nil}; 
InitCursor (}; 

RecordSound () calls the Sound Manager function SndRecord () . • 
The first parameter is an optional function pointer, which 
SndRecord () will use to filter user actions in the dialog box. This 
filter function is identical in nature to the filter function associated 
with ModalDialog (). For now, we'll use the default function by 
passing nil as the first parameter. 

The second parameter is a Point, used to determine the position of 
the upper left comer of the dialog box. The third parameter 
determines the quality of the sound. Better quality sound takes up 
more memory. 
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The final parameter is a handle to a block of storage space for the 
recorded sound. By passing a pointer to a n i 1 handle, we're asking 
SndRecord () to allocate memory for us. 

/****************** RecordSound ***********************/ 

Handle RecordSound( void ) 

OSErr 

Point 

Handle 

err; 

upperLeft; 

soundHandle; 

SetPt( &upperLeft, 50, 50 ); 

soundHandle = nil; 

err = SndRecord( nil, upperLeft, siBestQuality, 
&soundHandle ); 

If the recording was canceled, call DoError (). 

if ( err == userCanceledErr ) 

DoError( "\pRecording canceled ... ", true); 

If an error occurred while recording, call DoError (). 

if ( err != 0 ) 
DoError( "\pError returned by SndRecord() ... ", 

true); 

If the recording process went well, return the handle to the recorded 
sound. 

return( soundHandle ); 

PlaySound () calls the Sound Manager function SndPlay (). The 
first parameter allows you to specify a sound channel to play the 
sound on. The Sound Manager can handle more than one 
simultaneous sound channel. In our case, we've asked the Sound 
Manager to allocate a channel for us. ~ 

The second parameter is a handle to the sound we'd like p•ayed. 
The third parameter tells the Sound Manager to play this sound 
synchronously; that is, to not return until the sound finishes playing. 
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/****************** PlaySound ***********************/ 

void PlaySound( Handle soundHandle ) 

OSErr err; 

err= SndPlay( kNilSoundChannel, soundHandle, 

kSynchronous ); 

If SndPlay () returns an error, call DoError (). 

if ( err != noErr ) 

DoError( "\pError returned by SndPlay() ... ", true); 

/***************** DoError **************x*****/ 

void DoError( Str255 errorString, Boolean fatal 

ParamText( errorString, kEmptyString, kEmptyString, 

kEmptyString ); 

StopAlert( kErrorAlertID, kNilFilterProc ); 

if ( fatal 

Exit ToShell (); 

Sound.Maker demonstrates how easy it is to record and play back a 
sound using System 7's version of the Sound Manager. What 
Sound.Maker doesn't demonstrate is vast. The Sound Manager is big; 
it's comprehensive. The Sound Manager supports synthesizers, sound 
compression, and QuickTime. 

If you are interested in learning more about the Sound Manager, 
get Inside Macintosh, Volume VI, and start reading. There's a lot to 
learn, but the Sound Manager is so cool, it's worth the investment. 

Working with Macintosh Files 

The next program, OpenPICT, demonstrates several important 
techniques for working with Macintosh files. OpenPICT makes use of 
the Standard File Package, a set of Toolbox functions that make it 
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easy to retrieve and save Macintosh files. Once you've selected a file to 
open or a file name and directory you'd like to save under, you'll want 
to make use of the File Manager to read or write your file's contents. 

The Standard File Package 

The Standard File Package is used by most Macintosh applications to 
support the Open, Saue, and Saue Rs ... File menu items. The 
function StandardGetFile () brings up a dialog box similar to the 
one shown in Figure 7 .19. Use this call to allow the user to select a file 
to be opened. 

a Chqp 1 Fi s T 

D Fig 7.01 
[) Fig 7.02 
[) Fig 7.03 
[) Fig 7.04 
[) Fig 7.05 
[) Fig 7.06 
[) Fig 7.07 
Cl Fig 7.08 

Figure 7.19 Standard Get File dialog box. 

m • 
c:.i Erehwon 

Desktop 

( Cancel ) 

( Open D 

Here's the function prototype for StandardGetFile (): 

void StandardGetFile( FileFilterProcPtr fileFilter, 
short numTypes, SFTypeList typeList, 
StandardFileReply *replyPtr ); 

The first three parameters together determine what files will 
appear in the dialog box's scrolling list. The third parameter, 
typeList, is an array of type OSType (a 4-byte file type signature), 
whose length is determined by the second parameter, numTypes. To 
limit the list to files of type 'PICT', set numTypes to 1 and pass, as 
typeList, an OSType array of length 1. To list files of all types, set 
numTypes to -1. 

The first parameter, fileFilter, is a pointer to a function you 
provide, which can further filter the list of available file types. ~ass 
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n i 1 as the first parameter if you don't have a need for a more 
sophisticated filter procedure. 

The fourth parameter, replyPtr, points to a record of type 
StandardFileReply: 

struct StandardFileReply 
{ 

Boolean sf Good; 

Boolean sfReplacing; 

OS Type sfType; 

FSSpec sfFile; 

ScriptCode sf Script; 

short sfFlags; 

Boolean sfisFolder; 

Boolean sfisVolume; 

long sfReservedl; 

short sfReserved2; 
} ; 

You can read about this struct in detail in (Vl:26-4). Basically, this 
is where the selected file is described. The sfGood field tells you 
whether the user clicked the Cancel or Open button to dismiss the 
dialog. If sfGood is true, pass the fourth field, sfFile, on to the 
appropriate File Manager function to open the file. We'll get to the File 
Manager in a minute. 

The function StandardPutFile () brings up a dialog box similar to 
the one shown in Figure 7.20. Use this call to allow the user to name 
and save a file. 

I lilli Desktop .., I 
c:J Erehwon 
c:Jlremont 
!ii 'f rnst~ 

Saue File Hs: 

c:::::::)Erehwon 

( New LJ ) 

( Cancel ) 

Oaue's To Oo List _______ ___.I n Saue D 

Figure 7.20 Standard Put File dialog box. 
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Here's the function prototype for StandardPutFile (): 

void StandardPutFile( Str255 prompt, Str255 defaultName, 
StandardFileReply *replyPtr ); 

The prompt parameter specifies the text string to appear above the 
text field. The dialog box in Figure 7.20 uses a prompt of Saue File 
Rs:. The defaultName parameter specifies the text to appear in the 
editable text field. Typically, your application will use the current 
name of the file or, in the case of an unnamed file, a string like 
"Untitled" as a defaultName. StandardPutFile () will return the 
user's input to you in a struct of type StandardFileReply. · 

As before, the sfGood field tells you whether the user clicked Saue 
or Cancel to exit the dialog box. If sfGood is true, you'll pass the 
replyPtr on to the appropriate File Manager routine when you open 
the file for writing. ' 

The File Manager 

There are a few key terms you should know before you use the i File 
Manager. Volumes are the media used to store files. When users 
press the Desktop button in the StandardGetFile () dialog box, 
they'll be presented with a list of all mounted volumes, in addition to 
all items on the desktop. Macintosh floppy and hard disks are both 
examples of volumes. In the original Macintosh (the one with 64K 
ROMs), all the files on a volume were organized in a flat file format 
called the Macintosh File System (MFS) (Figure 7.21). 1 

Figure 7.21 Flat files. 
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The concept of folders existed on these "flat" Macs, but internally 
the files on a volume were all stored in one big list. The folders were 
an illusion maintained by the Finder. On flat volumes, users can't 
have two files with the same name, even if they're in different folders. 
The Mac Plus (with 128K ROMs) introduced a new method for 
organizing files: the Hierarchical File System (HFS) (Figure 7.22). 
HFS is truly hierarchical, allowing folders within folders within 
folders. By the way, as you read about the File Manager, you'll 
frequently see the term directory used interchangeably with the term 
folder. 

Figure 7.22 Hierarchical files. 

The File Manager was completely remade when the Mac Plus came 
out. The original Macintosh Filing System (MFS) was inadequate to 
handle the number of files that hard disks could hold. The 
Hierarchical Filing System (HFS) replaced it, and the new HFS 
Toolbox calls were written into Inside Macintosh, Volume IV . 

With the release of System 7, the File Manager was modified 
once again. These changes are described in Volume VI of Inside 
Macintosh. To learn everything there is to know about the File 
Manager, glance through the File Manager chapter in Volume I, 
then carefully read the File Manager chapters in Volumes IV and VI. 
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Using the File Manager 

OpenPICT makes use of some high-level File Manager calls to open a 
PI CT file, read in some data, and close the file again. Though these 
calls represent a small portion of the File Manager's capabilities, the 
techniques demonstrated by OpenPICT should get you started. 

Once the user has chosen a PICT file to open (by way of 
StandardGetFile () ), OpenPICT uses the File Manager routine 
FSpOpenDF () to open the file for reading: 

OSErr FSpOpenDF( FSSpec spec, SignedByte permission, 
short *refNumPtr ); 

FSpOpenDF () is designed to open a file's data fork (as opposed to its 
resource fork). The first parameter is an FSSpec, otherwise known as 
a file system specification. The FSSpec uses three things to 
identify a specific file: 

• The reference number of the file's volume. 
• The directory ID of the file's parent directory. 
• The file's name. 

If you use StandardGetFile () to prompt for a file to open~ you 
won't need to worry about the elements of an FSSpec. 
StandardGetFile () uses the selected file to create an FSSpec in the 
sfFile field of the StandardFileReply. You'll see how this is done 
when we walk through the OpenPICT source code. 

The second parameter to FSpOpenDF () specifies the mode you'll 
use to access the file. Our example opens the file for exclusive ~read 
permission. The other permissions are listed on (Vl:25-32). 

The third parameter is a pointer to a file reference number, a 
single 2-byte value that can be used to access an open file. OpenPICT 
passes this reference number on to File Manager routines, such as 
GetEOF (), FSRead () , and FSClose (). 

OpenPICT uses GetEOF () to find out how large the file is, 
FSRead () to read in the PICT, and FSClose () to close the file. Again, 
you'll see how this is done as we walk through the OpenPICT source 
code. The key point being made here is to use StandardGetFile () 
whenever you need to open a file. 

I 
By the way, don't confuse StandardGetFile {) with the fUhctl9r it 
replaces, FSGetF_ile < >. FSGe~File ( > is the Qfd way Qf ~Qit~g 
·th!ngs.. standa~Q.GetFil~{J i$ part of the new, impro~edl :F le 
Manager that rode .in on the heeurof :system 7. 1

: I': 
! ! 



430 Macintosh C Programming Primer 

OpenPICT Resources 

OpenPICT makes use of three resources, the ALRT and DITL used by 
DoError ( ) , and a WI ND used to create a picture window. Create a 
folder called OpenPICT inside your Development folder. Use ResEdit 
to create a new file called OpenPICT. 1t .rsrc inside the OpenPICT 
folder. Open the file SoundMaker .1t. rsrc and copy both the ALRT 
and the DITL resources, pasting them in OpenPICT .1t. rsrc. 

Next, create a WI ND resource according to the specifications in 
Figure 7.23. Make sure the WIND's resource ID is 128, change the 
window's title to OpenPICT, and make sure the Purgeable check box 
is checked. Quit ResEdit, saving your changes. 

iD WIND ID= 128 from OpenPICT.n.rsrc 

Iii J 1t11 ldll -...aut'bll Wlntaw 

Ill 

Top: !Du I Bottom: EJ 
Left: ~ Right: ~ 

[][] 
Color: ® Default 

0 Custom 

D Initially uisible 

D Close boH 

Figure 7.23 Specifications for OpenPICT's WIND resource. 

The OpenPICT Project 

Launch THINK C and create a new project in the OpenP ICT folder. 
Call it OpenPICT .1t. Use Add ... from the Source menu to add 
MacTraps to the project. 

Once MacTraps is added, open up a new source code window and 
enter the program: 

#include <GestaltEqu . h> 

#define kBaseResID 
#define kMoveToFront 

128 
(WindowPt r ) - lL 
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#define kEmptyString 
#define kNilFilterProc 

#define kErrorAlertID 

#define kPICTHeaderSize 

/***************/ 
/* Functions */ 
/***************/ 

"\p" 
nil 

kBaseResID 

512 

ToolBoxinit( void); 
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void 
void 
PicHandle 
void 
void 
void 

GetFileName( StandardFileReply *replyPtr ); 
LoadPICTFile( StandardFileReply *replyPtr ); 
Windowinit( void); 

void 

DrawMyPicture( PicHandle picture); 
CenterPict( PicHandle picture, Rect 

*destRectPtr ); 
DoError( Str255 errorString, Boolean fatal ); 

/**************************** main **********************/ 

void main ( void ) 

PicHandle 
StandardFileReply 

ToolBoxini t () ; 

GetFileName( &reply); 

if ( reply.sfGood ) 

picture; 
reply; 

picture= LoadPICTFile( &reply); 

if ( picture != nil 

Windowinit (); 
DrawMyPicture( picture); 

while ( ! But ton() ) ; 
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/****************** ToolBoxinit *********************/ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
InitFonts(); 
InitWindows (} ; 
InitMenus(); 
TEinit (); 
InitDialogs( nil ); 
Ini tCursor () ; 

/******************************** GetFileName *******/ 

void GetFileName( StandardFileReply *replyPtr 

SFTypeList 
short 

typeList; 
numTypes; 
feature; long 

OS Err err; 

err= Gestalt( gestaltStandardFileAttr, &feature); 

if ( err != noErr ) 
DoError( "\pError returned by Gestalt!", true); 

if ( feature & (1 << gestaltStandardFile58) 

else 

typeList[ 0 1 = 'PICT'; 
nurnTypes = 1; 

StandardGetFile( kNilFilterProc, nurnTypes, 
typeList, replyPtr ); 

DoError( "\pThe new Standard File routines \ 
are not supported by this OS!", true); 
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/******************************** LoadPICTFile *******/ 

PicHandle LoadPICTFile( StandardFileReply *replyPtr } 

short 
PicHandle 
char 
long 
long 
OSErr 

srcFile; 
picture; 
pictHeader[ kPICTHeaderSize ]; 
pictSize, headerSize; 
feature; 
err; 

err= Gestalt( gestaltFSAttr, &feature); 

if ( err != noErr ) 
DoError( "\pError returned by Gestalt!", true}; 

if ( feature & (1 << gestaltHasFSSpecCalls) ) 

if ( FSpOpenDF( &(replyPtr->sfFile}, fsRdPerm, 
&srcFile ) 

!= noErr 

DoError( "\pCan't open file ... ", false); 
return( nil }; 

if ( GetEOF( srcFile, &pictSize ) != noErr ) 

! 

DoError ( "\pError returned by GetEOF (} ... ", 
false ); 

return( nil ); 

headerSize kPICTHeaderSize; 

if FSRead( srcFile, &headerSize, pictHeader ~ 

!= noErr 

DoError( "\pError reading file header ... ", 
false); 

return( nil); 

pictSize kPICTHeaderSize; 
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if ( ( picture= (PicHandle}NewHandle( pictSize } 
} == nil } 

DoError( 
"\pNot enough memory to read picture ... " 
, false); 

return( nil}; 

HLock( (Handle)picture }; 

if { FSRead { srcFile, &pictSize, *picture } ! = 
noErr } 

DoError( "\pError returned by FSRead(} ... ", 
false}; 

return ( nil } ; 

HUnlock( (Handle}picture ); 
FSClose( srcFile }; 

return( picture}; 

DoError( "\pThe new FSSpec File Manager routines \ 
are not supported by this OS!", true); 

/****************** Window!nit ***********************/ 

void Window!nit( void 

WindowPtr window; 

window= GetNewWindow( kBaseResID, nil, kMoveToFront }; 

if ( window == nil ) 
DoError( "\pCan't load WIND resource ... ", true); 

ShowWindow( window}; 
SetPort( window); 
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/****************** DrawMyPicture ********************/ 

void DrawMyPicture( PicHandle picture ) 

Rect pictureRect; 
WindowPtr window; 

window = FrontWindow(); 

pictureRect = window->portRect; 

CenterPict( picture, &pictureRect ); 
DrawPicture( picture, &pictureRect ); 

/****************** CenterPict ********************/ 

void CenterPict( PicHandle picture, Rect *destRectPtr 

Rect windRect, pictRect; 

windRect = *destRectPtr; 
pictRect = (**(picture)) .picFrame; 
OffsetRect( &pictRect, windRect.left - pictRect.left, 

windRect.top - pictRect.top); 
OffsetRect( &pictRect, (windRect.right -

pictRect.right)/2, (windRect.bottom 
- pictRect.bottom)/2); 

*destRectPtr pictRect; 

/***************** DoError ********************/ 

void DoError( Str255 errorString, Boolean fatal 

ParamText( errorString, kEmptyString, kEmptyString, 
kEmptyString ); 

StopAlert( kErrorAlertID, kNilFilterProc ); 

if ( fatal 
Exit To Shell() ; 
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Running OpenPICT 

Once you've finished typing in the code, save it as OpenPICT. c and 
add it to the project using Rdd from the Source menu. Before you run 
your new program, use your favorite graphics program (Studio 8, 
Canvas, whatever) to create a PICT file. It's important that the file 
have a file type of PICT, otherwise our call to StandardGetF ile () 
won't find it. 

Once your PICT file is created, select Run from THINK C's Project 
menu, clicking Yes to the question Bring the project up to date?. 
If the source code compiles correctly, the Standard Get File dialog box, 
shown in Figure 7 .24, will appear. 

la 7.05 - OpenPICT ... 1 
D My Test PICT m 

G=> Erehwon 

( Ej•~c1 ) 
( Desktop ) 

( Cancel J 

ll Open J 

Figure 7.24 The Standard Get File dialog box, prompting for a PI CT file. 

If you hit the Cancel button, the dialog box will disappear and 
OpenPICT will exit. If you hit the Open button, OpenPICT will open 
the selected file and a window displaying your PICT will appear. 

Walking Through the OpenPICT Code 

OpenPICT starts with the #include needed to call Gestalt(). We'll 
need Gestalt () to check if the System 7 Standard File routines are 
available. 

#include <GestaltEqu.h> 
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You've seen most of these #defines before. kPICTHeaderSize is 
set to the standard length of a PICT file's header. We'll use this infor­
mation when we read in the header in the function LoadP I CTF i 1 e ( ) . 

#define kBaseResID 128 
#define kMoveToFront (WindowPtr) -lL 

#define kEmptyString "\p" 

#define kNilFilterProc nil 

#define kErrorAlertID kBaseResID 

#define kPICTHeaderSize 512 

As always, the function prototypes. 

/***************/ 
/* Functions */ 
/***************/ 

void 
void 
PicHandle 
void 

ToolBoxinit( void); 
GetFileName( StandardFileReply *replyPtr ); 
LoadPICTFile( StandardFileReply *replyPtr }; 
Windowinit( void); 

void 
void 

void 

DrawMyPicture( PicHandle picture); 
CenterPict( PicHandle picture, Rect 

*destRectPtr ); 
DoError( Str255 errorString, Boolean fatal); 

main() initializes the Toolbox, then calls GetFileName ()i to 
prompt the user for the name of a PICT file to open. 

/**************************** main **********************/ 

void main( void ) 

PicHandle 
StandardFileReply 

ToolBoxinit {); 

GetFileName( &reply); 

picture; 
reply; 
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If the user clicked the Open button, reply. sfGood will be true. 

if ( reply.sfGood ) 

In that case, call LoadPICTFile () to retrieve the PICT from the 
file. Note that the reply was loaded by GetF ileName (), then passed 
on to LoadPICTFile (). 

picture= LoadPICTFile( &reply ); 

If the picture was successfully retrieved, create a window and draw 
the picture in it. 

if ( picture != nil 

Window!nit(); 
DrawMyPicture( picture); 

while ( ! Button() ) ; 

ToolBoxinit () still hasn't changed. Sigh. 

/****************** ToolBoxinit *********************/ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
InitFonts(); 
InitWindows(); 
InitMenus(); 
TEinit(); 
InitDialogs( nil); 
InitCursor(); 

GetFileName () starts with a call to Gestalt(), checking for the 
Standard File routines that came with System 7. If an error is 
returned by Gestalt (),or the routines are not present, DoError () 
is called. 
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/******************************** GetFileNarne *******/ 

void GetFileNarne( StandardFileReply *replyPtr 

SFTypeList 
short 
long 
OS Err 

typeList; 
nurnTypes; 
feature; 
err; 

err= Gestalt( gestaltStandardFileAttr, &feature); 

if ( err != noErr ) 
DoError( "\pError returned by Gestalt!", true); 

if ( feature & (1 << gestaltStandardFile58) ) 

If the System 7 Standard File routines are present, create a 
typeList array with a single entry, 'PICT'. This will limit the 
Standard Get File dialog to display only PI CT files. 

typeList[ 0] = 'PICT'; 
nurnTypes = 1; 

Next, StandardGetFile () is called, placing its result in the struct 
pointed to by replyPtr. 

else 

StandardGetFile( kNilFilterProc, nurnTypes, 
typeList, replyPtr ); 

DoError( "\pThe new Standard File routines \ 
are not supported by this OS!", true); 

I 

LoadPICTFile () also calls Gestalt (), this time looking for the 
presence of FSSpec savvy calls. The File System Specification known 
as FSSpec was also introduced with System 7. 1 
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/******************************** LoadPICTFile *******/ 

PicHandle LoadPICTFile( StandardFileReply *replyPtr ) 

short 
PicHandle 
char 

srcFile; 
picture; 
pictHeader[ kPICTHeaderSize ]; 
pictSize, headerSize; long 

long feature; 
OS Err err; 

err= Gestalt( gestaltFSAttr, &feature); 

if ( err != noErr ) 
DoError( "\pError returned by Gestalt!", true); 

if ( feature & (1 << gestaltHasFSSpecCalls) ) 

If the FSSpec calls are present, call FSpOpenDF () to open the 
specified PICT file with read permission. Call DoError () if the file 
could not be opened. 

if ( FSpOpenDF( &(replyPtr->sfFile), fsRdPerm, 
&srcFile ) ! = noErr ) 

DoError( "\pCan't open file ... ", false); 
return( nil); 

Next, call GetEOF () to get the size of the file, in bytes. Again, if 
there is a problem with this call, call DoError (). Notice that the 
reference number returned by FSpOpenDF () is all we need to supply 
to GetEOF () to specify the file we want to perform this operation on. 

if ( GetEOF ( srcFile, &pictSize ) ! = noErr ) 

DoError( "\pError returned by GetEOF() ... ", 
false); 

return( nil); 

Next, call FSRead () to read in the PICT's header. The header 
contains information about the PI CT that we won't make use of here. 
For now, we'll read in the header, storing it in the buffer pictHeader. 
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Again, we used the reference number stored in srcFile to specify the 
PICT file. The second parameter plays two roles. As an input 
parameter, we'll use headerSize to specify the number of bytes we'd 
like to read. As an output parameter, FSRead () uses headerSize to 
tell us how many bytes were actually read in. 

headerSize = kPICTHeaderSize; 

if ( FSRead( srcFile, &headerSize, pictHeader ) 
!= noErr 

DoError( "\pError reading file header ... "; 
false); 

return( nil ); 

Since pictSize is the size of the entire PICT file, and we don't 
need the header information, we'll reduce pi ct size to the size of the 
PI CT itself. We'll use this value to allocate enough memory for the 
picture. 

pictSize -= kPICTHeaderSize; 

if ( picture= (PicHandle)NewHandle( pictSize ) ) 
== nil ) 

DoError( 
"\pNot enough memory to read picture ... " 
, false ) ; 

return( nil); 

Next, we'll lock this new block into memory, then pass a pointer to 
it on to FSRead ().Unless an error occurs, the PICT will be loaded into 
our new block of memory. 

HLock( (Handle)picture ); 

if ( FSRead ( srcFile, &pictSize, *picture ) ! = 

noErr ) 

DoError ( "\pError returned by FSRead () ... ".' 
false); 

return( nil}; 
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Once the PICT is loaded, unlock the block, close up the file, and 
return the handle to the picture. 

else 

HUnlock( (Handle)picture ); 
FSClose( srcFile ); 

return( picture); 

DoError( "\pThe new FSSpec File Manager routines \ 
are not supported by this OS!", true); 

Windowinit () is pretty straightforward. 

/****************** Windowinit ***********************/ 

void Windowinit( void 

WindowPtr window; 

window= GetNewWindow( kBaseResID, nil, kMoveToFront ); 

if ( window == nil ) 
DoError( "\pCan't load WIND resource ... ", true); 

ShowWindow( window); 
SetPort( window); 

You've seen DrawMyPicture (), CenterPICT (), and DoError () 
before. 

/****************** DrawMyPicture ********************/ 

void DrawMyPicture( PicHandle picture ) 

Rect pictureRect; 
WindowPtr window; 

window= FrontWindow(); 
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pictureRect = window->portRect; 

CenterPict( picture, &pictureRect ); 
DrawPicture( picture, &pictureRect ); 
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/****************** CenterPict ********************/ 

void CenterPict( PicHandle picture, Rect *destRectPtr 

RectwindRect, pictRect; 

windRect = *destRectPtr; 
pictRect = (**(picture)) .picFrame; 
OffsetRect( &pictRect, windRect.left - pictRect.left, 

windRect.top - pictRect.top); 
OffsetRect( &pictRect, (windRect.right -

pictRect.right)/2, (windRect.bottom -
pictRect.bottom)/2); 

*destRectPtr pictRect; 

/***************** DoError ********************/ 

void DoError( Str255 errorString, Boolean fatal 

ParamText( errorString, kEmptyString, kEmptyString, 
kEmptyString ); 

StopAlert( kErrorAlertID, kNilFilterProc ); 

if ( fatal 
ExitToShell (); 

The Printing Manager 

Chapter 7's final program, PrintPICT, demonstrates the proper use 
of the Printing Manager. PrintPICT loads a PICT from the resource 
file and prints the PICT on the currently selected printer. 
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Calling the Printing Manager 

Prepare the Printing Manager for use by calling PrOpen (). Then, 
allocate a new print record using NewHandle (). The print record 
contains information the Printing Manager needs to print your job, 
including page setup information and information specific to the 
print job. 

You can prompt the user to fill in the page setup information by 
calling PrStlDialog (). Prompt the user for job-specific information 
with a call to PrJobDialog (). Each of these routines displays the 
appropriate dialog box and fills the newly allocated print record with 
the results. 

Then, call P rOpenDoc () to set up a printing Graf Port. The 
printing Graf Port acts just like any other Graf Port, but exists only 
in memory, not on screen. PrOpenDoc () calls SetPort (), so any 
QuickDraw calls you make after this will apply to the printing 
Graf Port. 

The printing GrafPort is made up of pages. You'll call 
P rOpenP age ( ) to start a new page, then make a set of QuickDraw 
calls (like DrawPicture ()) to fill the page with graphics. Next, call 
PrClosePage () to close the current page. Call PrOpenPage () and 
PrClosePage () for each page you want to create. 

When you've drawn all your pages, close the document with a call to 
PrCloseDoc (). Now, it's time to print your document. Do this with a 
call to PrPicFile (). If background printing (spooling) is set up on 
your computer, you'll need to call PrPicFile () to start the printing 
process. If spooling is not set up, the call to PrCloseDoc () will start 
the process for you. 

The Printing Manager is described in detail in Inside Macintosh, 
Volume II, Chapter 5 and was extended to handle Color QuickDraw in 
Volume V, Chapter 22. If you plan on writing an application that 
supports printing, read this chapter thoroughly. 

Now, let's look at PrintPICT. 

PrintPICT 

Since the "paperless society" seems to be receding rapidly into the 
distance, it's reasonable to expect a Mac application to be able to print. 
PrintPICT shows you how to print a PICT resource. 
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PrintPICT prints a PICT by drawing it in the printing GrafPort . 
Printing text is a little more complex. You'll draw the text in the 
printing GrafPort, but you'll need to worry about things like 
breaking text along the margins properly, and starting a new page 
once you hit the end of the current page. The Printing Manager 
doesn't care what you draw on the printing GrafPort-that's your 
responsibility 

l l 
PrintPICT Resources 

, I 
PrintPICT makes use of three resources, the ALRT and DITL, used by 
DoError () , and the PICT that will be printed. Create a folder called 
PrintPICT inside your Development folder. Use ResEdit to create a 
new file called PrintpICT . 7t. rsrc inside the PrintpICT folder. 
Open the file OpenP ICT . 7t . rs re and copy both the ALRT and the 
DITL resources, pasting them in PrintPICT . 7t. rsrc . 

Next, use your favorite graphics program to create a PICT resource. 
Unless you are using a color printer, you'll probably want to create a 
black and white image. Make sure the PICT's resource ID is 128 and 
make sure the Purgeable check box is checked. Quit ResEdit, saving 
your changes. 

The PrintPICT Project 

Launch THINK C and create a new project in the PrintpICT folder. 
Call it PrintpICT . 7t. Use Add ••. from the Source menu to add 
MacTraps to the project. 

Once MacTraps is added, open a new source code window and enter 
the program: 

Jtinclude <PrintTraps . h> 

#define kBase ResID 128 

#define kDontScaleOutput nil 

#define kEmptyString " \p " 

#define kNilFilterProc nil 

#define kErrorAlertID kBaseResID 
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/***************/ 
/* Functions */ 
/***************/ 

void 
PicHandle 
THPrint 
Boolean 
void 

ToolBoxinit( void); 
LoadPICT( void); 
Printinit( void); 
DoDialogs( THPrint printRecordH ); 
PrintPicture( PicHandle picture, THPrint 

void 

void 

printRecordH ); 
CenterPict( PicHandle picture, Rect 

*destRectPtr ); 
DoError( Str255 errorString, Boolean fatal); 

/**************************** main **********************/ 

void main( void ) 

PicHandle 
THPrint 

picture; 
printRecordH; 

ToolBoxinit(); 

picture= LoadPICT(); 
printRecordH = Printinit(); 

if ( DoDialogs( printRecordH ) ) 
PrintPicture( picture, printRecordH ); 

/****************** ToolBox!nit *********************/ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
InitFonts(); 
InitWindows(); 
InitMenus(); 
TEinit(); 
InitDialogs( nil); 
InitCursor (); 
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/******************************** LoadPICT *********/ 

PicHandle LoadPICT( void 

PicHandle picture; 

picture= GetPicture( kBaseResID ); 

if ( picture == nil ) 
DoError ( "\pCan 't load PICT resource ... ", true. ) ; 

return( picture); 

/******************************** Printinit *********/ 

THPrint Printinit( void) 

THPrint printRecordH; 

printRecordH = (THPrint)NewHandle( sizeof( TPrint ) ); 

if ( printRecordH == nil ) 
DoError( 

"\pNot enough memory to allocate print record" 
, true); 

PrOpen (); 
PrintDefault( printRecordH ); 

return( printRecordH ); 

/******************************** DoDialogs *******/ 

Boolean DoDialogs( THPrint printRecordH ) 

Boolean confirmed = true; 

confirmed= PrStlDialog( printRecordH ); 

if ( confirmed ) 
confirmed= PrJobDialog( printRecordH ); 

return( confirmed); 
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/******************************** PrintPicture *******/ 

void PrintPicture( PicHandle picture, THPrint 
printRecordH 

TPPrPort 
Re ct 
TPrStatus 

printPort 

printPort; 
pictureRect; 
printStatus; 

PrOpenDoc( printRecordH, nil, nil); 

PrOpenPage( printPort, kDontScaleOutput ); 

if ( PrError() != noErr ) 
DoError( "\pError returned by PrOpenPage() ... ", 

true); 

pictureRect (**printRecordH) .prinfo.rPage; 

CenterPict( picture, &pictureRect ); 
DrawPicture( picture, &pictureRect ); 

PrClosePage( printPort ); 
PrCloseDoc( printPort ); 

if ( (**printRecordH) .prJob.bJDocLoop == bSpoolLoop 
PrPicFile( printRecordH, nil, nil, nil, 

&printStatus ); 

PrClose(); 
DisposHandle( (Handle)printRecordH ); 

/****************** CenterPict ********************/ 

void CenterPict( PicHandle picture, Rect *destRectPtr 

Rect windRect, pictRect; 

windRect = *destRectPtr; 
pictRect = (**(picture)) .picFrame; 
OffsetRect( &pictRect, windRect.left - pictRect.left, 

windRect.top - pictRect.top); 
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OffsetRect( &pictRect, (windRect.right -
pictRect.right)/2, (windRect.bottom 
- pictRect.bottom)/2); 

*destRectPtr pictRect; 

/***************** DoError ********************/ 

void DoError( Str255 errorString, Boolean fatal 

ParamText( errorString, kEmptyString, kEmptyString, 
kEmptyString ) ; 

StopAlert( kErrorAlertID, kNilFilterProc ); 

if ( fatal 
ExitToShell(); 

Running PrintPICT 

Once you've finished typing in the code, save it as PrintPICT. c and 
add it to the project using Rdd from the Source menu. Before you run 
your new program, use the Chooser to make sure your printer is on­
line and ready for printing. 

Once your printer is ready, select Run from THINK C's ProJect 
menu, clicking Yes to the question Bring the project up to date?. 
If the source code compiles correctly, a Page Setup dialog designed 
for your printer will appear (Figure 7.25). 

lmageWriter 

Poper: ® US Letter 
Qus Legal 

O R4 Letter 
v2.7 I~( ;;;;;;;;O;;;;;;;;K'iiiiiiiiift!)J 

O Computer Paper 
O lnternationol Fanfold (Cancel ) 

Orientotion Special Effects: O Toll Adjusted 
0 50 3 Reduction 
0 No Gops Between Pages 

Figure 7.25 The Image Writer's Page Setup dialog box. 
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If you click the Cancel button, PrintPICT will exit without printing 
your picture. If you click OK, a Job dialog box for your printer will 
appear (Figure 7.26). Again, clicking Cancel exits the program. If you 
click OK, your PICT image should start printing on your printer. 

lmageWriter v2.7 (( OK J) 
Qunllty: QBest ®Foster O Drnft 

Page Range: @All O From: D To: D (Cancel ) 

Coples: D 
Paper Feed: ®Automatic 0 Hand Feed 

Figure 7.26 The Image Writer's Job dialog box. 

Walking Through the PrintPICT Code 

OpenPICT starts with the #include containing the definitions 
necessary to use the Printing Manager. 

#include <PrintTraps.h> 

Most of these #defines should be familiar to you. 
kDontScaleOutput is used in the routine PrintPicture (), in its 
call to PrOpenPage (). 

#define kBaseResID 128 

#define kDontScaleOutput nil 

#define kEmptyString "\p" 
#define kNilFilterProc nil 

#define kErrorAlertID kBaseResID 

Ahhh, the function prototypes. 
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/***************/ 
/* Functions */ 
/***************/ 

void 
PicHandle 
THPrint 

Boolean 
void 

void 

ToolBoxinit( void); 
LoadPICT( void); 
Printinit( void); 
DoDialogs( THPrint printRecordH ); 
PrintPicture( PicHandle picture, THPrint 

printRecordH ) ; 
CenterPict( PicHandle picture, Rect 

*destRectPtr ); 
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void DoError( Str255 errorString, Boolean fatal); 

main () calls LoadPICT () to load the PICT from the resource file. 
Next, Printinit () is called to set up the printing environment. 

/**************************** main **********************/ 

void main( void ) 

PicHandle 
THPrint 

picture; 
printRecordH; 

ToolBoxinit(); 

picture= LoadPICT(); 
printRecordH = Printlnit(); 

After that, DoDialogs () is called to put up the Page Setup and 
Print Job dialog boxes. If either one exits by way of the Ca,ncel 
button, DoDialogs () will return false. If DoDialogs () returns 
true, the picture is printed by PrintPicture (). 

if ( DoDialogs( printRecordH ) ) 
PrintPicture( picture, printRecordH ); 

Ahhh, the familiar ToolBoxini t () . 
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/****************** ToolBoxlnit *********************/ 

void ToolBoxinit( void 

InitGraf ( &thePort ) ; 
InitFonts(); 
InitWindows () ; 
InitMenus(); 
TEinit(); 
InitDialogs( nil ); 
InitCursor(); 

LoadPICT () uses GetPicture () to load the PICT resource. If the 
resource wasn't found, DoError () is called. Otherwise, a handle to 
the picture is returned. 

/******************************** LoadPICT *********/ 

PicHandle LoadPICT( void 

PicHandle picture; 

picture= GetPicture( kBaseResID ); 

if ( picture == nil ) 

DoError( "\pCan't load PICT resource ... ", true); 

return( picture); 

Printinit () starts by allocating a TPrint record. All the 
information relating to printing (including Page Setup and Print 
Job information) will be stored in this record. A handle to this record 
is stored in printRecordH and will be returned by Printini t (). 

/******************************** Printinit *********/ 

THPrint Printinit( void) 

THPrint printRecordH; 

printRecordH = (THPrint)NewHandle( sizeof( TPrint) ); 
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if ( printRecordH == nil ) 
DoError( 

" \pNot enough memory to allocate pri nt record " 
, true ) ; 
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Next, PrOpen () is called to start up the Printing Manager. After 
that, PrintDefault () is called to load the print record with 
reasonable default values. 

PrOpen(); 
PrintDe fa ult( printRecordH ) ; 

Once the print record is initialized, a handle to it is returned. 

return( printRecordH ) ; 

DoDialogs ( ) calls Pr StlDial og ( ) to bring up the Page Setup 
dialog box. If the OK button is pressed, PrStlDia l og () will return 
true. 

/ ******************************** DoDialogs *******/ 

Boolean DoDia logs( THPrint 
{ 

Boo lean confirmed = true; 

printRecordH 

confirmed= PrStlDial og( printRecordH ) ; 

In that case, P r JobDialog () is called to bring up the Print Job 
dialog box. If its OK button is pressed, PrJobDialog () will return 
tru e. 

if ( con f irmed ) 
confirmed= PrJobDialog( printRecordH ); 

return( confirmed) ; 

T 

Normally, your application would bring up the Page Setup dialog 
in response to a Page Setup ... menu selection and the Print 
Job dialog in response to a Print •.. menu selection. PrintPICT 
calls both dialogs for demonstration purposes only. 
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PrintPicture () calls PrOpenDoc () to open a new printing 
GrafPort. 

/******************************** PrintPicture *******/ 

void PrintPicture( PicHandle picture, THPrint 

TPPrPort 

Re ct 

TPrStatus 

printPort 

printRecordH ) 

printPort; 

pictureRect; 

printStatus; 

PrOpenDoc( printRecordH, nil, nil); 

PrOpenPage () is called to open a new page. The second parameter 
is used only for print spooling. If it is not nil, it points to a Rect, in 
the printing Graf Port's local coordinates, to use as the frame for this 
page. All drawing will be scaled to fit inside the frame. Since we don't 
want our picture scaled, we passed nil as the second parameter. 

PrOpenPage( printPort, kDontScaleOutput ); 

PrError () returns any error conditions caused by the last Printing 
Manager call. In general, you'll want to call PrError () after each 
Printing Manager call. We've done it here so you can see it in context. 
If an error exists, call DoError (). 

if ( PrError() != noErr ) 

DoError( "\pError returned by PrOpenPage() ... ", 
true); 

So far, so good. Next, use the rPage field as a centering rectangle 
for the picture. rPage defines the boundary Rect for the current page. 

pictureRect = (**printRecordH) .prinfo.rPage; 

Since the printing GrafPort is the current port, call 
CenterPict () and DrawPicture () to draw the picture on the 
current page. 

CenterPict( picture, &pictureRect ); 

DrawPicture( picture, &pictureRect ); 

Finally, close the page and the doc and, if spooling is set up, call 
PrPicFile () to print the current document. 
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PrClosePage{ printPort ); 
PrCloseDoc{ printPort ); 
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if { {**printRecordH) .prJob.bJDocLoop == bSpoolLoop 
PrPicFile{ printRecordH, nil, nil, nil, 

&printStatus ); 

Now that the document is printed, close the print driver and dispose 
of the memory you allocated for the print record. 

PrClose (); 
DisposHandle{ {Handle)printRecordH ); 

CenterPict () and DoError () remain their same, old, humble 
selves. 

/****************** CenterPict ********************/ 

void CenterPict{ PicHandle picture, Rect *destRect~tr 

Rect windRect, pictRect; 

windRect = *destRectPtr; 
pictRect = (**(picture )) .picFrarne; 
OffsetRect{ &pictRect, windRect.left - pictRect.left, 

windRect.top - pictRect.top); 
OffsetRect( &pictRect, (windRect.right -

pictRect.right)/2, {windRect.bottom -
pictRect.bottorn)/2); 

*destRectPtr pictRect; 

/***************** DoError ********************/ 

void DoError{ Str255 errorString, Boolean fatal 

ParamText( errorString, kEmptyString, kEmptyString, 
kEmptyString ); 

StopAlert{ kErrorAlertID, kNilFilterProc ); 

if ( fatal 
ExitToShell (); 
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In Review 

We covered a lot in this chapter. Each of the six programs we pre­
sented involved a different part of the Mac Toolbox. If you're unsure 
about any of the concepts discussed, take the time to read about them 
in their respective Inside Macintosh chapters. The Resource Manager 
is covered in Volume I, Chapter 5. 

The Control Manager is covered in Volume I, Chapter 10; Volume 
VI, Chapter 7; and Volume V, Chapter 12. Scroll bars make up a small 
part of these chapters, but the concepts implemented in Pager will 
carry through to other types of controls. 

The Scrap Manager is covered in Volume I, Chapter 15 and 
Volume IV, Chapter 11. The Sound Manager is covered in Volume VI, 
Chapter 22, and completely replaces the discussions in Volume V, 
Chapter 27 and Volume I, Chapter 8. 

The Standard File Package is covered in Volume I, Chapter 20 and 
updated in Volume IV, Chapter 15 and Volume VI, Chapter 26. The 
File Manager is covered in several places. Start with Volume VI, 
Chapter 25, then read Volume IV, Chapter 19. (Warning: the File 
Manager section in Volume II, Chapter 4, has been completely 
replaced by Chapter 19 of Volume IV.) Finally, the Printing Manager 
is covered in Volume II, Chapter 5 and Volume V, Chapter 22. 

Now that you've completed your whirlwind tour of the Toolbox, 
you've probably already thought of 17 programs that people would pay 
big bucks for. Before you slap your homegrown software on a disk, 
read Chapter 8 so you can add custom icons to your application and 
documents. 

See you there! 



Finishing 
Touches 

Now that you've mastered the Toolbox, 
you're ready to start building your own 

Macintosh applications. This chapter 
discusses some of the things you need 

to know before you send your 
application out into the world. 

8 
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BY Now, you should have a good grip on the most important aspects of 
Macintosh application programming. We've described how to handle 
events, access files, and display pictures and text. You've worked with 
menus, windows, and dialogs. 

This chapter discusses some issues that become important after you 
have your basic programming problems in hand. For starters, we'll 
show you the proper way to turn your application into a standalone 
application. You11 learn about the resources your application will need 
to interact smoothly with the Finder. Finally, we'll present ~ome 
System 7-savvy sample code that shows you the correct way to 
respond to the required Apple events. 

Let's get to work. 

Building a Standalone Application 

After you compile your debugged application, but before you announce 
your first stock offering, you'll want to turn your code into a Finder­
savvy, standalone application. To do this, you11 use a set of resources 
known as the Finder resources. 

The Finder resources serve many purposes. One group of Finder 
resources tells the Finder which icon to attach to your applica~ion. 
Another group helps define the text that appears in your application's 
Get Info window. One Finder resource determines how your 
application will interface with the Mac Operating System. As you'll 
see, the Finder resources play a critical role when you turn your code 
into a standalone Macintosh application. 

Creating the Finder Resources 

Using ResEdit, we'll create a set of Finder resources and use them to 
turn Chapter 3's Hello2 program into a standalone application, 
complete with its own custom icon. 

Fire up ResEdit, navigate over to the Hello2 folder, and open the 
file Hello2 .1t. rsrc. At this point, the file contains a single resohrce 
of type WIND (Figure 8.1). The first Finder resource you're going to 
create is the BNDL resource. The BNDL resource acts as a little 
database, tying together all of your application's Finder resources. 

459 
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~lfili Hello2. n .rs re !el] 

lC] 
.Q. 

\flND 

~ 
15 

Figure 8.1 The file Hello2 .1t. rsrc, before we add the Finder resources. 

Select Create New Resource from the Resource menu and 
create a BNDL resource. The BNDL editing window will appear. Select 
EHtended Uiew from the BNDL menu, so that your window matches 
the one in Figure 8.2. 

The first field you'll see in the BND L editing window is the 
Signature: field. Your application's signature serves to distinguish 
your application from all others. 

BNDL ID = 128 from Hello2. n .rsrc 

Signature: Inn I 
ID: IO I (should be 0) 

©String: 
--~~~~~~~~~~~---

FREF Finder I cons 
local ! res ID !Type local ires ID I ICN# ic14 ic18 ics#fos4 icsa 

Figure 8.2 ResEdit's BNDL editing window. 
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Your Application's Signature 

Every Macintosh application must have a signature, otherwise known 
as a creator ID. The signature is a 4-byte field, specified in THINK C's 
Set Project Type ... dialog box. All of your application's files, whether 
it's the application itself or a document created by your application, 
share the same signature. When you double-click on a document's icon, 
the Finder notes the document's signature, then looks in its database 
for an application with the same signature. When it finds one, it 
launches the application, sending it a kAEOpenDocuments Apple event 
asking the application to open the specified document. 

You can use just about any four-character sequence (numbers and 
symbols are fine) as a signature. There is one restriction. Apple has 
reserved all signatures consisting of four lower-case letters. Eggo is 
fine, egGo is fine, but eggo is off limits. 

Once you've decided on a signature for your application, send a note 
to Apple's Developer Technical Support group, asking them to reserve 
your signature. (You can reach them through AppleLink at MacDTS.) 
You'll hear more about AppleLink and MacDTS in Chapter 9. For now, 
it's important to register your signature to avoid collisions with other 
applications. 

We've registered a signature for the Hello2 application with 
MacDTS. The signature is HELO. You'll use this signature throughout 
the rest of this chapter. 

Editing the BNDL Resource 

Back in the BNDL editing window, enter HELO in the Signature: field. 
Next, enter some text in the© String: field. This field is intended as a 
copyright notice, and will appear in the Finder's Get Info window for 
your application. Our© String: was: 

© 1992, by 0. Mark & C. Reed 

Hint: the © character is created by holding down the Option key and 
typing g. 

]I 
Once you enter your ® String:, the BNDL editor will create a new 
resource, using your application's signature as the resource type. 
The contents 0f the © String: field will be placed in this resource In 
the form of a Pascal string. In our case, the BNDL editor will create a 
HELO resource with a resource ID of 0. This resource is known as 
your signature resource. 

l l 
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Next, select Create New File Type from the Resource menu. A 
new line of six fields will appear in the bottom half of the window 
(Figure 8.3). This line represents a file type associated with your 
application. The six fields in the line tie an icon to that file type. For 
example, your application has a file type of APPL, which you set in 
THINK C's Set File Type ... dialog. You'll need one line in your BNDL 

to tie an icon to the APPL file type. 

BNDL ID = 128 from Hello2.n.rsrc 

Signature: I HELO I 
10: I 0 I (should be O) 

© String: I© 1992, by 0. Mark & C. Reed 

FREF Finder I cons 

0 128 ???? 0 0 

Figure 8.3 The BNDL editor, after Create New File Type was selected for 
the first time. 

You'll create one line in your BNDL for every file type associated 
with your application. For example, if your application supports 
documents of type PI CT and TEXT, you'll need two additional file type 
lines-one each for files of type PICT and TEXT. 

Most applications create their own unique file type. For example, 
Microsoft Word saves its documents under the file type WDBN. If you 
require your own custom file type, add a line for it to the BNDL 

resource. And, oh yes, make sure you register the type with 
MacDTS. Just like signatures, unique file types must be registered 
with Apple. 
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Let's take a closer look at the six fields in a BNDL file type line. The 
first three fields will be used to create the FREF Finder resource. The 
FREF turns a file type into a local ID. In a minute, we'll assign an icon 
to that ID. The res ID field determines the resource ID of the FREF 
resource. It should be set to 128. 

Basically, the local ID is used internally by the BNDL. You should 
never have to change its value. 

Replace the four ? s in the Type field with the characters APPL. The 
next three fields tie a set of icons to the local ID. Since we want our 
icon resources to start with a resource ID of 128, enter 128 in the 
second res ID field. Now you're ready to create some icons. Click on 
the sixth field (the empty icons) and select Choose I con ... from the 
BNDL menu. The dialog in Figure 8.4 should appear, asking you to 
select an icon for file type APPL. 

Since we haven't created an icon yet, click New. An icon editing 
window will appear (Figure 8.5). 

Choose on icon for the type APPL: 

( New ) Edit ) n Cancel )) ( OK 

Figure 8.4 Choosing an icon for file type APPL. 
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I con Fa mil ID = 128 from Hello2. 11.rsrc 

.......... 

•o 
• o 
•o 
I I 

Figure 8.5 The icon editing window. 

Creating an Icon Family 

ic14 
ics4 

D! 
Mask 

The icon editor shown in Figure 8.5 will actually be used to edit a 
series of icons, known as an icon family. The Finder uses a file's icon 
family to represent the file on the desktop. The icon family consists of 
six separate icon resources: 

• Resource type ICNt-a 32 x 32-pixel black-and-white icon. 
• Resource type icst-a 16 x 16-pixel black-and-white icon. 
• Resource type icl8-a 32 x 32-pixel color icon with 8 bits of color 

information per pixel. 
• Resource type ics8-a 16 x 16-pixel color icon with 8 bits of color 

information per pixel. 
• Resource type icl4-a 32 x 32-pixel color icon with 4 bits of color 

information per pixel. 
• Resource type ics4-a 16 x 16-pixel color icon with 4 bits of color 

information per pixel. 

The Finder uses the member of the icon family that's appropriate 
for a given situation. For example, on a Macintosh with a 1-bit black­
and-white monitor, the Finder makes use of the black-and-white icons 
found in the I CN# and ics# resources. In a color environment, the 
Finder makes use of the appropriate color resources. 

The large empty rectangle in the center of the icon editing window 
is the icon edit panel To the left of the edit panel is a set of 
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MacPaint-like tools you'll use to create your icon images. To the right 
of the edit panel are two sets of icon images. The left set shows the six 
icon resources and a pair of icon masks, one 64 x 64 pixels and one 32 
x 32 pixels. An icon mask is used to layout the clickable area of an 
icon. If the mask were blank, the user wouldn't be able to click on an 
icon. Usually, an icon's mask matches the outline of the icon and is 
filled in completely, leaving no holes. 

The set of icons on the gray background on the right edge of the 
window show how the icons look normally, open, and off-line. The 
icons are shown in pairs. In each pair, the one on the left is unselected 
and the one on the right selected. In each view you'll see four icons, 
two large and two small. The small ones are obtained by scaling down 
the large ones. Basically, your job is to edit the six icons and two 
masks until the views on the right look good. 

Click on a resource and start editing. Start with the icon labeled 
I CN#. Since this is a black-and-white icon, no color tools are 
supported. However, if you click on one of the color icons, a color popup 
will appear, allowing you to draw in color. 

Figure 8.6 shows the icon family we created for our Hello2 
application. Notice that the masks are the same shape as the icon with 
the center completely filled in. Here are a few icon editing tips. Copy 
one icon onto another by clicking and dragging the first icon, releasing 
the mouse button when your cursor is over its destination. rI'his 
technique is especially useful when creating a mask. Start with your 
ICN # icon. Once you are happy with it, drag it over to its little br other, 

Icon Famil ID = 128 from Hello2:rr.rsrc 

• ••• ••••• ••••••• •••• • ••• •••• • ••• •••• • ••• •••• • ••• •••• • ••• •••• • ••• •• ••• ••• • ••• • ••• ••• • ••• ••• ••• • ••• ••• • ••• ••••• • ••• •••• • ••• ••• • ••• • ••• • ••• •• ••• • ••• •••• ••• • ••• •••• ••• • ••• •••• • ••• •••• • •••• • •••• • •••• •• •••• • ••• ••••••• ••••• ••• • 

~~ 
ICN• 

~~ 
icsS 

ic18 

~~ 
ics4 

ic14 

~~ 
Mask 

Figure 8.6 Our Hello2 icon family, currently editing the icl8 resource. 
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the i cs# icon. Once you get those two, drag them to the i c 18 and 
ics8 icons. Now's the time to colorize your icons. 

Once you're happy with your icon family, close the icon editing 
window. The icon family you just created should appear in the BNDL 

editing window, as shown in Figure 8. 7. Don't let the shades of gray in 
our icon figures fool you-icons look great in living color! 

Select Create New File Type in the Resource menu to create 
entries for the PI CT and TEXT file types. Figure 8.8 shows our 
completed BNDL resource, with entries for files of type APPL, PICT, and 
TEXT. Notice that the PICT and TEXT entries have the familiar dog­
eared document shape, while the APPL icon family has the standard 
application diamond shape. 

Once your BNDL resource is complete, close the BNDL editing 
window and the BNDL picker window. Your main window should look 
like Figure 8.9. Notice that the BNDL editor created nine new resource 
types: the BNDL, FREF, and HELO resources, plus the six icon family 
resource types. Always use the BNDL editor to create these resources. 
The BNDL editor makes it easy to keep track of all the different Finder 
resource types. 

U!I BNDL ID = 128 from Hello2. 'ff .rsrc 

Signature: I HELO l 
ID: IO I (should be O) 

© String: I© 1992, by O. Mark & C. Reed 
................................................................................................................................................................................................................................ 
FREF Finder Icons 
local I res ID Type local I res ID ! tCN° io14 io18 ioso ios4 ioss 

RPPL 0 I 120 

I 
I 

1~·~···~ 

I 

0 l 120 

I 
I 

Figure 8. 7 The BNDL resource with one icon family. 
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s m BNDL ID = 128 from Hello2. ft .rsrc 

Signature: I .t!E~O ·I 
ID: IO I (should be 0) 

@ String: I © 1 992, by O. Mark & C. Reed 

FREF Finder I cons 
local jres ID !Type local 1 res ID i ICN° ic14 ic18 ics 0 ics4 ics8 

! 128 lRPPL 
! 

~~~~·· 
.Q 0 0 I 128 

I 129 

I 
I 129 1 !PICT 1 m I [!) ~LIL\g 

1130 
IIlITT 

1130 2 2 rrm I Ml ~lal ~ I 
I I ~ 

Figure 8.8 The completed BNDL resource, with entries for APPL, PICT, and 
TEXT files. 

§f!j Hello2. ft .rsrc Q~ 

lii=I ~ 
01011101 IDIJ) ii! 
00101001 
0110 IOIO 
00011110 ~···· ~ 01000000 

BNDL. FREF HELO ic14 

•D LID Cl[) 1.mrl 
~ .... ~ .... <Sl .... ~ ... 

ic18 ICN° ics 0 ics4 

Qa[l Cl ~-·· '{!; 
ics8 WIND l!i 

Figure 8.9 Hello2 .1t. rsrc, after the BNDL resource is completed. 

Testing Your New Icon 

Quit ResEdit, saving your changes. Go into your Hello2 folder 1and 
double-click on the file Hello2 .1t, launching THINK C in the process. 
Select Set Project Type ••• from the Project menu. When the Set 
Project Type ••• dialog appears, enter HELQ in the Creator field, 
then click the QK button. 



468 Macintosh C Programming Primer 

Next, select Build Application ... from the Project menu. When 
the Build Application ... dialog appears (Figure 8.10), enter Hello2 
in the Saue application as: field and click the Saue button. 

THINK C will create an application file with the name Hello2 . 
Hello2 will have a type of APP L and a creator of HELO. Figure 8.11 
shows the new application in a Finder window. 

lesi 3.1 - Hello2 """I 
D lh~l!o2. c 
D lh~ l! o2. 11 

D lh~l!D2. 11 X HC 

saue application as: 

IHello2 
181 Smart Link 

ii!: = Erehwon 

[ Ej !~C1 J 

[Desktop ] 

n Saue B 
[ Cancel J 

Figure 8.10 THINK C's Build Hpplication ... dialog. 

::!Ei Hello2 ool 
4 items 73.9 MB in disk 2 .2 MB av~ 

~ [iJ ~ 
-\} 

l-"-1 

He11o2.c He11o2.71 He11o2 .71.rsrc 

~ 
He11o2 

izy 
¢1 1¢ 9-J 

Figure 8.11 Your new icon, in the Hello 2 folder. 

If your custom icon didn't appear, carefully check your resources. If 
they all look OK, try rebuilding your desktop by rebooting, then 
holding down the command and option keys. 

f 
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Testing the PICT and TEXT Icons 

You've tested the APPL portion of the Hello2 BNDL resource. Next, 
you'll use ResEdit to create document files with the HELO signature. 
You'll create one document with a type of PICT and one with a type of 
TEXT. 

Quit THINK C and launch ResEdit. When the animated jack-in­
the-box appears, click once and, when prompted for a file to open, click 
the New button. When prompted for a file name, navigate over to the 
Hello2 folder, enter Hello2 PICT File, and click the New button. 
ResEdit will create a new file and create a window showing the e:riipty 
resource fork. 

In the File menu, select Get Info for Hello2 PI CT File. This will 
bring up a Get Info dialog box for your new file (Figure 8.12). Enter 
PICT in the Type: field and HELO in the Creator: field. 

Info for Hello2 PI CT File 

File: I Hello2 'PJCT Fiie D Locked 

Type: I rsrc I Creator: I RSED 

O File Locked O Resources Locked File In Use: Yes 
O Printer Driuer MultiFinder Compatible File Protected: No 

Created: I Sat, Feb 22, 1992 I Time: 14:48:08 PM 

Modified: I Sat, Feb 22, 1992 I Time: 14:48:09 PM 

Size: 286 bytes in resource fork 
O bytes in data fork 

Finder Flags: ® 7 .H O 6.0.H 

0 Has BNDL 0 No INITs Lobel:! None ~I 
D Shared O I nlted D I nuisible 
D Stationery D Alias D Use Custom Icon 

Figure 8.12 The Get Info window for Hello2 PICT File. 

Click on the close box. When asked to save the changes, click Yes. 
After a slight delay, the icon for Hello2 PICT File should change to 
the one shown in Figure 8.13. 
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rHl 
He 11o2 PICT File 

Figure 8.13 The icon for Hello2 PICT File. 

Now let's create a TEXT file with the HELO signature. Back in 
ResEdit, select New from the File menu. When prompted for a file 
name, enter Hello2 TEHT File. Now select Get Info for Hello2 TEHT 
File from the File menu. When the Get Info dialog box appears, 
enter TEHT in the Type: field and HELO in the Creator: field. Click on 
the close box.When asked to save the changes, click Yes. After a slight 
delay, the icon for Hello2 TEXT File should change to the one 
shown in Figure 8.14. 

1n~.J 
He llo2 TEXT File 

Figure 8.14 The icon for Hello2 TEXT File. 

Testing the Finder's Database 

Once you've finished basking in the glory of your new icons, let's take 
them for a test drive. Quit ResEdit, going back to the Finder. Double­
click on the Hello2 PICT File. Notice that the Finder launched the 
Hello2 application. Click once to exit Hello2, then try the same trick 
with Hello2 TEXT File. 
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l l 
If your Hello2 program contained an event loop, the Finder would 
have redrawn the application icon in the open mode, then sent a 
kAEOpenDocument s Apple event to Hello2, asking it to open 
Hello2 PICT File. 

To try this yourself, throw the Hello2 application (not the two docu­
ments) into the trash, then empty it. Next, make a copy of Chapter 
4's Event Tracker folder, then open Event Tracker .1t. rsrc in 
ResEdit. Open Hello2 .1t. rsrc and copy all of the resourtces, 
except the WIND resource, into Event Tracker .1t. rsrc. Quit 
ResEdit, saving your changes. 

Next, open your copy of Event Tracker .1t in THINK C. Use 
Set Project Type ... to set the project type to APPL and the 
creator to HELO. Make sure the SIZE Flags are set to 5840. Use 
Build Rpplication... to build an application, saving it as 
Event Tracker. Quit THINK C. 

The Event Tracker icon should look like the Hello2 icon. (And 
why not? You're using the same resources!) Double-click on 
Event Tracker. Yo1:1'1l see the familiar EventTracker window. Click 
on the desktop to return to the Finder. 

First, take a look at the EventTracker icon. It should be dis­
played in the open mode, appearing as a gray-filled diamond. 
Double-click on the file Hello2 TEXT File. A kAEOpenDocumentis 
Apple event should appear in the EventTracker window. 

Click in the close box to exit Event Tracker. 

More Finder Resources 

At this point, you've seen the power of the Finder resources. You've 
used a BNDL resource to attach an icon to a file. More importantly, 
you've used the BNDL resource to alter the Finder's database. The 
PICT and TEXT files you created didn't contain any resources, yet they 
appeared with the correct icons and launched the correct programs. 

Before we move on to the proper handling of the required Apple 
events, we'll take a few moments to examine some of the other Finder 
resources. 
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The SIZE Resource 

There's one Finder resource you've already seen several times. The 
SIZE resource is created for you automatically by THINK C's Set 
Project Type ••• dialog. When the Finder launches your application, 
it looks for a s I ZE resource with an ID of 0. If it can't find one, it looks 
for a SIZE resource with an ID of-1. If either is found, the Finder uses 
the flags found in the resource as a guide when launching the 
application. 

THINK C automatically creates a s I ZE resource for your appli­
cation with an ID of-1. In certain cases, the Finder will create a SIZE 
resource for your application. For example, when you use the Get 
Info command to change your application's default memory require­
ments, the Finder will copy your existing s I ZE resource (if one exists), 
creating a new one with an ID of 0. The changes specified in the Get 
Info window will be applied only to the SIZE resource with an ID ofO. 

Figure 8.15 shows the SI 2E Flags menu. 

MultiFinder-Rware 
Background Null Euents 
Suspend & Resume Euents 

Background Only 
Get FrontClicks 
Accept ChildDiedEuents 

32-Bit Compatible 
HighLeuelEuent-Rware 
Accept Remote HighLeuelEuents 
Stationery-Aware 

Figure 8.15 The SIZE Flags menu from THINK C's Set Project Type ••. 
dialog. 

The Multifinder-Rware flag and the Suspend & Resume 
Euents flag go hand in hand. If one is set, the other should be set. 
Together, they say that your application knows how to handle suspend 
and resume events, and is capable of intelligently making the shift 
from the foreground to the background. These two flags will almost 
always be set. 

Background Null Euents says that your program wants 
nullEvts while it is in the background. Set this flag if you need 
processing time, even when you are not in the foreground. 
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B ackg round 0 nly means that your program cannot run in the 
foreground and has no user interface. 

If Get FrontClicks is set, your application will receive[ any 
rnouseDown and rnouseUp events used to bring your application to the 
foreground. If the flag is not set, your application will be brought to 
the foreground, but it will not see any mouse events used to bring it to 
the foreground. 

Accept ChildDiedEuents tells the Mac OS to tell you if any 
processes you've launched died unexpectedly. 1 

The 32-Bit Compatible flag tells the Mac OS that you've tested 
your program and that it runs just fine in 32-bit mode. Don't set this 
flag unless you've tested your application in 32-bit mode. · 

HighleuelEuent-Aware asks the Mac OS to send you all high­
level events, including Apple events. From now on, you'll be writing 
only high-level aware applications. 

Accept Remote HighleuelEuents asks the Mac OS to send you 
high-level events that come over the network. If you set: the 
HighleuelEuent-Aware bit, you'll usually set this bit as well. 

Finally, Stationery-Aware tells the Finder that your applic~tion 
can handle stationery pads. What are stationery pads? Glad you 
asked ... 

Stationery Pads 

A stationery pad is a document used as a template by 1your 
application. For example, in a word-processing package, users might 
create a document with their corporate logo on the top, saving the 
document as a stationery pad. Whenever they click on the stationery 
pad's icon, a new, untitled document appears with the corporate logo 
already in it. Stationery pads allow your users to create a set of 
canned documents they can use again and again. 

As you design your application, you'll have to decide which file types 
the user can save as stationery pads. For example, suppose your 
application supports two file types, PI CT and TEXT. You might allow 
the user to use a TEXT document as the basis for stationery, but not a 
PI CT document. 

You'll need to design a unique icon family for each file type that 
supports stationery. To link a stationery icon family to its parent file 
type, add the icon family to the BNDL resource, using an FREF :type 
that matches the parent file type, with the first letter changed to s. 
For example, to support TEXT stationery, add an icon family with a 
type of sEXT to the BNDL. To support PICT stationery, add an icon 
family with a type of sICT to the BNDL. 
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If your application supports stationery, you'll have to make sure the 
file types you support are unique in their last three characters. 

When users indicate that they'd like to save a document as 
stationery, they'll also have to indicate the file type they'd like the 
stationery based on. If you support more than one file type, you might 
try the interface shown in Figure 8.16. The File Format: popup 
allows the user to select the file type, and the Saue as stationery 
pad check box specifies whether the file is to be saved as stationery. 

If the document is to be saved as stationery, save the document 
using the selected type (PICT, not sICT; TEXT, not sEXT) and mark 
the document as stationery. The File Manager maintains a set of 
Finder flags for every file and folder it knows about. One of these 
flags is the isStatione r y flag. When saving a document as 
stationery, you'll set the is Stationery flag. We'll show you how to do 
this in the Finder information section, coming up next. 

Before the Finder draws a file's icon, it checks to see if that file's 
isStationery flag is set. If so, it substitutes ans for the first letter of 
the file type, then looks in the file's signature BNDL for an icon family 
with this modified type. For example, if it encounters a file with a 
signature of HELO, a type of TEXT, and a set isSt ationery flag, the 
Finder looks for an icon family with a signature of HELO and a type of 
sEXT. If found, this stationery icon family is used to draw the file's 
icon. If a stationery icon family is not found, a default stationery icon 
is drawn. 

I Iii Desktop ,... I 
=Erehwon 
=Tremont 
11'.ii "frnst1 

~ =Tremont 

( E:J•~c1 ) 

(Il<~~k top) 

Soue current document 8s: n Soue ] 

(Cancel ) 

File Format: I PICT ._ _____ _, 

D Soue os stationery pod 

Figure 8.16 A sample stationery pad Saue As ••• dialog. 
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In summary, if you plan on supporting stationery, create an icon 
family for each file type that will serve as a basis for stationery, and 
make sure you set the Stationery-Rware flag in your application's 
s I ZE resource. You'll find more information about stationery pads in 
Inside Macintosh M: 9-26-9-27). 

Finder Information 

The File Manager maintains a series of data structures that describe 
the files and folders accessible by the Finder. One of these data 
structures, the Finfo, contains the Finder flags referred to earlier: 

struct Flnfo 

} ; 

OS Type 
OS Type 
unsigned short 
Point 
short 

fdType; 
fdCreator; 
fdFlags; 
fdLocation; 
fdFldr; 

A file's Finfo holds its type and creator (fdType and fdCreator), 
its Finder flags (fdFlags), its location within its Finder window 
(fdLocation), and a short specifying whether the file is in the trash, 
on the desktop, or in a window (fdFldr). ' 

The fdFlags field is an unsigned short, referenced by bits 
numbered 0 through 15: 

• Bit 0 is reserved. 
• Bits 1-3 indicate the file's color. 
• Bits 4-5 are reserved. 
• Bit 6 is set only if the file is an application and can be opened by 

multiple users. 
• Bit 7 is set only if the file contains no INIT resources. 
• Bit 8 is set when the Finder has stored the Finder information in 

its desktop database. 
• Bit 9 is reserved. 
• Bit 10 is set if the file has a custom icon. A user can create a custom 

icon by selecting Get Info for a Die, then pasting a picture intb the 
Get Info window. Custom icons are described in Inside Macintosh 
(VI: 9-28). 

• Bit 11 is set if the file is a stationery pad. This is' the 
isStationery bit we referred to earlier. 

• Bit 12 is set if the file's name is locked and can't be changed. 
• Bit 13 is set if the file contains a BNDL resource. 
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• Bit 14 is set if the file is invisible. 
• Bit 15 is set if the file is an alias. 

To change a file or folder's Finder information, go into ResEdit and 
select Get File / Folder Info ... from the File menu. When prompted, 
select a file or folder. The Get Info window for that file or folder will 
appear. When you were editing the Hello2 BNDL, you saw an example 
of this window (Figure 8.12). 

To change the Finder information from within your program, use 
the File Manager routines GetFinfo () and SetFinfo () (IV:113). 

The vers Resources 

Next on our list of Finder resources is the ve r s resource. You'll create 
two vers resources for your applications. The vers resource with an 
ID of 1 describes version information for a particular file. This version 
information includes a version number, the version's release level, 
country code, and a text string that will appear in the Finder's Get 
Info window for the file. 

The v ers resource with an ID of 2 contains the same information, 
but is used to describe a set of files, instead of a single file. For 
example, the vers 1 resource might describe a configuration file for 
your application, citing the release number and date of the 
configuration file. The vers 2 resource, on the other hand, would 
describe the version information of the application itself. 

Try this yourself. Use ResEdit to build vers 1 and vers 2 resources 
for your Hello2 application. Figure 8.17 shows a sample vers 1 

§0 uers ID = 1 from Hello2. 11 .rs re 

Uersion number: Ll . LI . @=] 

Release:! Final ... I Non-release: @=] 

Country Code:! 00 - USA ... I 

Short uersion string: 11.o, ©1992, Mark & Reed I 
Long uersion string (ulsible in Get Info): 

1.0 (US), ©1992 by Oaue Mark and Cartwright 
Ree~ 

Figure 8.17 The vers 1 resource for Hello2. 
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resource for the Hello2 application. Notice that the file name isn't 
included in the version string. The Finder will do that for you. Be sure 
to include both a short and a long version string. The Finder uses the 
long string in the Get Info window, but there will be times when the 
short string is used. 

By the way, if the Finder can't find a vers 1 resource, it will use the 
string found ir:l the signature resource instead. 

l l 
You'll find more information on the vers resource in Inside 

Macintosh (VI: 9-23-9-24). 

Some Useful STR Resources 

When you double-click on a document icon and the Finder can't find 
an application with a matching signature, the Finder takes one of two 
actions. If the document is of type PICT or TEXT and TeachText is 
present, the document is opened with Teach Text. If the document is of 
another type, or if TeachText is not present, the Finder puts up an 
Application Not Found alert. 

There are two different ' STR ' resources you can add to a 
document that alter the appearance of this alert. The first, a ' STR ' 
resource with a resow-ce ID of -16397, is known as the m essage 
string resource. The second, a ' STR ' with an ID of - 16396, is 
known as the name string resource. 

If the document was not meant to be opened, include a message 
string resow-ce in the document explaining the proper way to work 
with the document. Figure 8.18 shows a sample message string 
resource. 

The String 

Data $ 

Figure 8.18 A message string resource from the GalumphWriter 
preferences file. 
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If the document was meant to be opened, include a name string 
resource consisting of the name of your application (Figure 8.19). The 
Finder will include the string in an alert of the form, "The document 
HHH could not be opened, because the application yyy could 
not be found," where HHH is the document's name and yyy is the 
name string resource. 

§0~ STR ID = -16396 from My GolumphWriter Doc ~ 
-0-

The String 

Data $ 

Figure 8.19 Aname string resource from a GalumphWriter document. 

The Help and Edition Managers 

Before we move on to Apple events, there are a few more Toolbox 
managers you need to know about. The Help Manager implements a 
fun and informative help mechanism taken straight from the Sunday 
comics. Point the mouse at an item on the screen and a cartoon balloon 
appears, describing the object in question. This mechanism is known 
as balloon help. 

The Edition Manager allows your application to publish data as an 
edition. Other applications can subscribe to that same edition, 
creating a live data link between applications. 

These two Toolbox managers are discussed in the next few pages. 
Then, it's on to Apple events! 

Balloon Help 

One of the most noticeable changes brought on by System 7 is the 
addition of a small cartoon balloon icon on the right side of the menu 
bar. The Balloon Help menu (Figure 8.20) gives Macintosh users 
access to fast, friendly help whenever they drag their mouse over an 
item that supports balloon help. Balloon help is turned on by selecting 



Finishing Touches ;479 

About Balloon Help .•• 

Show Balloons 

Finder Shortcuts 

Figure 8.20 The Balloon Help menu. 

Show Balloons from the Balloon Help menu. The Balloon Help 
menu is always available, even when a modal dialog is running. 

Figure 8.21 shows an example of balloon help in action. This 
particular balloon appears in the Finder when the mouse moves over 
an application icon. The Finder provides help balloons for practically 
everything you see on the screen: menu titles, menu items, icons, even 
windows. 

This is an application-a program 
with which you can perform a 
task or create a document. 
Applications include word 
processors / graphics programs / 
database pro9r ams / games / and 
spreadsheets. 

Figure 8.21 The balloon help offered by the Finder when the mouse passes 
over the Hello2 icon. 

You can (and should) include help balloons in your 'own 
applications. To do this, create a series of help resources, each of 
which attaches a help balloon to a part of your program's interface. 

The current version of ResEdit doesn't come with built-in 1 help 
resource templates, and that's a problem when it comes to help 
resource design. Luckily, there are a few alternatives. Apple's 
BalloonWriter program is specifically designed to construct [help 
balloons and attach them to your files. You can buy Balloon Writer 
directly from APDA (APDA is discussed in Chapter 9) for a modest fee. 
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You can also create and edit help resources in Resourcerer, the 
alternative resource editor from Mathemaesthetics, in Chestnut Hill, 
Massachusetts. Resourcerer is a very powerful resource editor and is 
definitely worth checking out. 

A complete discussion of the Help Manager is contained in Inside 
Macintosh, Volume VI, Chapter 11. If you're going to write a truly 
System 7-savvy program, you must read this chapter. 

Edition Manager 

Before we hit Apple events, there's one more topic to cover: the Edition 
Manager. As we mentioned earlier, the Edition Manager allows your 
application to publish data as an edition. Other applications can 
subscribe to that same edition, creating a live data link between 
applications. 

For example, suppose you wanted to include a spreadsheet table in 
a word-processing document. Normally, you'd open the spreadsheet, 
copy the table, open the word processor, then paste the table into the 
word-processing document. If the data in your table changes, you have 
to repeat this process all over again. 

If your spreadsheet and word processor support the Edition 
Manager, you can save yourself a lot of work. Open the spreadsheet 
and publish the table as an edition. Next, open the word-processing 
document and subscribe to the edition, placing the table where you 
want it. The live data link provided by your spreadsheet subscription 
means that if that table ever changes, your word-processing document 
will be updated as well. 

You can read all about the Edition Manager in Inside Macintosh, 
Volume VI, Chapter 4. lfyou decide to add publish and subscribe to an 
application, you'll need to add an icon family for each edition file type 
you'll support to the BNDL resource (VI: 9-27). 

Responding to the Required Apple Events 

Earlier in the chapter, we used some Finder resources to link the 
Hello2 application to some PI CT and TEXT documents, all of which 
shared a common signature. One key point that emerged from this 
discussion was the sequence of events that occur when you select a 
document and select Open from the Finder's File menu. 

First, the Finder looks for an application whose signature matches 
the selected document. Next, the Finder launches the application, 
sending it a kAEOpenApplication Apple event. Finally, the Finder 
sends the application a kAEOpenDocuments Apple event, asking the 
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application to open the specified document. 
In the same vein, if Print was selected from the File menu instead 

of Open, the Finder follows these same steps, ending with a 
kAEPrintDocuments Apple event instead of the kAEOpenDocuments 
Apple event. 

Our goal for the remainder of this chapter is to follow this algorithm 
all the way to its conclusion. Once your program receives one of the 
required Apple events, how should it respond? Chapter 4's 
EventTracker program showed you how to install event handlers for 
the required Apple events. Now we'll take a look inside the ha~dlers 
themselves. 

A Quick Review of the EventTracker Code 

Before entering its main event loop, EventTracker uses 
AEinstallEventHandler () to install an event handler for each of 
the four required Apple events: 

err= AEinstallEventHandler( kCoreEventClass, 
kAEOpenApplication,DoOpenApp, 01, 
false); 

if ( err != noErr ) 
DrawEventString( 

"\pkAEOpenApplication Apple event notavailable~" ); 

err AEinstallEventHandler( kCoreEventClass, 
kAEOpenDocurnents, DoOpenDoc, OL, 
false); 

if ( err != noErr ) 
DrawEventString( 

I 

"\pkAEOpenDocurnents Apple event not available!" ); 

err AEinstallEventHandler( kCoreEventClass, 
kAEPrintDocuments, DoPrintDoc, OL, 
false); 

if ( err != noErr ) 
DrawEventString( 

"\pkAEPrintDocuments Apple event not available!" ); 

err AEinstallEventHandler( kCoreEventClass, 
kAEQuitApplication, 
DoQuitApp, OL, false); 

if ( err != noErr ) 
DrawEventString( 

"\pkAEQuitApplication Apple event not available!" ); 
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The four Apple events kAEOpenApplication, kAEOpenDocuments, 
kAEPrintDocuments, and kAEQuitApplication will be sent to the 
four routines DoOpenApp (), DoOpenDoc (), DoPrintDoc (), and 
DoQuitApp () respectively. 

Here are the prototypes for the four handlers: 

pascal OS Err DoOpenApp( AppleEvent theAppleEvent, 
AppleEvent reply, long refCon ) ; 

pascal OS Err DoOpenDoc( AppleEvent theAppleEvent, 
AppleEvent reply, long refCon ) ; 

pascal OSErr DoPrintDoc( AppleEvent theAppleEvent, 
AppleEvent reply, long refCon ) ; 

pascal OSErr DoQuitApp( AppleEvent theAppleEvent, 
AppleEvent reply, long refCon ) ; 

In EventTracker, each handler printed a message in the 
Event Tracker window. In real life, you'll need to do a bit more than 
that. Let's take a fresh look at each of these handlers. 

Responding to kAEOpenApplication: DoOpenApp() 

DoOpenApp () is probably the easiest of the four required Apple event 
handlers to write. If you want your application to start up with a new, 
untitled document window, DoOpenApp () should call some code that 
creates a new, untitled document window. Here's a sample: 

#define kCantCreateWindowErr -1 

pascal OSErr DoOpenApp( AppleEvent theAppleEvent, 
AppleEvent reply, long refCon 

WindowPtr window; 

window= CreateWindow(); 

if ( window == nil ) 
return( kCantCreateWindowErr ); 

ShowWindow( window); 

return( noErr ); 

In this example, the parameters to DoOpenApp () are ignored. The 
routine CreateWindow () should create a new, untitled document 
window, placing it properly on the screen. 
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l l 
In this example, Creat eWindow () returns nil if the window could 
not be created. In that case, ooopenApp < > returns an error code 
#de f i ned above. Whether you adopt this particular error-handling 
model or not, be sure to integrate your Apple event handlers into 
your overall error-handling strategy. 

Responding to kAEOpenDocuments: DoOpenDoc() 

The first parameter to DoOpenDoc ( ), theAppleEvent, contains, 
among other things, a list of files to open. DoOpenDoc () 's job is to pull 
out the list of files, one by one, and pass the file specification on to a 
routine that will read in the file, displaying its contents in a new 
window. 

The second parameter, repl y, is also an Apple event, though at 
this point it is empty. Many Apple events require a reply from the 
handler. Sometimes the reply contains data requested in the original 
Apple event, sometimes the reply is sent to inform the originator of an 
error. The four required events don't require a reply. 

The third parameter, refCon, contains whatever value was 
passed to it when the handler was installed with 
AEinstal lEventHandler () .You can use this value as you like. 

pascal OSErr DoOpenDoc( AppleEvent theAppleEvent , 
AppleEvent reply , long r e fCon 

l 
Both theAppleEvent and reply refer to structs, and would 
normally be passed using a pointer. In this case, however, the 
routine is declared using the pascal keyword, and all parameters 
will be passed using the Pascal parameter-passing mechanism. 

Remember, this rule applies only to routines declared with the 
pascal keyword. DoOpenDoc () is declared this way because it is 
called by the Toolbox and not directly by our own code. 

The variables declared below will be discussed in context. 

AEDescList 
FSSpec 
OSErr 
DescType 
Size 

fileSpec List ; 
file ; 
err; 
type; 
actual ; 

T 
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long 
AEKeyword 
long 
WindowPtr 

count ; 
keyword ; 
index ; 
window ; 
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Apple events contain two types of information. An Apple event 
attribute describes the event class (kCoreEventClass), event ID 
(kAEOpenDocuments), or some other characteristics of the Apple 
event. DoOpenApp () knows everything it needs to about this event. It 
wouldn't be called unless a kAEOpenDocuments event occurred. If we 
needed more information about the attributes of theAppleEvent, we 
could call AEGetAttributePt r () or AEGetAttributeDesc ( ) . 

The second type of information embedded in an Apple event is 
known as a parameter. A parameter contains the Apple event's data. 
In this case, the parameter we're interested in is a list of files to open. 
Typically, parameters are wrapped in data structures known as 
descriptors. A descriptor contains a data type, followed by the data of 
that type. 

Since the Apple Event Manager provides a set of routines to access 
both parameters and attributes, there's no need to worry about the 
details of the different Apple event data structures. We strongly 
recommend, however, that you read the Apple Event Manager 
chapter in Volume VI of Inside Macintosh. 

l 

AEGetParamDesc () takes a pointer to an Apple event and returns 
a list of parameter descriptors embedded in the Apple event. 
keyDirectObject tells AEGetParamDesc () that the requested data 
is found in the descriptor record itself. typeAEList tells 
AEGetparamDesc () that the data will be in the form of a list. 

Finally, the data is returned in a parameter of type AEDesc List , a 
list of descriptors, each of which contains a file specification. 

err= AEGetParamDesc( &theAppleEvent , keyDirectObject , 
typeAEList , &fileSpecList ) ; 

If AEGetParamDesc () returns an error, you'll want to call an error­
handling routine of your own design. Depending on your error­
handling strategy, you might want to send a return Apple event that 
describes the problem, you might want to log the error, or you might 
want to ask the user for guidance. As you learn more and more about 
Apple events, your error-handling strategy will get more and more 
sophisticated. For now, you might want to write a DoAEError () that 
beeps once and then returns. 
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if ( err != noErr ) 

DoAEError( &theAppleEvent, &reply, err); 
return( err); 

485 

Once the file specification list is pulled out of the Apple event, you 
need to make sure you received only those parameters you were 
supposed to. In this case, we should receive only a single parameter, 
the list of file specifications. If any additional parameters 1 were 
received, call DoAEError (). The code for GotRequiredParams (} is 
listed following DoOpenDoc () . 

err= GotRequiredParams( &theAppleEvent ); 
if ( err != noErr ) 

DoAEError( &theAppleEvent, &reply, err); 
return( err); 

AECountitems () takes a list of descriptors and retum:s the 
number of descriptors in the list. In this case, count will contain the 
number of files we were asked to open. 

err= AECountitems( &fileSpecList, &count ); 
if ( err != noErr ) 

DoAEError( &theAppleEvent, &reply, err); 
return( err); 

Next, enter a loop, counting from 1 to the number of files 
1

to be 
processed. 

for index 1; index <= count; index++ ) 

Inside the loop, call AEGetNthPtr (),passing it the descriptor list. 
AEGetNthPt~ () returns the appropriate file in the form of a FSS~ec. 

err= AEGetNthPtr( &fileSpecList, index, 
typeFSS, &keyword, &type, (Ptr)&file, 
sizeof( FSSpec ), &actual ); 
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if ( err != noErr ) 

DoAEError( &theAppleEvent, &reply, err); 
return( err); 

If no problem occurred, pass the FSSpec on to a routine that will 
read in the file, displaying its contents in a window. 

if ( window= CreateWindowFromFile( &file ) ) 
ShowWindow( window); 

If CreateWindowFromFile () returns nil, return the same error code 
#defined for DoOpenApp (). 

else 

DoAEError( &theAppleEvent, &reply, 
kCantCreateWindowErr ); 

return( kCantCreateWindowErr ); 

return( noErr ); 

Here's the code for GotRequiredParams (),mentioned earlier: 

OS Err GotRequiredParams( AppleEvent *appleEventPtr ) 

DescType 
Size 
OS Err 

returnedType; 
actualSize; 
err; 

AEGetAttributePtr () looks for the specified attribute, returning 
an error that indicates the attribute's status. This set of parameters 
will return the first required parameter that we haven't already 
retrieved. Since we think we've pulled the required parameters 
already, we're hoping AEGetAttributePtr () returns the error 
errAEDescNotFound, indicating that there are no more required 
parameters. 

err = AEGetAttributePtr( appleEventPtr, 

keyMissedKeywcrdAttr,typeWildCard, 
&returnedType, nil, 0, &actualSize ); 
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If AEGetAttributePtr () returns noErr, another paramet~r was 
found and we had better return an error. ' 

if ( err == errAEDescNotFound 
return( noErr ); 

else if (err == noErr ) 
return( errAEEventNotHandled ); 

else 
return( err); 

Responding to kAEPrintDocuments: DoPrintDo<10 

DoPrintDoc () is virtually identical to DoOpenDoc (): 

pascal OSErr DoPrintDoc( AppleEvent theAppleEvent, 
1 

AppleEvent reply, long refCon ) 

AEDescList fileSpecList; 

FSSpec file; 

OS Err err; 

DescType type; 

Size actual; 

long count; 

AEKeyword keyword; 

long index; 

WindowPtr window; 

First, pull the file descriptor list out of the Apple event. 

err = AEGetParamDesc( &theAppleEvent, keyDirectObject, 
typeAEList, &fileSpecList); 

if ( err != noErr ) 

DoAEError( &theAppleEvent, &reply, err ); 

return( err); 

Next, make sure all of the required parameters were handled. 

err= GotRequiredParams( &theAppleEvent ); 
if ( err != noErr ) 
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DoAEError( &theAppleEvent, &reply, err); 
return( err); 

Count the number of files to print. 

err= AECountitems( &fileSpecList, &count ); 
if ( err != noErr ) 

DoAEError( &theAppleEvent, &reply, err); 
return( err); 

Loop on this number, pulling out the FSSpecs, one at a time. 

for ( index = 1; index <= count; index++ ) 

err= AEGetNthPtr( &fileSpecList, index, typeFSS, 
&keyword, &type, (Ptr) &file, 
sizeof( FSSpec ), &actual); 

if ( err != noErr 

DoAEError( &theAppleEvent, &reply, err); 
return( err); 

Here's the difference. You'll still load the data from the file, creating 
a (still invisible) window. Next, you'll call a routine that prints the 
window's contents. Once the data is printed, dispose of the window. 

if ( window= CreateWindowFromFile( &file ) ) 

else 

PrintWindow( window); 
CloseWindow( window); 

DoAEError( &theAppleEvent, &reply, 
kCantCreateWindowErr ); 

return( kCantCreateWindowErr ); 

return{ noErr ); 
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Responding to kAEQuitApplication: DoQuitApp() 

DoQui tApp ( ) gets called when someone wants your application to 
exit. For example, if your application is running and the user s~lects 
Restart or Shutdown from the Finder's Special menu, the Finder 
will send your application a kAEQuitApplication Apple eventl and 
your DoQuitApp () handler will be called. 

pascal OSErr DoQuitApp( AppleEvent theAppleEvent, 
AppleEvent reply, long refCon 

OSErr err; 

Typically, you'll write a single routine to handle quitting. In! this 
case, DoQui tApp () calls a routine called CloseDown () . CloseDown () 
walks through the list of application windows, closing each one in turn. 
If a window's contents have not been saved, the user will be pr01ripted 
to save or discard the contents. 

If CloseDown () was able to close all windows, it returns true, and 
DoQuitApp () returns noErr. If a problem is encountered, 
CloseDown () will return false, and DoQuitApp () will return an 
error. In either case, gDone is set to true and the program exits. 

if ( CloseDown() 
err noErr; 

else 
err errAEWaitCanceled; 

gDone = true; 

return( err); 

In Review 

We've covered a lot of material in this chapter. Most of the concepts 
are described in great detail in Inside Macintosh, Volume VI. Although 
we've tried to get you started, you owe it to yourself to read Volume VI 
cover to cover. Here are a few key chapters: 

Start with Chapters 1and2. Read these straight through. Chapter 
1 is an overview of the book and is quite short. Chapter 2 discusses 
important user interface issues. 
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Next, check out Chapter 9, the Finder Interface chapter. This 
chapter details the Finder resources and adds a few we didn't cover in 
this chapter. 

Chapter 6 presents the Apple Event Manager. There is a lot of 
detail in this chapter, so don't try to absorb it all in one sitting. Before 
you start, take the concepts in this chapter and try your hand at a 
small application that implements the required Apple event handlers. 
If you like, use the coupon in the back of this book to send away for the 
Mac Primer source code disk. We've included a complete Apple events 
program that you can use as a model. 

Next, check out Chapters 4 (the Edition Manager) and 11 (the Help 
Manager). Once that's done, start on the rest of the chapters. 

Our last chapter discusses the issues you'll face as you start 
developing your own Macintosh applications. We'll start by taking a 
look at a few Mac periodicals you may find useful. We'll talk about 
Inside Macintosh and other Apple technical references, and we'll look 
at Apple's support apparatus for Macintosh programmers and 
developers. 
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To successfully develop software for the 
Macintosh, you need current technical 
information. You need to know how to 

use the standard Macintosh references 
effectively. You also need to know about 

the different technical support 
programs Apple offers. In this chapter, 

we'll discuss these and other Mac 
development issues. 

9 
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THE BASICS OF programming the Macintosh have been laid out in the 
eight pre~eding chapters. Familiarity with these basics is half the job 
of becommg a successful developer. The other half is understanding 
~ow the ~ac programming world works and knowing where to get' the 
mformation you, as a Macintosh software developer, will need. 

This chapter investigates the periodicals that are your link to the 
Macintosh community. It looks at Inside Macintosh and other Mac 
technical texts, as well as software tools, from compilers to debuggers. 
The chapter also examines Apple's support programs for Macinto'sh 
software developers. 

The Macintosh Programming Primer is your passport to Mac appli­
cation programming. When you've finished reading this book, join a 
local Mac user group, and buy a copy of the best Mac programmer's 
magazine, MacTutor. Get involved and write some code! 

Macintosh Periodicals 

Whether you're interested in creating a commercial product or a 
shareware product, or whether you just want to know the latest news 
from the Mac community, read the trade magazines. MacWeek is. 
great, and PCWeek and InfoWorld are good, if less oriented to the 
Macintosh computer line. All three magazines deliver timely dollops of 
news: the new software packages, scoops on company goings-on, and 
juicy industry gossip. 

The Macintosh programming journal is MacTutor, an invigorating 
monthly discourse on the art of Mac programming. Popular Mac 
magazines include MacUser and Mac World. Their broad viewpoint can 
show you what's of interest to Macintosh users and what's available. 

While you wait for the idea that will make you the seventh richest 
person in the world, you need to learn the Macintosh inside and out. 
To do this, you need Inside Macintosh. 

The Essential Inside Macintosh 

The Inside Macintosh technical reference series is written by Apple 
and published by Addison-Wesley. As this book went to press, Apple 
was hard at work reorganizing the entire series. The new Inside 
Macintosh series will consist of 16 books published between summer of 
1992 and spring of 1993. The series is described in more detail in 

493 



494 Macintosh C Programming Primer 

Appendix H. Although the new version of Inside Macintosh. will ~ave a 
new look, the information in the old series should remam vahd for 
quite some time. 

Since the new version hasn't hit the bookstores yet, here's a descrip-
tion of the seven books that make up the current series (Volumes I-VI 
and the Inside Macintosh X-RefJ. 

Volumes I, II, and III represent the Mac technical world as it was 
before the Mac Plus was introduced. All three volumes focus on the 
original 128K Mac, describing interfaces to the ROM routines, 
memory management, hardware specs, and more. 

Volume IV was released after the Mac Plus and the Mac 512KE 
were introduced. Both of these new Macs sported 128K ROMs (as 
opposed to the 128K Mac's 64K ROMs). These larger ROMs contain 
the routines that handle the Hierarchical File System (HFS), routines 
that interface to the SCSI (Small Computer System Interface) port, 
and updates to most of the 64K ROM routines. Volume IV covers all of 
these changes. 

Volume V was released after the introduction of the Mac SE and the 
Mac II. The Mac II and the SE have 256K ROMs and support features 
such as pop-up, hierarchical, and scrolling menus; a sophisticated 
sound manager; new text-edit routines; and more. Perhaps the biggest 
change was the addition of color support to the Mac II series. 

Finally, Volume VI explains the enhancements provided by the long­
awaited System 7: InterApplication Communication (IAC), virtual 
memory, AppleEvents, a redesigned Finder, new printing, database 
routines, and more! 

The Typical Inside Macintosh Chapter 

One of the best features of the Inside Macintosh volumes is their 
consistency. Each chapter starts with a table of contents, followed by 
the "About This Chapter" section, which gives you an overview of what 
the chapter covers and what you should already be familiar "'ith 
before you continue. 

The next section, or sections, gives an overview of the chapter's 
technical premise; for example, "About the Event Manager," or "About 
the Window Manager." The fundamental concepts are explained in 
great detail. At first, you may be overwhelmed by the wealth of detail, 
but after a few readings (and a little experimentation), you'll warm to 
the concept. 

Next, the chapter's data structures, constants, and essential vari­
ables are detailed. These are presented in Pascal and/or assembly 
language. Then come the chapter's Toolbox routines. Each routine's 
calling sequence is presented in Pascal, along with a detailed explana­
tion of the uses of the routine. This section includes notes and warn­
ings, as appropriate. 
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Some chapters follow the Toolbox routines section with a few 
additional sections. Among these extras are a description of the 
resources pertinent to that chapter and, perhaps, a description of 
extensions available to the advanced programmer. 

Finally, there's a chapter summary, with unadorned lists of 
constants, data types, routines, and variables. 

Appendixes and Special Sections 

The preface from Inside Macintosh, Volume VI is a must read: It 
contains an overview of each Inside Macintosh volume and a road map 
that leads you through the remainder of Volume VI, chapter 1 by 
chapter. The road map lists related chapters from earlier Inside 
Macintosh volumes, making clear which volume has the final say ',on 
which topic. 

Volume III contains three chapters, some appendixes, a glossary, 
and an index. Chapter 1 discusses the Finder (with an emphasis bn 
Finder-related resources). Chapter 2 discusses the pre-Mac Plus hard­
ware. Chapter 3 is a compendium of all the summary sections from 
Volumes I and II. Appendix A is a handy, if occasionally inaccurate, 
table of result codes from the functions defined in Volumes I and II. 
The rest of the appendixes in Volume III have been superseded by the 
appendixes in the second edition of the Inside Macintosh X-Ref. ' 

The second edition of the Inside Macintosh X-Ref starts with ,a 
general index covering all six Inside Mac volumes, plus Inside the 
Macintosh Communications Toolbox; Designing Cards and Drivers fpr 
the Macintosh Family; Guide to the Macintosh Family Hardware; 
Programmer's Introduction to the Macintosh Family; and Technical 
Introduction to the Macintosh Family. The general index is followed by 
an index of constants and field names. Appendix A of the X-Ref lists 
every Toolbox routine that may move or purge memory. ' 

Appendix B of the Inside Macintosh X-Ref, second edition, consists 
of four lists. The first is a list of Toolbox routines presented alpha~ 
betically by name, with each name followed by the routine's tra~ 
address, which is the 4-byte instruction the compiler generates to call 
the routine. The second is a list of the trap addresses, in order, with: 
each trap address followed by the routine name. The third lists traps• 
that have more than one routine associated with them, and the fourth'· 
lists these same traps ordered by routine name. This information is 

1 

extremely useful if you ever have to look at code in hexadecimal for- . 
mat, a likely event if you use TMON or MacsBug, two Mac debuggers. 

Appendix C of the Inside Macintosh X-Ref lists most of the operat- , 
ing system global variables, with their memory location and a brief '. 
description. Appendix D contains a table showing the standard roman ·, 
character set, listing each character's hex and decimal value, along 
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with the character's PostScript name. Finally, Appendix Dis followed 
by a glossary of terms presented in Volumes I through VI. 

Apple Technical References 

In the first few years of the Mac era, Inside Macintosh was the only 
definitive reference on the Macintosh. Over the years, however, Apple 
has published many additional reference texts for the Macintosh, 
including Inside the Macintosh Communications Toolbox; Designing 
Cards and Drivers for the Macintosh Family; Guide to the Macintosh 
Family Hardware; Programmer's Introduction to the Macintosh 
Family; and Technical Introduction to the Macintosh Family. These 
books are all part of Addison-Wesley's Apple Technical Library. 
Another excellent source of technical information is the Macintosh 
Technical Notes. 

Macintosh Technical Notes 

Macintosh Technical Notes are published on a regular basis by Apple 
and distributed to Apple Partners and Associates (we'll discuss both in 
a moment) free of charge. The Tech Notes are a necessity for serious 
Mac developers. They contain technical information that was not yet 
available when the latest volume of Inside Macintosh went to press. 
For example, Tech Note #184 described the Notification Manager (used 
in Chapter 6) well before Volume VI of Inside Macintosh hit the 
bookstore shelves. Without this Tech Note, developers wouldn't even 
know the Notification Manager existed, let alone know how to use it. 

A timely way to receive Tech Notes if you are not a Partner or 
Associate is to order them through APDA, the Apple Programmers 
and Developers Association. APDA sells almost everything on the 
Mac's technical side. They sell the Tech Notes in both hard copy 
and disk formats. Call APDA at (800) 282-2732, and ask them to 
send you a catalog. You'll be glad you did. 

If you don't want to order the tech notes from APDA, you can still 
get Tech Notes by downloading them from Mac-based bulletin boards 
around the country. 

Another important technical guide from APDA benefits developers 
using Apple events. If you plan on going beyond the required Apple 
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events, buy the Apple Event Registry, which contains detailed 
information on all the currently defined Apple Events. 

Other Books 

There are several excellent books on Macintosh programming. 'One 
classic title is Scott Knaster's How to Write Macintosh Software, now 
in its third edition. This book is a little too advanced for the begi11ner, 
but it's worth the struggle to get through it. If you plan on writing a lot 
of Mac code, read this book. 

Addison-Wesley has published a number of excellent Macintosh 
programming books under the banner of the Macintosh lnside•Out 
series. These books include such titles as Programming for System 7 
and ResEdit Complete. 1 

Finally, you might want to try the Macintosh C Programming 
Primer, Volume II, by Dave Mark. Object programming, Color 
QuickDraw, INITs, cdevs, and other interesting Toolbox routines' are 
examined, with lots of examples and code walkthroughs. 

Apple's Developer Programs 

Apple's Partner and Associate programs were designed to give full­
time Macintosh developers additional technical support from Apple. 
The Apple Partners program offers complete Apple technical docu­
mentation, system software updates, access to training classes, 

1

and 
discounts on Apple hardware and software. Partners also get a year's 
subscription to AppleLink, Apple's electronic communication network, 
and access to Macintosh Developer Technical Support (see next 
section). If you have a CD-ROM drive, you may want to take advan­
tage of the Developer CD Series, which is a set ofCD-ROMs shippe~ to 
developers every few months, containing sample code, utility pro­
grams, and an electronic version of Inside Macintosh! 

The only disadvantage of being a developer is parting with the clieck 
you include with your Apple Partners application (currently $600). 

You don't have to be a Fortune 500 company to qualify as an Apple 
Partner, but Apple is looking specifically for developers of Apple hard­
ware and software who intend to resell their products. If you are 
interested in developing software but don't have an immediate plart to 
market it, you might consider the Apple Associates Program, another 
support program froni Apple. 

The Apple Associates Program is aimed at educators, in-house 
developers, and shareware programmers. It provides a basic level of 
support, including AppleLink (one month prepaid), system software 
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upgrades, Tech Notes, and access to other technical information. The 
Associates program currently costs $350 a year. 

If you plan on writing a product for the Mac, the information you 
receive in either program is invaluable. Call the Developer Programs 
Hotline at ( 408) 97 4-4897 and ask them to send you an application. 

If you are a developer, there's nothing more satisfying than talking 
to people who have solved, or at least are aware of, the technical prob­
lems you encounter in writing programs. At Apple, these people come 
from Macintosh Developer Technical Support, or MacDTS. 

Macintosh Developer Technical 
Support and AppleLink 

Macintosh Developer Technical Support is a team of talented Mac soft­
ware engineers dedicated to helping developers with their technical 
problems. To work with MacDTS, you must first join the Apple 
Partners program. Once you're an Apple Partner, you can send your 
technical questions to Developer Technical Support through AppleLink 
(the AppleLink address is MacDTS). 

AppleLink offers access to Apple product, pricing, support pro­
grams, and policy information. If you write to Developer Technical 
Support (their AppleLink address is MacDTS), they will make every 
possible effort to answer your question promptly. 

Both Apple Partners and Apple Associates receive subscriptions to 
AppleLink: Apple Partners receive a full year's subscription with the 
minimum monthly fees prepaid; Apple Associates receive one month of 
the minimum monthly fee prepaid. 

Besides access to MacDTS, AppleLink gives you access to a lot of 
other services. You can download the new system utilities or look at 
the Help Wanted ads posted on the bulletin board. You can send beta 
versions of your products to your evangelist at Apple or to other devel­
opers. AppleLink makes you a part of the developer community. 

CompuServe and America Online 

If you don't have access to AppleLink, there are several other ways to 
hook up with the Macintosh programming community. For starters, 
there's the CompuServe Information Service. CompuServe has one of 
the strongest Macintosh followings of any on-line service. By logging 
on to CompuServe, you have access to a vast quantity of Macintosh 
technical information, from the latest System files to a guru to help 
you with your latest programming project. When logging on to 
CompuServe, type GO MACDEV, then stop by the Learn Program­
ming area (Section 11) and say hello. 
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Another electronic service is America Online. America Online offers 
access to most of the same services, information, and people as 
CompuServe, and at a lower price. It is definitely worth checking out. 

To use either of these services, you'll need a modem and ~ome 
special software. For CompuServe access, any telecommunications 
package will work, but you'll save time and money if you pick up a copy 
of either the CompuServe Information Manager or CIS Navigator. 
Both of these programs help you organize your on-line time. 

To access America Online, you'll need the America Online pro~am, 
available from Quantum Computer Services, in Vienna, Virginia. 
Occasionally, you'll spot CompuServe and America Online starter kits 
in your favorite technical bookstore. ' 

Software Development Tools 
I 

All the applications presented in this book were written in C, using the 
THINK C development environment from Symantec. The advantages 
of THINK C lie primarily in its ease of use and debugging facilities. 
Symantec also makes a powerful, yet friendly, Pascal development 
environment called THINK Pascal. 

Both THINK environments are basically nonextensible. This me.ans 
you can't create shell scripts to back up your files automatically, or 
rebuild an older version of your project. You also can't create custom 
menu items that automate your development process. THINK environ-

' ments handle most of the development cycle so thoroughly that you 
may not miss these features. If you do, you may want to take a look at 
the Macintosh Programmer's Workshop (MPW) from Apple. ! 

MPW from Apple 

MPW is an extremely powerful development environment that is 
totally extensible-so extensible, in fact, that several third paljties 
have produced compilers that run under MPW. MPW is like a Mac­
based UNIX shell. You can write shell scripts, tie them to your own 
menus, and create tools that have total access to the Toolbox yet run 
inside the Toolbox environment with access to all of your data. The 
catch is that MPW is more complex than THINK C and, therefore, 
more difficult to master. MPW is also not cheap, typically costing more 
than three times as much as THINK C or Pascal. 

Both MPW and THINK have many followers and are supporteq by 
MacDTS. Whichever way you go, you'll be in good company. 
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Debugging with THINK C, TMON, The Debugger, 
andMacsBug 

Debugging on any computer can be a tedious and frustrating expe­
rience. Luckily, there are some excellent tools you can use to fix up 
your code. 

Normally, the THINK C debugger will prove more than adequate to 
track down most bugs. If you need lower-level support, however, there 
are several other options available. 

MacsBug is an object-level debugger developed by Motorola for the 
68000 family of processors. For a long time, it was the only debugger 
available for the Mac. 

If you need a little more horsepower than MacsBug offers, consider 
either TMON from ICOM Simulations, or Jasik Designs' excellent 
combination, MacNosy and the Debugger. Both of these products are 
professional debugging tools. Instead of running as a normal applica­
tion, both of these products take over the processor when they run. 
They preserve your program's run-time environment by not calling 
any of the Mac Toolbox routines (which might alter the state of your 
program). Instead, each implements its own window and menu 
handlers. Although each is somewhat difficult to learn, they're worth 
it. When you run into an exasperatingly unexplainable bug, pop into 
TMON or the Debugger and step through your program. You can set 
breakpoints, disassemble your executable image, and even make 
changes to your program and data. For debugging drivers, INITs, and 
DAs, these two programs can't be beat. 

Resourcerer: An Alternative to ResEdit 

Although ResEdit is powerful, it has its limitations. A resource-editing 
alternative is Resourcerer, from Mathemaesthetics. Resourcerer offers 
most of the same features as ResEdit, with lots of extras. Here's a 
sampling. 

When you open a CODE resource, Resourcerer will disassemble it 
for you. The CODE editor includes symbolic names, and allows you to 
edit and patch CODE resources in a variety of formats. Unlike 
ResEdit, Resourcerer knows how to edit all balloon help resources and 
lets you try out your help balloons in both dialogs and menus. You can 
edit your data fork as a resource, write your own resource editing 
templates, and compare two resource files. 

To find out more about Resourcerer, call Mathemaesthetics at (617) 
738-8803. 
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CMaster: Customizing Your TIIlNK C Environment 

One final product we'd like to mention is CMaster, a THINK C cus­
tomizer. Once you've installed CMaster, you'll find yourself with 
several new features when you run THINK C. The most noticeable 
change is evidenced by the menus and icons that appear in each of 
your source code windows. One menu lists each of the functions in the 
file. Select a function from the menu and CMaster jumps to that 
section of code. 

When you click and drag in the thumb of a source code window, 
CMaster scrolls your code as you move the thumb. (This may not seem 
like much, but it's really cool to watch.) There's a find icon that 
searches up or down in the file, depending on whether you click oni the 
top or bottom half of the icon. 

CMaster has a boatload of features. To find out more, call Jersey 
Scientific at (212) 736-0406. 

Source Code Bounty 

Tired of burning the midnight oil struggling with some weighty 
Toolbox concept? Put down those pruning shears and pay close atten­
tion. Chances are, someone, somewhere has already done what yoh're 
trying to do. 

America Online and CompuServe both feature a treasure trove of 
useful source code examples. Get the current issue of MacTutor. ~ow 
go to the bookstore and buy all of the back issues, marketed under i the 
title The Best of MacTutor. There are several volumes, all of them 
useful. 

Check out your local Macintosh user group. Most user groups have 
a special interest group dedicated to programming. Some, like 1 the 
Berkeley Macintosh user group, offer source code disks through mail 
order. 

Finally, check out the selection offered by Intelligence At Large. For 
starters, they feature a complete line of Mac Primer source code disks. 
They also offer the Mac Programming 101 series, source code for 
aspiring Mac programmers that shows the basics for text editing, 
picture displaying, sound making, Apple events, and more. To place 
an order, or for more information, call Intelligence At Large at (215) 
387-6002. 
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To Boldly Go 

The Macintosh world is accelerating. 
New names, functions, and features appear with startling speed: 

Taligent, QuickTime, voice recognition, and synthesized speech are all 
new parts of an exciting Macintosh revolution. The Macintosh opera­
ting system has hit its stride with System 7. As a testbed for inno­
vation and excitement, the Macintosh stands alone. 

A new generation of Macintosh developers is coming on board. 
And you ain't seen nothing yet! 
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Glossary 

A5 world: An area of memory in the application's partition that 
contains QuickDraw™ global variables and the application's 
global variables, parameters, and jump table-all of which ~re 
accessed through the A5 register. ! 

access path: A description of the route that the File Manager follows 
to access a file; created when a file is opened. 

action procedure: A procedure, used by the Control Manager fuhc­
tion TrackControl, that defines an action to be performed repeat­
edly for as long as the mouse button is held down. 

activate event: An event generated by the Window Manager whe:p. a 
window changes from active to inactive or vice versa. 

active application: The application currently interacting with the 
user. Its icon appears on the right side of the menu bar. See also 
current process, foreground process. 

active control: A control that responds to the user's actions with the 
mouse. 

active field: The target of keyboard input in a dialog box. 
active window: The front-most window on the desktop. 
address: A number used to identify a location in the computer's 

address space. Some locations are allocated to memory, others' to 
1/0 devices. 

address descriptor record: A descriptor record that contains the 
address of the target or source of an Apple event. 1 



504 Macintosh C Programming Primer 

AEIMP: See Apple Event Interprocess Messaging Protocol. 
AE record: A record of data type AERecord that contains a list of param­

eters for an Apple event. See also Apple event parameter. 
alert: A warning or report of an error in the form of an alert box, a sound 

from the Macintosh® speaker, or both. 
alert box: A box that appears on the screen to give a warning or report 

an error during a Macintosh application. 
alert template: A resource that contains information from which the 

Dialog Manager can create an alert. 
alert window: The window in which an alert box is displayed. 
alias: An object on the desktop that represents another file, directory, or 

volume. An alias looks like the icon of its target, but its name is 
displayed in a different font style. The style depends on the system 
script; for Roman and most other scripts, alias names are displayed 
in italic. Aliases give users more flexibility in organizing their 
desktops and offer a convenient way to store local copies of large or 
dynamic files that reside on file servers. 

alias file: A file that contains a record that points to another file, direc­
tory, or volume. An alias file is displayed by the Finder™ as an alias. 

alias record: A data structure created by the Alias Manager to identify 
a file, directory, or volume. 

alternate rectangle: A rectangle used by the Help Manager (under 
some circumstances) for transposing a help balloon's tip when trying 
to fit the balloon on screen. For all help resources except the 'hdlg' 
resource, the Help Manager moves the tip to different sides of the hot 
rectangle. For 'hdlg' resources, however, the Help Manager allows you 
to specify alternate rectangles for transposing balloon tips. You can 
also specify alternate rectangles when you use the HMShowBalloon 
and HMShowMenuBalloon functions. 

Apple event: A high-level event that adheres to the Apple Event 
Interprocess Messaging Protocol. An Apple event consists of 
attributes (including the event class and event ID, which identify the 
event and its task) and, usually, parameters (which contain data 
used by the target application of the event). See also Apple event 
attribute, Apple event parameter. 

Apple event attribute: A keyword-specified descriptor record that 
identifies the event class, event ID, target application, or some other 
characteristic of an Apple event. Taken together, the attributes of an 
Apple event identify the event and denote the task to be performed 
on the data specified in the Apple event's parameters. Compared to 
parameters (which contain data used only by the target application of 
the Apple event), attributes contain information that can be used by 
both the Apple Event Manager and the target application. See also 
Apple event parameter. 



Glossary 
I 

505 

Apple event dispatch table: A table that the Apple Event Manager 
uses to map Apple events to application-defined functions called 
Apple event handlers. 

Apple event handler: An application-defined function that extracts 
pertinent data from an Apple event, performs the action requested 
by the Apple event, and returns a result. 1 

Apple Event Interprocess Messaging Protocol (AEIMP): A 
standard defined by Apple Computer, Inc., for communication1and 
data sharing among applications. High-level events that adhere to 
this protocol are called Apple events. 

Apple event parameter: A keyword-specified descriptor record ~hat 
contains data that the target application of an Apple event must 
use. Compared to attributes (which contain information that can 
be used by both the Apple Event Manager and the target appli­
cation), parameters contain data used only by the target applica­
tion of the Apple event. See also Apple event attribute, direct 
parameter, optional par~eter, required parameter. ! 

Apple event record: A record of data type AppleEvent that contains 
a list of keyword-specified descriptor records. These 
descriptor records describe-at least-the attributes necessacy for 
an Apple event; they may also describe parameters for the Apple 
event. Apple Event Manager functions are used to add param~ters 
to an Apple event record. ' 

Apple Menu Items folder: A directory located in the System Folder 
for storing desk accessories, applications, folders, and aliases that 
the user wants to display in and access from the Apple menu. 

application font: The font your application uses unless you specify 
otherwise-Geneva, by default. ' 

application heap: An area of memory in the application partition 
that contains the application's 'CODE' segment 1, data structures, 
resources, and other code segments as needed. ' 

application heap limit: The boundary between the space available 
for the application heap and the space available for the stack. 

application heap zone: The heap zone initially provided by the 
Memory Manager for use by the application program and the 
Toolbox; initially equivalent to the application heap, but may be 
subdivided into two or more independent heap zones. · 

application window: A window created as the result of something 
done by the application, either directly or indirectly (as thr6ugh 
the Dialog Manager). 

auto-key event: An event generated repeatedly when the 1i1ser 
presses and holds down a character key on the keyboard or 
keypad. 

auto-key rate: The rate at which a character key repeats after it's 
begun to do so. 
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auto-key threshold: The length of time a character key must be held 
down before it begins to repeat. 

background activity: A program or process that runs while the user is 
engaged with another application. 

background process: A process that isn't currently interacting with the 
user. Compare foreground process. 

bit image: A collection of bits in IPemory th~t have a rectilinear repre­
sentation. The screen is a visible bit image. 

bitmap: A set of bits that represents the positions and states of a 
corresponding set of items, such as pixels. 

bitmapped font: A collection of bitmapped glyphs in a particular type­
face, size, and style. 

bundle: A resource that maps local IDs of resources to their actual 
resource IDs; used to provide mappings for file references and icon 
lists needed by the Finder. 

bundle bit: A flag in a file's Finfo record that informs the Finder that a 
'BNDL' resource exists for the file. A file's Flnfo record is stored in a 
volume's catalog. The Finder uses the information in the 'BNDL' 
resource to associate icons with the file. 

button: A standard Macintosh control that causes some immediate or 
continuous action when clicked or pressed with the mouse. See also 
radio button. 

caret: A generic term meaning a symbol that indicates where something 
should be inserted in text. The specific symbol used is a vertical 
bar (I). 

caret-blink time: The interval between blinks of the caret that marks 
an insertion point. 

cdev: A resource file containing device information, used by the Control 
Panel (in system software prior to version 7.0) or stored in the 
Control Panels folder inside the System Folder (in version 7.0). See 
also control panel. 

cell: The basic component of a list from a structural point of view; a cell 
is a box in which a list element is displayed. 

character code: A hexadecimal number from $00 through $FF that 
represents the character that a key or key combination stands for. 

character key: A key that generates a keyboard event when pressed; 
any key except Shift, Caps Lock, Command, Option, Control, or Esc. 

check box: A standard Macintosh control that displays a setting, either 
checked (on) or unchecked (off). Clicking inside a check box reverses 
its setting. 

Chooser: A desk accessory that provides a standard interface for device 
drivers to solicit and accept specific choices from the user. 

clipping: Limiting drawing to within the bounds of a particular area. 
clipping region: Same as clipRgn. 
clipRgn: The region to which an application limits drawing in a grafPort. 
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closed file: A file without an access path. Closed files cannot be read 
from or written to. 

content region: The area of a window that the application draws in. 
control: An object in a window on the Macintosh screen with which 

the user, using the mouse, can cause instant action with visible 
results or change settings to modify a future action. 1 

control definition ID: A number passed to control-creation routines 
to indicate the type of control. It consists of the control definition 
function's resource ID and a variation code. 

control list: A list of all the controls associated with a given window. 
Control Manager: The part of the Toolbox that provides routines for 

creating and manipulating controls (such as buttons, check boxes, 
and scroll bars). 

control panel: A dialog box defined by a file of file type 'cdev'. A 
control panel allows the user to set or control some feature of 

I 

hardware or software, such as the volume of the speaker 011 the 
number of colors displayed on screen. 

1 

control panel file: A file of file type 'cdev'. Se also control panel. 
Control Panels folder: A directory located in the System Folder for 

storing control panels, which allow users to modify the work 
environment of their Macintosh computer. ~ 

control record: The internal representation of a control, where the 
Control Manager stores all the information it needs for its opera­
tions on that control. 

coordinate plane: A two-dimensional grid. In QuickDraw, the 
1

grid 
coordinates are integers ranging from -32767 to 32767, an~ all 
grid lines are infinitely thin. · 

core Apple event: An Apple event that nearly all applications can 
use to communicate. The suite of core Apple events is described in 
the Apple Event Registry; Apple Computer, Inc., recommends .that 
all applications support the core Apple events. 1 

current process: The process that is currently executing and whose 
A5 world is valid; this process can be in the background or 
foreground. 

current resource file: The last resource file opened, unless• you 
specify otherwise with a Resource Manager routine. I 

cursor: A 16-by-16 bit image that appears on the screen and is 
controlled by the mouse; called the "pointer" in Macintosh 'user 
manuals. 

custom Apple event: An Apple event defined by you for use by ;your 
own applications. You should register all of ·your custom i\pple 
events with Macintosh Developer Technical Support. You: can 
choose to publish your Apple events in the Apple Event Registry so 
that other applications can share them, or you may choose to keep 
them unpublished for exclusive use by your own applications. 
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customized icon: An icon created by the user or by an application and 
stored with a resource ID of -16455 in the resource fork of a file. A 
file with a customized icon has the hasCustomlcon bit set in its 
Finder flags field. 

data fork: The part of a file that contains data accessed via the File 
Manager. 

default button: In an alert box or modal dialog box, the button whose 
effect occurs if the user presses Return or Enter. In an alert box, it's 
boldly outlined; in a modal dialog box, it's boldly outlined or it's the 
OK button. 

descriptor record: A record of data type AEDesc that consists of a 
handle to data and a descriptor type that identifies the type of the 
data referred to by the handle. Descriptor records are the funda­
mental structures from which Apple events are constructed. 

descriptor type: An identifier for the type of data referred to by the 
handle in a descriptor record. 

desk accessory: A "mini-application," implemented as a device driver, 
that can be run at the same time as a Macintosh application. 

Desk Manager: The part of the Toolbox that supports the use of desk 
accessories from an application. 

desk scrap: The place where data is stored when it's cut (or copied) and 
pasted among applications and desk accessories. 

desktop: The screen as a surface for doing work on the Macintosh. 
dial: A control with a moving indicator that displays a quantitative set­

ting or value. Depending on the type of dial, the user may be able to 
change the setting by dragging the indicator with the mouse. 

dialog: Same as dialog box. 
dialog box: A box that a Macintosh application displays to request 

information it needs to complete a command, or to report that it's 
waiting for a process to complete. 

dialog hook function: A function supplied by your application for 
handling item hits in a dialog box. 

Dialog Manager: The part of the Toolbox that provides routines for 
implementing dialog boxes and alert boxes. 

dialog record: The internal representation of a dialog box, where the 
Dialog Manager stores all the information it needs for its operations 
on that dialog box. 

dialog template: A resource that contains information from which the 
Dialog Manager can create a dialog box. 

dialog window: The window in which a dialog box is displayed. 
dimmed: Drawn in gray rather than black. 
direct parameter: The parameter in an Apple event that contains the 

data to be used by the server application. For example, a list of 
documents to be opened is specified in the direct parameter of the 
Open Documents event. See also Apple event parameter. 
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directory: A subdivision of a volume, available in the hierarchical file 
system (HFS). A directory can contain files and other directories. 

directory ID: A unique number assigned to a directory, which the 
File Manager uses to distinguish it from other directories on the 
volume. (It's functionally equivalent to the file number assigned to 
a file; in fact, both directory IDs and file numbers are assigned 
from the same set of numbers.) 

disk-inserted event: An event generated when the user inserts a 
disk in a disk drive or takes any other action that requires a 
volume to be mounted. 

display rectangle: A rectangle that determines where an item is 
displayed within a dialog or alert box. ' 

empty handle: A handle that points to a NIL master pointer, signi­
fying that the underlying relocatable block has been purged. 

event: A notification to an application of some occurrence that the 
application may want to respond to. 

event class: An attribute that identifies a group of related Apple 
events. The event class appears in the message field of the Apple 
event's event record. In conjunction with the event ID attribute, 
the event class specifies what action an Apple event performs. ,See 
also Apple event attribute. · 

event code: An integer representing a particular type of event. 
event ID: An attribute that identifies a particular Apple event within 

I 

a group of related Apple events. The event class appears in i the 
where field of the Apple event's event record. In conjunction With 
the event class attribute, the event ID specifies what action an 
Apple event performs. See also Apple event attribute. 

event mask: A parameter passed to an Event Manager routine to 
specify which types of events the routine should apply to. 

event message: A field of an event record containing information 
specific to the particular type of event. 

event queue: The Operating System Event Manager's list of pending 
events. 

event record: The internal representation of an event, thropgh 
which your program learns all pertinent information about that 

I 

ff~ i 

file: A named, ordered sequence of bytes; a principal means by which 
data is stored and transmitted on the Macintosh. 1 

file ID: An unchanging number assigned by the File Manager to 
identify a file on a volume. When it establishes a file ID, the File 
Manager records the filename and parent directory ID of the file. 
The Alias Manager records a file's ID to help identify it if it is 
moved or renamed. 

filename: A sequence of up to 255 printing characters, excluding 
colons (:), that identifies a file. 
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file number: A unique number assigned to a file, which the File 
Manager uses to distinguish it from other files on the volume. A file 
number specifies the file's entry in a file directory. 

file reference: A resource that provides the Finder with file and icon 
information about an application. 

file system specification (FSSpec) record: A record that identifies a 
stored file or directory by volume reference number, parent directory 
ID, and name. The file system specification record is the file­
identification convention adopted by system software version 7 .0. 

file type: A four-character sequence, specified when a file is created, that 
identifies the type of file. 

Finder flags: Bits in the fdFlags field of a file's Finfo record; these bits 
are used by the Finder and by applications for setting and reading 
certain information about the file, such as whether the file is an alias 
file, whether it has a bundle resource, whether it is a stationery pad, 
and whether it has a customized icon. 

Finder information: Information that the Finder provides to an appli­
cation upon starting it up, telling it which documents to open or 
print. 

font: ( 1) For bitmapped fonts, a complete set of characters in one typeface, 
size, and style. (2) For outline fonts, a complete set of characters in 
one typeface and style. See also bitmapped font, outline font. 

Font Manager: The part of the Toolbox that supports the use of various 
fonts for QuickDraw when it draws text. 

font number: The number by which you identify a font to QuickDraw or 
the Font Manager. 

font scaling: The process of changing a glyph from one size or shape to 
another. The Font Manager can scale bitmapped and outline fonts in 
three ways: changing a glyph's point size on the same display device, 
modifying the glyph but keeping the point size constant when using a 
different display device, and altering the shape of a glyph. 

font size: The size of the glyphs in a font in points, measured from the 
base line of one line of text to the base line of the next line of single­
spaced text. 

font style: Stylistic variations in the appearance of a typeface, such as 
italic, bold, and underline. 

foreground process: The process currently interacting with the user; it 
appears to the user as the active application. The foreground process 
displays its menu bar, and its windows are in front of the windows of 
all other applications. Compare background process. 

fork: One of the two parts of a file; see data fork and resource fork. 
functional-area Apple event: An Apple event supported by applica­

tions with related features-for example, an Apple event related to 
text manipulation for word-processing applications, or an Apple event 
related to graphics manipulation for drawing applications. Fune-
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tional-area Apple events are defined by Apple Computer, Inc., in 
consultation with interested developers, and they are published in 
the Apple Event Registry. 

global coordinate system: The coordinate system based on the top 
left corner of the bit image being at (0,0). 

go-away region: A region in a window frame. Clicking inside this 
region of the active window makes the window close or disapp~ar. 

grafPort: A complete drawing environment, including such elements 
as a bitmap, a subset of it in which to draw, a font, patterns for 
drawing and erasing, and other pen characteristics. 

graphics environment: The combination of one or more grafPorts, 
which contain information about windows, and graphics device 
records, which contain information about display devices attathed 
to a computer system. I 

gray region: The region that defines the desktop, or the display area 
of all active devices, excluding the menu bar on the main screen 
and the rounded corners on the outermost screens. It is the area 
in which windows can be moved. See also main screen. 

GrayRgn: The global variable that in the multiple screen desktop 
describes and defines the desktop, the area on which windowJ can 
be dragged. · 

grow region: A window region, usually within the content region, 
where dragging changes the size of an active window. 

handle: A pointer to a master pointer, which designates a relocatable 
block in the heap by double indirection. I 

hierarchical menu: A menu that includes, among its various menu 
choices, the ability to display a submenu. In most cases the sub­
menu appears to the right of the menu item used to select it, and 
is marked with a filled triangle indicator. 

high-level event: An event that your application can send to another 
application to transmit some information, to receive from it some 
information, or to have it perform some action. ! 

icon: An image that graphically represents an object, concept, or 
message. 

icon family: The set of icons that represent an object, such as an 
application or document, on the desktop. An entire icon family 
consists oflarge (32-by-32 pixel) and small (16-by-16 pixel) i~ons, 
each with a mask, and each available in three different versions of 
color: black and white, 4 bits of color data per pixel, and 8 bits of 
color data per pixel. 

icon list: A resource consisting of a list of icons. 
idle state: A state in which the Macintosh Portable computer slows 

from its normal 16 MHz clock speed to a 1 MHz clock speed.! The 
Power Manager puts the Macintosh Portable in the idle $tate 
when the system has been inactive for 15 seconds. 
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inactive control: A control that won't respond to the user's actions with 
the mouse. An inactive control is highlighted in some special way, 
such as dimmed. 

inactive window: Any window that isn't the frontmost window on the 
desktop. 

insertion point: An empty selection range; the character position where 
text will be inserted (usually marked with a blinking caret). 

interapplication communication (IAC): A collection of features, 
provided by the Edition Manager, Apple Event Manager, Event 
Manager, and PPC Toolbox, that help applications work together. 
You can use these managers to share data, send and receive events, 
or exchange low-level message blocks. 

item: In dialog and alert boxes, a control, icon, picture, or piece of text, 
each displayed inside its own display rectangle. See also menu item. 

item list: A list of information about all the items in a dialog or alert 
box. 

item number: The index, starting from 1, of an item in an item list. 
keyboard equivalent: The combination of a modifier key and another 

key, used to invoke a menu item from the keyboard. 
keyboard event: An event generated when the user presses, releases, or 

holds down a character key on the keyboard or keypad; any key­
down, key-up, or auto-key event. 

key code: An integer representing a key on the keyboard or keypad, 
without reference to the character that the key stands for. 

key-down event: An event generated when the user presses a character 
key on the keyboard or keypad. 

key-up event: An event generated when the user releases a character 
key on the keyboard or keypad. 

keyword: A four-character code used to uniquely identify the descriptor 
record for either an attribute or a parameter in an Apple event. In 
Apple Event Manager functions, constants are typically used to 
represent the four-character codes. 

keyword-specified descriptor record: A record of data type 
AEKeyDesc that consists of a keyword and a descriptor record. 
Keyword-specified descriptor records are used to describe the attri­
butes and parameters of an Apple event. 

localization: The process of adapting software to a particular region, 
language, and culture. Script and language adaptations are neces­
sary but not sufficient for this process. Localization also includes date 
and time formats, keyboard resources, and fonts. 

localized system software: Macintosh system software that has been 
adapted to a particular region, language, and culture. Japanese sys­
tem software is the combination of the U.S. system software (includ­
ing the Roman Script System, the Macintosh Operating System, the 
Toolbox, and so forth) and the Japanese Script System, all of which 
are adapted for use in Japan. The French and Turkish versions of the 
Macintosh system software are examples of localized variations of the 
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lock: To temporarily prevent a relocatable block from being moved 
during heap compaction. 

lock bit: A bit in the master pointer to a relocatable block that 
indicates whether the block is currently locked. 

locked file: A file whose data cannot be changed. 
main event loop: In a standard Macintosh application prograµi, a 

loop that repeatedly calls the Toolbox Event Manager to get 
events and then responds to them as appropriate. 

main screen: The screen on which the menu bar appears. QuickDraw 
uses it to determine global coordinates. 

mark: A marker used by the File Manager to keep track of where it is 
during a read or write operation. It is the position of the next !byte 
in a file that will be read or written. I 

master pointer: A single pointer to a relocatable block, maintained 
by the Memory Manager and updated whenever the block is 
moved, purged, or reallocated. All handles to a relocatable block 
refer to it by double indirection through the master pointer. ' 

Memory Manager: The part of the Operating System that dynami-
cally allocates and releases memory space in the heap. 1 

menu: A list of menu items that appears when the user points· to a 
menu title in the menu bar and presses the mouse button. 
Dragging through the menu and releasing over an enabled menu 
item chooses that item. : 

menu bar: The horizontal strip at the top of the Macintosh screen 
that contains the menu titles of all menus in the menu list. ' 

menu definition procedure: A procedure called by the Menu 
Manager when it needs to perform type-dependent operations on 
a particular type of menu, such as drawing the menu. 

menu entry: An entry in a menu color table that defines color v~lues 
for the menu's title, bar, and items. ' 

menu ID: A number in the menu record that identifies the menu. 
menu item: A choice in a menu, usually a command to the current 

application. 
menu item number: The index, starting from 1, of a menu item in a 

menu. I 

menu list: A list containing menu handles for all menus in the riienu 
bar, along with information on the position of each menu. 

Menu Manager: The part of the Toolbox that deals with setting up 
menus and letting the user choose from them. 

menu record: The internal representation of a menu, where the 
Menu Manager stores all the information it needs for its opera­
tions on that menu. 

menu title: A word, phrase, or icon in the menu bar that designates 
one menu. 

minimum partition size: The actual partition size limit below 
which your application cannot run. I 
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minor switch: The Process Manager switches the context of a process 
to give time to a background process without bringing the 
background process to the front. 

modal dialog box: A dialog box that requires the user to respond before 
doing any other work on the desktop. 

modal-dialog filter function: A function supplied by your application 
for handling events received from the Event Manager while a dialog 
box is displayed. 

modeless dialog box: A dialog box that allows the user to work else­
where on the desktop before responding. 

modifier key: A key (Shift, Caps Lock, Option, Command, or Control) 
that generates no keyboard events of its own, but changes the 
meaning of other keys or mouse actions. 

mouse-down event: An event generated when the user presses the 
mouse button. 

mouse-up event: An event generated when the user releases the mouse 
button. 

notification queue: The Notification Manager's list of pending notifi­
cation requests. 

notification record: The internal representation of a notification 
request, through which you specify how a notification is to occur. 

notification request: A request to the Notification Manager to create a 
notification. 

notification response procedure: A procedure that the Notification 
Manager can execute as the final step in a notification. 

null event: An event reported when there are no other events to report. 
Open Application event: An Apple event that asks an application to 

perform the tasks-such as displaying untitled windows-associated 
with opening itself; one of the four required Apple events. 

Open Documents event: An Apple event that requests an application 
to open one or more documents specified in a list; one of the four 
required Apple events. · 

open file: A file with an access path. Open files can be read from and 
written to. 

Operating System: The lowest-level software in the Macintosh. It does 
basic tasks such as I/O, memory management, and interrupt 
handling. 

Operating System Event Manager: The part of the Operating System 
that reports hardware-related events such as mouse-button presses 
and keystrokes. 

optional parameter: A supplemental parameter in an Apple event used 
to specify data that the server application should use in addition to 
the data specified in the direct parameter. Optional parameters are 
listed in the attribute identified by the keyOptionalKeywordAttr 
keyword. Applications use this attribute to specify or determine 
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whether data exists in the form of optional parameters. Optional 
parameters need not be included in an Apple event; default values 
for optional parameters are part of the event definition. It is the 
responsibility of the server application that handles the event to 
supply values if optional parameters are omitted. See also Apple 
event attribute, Apple ev~nt parameter. 1 

outline font: A collection of outline glyphs in a particular typeface 
and style with no size restriction. The Font Manager can generate 
thousands of point sizes from the same TrueType font. 

picture: A saved sequence of Quick.Draw drawing commands (~nd, 
optionally, picture comments) that you can play back later with a 
single procedure call; also, the image resulting from these 
commands. 

pixel: Short for picture element; the smallest dot you can draw on the 
screen. 

pixel map: A data structure that contains information about an 
image's pixels, including tlieir arrangement for display, the ~um­
ber of bits per pixel (its depth), and the colors the image requires. 

point: (1) A unit of measurement for type. Twelve points equal 1 pica, 
and 6 picas equal 1 inch; thus, 1 point equals approximately 1/72 
inch. (2) The intersection of a horizontal grid line and a ve1ical 
grid line on the coordinate plane, defined by a horizontal and a 
vertical coordinate. 

1 

polygon: A sequence of connected lines, defined by QuickDraw line­
drawing commands. 

pop-up menu: A menu not located in the menu bar, which appears 
when the user presses the mouse button in a particular place. I 

port: (1) A portal through which an open application can exchange 
information with another open application using the PPC Toolbox. 
A port is designated by a port name and a location name. An 
application can open as many ports as it requires so long as each 
port name is unique within a particular computer. (2) A 

I 

connection between the CPU and main memory or a device (~uch 
as a terminal) for transferring data. (3) A socket on the back panel 
of a computer where you plug in a cable for connection to a 
network or a peripheral device. 

portBits: The bitmap of a grafPort. 
portRect: A rectangle, defined as part of a grafPort, that enclo~es a 

subset of the bitmap for use by the grafPort. 
post: To place an event in the event queue for later processing. 
Print Documents event: An Apple event that requests that an 

application print a list of documents; one of the four required 
Apple events. I 

printing grafPort: A special grafPort customized for printing 
instead of drawing on the screen. 
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Printing Manager: The routines and data types that enable 
applications to communicate with the Printer Driver to print on any 
variety of printer via the same interface. 

print record: A record containing all the information needed by the 
Printing Manager to perform a particular printing job. 

process: An open application or, in some cases, an open desk accessory. 
(Only desk accessories that are not opened in the context of another 
application are considered processes.) 

programming language: A set of symbols and associated rules or con­
ventions for writing programs. For example, BASIC, Logo, and Pascal 
are programming languages. 

purge: To remove a relocatable block from the heap, leaving its master 
pointer allocated but set to NIL. 

purgeable block: A relocatable block that can be purged from the heap. 
purge bit: A bit in the master pointer to a relocatable block that indi­

cates whether the block is currently purgeable. 
purge warning procedure: A procedure associated with a particular 

heap zone that's called whenever a block is purged from that zone. 
queue: A list of identically structured entries linked together by pointers. 
QuickDraw: The part of the Toolbox that performs all graphics 

operations on the Macintosh screen. 
Quit Application event: An Apple event that requests that an appli­

cation perform the tasks-such as releasing memory, asking the user 
to save documents, and so on-associated with quitting: one of the 
four required Apple events. The Finder sends this event to an appli­
cation immediately after sending it a Print Documents event or if the 
user chooses Restart or Shut Down from the Finder's Special menu. 

radio button: A standard Macintosh control that displays a setting, 
either on or off, and is part of a group in which only one button can be 
on at a time. 

RAM: The random access memory, which contains exception vectors, 
buffers used by hardware devices, the system and application heaps, 
the stack, and other information used by applications. 

region: (1) An arbitrary area or set of areas on the QuickDraw coor­
dinate plane. The outline of a region should be one or more closed 
loops. (2) A linguistic or cultural entity that does not necessarily 
correspond to a province or nation and is associated with a number, 
called a region code, that indicates a specific localized version of 
Macintosh system software. 

required Apple event: One of four core Apple events that the Finder 
sends to applications. These events are called Open Documents, Open 
Application, Print Documents, and Quit Application. They are a 
subset of the core Apple events. 



Glossary 517 

required parameter: A keyword-specific descriptor record ~ an 
Apple event that must be specified. For example, a li~t of 
documents to open is a required parameter for the Open 
Documents event. Direct parameters are often required, and 
other additional parameters may be required. Optional 
parameters are never required. 

resource: Data or code stored in a resource file and managed by the 
Resource Manager. · 

resource attribute: One of several characteristics, specified by; bits 
in a resource reference, that determine how the resource sh6uld 
be dealt with. 

resource data: In a resource file, the data that comprises a resource. 
resource tile: The resource fork of a file. 
resource fork: The part of a file that contains data used by an 

application (such as menus, fonts, and icons). The resource fork of 
an application file also contains the application code itself. 1 

resource ID: A number that, together with the resource type, iden­
tifies a resource in a resource file. Every resource has an ID 
number. 

Resource Manager: The part of the Toolbox that reads and writes 
resources. 

1 

resource name: A string that, together with the resource type, 
identifies a resource in a resource file. A resource may or may not 
have a name. 

resource type: The type of a resource in a resource file, designated 
by a sequence of four characters (such as 'MENU' for a menu). 

result code: An integer indicating whether a routine completed its 
task successfully or was prevented by some error condition (or 
other special condition, such as reaching the end of a file). 1 

scrap: A place where cut or copied data is stored. 
scrap file: The file containing the desk scrap (usually named "Clip­

board File"). 
Scrap Manager: The part of the Toolbox that enables cutting. and 

pasting between applications, desk accessories, or an application 
and a desk accessory. ! 

SCSI: See Small Computer Standard Interface. 
SCSI Manager: The part of the Operating System that controls the 

exchange of information between a Macintosh and peripheral 
devices connected through the Small Computer Standard Inter­
face (SCSI). 

selector code: A parameter passed to the Gestalt function indicating 
what information about the operating environment the appli-
cation currently requires. · 

selector function: The function called by the Gestalt function when 
an application has called Gestalt to determine information about 
the operating environment. 
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7.0-compatible: Said of an application that runs without problems in 
system software version 7 .0. 

7 .O-dependent: Said of an application that requires the existence of 
features that are present only in system software version 7 .0. 

7.0-friendly: Said of an application that is 7.0-compatible and takes 
advantage of some of the special features of system software version 
7.0, but is still able to perform all its principal functions when 
operating in version 6.0. 

signature: A resource whose type is defined by a four-character 
sequence that uniquely identifies an application to the Finder. A 
signature is located in an application's resource fork. 

Small Computer Standard Interface (SCSI): A specification of 
mechanical, electrical, and functional standards for connecting small 
computers with intelligent peripherals such as hard disks, printers, 
and optical disks. 

source application: The application that sends a particular Apple event 
to another application or to itself. Typically, an Apple event client 
sends an Apple event requesting a service from an Apple event 
server; in this case, the client is the source application for the Apple 
event. The Apple event server may return a different Apple event as 
a reply-in which case, the server is the source for the reply Apple 
event. 

source transfer mode: One of eight transfer modes for drawing text or 
transferring any bit image between two bitmaps. 

stage: Every alert has four stages, corresponding to consecutive 
occurrences of the alert, and a different response may be specified for 
each stage. 

startup screen: When the system is started up, one of the display 
devices is selected as the startup screen, the screen on which the 
"happy Macintosh" icon appears. 

stationery pad: A document that a user creates to serve as a template 
for other documents. The Finder tags a document as a stationery pad 
by setting the isStationery bit in the Finder flags field of the file's 
Flnfo record. An application that is asked to open a stationery pad 
should copy the template's contents into a new document and open 
the document in an untitled window. 

submenu delay: The length of time before a submenu appears as a user 
drags through a hierarchical main menu; it prevents rapid flashing of 
submenus. 

System file: A file, located in the System Folder, that contains the basic 
system software plus some system resources, such as font and sound 
resources. In system software version 7.0, the System file behaves 
like a folder in this regard: although it looks like a suitcase icon, 
double-clicking it opens a window that reveals movable resource files 
(such as fonts, sounds, keyboard layouts, and script system resource 
collections) stored in the System file. 
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system font: The font that the system uses (in menus, for example). 
Its name is Chicago. I 

system font size: The size of text drawn by the system in the system 
font; 12 points. 

target: The file, directory, or volume described by an alias record. 
target address: An application signature, a process serial number, a 

session ID, a target ID record, or some other application-defined 
type that identifies the target of an Apple event. 

target application: The application addressed to receive an Apple 
event. Typically, an Apple event client sends an Apple event 
requesting a service from an Apple event server; in this case, the 
server is the target application of the Apple event. The Apple 
event server may return a different Apple event as a reply-in 
which case, the client is the target of the reply Apple event. : 

TextEdit: The part of the Toolbox that supports the basic text entry 
and editing capabilities of a standard Macintosh application. i 

32-bit clean: Said of an application that is able to run in an envi­
ronment where all 32 bits of a memory address are used for 
addressing. 

thumb: The Control Manager's term for the scroll box (the indicator 
of a scroll bar). 1 

tick: A sixtieth of a second. 1 

tip: For a help balloon, the point at the side of the rounded rectangle 
that indicates what object or area is explained in the help balloon. 

Toolbox Event Manager: The part of the Toolbox that allows your 
application program to monitor the user's actions with the mouse, 
keyboard, and keypad. 

Toolbox Utilities: The part of the Toolbox that performs gent1rally 
useful operations such as fixed-point arithmetic, string manipula-
tion, and logical operations on bits. 1 

transaction: A sequence of Apple events sent back and forth between 
a client and a server application, beginning with the client's initial 
request for a service. All Apple events that are part of one trans­
action must have the same transaction ID. 

transaction ID: An identifier assigned to a transaction. 
trap dispatcher: The part of the Operating System that examines a 

trap word to determine what operation it stands for, looks up the 
address of the corresponding routine in the trap dispatch table, 
and jumps to the routine. 

trap dispatch table: A table in RAM containing the addresses of all 
Toolbox and Operating System routines in encoded form. 

unlock: To allow a relocatable block to be moved during heap 
compaction. 

update event: An event generated by the Window Manager when a 
window's contents need to be redrawn. 
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update region: A window region consisting of all areas of the content 
region that have to be redrawn. 

User Interface Toolbox: The software in the Macintosh ROM that 
helps you implement the standard Macintosh user interface in your 
application. 

version data: In an application's resource file, a resource that has the 
application's signature as its resource type, typically a string that 
gives the name, version number, and date of the application. 

version number: A number from 0 to 255 used to distinguish between 
files with the same name. 

virtual memory: The part of the Operating System that allows any 
properly configured Macintosh computer with a memory manage­
ment unit to extend the available amount of memory beyond the 
limits of physical RAM. 

visRgn: The region of a grafPort, manipulated by the Window Manager, 
that's actually visible on the screen. 

volume: A piece of storage medium formatted to contain files: usually a 
disk or part of a disk. A 3.5-inch Macintosh disk is one volume. 

window: An object on the desktop that presents information, such as a 
document or a message. 

Window Manager: The part of the Toolbox that provides routines for 
creating and manipulating windows. 

Window Manager port: A grafPort that has the entire screen as its 
portRect and is used by the Window Manager to draw window frames. 

window template: A resource from which the Window Manager can 
create a window. 

X-Ref: An abbreviation for cross-reference. 
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Code Listings 

The following pages contain complete 
listings of all the source code presented 
in this book. The listings are presented 

in order by chapter. Remember, you 
can send in the coupon in the back of 

the book for a disk containing the 
complete set of Macintosh C 

Programming Primer, Volume I 
applications. 



Chapter 2: Hello.c 

/*********************** main *************/ 

void main( void 

printf( "Hello, world!"); 

#define kBaseResID 
#define kMoveToFront 

Chapter 3: Hello2.c 

128 
(WindowPtr)-lL 

#define kHorizontalPixel 30 
#define kVerticalPixel 50 

/***************/ 
/* Functions */ 

/***************/ 

void 
void 

ToolBoxinit( void); 
Windowinit( void); 

/****************** main ***************************/ 

void main( void 

ToolBoxinit(); 
Windowinit(); 

while ( ! But ton () 

/****************** ToolBoxinit *********************/ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
InitFonts (); 
InitWindows(); 
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InitMenus (); 
TEinit (); 
InitDialogs( nil); 
Ini tCursor () ; 
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/****************** Windowinit ***********************/ 

void Windowinit( void 

WindowPtr window; 

window= GetNewWindow( kBaseResID, nil, kMoveToFront ); 

if ( window == nil 

SysBeep( 10 ); 
ExitToShell(); 

ShowWindow( window); 
SetPort( window); 

/* Couldn't load the WIND resource!!! */ 

MoveTo( kHorizontalPixel, kVerticalPixel ); 
DrawString("\pHello, world!"); 

Chapter 3: Mondrian.c 

#define kBaseResID 
#define kMoveToFront 
#define kRandomUpperLimit 

/*************/ 
/* Globals */ 
/******"******/ 

longgFillColor = blackColor; 

128 
(WindowPtr)-lL 
32768 
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/***************/ 
/* Functions */ 
/***************/ 

void ToolBoxinit( 
void Windowinit( 

void ) ; 
void); 

void MainLoop( void); 

void DrawRandomRect( void ) ; 

void RandomRect( Re ct *rectPtr 

short Randomize( short range ) ; 

) ; 

/****************** main ***************************/ 

void main( void 

ToolBoxinit(); 
Windowinit(); 
MainLoop(); 

/****************** ToolBoxinit *********************/ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
InitFonts(); 
InitWindows(); 
InitMenus (); 
TEinit (); 
InitDialogs( nil ); 
InitCursor (); 

/****************** Windowinit ***********************/ 

void Windowinit( void 

WindowPtr window; 

window= GetNewWindow( kBaseResID, nil, kMoveToFront ); 

if ( window == nil ) 
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SysBeep( 10 ); 
Exit To Shell {) ; 

ShowWindow( window); 
SetPort( window); 
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/* Couldn't load the WIND resource!!! */ 

/****************** MainLoop ***********************/ 

void MainLoop( void ) 

GetDateTime( (unsigned long *) (&randSeed) ); 

while ( ! Button() ) 
{ 

DrawRandomRect(); 

if ( gFillColor == blackColor 
gFillColor 

else 

gFillColor 

whiteColor; 

blackColor; 

/****************** DrawRandomRect *****************/ 

void DrawRandomRect( void ) 

Rect randomRect; 

RandomRect( &randomRect ); 
ForeColor( gFillColor ); 
PaintOval( &randomRect ); 

/****************** RandomRect *********************/ 

void RandomRect( Rect *rectPtr) 

WindowPtr window; 

window= FrontWindow(); 
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rectPtr->left =Randomize( window->portRect.right 
- window->portRect.left ); 

rectPtr->right =Randomize( window->portRect.right 
- window->portRect.left ); 

rectPtr->top =Randomize( window->portRect.bottom 
- window->portRect.top ); 

rectPtr->bottom =Randomize( window->portRect.bottom 
- window->portRect.top }; 

/****************** Randomize **********************/ 

short Randomize( short range 

long randomNumber; 

randomNumber =Random(}; 

if ( randomNurnber < 0 ) 
randornNurnber *= -1; 

return( (randornNurnber *range} I kRandornUpperLirnit ); 

Chapter 3: ShowPICT.c 

#define kBaseResID 
#define kMoveToFront 

128 
(WindowPtr}-lL 

/***************/ 
I* Functions */ 
/***************/ 

void 
void 
void 
void 

ToolBoxinit( void}; 
Windowinit( void); 
DrawMyPicture( void); 
CenterPict( PicHandle picture, Rect *destRectPtr ); 
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/****************** main ***************************/ 

void main( void 

ToolBoxinit(); 
Window!nit(); 

DrawMyPicture(); 

while ( ! But ton() 

/****************** ToolBoxinit *********************/ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
InitFonts(); 
InitWindows (); 
Ini tMenus () ; 
TEinit(); 

InitDialogs( nil); 
InitCursor () ; 

/****************** Window!nit ***********************/ 

void Windowinit( void 

WindowPtr window; 

window= GetNewWindow( kBaseResID, nil, kMoveToFront ); 

if ( window == nil 

SysBeep ( 10 ) ; 
Exit ToShell () ; 

ShowWindow( window); 
SetPort( window); 

/* Couldn't load the WIND resource!!! */ 
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/****************** DrawMyPicture ********************/ 

void DrawMyPicture( void ) 

Rect pictureRect; 
WindowPtr 
PicHandle 

window; 
picture; 

window= FrontWindow(); 

pictureRect = window->portRect; 

picture= GetPicture( kBaseResID ); 

if ( picture == nil 

SysBeep ( 10 ) ; 
ExitToShell (); 

/* Couldn't load the PICT resource!!! */ 

CenterPict( picture, &pictureRect ); 
DrawPicture( picture, &pictureRect ); 

/****************** CenterPict ********************/ 

void CenterPict( PicHandle picture, Rect *destRectPtr 

Rect windRect, pictRect; 

windRect = *destRectPtr; 
pictRect = (**(picture)) .picFrame; 
OffsetRect( &pictRect, windRect.left - pictRect.left, 

windRect.top - pictRect.top); 
OffsetRect( &pictRect, (windRect.right - pictRect.right)/2, 

(windRect.bottom - pictRect.bottom)/2); 
*destRectPtr = pictRect; 

Chapter 3: FlyingLine.c 

#define kNumLines 
#define kMoveToFront 
#define kRandomUpperLimit 

50 /* Try 100 or 150 */ 
(WindowPtr)-lL 
32768 
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#define kEmptyString 

#define kEmptyTitle 
#define kVisible 
#define kNoGoAway 
#define kNilRefCon 

/*************/ 
/* Globals */ 
/*************/ 

"\p" 
kErnptyString 
true 
false 
(long) nil 

Re ct 
short 
short 
short 

gLines[ kNumLines ]; 
gDeltaTop=3, gDeltaBottom=3; 
gDeltaLeft=2, gDeltaRight=6; 

gOldMBarHeight; 

/***************/ 
/* Functions */ 
/***************/ 

void 
void 
void 
void 
void 
short 
void 
void 

ToolBoxinit( void); 
Windowinit( void}; 
Lineslnit( void); 
MainLoop( void); 
RandomRect( Rect *rectPtr ); 
Randomize( short range); 
RecalcLine( short i ); 
DrawLine( short i ); 
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/* These four are the */ 
I* key to flying line! */ 

/****************** main ***************************/ 

void main( void 

ToolBoxini t () ; 
Windowinit (); 
Linesinit (); 
MainLoop (); 
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/****************** ToolBoxinit *********************/ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
InitFonts(); 
InitWindows(); 
InitMenus(); 
TEinit (); 
InitDialogs( nil); 
InitCursor(); 

/****************** Windowinit ***********************/ 

void Windowinit( void) 

Re ct 
RgnHandle 
WindowPtr 

totalRect, mBarRect; 
mBarRgn; 
window; 

gOldMBarHeight ; MBarHeight; 
MBarHeight = 0; 

window; NewWindow( nil, &(screenBits.bounds), 
kEmptyTitle, kVisible, plainDBox, kMoveToFront, 
kNoGoAway, kNilRefCon ); 

SetRect( &mBarRect, screenBits.bounds.left, 
screenBits.bounds.top, 
screenBits.bounds.right, 
screenBits.bounds.top+gOldMBarHeight ); 

mBarRgn; NewRgn(); 
RectRgn( mBarRgn, &mBarRect ); 
UnionRgn( window->visRgn, mBarRgn, window->visRgn ); 
DisposeRgn( mBarRgn ); 
SetPort( window); 
FillRect( &(window->portRect), black); 

/* Change black to ltGray, */ 

PenMode( patXor ); /* <--- and comment out this line */ 



532 Macintosh C Programming Primer 

/****************** Linesinit **********************/ 

void Linesinit( void) 

short i; 

HideCursor(); 
GetDateTime( (unsigned long *) (&randSeed) ); 
RandomRect( &(gLines[ 0 ]) ); 
DrawLine( 0 ); 

for ( i=l; i<kNumLines; i++ ) 

gLines[ i ] = gLines[ i-1 ]; 
RecalcLine( i ); 
DrawLine( i ); 

/****************** MainLoop ***********************/ 

void MainLoop( void ) 

short i; 

while ( ! Button() ) 

DrawLine( kNumLines -·1 ); 
for ( i=kNumLines-1; i>O; i-­

gLines [ i J = gLines[ i-1 ]; 
RecalcLine( 0 ); 
DrawLine( 0 ); 

MBarHeight = gOldMBarHeight; 

/****************** RandomRect *********************/ 

void RandomRect( Rect *rectPtr ) 

WindowPtr window; 

window= FrontWindow(); 
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rectPtr->left = Randomize( window->portRect.right 
- window->portRect.left ); 

rectPtr->right =Randomize( window->portRect.right 
- window->portRect.left ); 

rectPtr->top =Randomize( window->portRect.bottom 
- window->portRect.top ); 

rectPtr->bottom = Randomize( window->portRect.bottom 
- window->portRect.top ); 

/****************** Randomize **********************/ 

short Randomize( short range ) 

long randomNumber; 

randomNumber =Random(); 

if ( randomNumber < 0 ) 
randomNumber *= -1; 

return( (randomNumber * range) I kRandomUpperLimit ); 

/****************** RecalcLine *********************/ 

void RecalcLine( short i ) 

WindowPtr window; 

window= FrontWindow(); 

gLines[ i ].top+= gDeltaTop; 
if ( ( gLines[ i J .top< window->portRect.top I I 

( gLines[ i ].top> window->portRect.bottom) 

gDeltaTop *= -1; 
gLines[ i ].top+= 2*gDeltaTop; 

gLines[ i J .bottom += gDeltaBottom; 
if gLines[ i ].bottom< window->portRect.top) I I 

( gLines[ i ].bottom> window->portRect.bottom) 
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gDeltaBottom *= -1; 
gLines[ i J .bottom+= 2*gDeltaBottom; 

gLines[ i ] .left += gDeltaLeft; 
if ( ( gLines [ i ] . left < window->portRect. left ) I I 

( gLines[ i ] .left > window->portRect.right ) ) 

gDeltaLeft *= -1; 
gLines[ i J .left += 2*gDeltaLeft; 

gLines[ i J .right += gDeltaRight; 

if { ( gLines [ i J • right < window->portRect. left ) I I 
( gLines[ i ] .right > window->portRect.right ) ) 

gDeltaRight *= -1; 

gLines[ i ] .right += 2*gDeltaRight; 

/****************** DrawLine ***********************/ 

void DrawLine( short i ) 

MoveTo( gLines[ i] .left, gLines[ i] .top); 
LineTo( gLines[ i] .right, gLines[ i] .bottom); 

Chapter 4: EventTracker.c 

#include <AppleEvents.h> 
#include <GestaltEqu.h> 
#include <Values.h> 

#define kBaseResID 
#define kMoveToFront 
#define kSleep 

#define kLeftMargin 
#define kRowStart 
#define kFontSize 
#define kRowHeight 
#define kHorizontalOff set 

#define kGestaltMask 

128 
(WindowPtr)-lL 

MAX LONG 

4 

285 
9 
(kFontSize + 2) 
0 

lL 
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/*************/ 
/* Globals */ 
/*************/ 

Boolean 

/***************/ 
/* Functions */ 
/***************/ 

void 
void 
void 
void 
void 

gDone; 

ToolBoxinit( void); 
Windowinit( void); 
Eventinit( void); 
EventLoop( void); 
DoEvent( EventRecord *eventPtr ); 
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pascal OSErr DoOpenApp( AppleEvent theAppleEvent, AppleEvent reply, 
long refCon ); 

pascal OS Err DoOpenDoc( AppleEvent theAppleEvent, AppleEvent reply, 
long refCon ); 

pascal OS Err DoPrintDoc( AppleEvent theAppleEvent, AppleEvent reply, 
long refCon ); 

pascal OSErr DoQuitApp( AppleEvent theAppleEvent, AppleEvent reply, 
long refCon ); 

void 
void 

DrawEventString( Str255 eventString ); 
HandleMouseDown( EventRecord *eventPtr ); 

/******************************** main *********/ 

void main( void 

ToolBoxini t () ; 
Windowinit (); 
Event Ini t () ; 

EventLoop(); 

/*********************************** ToolBoxinit */ 

void ToolBoxinit( void 

InitGraf ( &thePort ) ; 
InitFonts(); 
InitWindows (); 



536 

InitMenus () ; 
TEinit(); 
InitDialogs( nil ); 
InitCursor(); 
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/******************************** Windowinit *********/ 

void Windowinit( void 

WindowPtr window; 
Rect windRect; 

window GetNewWindow( kBaseResID, nil, kMoveToFront ); 

if window == nil 

SysBeep( 10 ); 
ExitToShell (); 

SetPort( window ); 
Tex~Size( kFontSize ); 

ShowWindow( window); 

/* Couldn't load the WIND resource!!! */ 

/******************************** Eventinit *********/ 

void Eventinit( void) 

OS Err 
long 

err; 
feature; 

err= Gestalt( gestaltAppleEventsAttr, &feature); 

if ( err != noErr ) 

else 

DrawEventString( "\pProblern in calling Gestalt!" ); 
return; 
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if ! ( feature & ( kGestaltMask << gestaltAppleEventsPresent) ) ) 

DrawEventString( "\pApple events not available!" ); 
return; 

err = AEinstallEventHandler( kCoreEventClass, kAEOpenApplication, 
DoOpenApp, OL, false ); 

if ( err != noErr ) DrawEventString( 

"\pkAEOpenApplication Apple event not available!" ); 

err = AEinstallEventHandler( kCoreEventClass, kAEOpenDocuments, 

DoOpenDoc, OL, false); 

if ( err != noErr ) DrawEventString( 
"\pkAEOpenDocuments Apple event not available!"); 

err = AEinstallEventHandler( kCoreEventClass, kAEPrintDocuments, 

DoPrintDoc, OL, false); 

if ( err != noErr ) DrawEventString( 

"\pkAEPrintDocuments Apple event not available!" ); 

err= AEinstallEventHandler( kCoreEventClass, kAEQuitApplication, 

DoQuitApp, OL, false ); 

if ( err != noErr ) DrawEventString( 

"\pkAEQuitApplication Apple event not available!"); 

/******************************** EventLoop *********/ 

void EventLoop( void ) 

Event Record event; 

false; gDone 
while gDone == false ) 

if ( WaitNextEvent( everyEvent, &event, kSleep, nil ) ) 

DoEvent( &event ); 
/*else DrawEventString( "\pnullEvent" );*/ 
/* Uncomment the previous line for a burst of flavor! */ 
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/**~~********************************* DoEvent */ 

void DoEvent( EventRecord *eventPtr ) 

switch ( eventPtr->what ) 

case kHighLevelEvent: 
DrawEventString( "\pHigh level event: "); 
AEProcessAppleEvent( eventPtr ); 
break; 

case mouseDown: 
DrawEventString( "\pmouseDown" ); 
HandleMouseDown( eventPtr ); 
break; 

case mouseUp: 

DrawEventString( "\pmouseUp" ); 
break; 

case keyDown: 
DrawEventString( "\pkeyDown" ); 
break; 

case keyUp: 
DrawEventString( "\pkeyUp" ); 
break; 

case autoKey: 
DrawEventString( "\pautoKey" ); 
break; 

case updateEvt: 
DrawEventString( "\pupdateEvt" ); 

BeginUpdate( (WindowPtr)eventPtr->message ); 
EndUpdate( (WindowPtr)eventPtr->message ); 
break; 

case diskEvt: 

DrawEventString( "\pdiskEvt" ); 
break; 

case activateEvt: 

DrawEventString( "\pactivateEvt" ); 
break; 

case networkEvt: 
DrawEventString( "\pnetworkEvt" ); 
break; 

case driverEvt: 
DrawEventString( "\pdriverEvt" ); 
break; 

case applEvt: 
DrawEventString( "\papplEvt" ); 
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break; 
case app2Evt: 

DrawEventString( "\papp2Evt" ); 
break; 

case app3Evt: 
DrawEventString( "\papp3Evt" ); 
break; 

case osEvt: 
DrawEventString( "\posEvt: "); 
if ( ( eventPtr->message & suspendResumeMessage 

== resurneFlag ) 
Drawstring( "\pResurne event"); 

else 
Drawstring( "\pSuspend event"); 

break; 

/************************************* DoOpenApp */ 

539 

pascal OSErr DoOpenApp( AppleEvent theAppleEvent, AppleEvent reply, 
long refCon ) 

Drawstring( "\pApple event: kAEOpenApplication" ); 

/************************************* DoOpenDoc */ 

pascal OSErr DoOpenDoc( AppleEvent theAppleEvent, AppleEvent reply, 
long refCon ) 

Drawstring( "\pApple event: kAEOpenDocurnents" ); 

/************************************* DoPrintDoc */ 

pascal OSErr DoPrintDoc( AppleEvent theAppleEvent, AppleEvent reply, 
long refCon ) 

Drawstring( "\pApple event: kAEPrintDocurnents" ); 
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/************************************* DoQuitApp */ 

pascal OSErr DoQuitApp( AppleEvent theAppleEvent, AppleEvent reply, 
long refCon ) 

Drawstring( "\pApple event: kAEQuitApplication" ); 

/************************************* DrawEventString *******/ 

void DrawEventString( Str255 eventString ) 

RgnHandle 
WindowPtr 

tempRgn; 
window; 

window= FrontWindow(); 
tempRgn = NewRgn(); 

ScrollRect( &window->portRect, kHorizontalOffset, -kRowHeight, 
tempRgn ) ; 

DisposeRgn( tempRgn ); 

MoveTo( kLeftMargin, kRowStart ); 
Drawstring( eventString ); 

/************************************* HandleMouseDown */ 

void HandleMouseDown( EventRecord *eventPtr ) 

WindowPtr window; 
long thePart; 

thePart; FindWindow( eventPtr->where, &window); 

switch ( thePart ) 
{ 

case inSysWindow 
SystemClick( eventPtr, window); 
break; 

case inDrag : 

DragWindow( window, eventPtr->where, &screenBits.bounds ); 
break; 

case inGoAway : 
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gDone = true; 
break; 

Chapter 4: Updater.c 

#include <Values.h> 

#define kBaseResID 
#define kMoveToFront 

#define kScrollbarAdjust 
#define kLeaveWhereitis 

#define kNormalUpdates 

idefine kMinWindowHeight 

#define kMinWindowWidth 

/*************/ 
/* Globals */ 
/*************/ 

Boolean gDone; 

/***************/ 
/* Functions */ 
/***************/ 

128 
(WindowPtr)-lL 

( 16-1) 

false 
true 
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80 

void 
void 
void 
void 
void 
void 
void 
void 
void 

ToolBoxinit( void); 
Windowinit( void); 
EventLoop( void); 
DoEvent( EventRecord *eventPtr ); 
HandleMouseDown( EventRecord *eventPtr ); 
DoUpdate( EventRecord *eventPtr ); 
DoActivate( WindowPtr window, Boolean becorningActive ); 
DoPicture( WindowPtr window, PicHandle picture); 
CenterPict( PicHandle picture, Rect *destRectPtr ); 
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/****•*************************** main *********/ 

void main( void 

ToolBoxinit(); 

Windowinit(); 

EventLoop(); 

/*****•***************************** ToolBoxinit */ 

void ToolBoxinit( void 

InitGraf( &thePort ); 

InitFonts (); 

InitWindows(); 

InitMenus (); 

'l'Einit(); 

InitDialogs( nil); 

InitCursor (); 

/******************************** Windowinit *********/ 

void Windowinit( void 

WindowPtr window; 

window= GetNewWindow( kBaseResID, nil, kMoveToFront ); 

if ( window == nil 

SysBeep ( 10 ) ; 

ExitToShell (); 
/* Couldn't load the WIND resource!!! */ 

SetWRefCon ( window, (long) kBaseResID ) ; 

Showwindow( window); 

window= GetNewWindow( kBaseResID+l, nil, kMoveToFront ); 

if ( window == nil ) 
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SysBeep ( 10 ) ; 
ExitToShell (); 

/* Couldn't load the WIND resource!!! */ 

SetWRefCon (window, (long) ( kBaseResID+l) ); 
ShowWindow( window); 

/******************************** EventLoop *********/ 

void EventLoop( void ) 

Event Record event; 

false; gDone 
while gDone == false ) 

if ( WaitNextEvent( everyEvent, &event, MAXLONG, nil ) ) 
DoEvent( &event); 

/************************************* DoEvent */ 

void DoEvent( EventRecord *eventPtr ) 

Boolean becomingActive; 

switch ( eventPtr->what 
{ 

case mouseDown: 
HandleMouseDown( eventPtr ); 

break; 
case updateEvt: 

DoUpdate( eventPtr ); 
break; 

case activateEvt: 
becomingActive (eventPtr->modifiers & activeFlag) 

activeFlag ); 

543 

DoActivate( (WindowPtr)eventPtr->message, becomingActive ); 

break; 
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/************************************* HandleMouseDown */ 

void HandleMouseDown( EventRecord *eventPtr ) 

WindowPtr 
short 
Graf Ptr 
long 

window; 
thePart; 
oldPort; 
windSize; 
growRect; Re ct 

thePart FindWindow( eventPtr->where, &window); 

switch ( thePart 

case inSysWindow 
SystemClick( eventPtr, window); 
break; 

case inContent: 
SelectWindow( window ); 
break; 

case inDrag : 
DragWindow( window, eventPtr->where, &screenBits.bounds ); 
break; 

case inGoAway : 
if ( TrackGoAway( window, eventPtr->where ) ) 

gDone :;;:: true; 
break; 

case inGrow: 
growRect.top :;;:: kMinWindowHeight; 
growRect.left :;;:: kMinWindowWidth; 
growRect.bottom = MAXSHORT; 
growRect.right = MAXSHORT; 

windSize = GrowWindow( window, eventPtr->where, &growRect ); 
if ( windSize != 0 ) 

GetPort( &oldPort ); 
SetPort( window); 
EraseRect( &window->portRect ); 
SizeWindow( window, LoWord( windSize ), 

HiWord( windSize ), kNormalUpdates ); 
InvalRect( &window->portRect ); 
SetPort( oldPort ); 
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break; 
case inZoornin: 
case inZoornOut: 

if ( TrackBox( window, eventPtr->where, thePart ) ) 

GetPort( &oldPort ); 
SetPort( window); 
EraseRect( &window->portRect ); 
ZoornWindow( window, thePart, kLeaveWhereitis ); 
InvalRect( &window->portRect ); 
SetPort( oldPort ); 

break; 

/************************************* DoUpdate */ 

void DoUpdate( EventRecord *eventPtr ) 

short 
PicHandle 
WindowPtr 

picture ID; 
picture; 
window; 

window = (WindowPtr)eventPtr->rnessage; 

BeginUpdate( window); 
pictureID = GetWRefCon (window); 
picture= GetPicture( pictureID ); 

if ( picture == nil 

SysBeep( 10 ); 
ExitToShell (); 

/* Couldn't load the PICT resource!!! */ 

DoPicture( window, picture); 
EndUpdate( window); 
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/************************************* DoActivate */ 

void DoActivate( WindowPtr window, Boolean becomingActive 

DrawGrowicon( window); 

/******************************** DoPicture *********/ 

void DoPicture( WindowPtr window, PicHandle picture 

Re ct 
GrafPtr 
RgnHandle 

drawingClipRect, windowRect; 
oldPort; 
tempRgn; 

GetPort( &oldPort ); 
SetPort( window); 

ternpRgn = NewRgn(); 
GetClip( tempRgn ); 
EraseRect( &window->portRect ); 

DrawGrowicon( window ); 

drawingClipRect = window->portRect; 
drawingClipRect.right -= kScrollbarAdjust; 
drawingClipRect.bottom -= kScrollbarAdjust; 

windowRect = window->portRect; 

CenterPict( picture, &windowRect ); 
ClipRect( &drawingClipRect ); 
DrawPicture( picture, &windowRect ); 

SetClip( tempRgn ); 
DisposeRgn( tempRgn ); 
SetPort( oldPort ); 

/****************** CenterPict ********************/ 

void CenterPict( PicHandle picture, Rect *destRectPtr 

Rect windRect, pictRect; 
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windRect = *destRectPtr; 
pictRect = (**(picture)) .picFrame; 
OffsetRect( &pictRect, windRect.left - pictRect.left, 

windRect.top - pictRect.top); 
OffsetRect( &pictRect, (windRect.right - pictRect.right)/2, 

(windRect.bottom - pictRect.bottom)/2); 

*destRectPtr = pictRect; 

Chapter 4: EventTrigger.c 

#i~clude <AppleEvents.h> 
#include <GestaltEqu.h> 

#define kGestaltMask lL 

/***************/ 
/* Functions */ 
/***************/ 

void 
void 
void 

ToolBoxinit( void); 
Eventsinit( void); 
SendEvent( AEEventID theAEEventID ); 

/******************************** main *********/ 

void main( void 

ToolBoxinit(); 
Eventsinit (); 

SendEvent( kAEOpenApplication ); 
SendEvent( kAEOpenDocuments ); 
SendEvent( kAEPrintDocuments ); 
SendEvent( kAEQuitApplication ); 

/*********************************** ToolBoxinit */ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
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InitFonts (); 
!nit Windows(); 
InitMenus (); 
TEinit(); 
InitDialogs( nil ); 
InitCursor(); 
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/*********************************** Events!nit */ 

void Eventsinit( void 

long feature; 
OSErr err; 

err= Gestalt( gestaltAppleEventsAttr, &feature); 

if ( err != noErr ) 

SysBeep( 10 ); 
Exit To Shell () ; 

/* Error calling Gestalt!!! */ 

if ( ! ( feature & ( kGestaltMask << gestaltAppleEventsPresent ) ) ) 

SysBeep ( 10 ) ; 
ExitToShell (); 

/* AppleEvents not supported!!! */ 

/******************************** SendEvent *********/ 

void SendEvent( AEEventID theAEEventID ) 

OSErr 
AEAddressDesc 
OS Type 
Apple Event 

appSig = 'Prmr'; 

err; 
address; 
appSig; 
appleEvent, reply; 

err= AECreateDesc( typeApplSignature, (Ptr) (&appSig), 
(Size)sizeof( appSig ), &address ); 
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err; AECreateAppleEvent( kCoreEventClass, theAEEventID, &address, 
kAutoGenerateReturnID, lL, &appleEvent ); 

err AESend( &appleEvent, &reply, kAENoReply + kAECaninteract, 
kAENormalPriority, kAEDefaultTimeout, nil, nil); 

Ch~pter 5: WorldClock.c 

#include <Packages.h> 
#include <GestaltEqu.h> 

#define kBaseResID 128 
#define kMoveToFront (WindowPtr)-lL 

#define kUseDefaultProc (void *)-lL 

#define kSleep 20L 

#define kLeaveWhereitis false 

#define kincludeSeconds true 

#define kTicksPerSecond 60 
#define kSecondsPerHour 3600L 

#define kAddCheckMark true 

#define kRemoveCheckMark false 

#define kPopupControlID kBaseResID 

#define kPopupBitMask OxOOOl 

#define kNotANormalMenu -1 

#define mApple kBaseResID 

#define iAbout 1 

#define mFile kBaseResID+l 

#define iQuit 1 

#define mFont 100 

#define mStyle 101 

#define iPlain 1 

#define iBold 2 

#define iitalic 3 

#define iUnderline 4 

#define iOutline 5 

#define iShadow 6 
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#define kPlainStyle 0 

#define kExtraPopupPixels 25 

#define kClockLeft 12 
#define kClockTop 25 
#define kClockSize 24 

#define kCurrentTimeZone 1 
· #define kNewYorkTimeZone 2 

#define kMoscowTirneZone 3 
#define kUlanBatorTirneZone 4 

#define TopLeft( r ) 
#define BottomRight( r ) 

(*(Point*) &(r) .top) 
(*(Point*) &(r) .bottom) 

#define IsHighBitSet( longNum 
#define SetHighByte( longNum) 
#define ClearHighByte( longNum ) 

(longNum >> 23) & 1 ) 
longNum I= OxFFOOOOOO 
longNum &= OxOOFFFFFF 

/*************/ 
/* Globals */ 

/*************/ 

Boolean 
short 
Style 
Re ct 

gDone, gHasPopupControl; 
gLastFont = 1, gCurrentZoneID 
gCurrentStyle = kPlainStyle; 
gClockRect; 

/***************/ 
/* Functions */ 
/***************/ 

ToolBoxinit( void); 
Windowinit( void); 
MenuBarinit( void); 
EventLoop( void); 
DoEvent( EventRecord *eventPtr ); 
HandleNull( EventRecord *eventPtr }; 

kCurrentTimeZone; 

void 
void 
void 
void 
void 
void 
void 
void 
void 
void 

HandleMouseDown( EventRecord *eventPtr ); 
SetUpZoomPosition( WindowPtr window, short zoominOrOut ); 
HandleMenuChoice( long menuChoice ); 
HandleAppleChoice( short item); 
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void 
void 
void 
void 
long 

HandleFileChoice( short item); 
HandleFontChoice( short item); 
HandleStyleChoice( short item); 
DoUpdate( EventRecord *eventPtr ); 
GetZoneOffset( void); 

/**************************** main **********************/ 

void main( void 

ToolBoxini t () ; 
Windowinit(); 
MenuBarinit (); 

EventLoop(); 

/****************** ToolBoxinit *********************/ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
InitFonts(); 
InitWindows(); 
InitMenus(); 
TEinit (); 
InitDialogs( nil); 
InitCursor(); 

/****************** Windowinit ***********************/ 

void Windowlnit( void) 

WindowPtr window; 

window= GetNewWindow( kBaseResID, nil, kMoveToFront ); 

if ( window == nil 

SysBeep ( 10 ) ; 
ExitToShell (); 

/* Couldn't load the WIND resource!!! */ 
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SetPort( window); 
TextSize( kClockSize ); 

gClockRect = window->portRect; 

ShowWindow( window); 
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/****~************* MenuBarinit ***********************/ 

void MenuBarinit( void ) 

Handle 
MenuHandle 
ControlHandle 
OS Err 
long 

menuBar; 
menu; 
control; 
myErr; 
feature; 

menuBar GetNewMBar( kBaseResID ); 
SetMenuBar( menuBar ); 

menu= GetMHandle( mApple ); 
AddResMenu( menu, 'DRVR' ); 

menu= GetMenu( mFont ); 
InsertMenu( menu, kNotANormalMenu ); 
AddResMenu( menu, 'FONT' ); 

menu= GetMenu( mStyle ); 
InsertMenu( menu, kNotANormalMenu ); 
Checkitem( menu, iPlain, true); 

DrawMenuBar(); 

HandleFontChoice( gLastFont ); 

myErr =Gestalt( gestaltPopupAttr, &feature); 
gHasPopupControl = ((myErr == noErr) && 

((feature & kPopupBitMask) 1)); 

if ( gHasPopupControl ) 

control= GetNewControl( kPopupControlID, FrontWindow() ); 
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/****************** EventLoop ***********************/ 

void EventLoop( void ) 

Event Record event; 

gDone false; 

while ( gDone == false ) 
{ 

if ( WaitNextEvent( everyEvent, &event, kSleep, nil ) ) 
DoEvent( &event); 

else 
HandleNull( &event ); 

/****************** DoEvent ***********************/ 

void DoEvent( EventRecord *eventPtr ) 

char theChar; 

switch eventPtr->what 

case mouseDown: 
HandleMouseDown( eventPtr ); 
break; 

case keyDown: 
case autoKey: 

theChar = eventPtr->message & charCodeMask; 
if ( (eventPtr->modifiers & cmdKey) != 0 ) 

HandleMenuChoice( MenuKey( theChar ) ); 

break; 
case updateEvt: 

DoUpdate( eventPtr ); 
break; 

553 



554 Macintosh C Programming Primer 

/****************** HandleNull ***********************/ 

void HandleNull( EventRecord *eventPtr 

static long lastTime = O; 

if ( (eventPtr->when I kTicksPerSecond) > lastTime ) 

InvalRect( &gClockRect ); 

lastTime = eventPtr->when I kTicksPerSecond; 

/****************** HandleMouseDown *******************~***/ 

void HandleMouseDown( EventRecord *eventPtr ) 

WindowPtr 
GrafPtr 
short 
long 

whichWindow; 
oldPort; 
thePart; 
menuChoice; 
control; 
ignored; 

Control Handle 
short 

thePart FindWindow( eventPtr->where, &whichWindow ); 
switch ( thePart ) 
{ 

case inMenuBar: 

menuChoice = MenuSelect( eventPtr->where ); 
HandleMenuChoice( menuChoice ); 
break; 

case inSysWindow: 

SystemClick( eventPtr, whichWindow ); 
break; 

case inContent: 
SetPort( whichWindow ); 
GlobalToLocal( &eventPtr->where ); 

if ( FindControl( eventPtr->where, whichWindow, &control ) ) 

ignored= TrackControl( control, event?tr->where, 
kUseDefaultProc ); 

gCurrentZoneID = GetCtlValue( control ); 
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break; 
case inDrag: 

DragWindow( whichWindow, eventPtr->where, &screenBits.bounds ); 

break; 
case inZoomin: 
case inZoomOut: 

if ( TrackBox( whichWindow, eventPtr->where, thePart ) ) 

SetUpZoomPosition( whichWindow, thePart ); 
ZoomWindow( whichWindow, thePart, kLeaveWhere!t!s ); 

break; 

/****************** SetUpZoomPosition ****************/ 

void SetUpZoomPosition( WindowPtr window, short zoominOrOut 

WindowPeek 
WStateData 
Re ct 
Boolean 
short 

wPeek; 
*wStatePtr; 
windowRect; 
isBig; 
deltaPixels; 

wPeek (WindowPeek) window; 
wStatePtr = (WStateData *) *(wPeek->dataHandle); 

windowRect = window->portRect; 
LocalToGlobal( &TopLeft( windowRect) ); 
LocalToGlobal( &BottomRight( windowRect ); 

wStatePtr->stdState = windowRect; 
wStatePtr->userState = wStatePtr->stdState; 

if ( gHasPopupControl ) 

isBig = (windowRect.bottom - windowRect.top) > 
(gClockRect.bottom - gClockRect.top}; 

if ( isBig } 
deltaPixels 

else 
deltaPixels 

-kExtraPopupPixels; 

kExtraPopupPixels; 
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else 
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if ( zoomlnOrOut == inZoomln ) 
wStatePtr->userState.bottom += deltaPixels; 

else 
wStatePtr->stdState.bottom += deltaPixels; 

SysBeep( 20 ); 

/****************** HandleMenuChoice ***********************/ 

void HandleMenuChoice( long menuChoice ) 

short 
short 

menu; 
item; 

if ( menuChoice != 0 ) 

menu 
item 

HiWord( menuChoice ); 
LoWord( menuChoice ); 

switch ( menu ) 

case mApple: 
HandleAppleChoice( item); 
break; 

case mFile: 
HandleFileChoice( item); 
break; 

case mFont: 
HandleFontChoice( item); 
break; 

case mStyle: 
HandleStyleChoice( item); 
break; 

HiliteMenu( 0 ); 

/****************** HandleAppleChoice ***********************/ 

void HandleAppleChoice( short item ) 
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MenuHandle 
Str255 
short 

appleMenu; 
accName; 
accNumber; 

switch item ) 

case iAbout: /* We'll put up an about box next chapter.*/ 
SysBeep( 20 ); 
break; 

default: 
appleMenu = GetMHandle( mApple ); 
Getitem( appleMenu, item, accName ); 
accNumber = OpenDeskAcc( accName ); 
break; 

/****************** HandleFileChoice ***********************/ 

void HandleFileChoice( short item ) 

switch ( item ) 
{ 

case iQuit 
gDone = true; 
break; 

/****************** HandleFontChoice ***********************/ 

void HandleFontChoice( short item ) 

short 
Str255 
MenuHandle 

menuHandle 

fontNumber; 
fontName; 
menuHandle; 

GetMHandle( mFont ); 

Checkitem( menuHandle, gLastFont, kRemoveCheckMark ); 
Checkitem( menuHandle, item, kAddCheckMark ); 

gLastFont = item; 
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Getitem( menuHandle, item, fontName ); 
GetFNum( fontName, &fontNumber ); 

TextFont( fontNumber ); 

Macintosh C Programming Primer 

/**~*************** HandleStyleChoice ***********************/ 

void HandleStyleChoice( short item ) 

MenuHandle menuHandle; 

switch( item) 

case iPlain: 
gCurrentStyle kPlainStyle; 
break; 

case iBold: 
if ( gCurrentStyle & bold ) 

gCurrentStyle bold; 
else 

gCurrentStyle I= bold; 
break; 

case i!talic: 
if ( gCurrentStyle & italic ) 

gCurrentStyle italic; 
else 

gCurrentStyle I= italic; 
break; 

case iUnderline: 

if ( gCurrentStyle & underline ) 
gCurrentStyle underline; 

else 
gCurrentStyle I= underline; 

break; 
case iOutline: 

if ( gCurrentStyle & outline ) 
gCurrentStyle outline; 

else 
gCurrentStyle I= outline; 

break; 
case iShadow: 

if ( gCurrentStyle & shadow ) 
gCurrentStyle -= shadow; 
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else 
gCurrentStyle I= shadow; 

break; 

menuHandle = GetMHandle( mStyle ); 

Checkitem ( menuHandle, 
Checkitem( menuHandle, 
Checkitem( menuHandle, 
Checkitem( menuHandle, 
Checkitem( menuHandle, 
Checkitem( menuHandle, 

iPlain, gCurrentStyle == kPlainStyle ); 
iBold, gCurrentStyle & bold); 
iitalic, gCurrentStyle & italic); 
iUnderline, gCurrentStyle & underline); 
iOutline, gCurrentStyle & outline); 
iShadow, gCurrentStyle & shadow); 

TextFace( gCurrentStyle ); 

/****************** DoUpdate ***********************/ 

void DoUpdate( EventRecord *eventPtr ) 

WindowPtr 
Str255 
unsigned long 

window; 
timeString; 
curTimeinSecs; 

window = (WindowPtr)eventPtr->message; 

BeginUpdate( window); 

GetDateTime ( &curTimeinSecs ); 
curTimeinSecs += GetZoneOffset(); 

IUTimeString( (long)curTimeinSecs, kincludeSeconds, 
timeString ); 

EraseRect( &gClockRect ); 
MoveTo( kClockLeft, kClockTop ); 
Drawstring( timeString ); 

DrawControls( window ); 

EndUpdate( window); 
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/****************** GetZoneOffset ***********************/ 

long GetZoneOffset( void) 
{ 

loc; MachineLocation 
long delta, defaultZoneOffset; 

ReadLocation( &loc ); 
defaultZoneOffset = ClearHighByte( loc.gmtFlags.grntDelta ); 

if ( IsHighBitSet( defaultZoneOffset ) 
SetHighByte( defaultZoneOffset ); 

switch ( gCurrentZoneID ) 
{ 

case kCurrentTimeZone 
delta = defaultZoneOffset; 
break; 

case kNewYorkTimeZone : 
delta = -SL * kSecondsPerHour 
break; 

case kMoscowTimeZone : 
delta = 3L * kSecondsPerHour; 
break; 

case kUlanBatorTimeZone : 
delta = BL * kSecondsPerHour; 
break; 

delta -= defaultZoneOffset; 

return delta; 

Chapter 6: Reminder.c 

#include <Notification.h> 
#include <Processes.h> 
#include <Aliases.h> 

idef ine kBaseResID 
#define kMoveToFront 
idef ine kSleep 
#define kLeaveWhereltls 
#define kUseDefaultProc 

128 
(WindowPtr)-lL 
3600L 
false 
(void *) -lL 
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#define kNotANormalMenu -1 

#define mApple kBaseResID 
#define iAbout 1 

#define mFile kBaseResID+l 
#define iSetReminder 1 

#define iCancelReminder 2 

#define iQuit 4 

#define mHours 100 
#define mMinutes 101 
#define mAMorPM 102 
#define mReminders 103 

#define kDialogResID kBaseResID+l 

#define iHoursPopup 4 

#define iMinutesPopup 5 
#define iAMorPMPopup 6 

#define iMessageText 8 

#define iSoundCheckBox 9 

#define iRotateCheckBox 10 

fdef ine iLaunchCheckBox 11 

#define iAppNameText 12 

#define kOn 1 

#define kOf f 0 

#define kMarkApp 1 

#define kAM 1 

#define kPM 2 

#define kMinTextPosition 0 

#define kMaxTextPosition 32767 

#define kDisableButton 255 

#define kEnableButton 0 
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typedef struct 
{ 

QElem 
NMRec 
FSSpec 
short 
short 
Boolean 
Str255 

Str255 

short 
Boolean 
Boolean 

queue; 
notify; 
file; 
hour; 
minute; 
launch; 
alert; 
menuString; 
menuitem; 
dispose; 
wasPosted; 
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ReminderRec, *ReminderPtr; 

/***************/ 
I* Functions */ 
/***************/ 

void 
void 
void 
void 
void 
void 
void 
void 
void 

ReminderPtr 

void 

pascal 
pascal 

void 

void 
void 

ReminderPtr 
ReminderPtr 
ReminderPtr 

ToolBoxinit( void ); 
MenuBarinit( void ); 
EventLoop( void); 
DoEvent( EventRecord *eventPtr ); 
HandleNull( void); 

HandleMouseDown( EventRecord *eventPtr ); 
HandleMenuChoice( long menuChoice ); 
HandleAppleChoice( short item); 
HandleFileChoice( short item); 

HandleDialog( void); 

GetFileName( StandardFileReply *replyPtr ); 

LaunchResponse( NMRecPtr notifyPtr ); 
NormalResponse( NMRecPtr notifyPtr ); 

CopyDialogToReminder( DialogPtr dialog, 

ReminderPtr reminder); 

GetFirstReminder( void); 
GetNextReminder( ReminderPtr reminder); 
GetReminderFromNotification( NMRecPtr notifyPtr ); 
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ReminderPtr 
ReminderPtr 
ReminderPtr 

void 
short 
void 
void 
void 
void 
void 
void 
ReminderPtr 

void 

FindReminderOnMenu( short menuitem ); 
FindReminderToPost( short hour, short minute); 
FindReminderToDispose( void); 

SetupReminderMenu( void); 
CountRemindersOnMenu( void); 
RenumberTrailingReminders( ReminderPtr reminder); 
InsertReminderintoMenu( ReminderPtr reminder); 
ScheduleReminder( ReminderPtr reminder); 
PostReminder( ReminderPtr reminder); 
DeleteReminderFromMenu( ReminderPtr reminder); 
DeleteReminder( ReminderPtr reminder); 
DisposeReminder( ReminderPtr reminder); 

ConcatString( Str255 strl, Str255 str2); 

/* see tech note 304 */ 
pascal OSErr SetDialogDefaultitem(DialogPtr theDialog, short newitem) 

= { Ox303C, Ox0304, OxAA68 }; 
pascal OSErr SetDialogCancelitem(DialogPtr theDialog, short newitem) 

= { Ox303C, Ox0305, OxAA68 }; 
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pascal OSErr SetDialogTracksCursor(DialogPtr theDialog, Boolean tracks) 
= { Ox303C, Ox0306, OxAA68 }; 

/*************/ 
/* Globals */ 
/*************/ 

Boolean 
QHdr 

gDone; 
gReminderQueue; 

/******************************** main *********/ 

void main( void ) 

ToolBoxinit (); 
MenuBarinit (); 

EventLoop(); 
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/*********************************** ToolBoxinit */ 

void ToolBoxinit( void 

InitGraf( &qd.thePort ); 
InitFonts(); 
InitWindows(); 
InitMenus(); 
TEinit (}; 
InitDialogs( nil); 
Ini tCursor (}; 

/*********************************** MenuBarinit */ 

void MenuBarinit( void ) 

Handle 
MenuHandle 

menuBar; 
menu; 

menuBar = GetNewMBar( kBaseResID ); 
if ( menuBar == nil 

SysBeep( 20 ); 
Exit To Shell () ; 

SetMenuBar( menuBar ); 

menu= GetMenu( mReminders ); 
InsertMenu( menu, kNotANormalMenu ); 

menu= GetMHandle( mApple ); 
AddResMenu( menu, 'DRVR' ); 

DrawMenuBar(); 

/*********************************** EventLoop */ 

void EventLoop( void ) 

EventRecord event; 
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gDone false; 

while ( gDone == false ) 
{ 

if ( WaitNextEvent( everyEvent, &event, GetCaretTime(), nil ) ) 
DoEvent( &event); 

else 
HandleNull (); 

/*********************************** DoEvent */ 

void DoEvent( EventRecord *eventPtr ) 

char theChar; 

switch eventPtr->what 

case mouseDown: 
HandleMouseDown( eventPtr ); 
break; 

case keyDown: 
case autoKey: 

theChar = eventPtr->message & charCodeMask; 
if ( (eventPtr->modifiers & cmdKey) != 0 ) 

HandleMenuChoice( MenuKey( theChar) ); 

break; 

/****************** HandleNull **********************/ 

void HandleNull( void) 

unsigned long 
DateTimeRec 
ReminderPtr 

time; 
dateTime; 
theReminder; 

GetDateTime( &time); 
Secs2Date( time, &dateTime ); 
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theReminder = FindReminderToPost( dateTime.hour, dateTime.minute ); 
while ( theReminder ) 
{ 

PostReminder( theReminder ); 
DeleteReminderFromMenu( theReminder ); 
theReminder = FindReminderToPost ( dateTime.hour, dateTime.minute ); 

the~eminder = FindReminderToDispose(); 
while ( theReminder ) 
{ 

DisposeReminder( theReminder ); 
theReminder = FindReminderToDispose (); 

/***~************** HandleMouseDown ***********************/ 

void HandleMouseDown( EventRecord *eventPtr ) 

WindowPtr window; 
sho~t thePart; 
long menuChoice; 

thePart FindWindow( eventPtr->where, &window); 
s~itch ( thePart ) 

case inMenuBar: 
SetupReminderMenu(); 

menuChoice = MenuSelect( eventPtr->where ); 
HandleMenuChoice( menuChoice ); 
break; 

case inSysWindow: 
SystemClick( eventPtr, window); 
break; 

/******************** SetupReminderMenu *************************/ 

void SetupReminderMenu( void ) 

MenuHandle 
short 

f ileMenu; 
items; 
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fileMenu = GetMenu( mFile }; 
items= CountRemindersOnMenu(}; 
if (items} Enableitem( fileMenu, iCancelReminder}; 
else Disableitem( fileMenu, iCancelReminder}; 

/****************** HandleMenuChoice ***********************/ 

void HandleMenuChoice( long menuChoice } 

short menu; 
short item; 
ReminderPtr reminder; 

if ( menuChoice != 0 ) 
{ 

menu 
item 

HiWord( menuChoice }; 
LoWord( menuChoice ); 

switch ( menu ) 

case mApple: 
HandleAppleChoice( item}; 
break; 

case mFile: 
HandleFileChoice( item); 
break; 

case mReminders: 
reminder= FindReminderOnMenu( item}; 
if ( reminder ) 

DeleteReminder( reminder); 

break; 

HiliteMenu( 0 }; 

/****************** HandleAppleChoice ***********************/ 

void HandleAppleChoice( short item ) 

MenuHandle 
Str255 
short 

appleMenu; 
accName; 
accNumber; 

• 
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switch ( item ) 
{ 

case iAbout: 
NoteAlert( kBaseResID, nil); 

break; 
default: 
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appleMenu = GetMHandle( mApple ); 
Getitem( appleMenu, item, accName ); 

accNumber = OpenDeskAcc( accName ); 
break; 

/******x*********** HandleFileChoice ***********************/ 

void HandleFileChoice( short item ) 

ReminderPtr reminder; 

switch ( item ) 
{ 

case iSetReminder: 

reminder= HandleDialog(); 
if ( reminder ) 

ScheduleReminder( reminder); 
break; 

case iQuit : 
gDone = true; 
break; 

/******************** GetFirstReminder **************************/ 

ReminderPtr GetFirstReminder( void ) 

return( (ReminderPtr)gReminderQueue.qHead ); 
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/******************** GetNextReminder **************************/ 

ReminderPtr GetNextReminder( ReminderPtr reminder 

return( (ReminderPtr)reminder->queue.qLink ); 

/******************** FindReminderOnMenu ************************/ 

ReminderPtr FindReminderOnMenu( short menultem ) 

RerninderPtr theReminder; 

theReminder = GetFirstReminder(); 
while ( theReminder ) 
{ 

if ( theReminder->menuitern =; menultern ) 
break; 

theReminder = GetNextRerninder( theReminder ); 

return( theReminder ); 

/******************** FindReminderToPost ************************/ 

RerninderPtr FindReminderToPost( short hour, short minute ) 

ReminderPtr theReminder; 

theRerninder = GetFirstReminder(); 
while ( theReminder ) 
{ 

if ( (!theRerninder->wasPosted) 
&& (theReminder->hour <= hour) 
&& (theReminder->minute <= minute) 

break; 
theReminder = GetNextReminder (theReminder); 

return( theReminder ); 
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/******************** FindReminderToDispose **********************/ 

ReminderPtr FindReminderToDispose( void ) 

ReminderPtr theReminder; 

theReminder = GetFirstReminder (); 
while ( theReminder ) 
{ 

if ( theReminder->dispose 
break; 

theReminder = GetNextReminder (theReminder); 

return( theReminder ); 

/******************** InsertReminderintoMenu ************************/ 

void InsertReminderlntoMenu( ReminderPtr reminder ) 

short 
MenuHandle 

itemBefore; 
reminderMenu; 

reminderMenu = GetMenu( mReminders ); 

itemBefore = CountRemindersOnMenu(); 

InsMenuitem( reminderMenu, reminder->menuString, itemBefore ); 

reminder->menuitem = itemBefore + 1; 

/********************* CountRemindersOnMenu *******************/ 

short CountRemindersOnMenu( void ) 

MenuHandle reminderMenu; 

reminderMenu = GetMenu( mReminders ); 

return( CountMitems( reminderMenu) ); 
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/******************* DeleteReminderFromMenu **************/ 

void DeleteReminderFromMenu( ReminderPtr reminder ) 

MenuHandle reminderMenu; 

reminderMenu = GetMenu( mReminders ); 
RenumberTrailingReminders( reminder); 
DelMenuitem( reminderMenu, reminder->menuitem ); 
reminder->menuitem = O; 

/***************** RenumberTrailingReminders ****************/ 

void RenumberTrailingReminders( ReminderPtr reminder ) 

short count; 

count reminder->menultem; 
reminder= GetNextReminder( reminder); 
while ( reminder ) 
{ 

if (reminder->menuitem != 0) 
reminder->menuitem = count++; 

reminder= GetNextReminder( reminder); 

/****************** ScheduleReminder ***********************/ 

void ScheduleReminder( ReminderPtr reminder 

Enqueue( &reminder->queue, &gReminderQueue ); 
InsertReminderintoMenu( reminder); 

/****************** PostReminder ****************************/ 

void PostReminder( ReminderPtr reminder ) 

reminder->notify.nmRefCon = (long)reminder; 
reminder->wasPosted = true; 
NMinstall( &reminder->notify ); 
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/****************** DeleteReminder **************************/ 

void DeleteReminder( ReminderPtr reminder ) 

if ( reminder->menuitem ) 
DeleteReminderFromMenu( reminder); 

reminder->dispose ; true; 

/*************** DisposeRerninder ***************************/ 

RerninderPtr DisposeRerninder( RerninderPtr reminder ) 

ReminderPtr next; 

if (rerninder->rnenuitem) 
DeleteRerninderFrornMenu( reminder); 

next ; (RerninderPtr)rerninder->queue.qLink; 
Dequeue( &reminder->queue, &gReminderQueue ); 
DisposePtr( (Ptr)reminder ); 
return( next); 

/******************************** GetFileNarne *******/ 

void GetFileNarne( StandardFileReply *replyPtr ) 

SFTypeList typeList; 
short nurnTypes; 

typeList[ 0 ; 'APPL'; 
numTypes ; 1; 

StandardGetFile( nil, numTypes, typeList, replyPtr ); 

/******************************** HandleDialog *********/ 

RerninderPtr HandleDialog( void ) 
{ 

DialogPtr dialog; 
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Boolean 
short 
Handle 
Handle 
Handle 
Handle 
Re ct 
Str255 
StandardFileReply 
ReminderPtr 

dialogDone = false; 
itemHit, itemType; 
textitemHandle; 
itemHandle; 
okitemHandle; 
launchitemHandle; 
itemRect; 
itemText; 
reply; 
reminder; 

dialog = GetNewDialog( kDialogResID, nil, kMoveToFront ) ; 

ShowWindow( dialog); 
SetPort( dialog); 

reminder= (ReminderPtr)NewPtr( sizeof ( ReminderRec) ); 
reminder->menuitem = 0; 
reminder->dispose = false; 
reminder->wasPosted = false; 

SetDialogDefaultitem( dialog, ok ); 
SetDialogCancelitem( dialog, cancel); 
SetDialogTracksCursor( dialog, true); 

GetDitem( dialog, iMessageText, &itemType, 
&textitemHandle, &itemRect ); 

GetDitem( dialog, ok, &itemType, &okitemHandle, &itemRect ); 
GetDitem( dialog, iLaunchCheckBox, &itemType, 

&launchitemHandle, &itemRect ); 
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SelIText( dialog, iMessageText, kMinTextPosition, kMaxTextPosition ); 

while ( ! dialogDone ) 
{ 

GetIText( textitemHandle, itemText ); 

if ( itemText[ 0 ] == 0 && 
!GetCtlValue( (ControlHandle)launchitemHandle ) ) 
HiliteControl( (ControlHandle)okitemHandle, kDisableButton ); 

else 
HiliteControl( (ControlHandle)okitemHandle, kEnableButton ); 

ModalDialog( nil, &itemHit ); 
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switch ( itemHit 

case ok: 
case cancel: 

dialogDone = true; 
break; 

case iSoundCheckBox: 
case iRotateCheckBox: 

GetDitem( dialog, itemHit, &itemType, &itemHandle, 
&itemRect ); 

SetCtlValue( (ControlHandle)itemHandle, 
! GetCtlValue( {ControlHandle)itemHandle) ); 

break; 
case iLaunchCheckBox: 
case iAppNameText: 

if ( ! GetCtlValue{ (ControlHandle)launchitemHandle ) ) 

else 

GetFileName( &reply); 
if ( reply.sfGood ) 

SetCtlValue{ (ControlHandle)launchitemHandle, 
kOn ); 

reminder->file = reply.sfFile; 

GetDitem{ dialog, iAppNameText, &itemType, 
&itemHandle, &itemRect ); 

SetIText{ itemHandle, reminder->file.name ); 

SetCtlValue( {ControlHandle)launchitemHandle, kOff ); 
GetDitem( dialog, iAppNameText, &itemType, 

&itemHandle, &itemRect ); 
SetIText{ itemHandle, "\p<Not Selected>" ); 

break; 

if ( itemHit == cancel ) 

DisposePtr( {Ptr)reminder ); 
reminder = nil; 

e.:se 

CopyDialogToReminder( dialog, reminder); 
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DisposDialog( dialog ); 

return( reminder); 

/************************************* CopyDialogToReminder */ 

void CopyDialogToReminder( DialogPtr dialog, ReminderPtr reminder) 

short 

Re ct 

Handle 

Str255 

MenuHandle 

short 

long 

itemType; 

itemRect; 

itemHandle; 
string; 

menu; 

val; 

tmp; 

GetDitem( dialog, iMessageText, &itemType, &itemHandle, &itemRect ~; 

GetIText( itemHandle, reminder->alert ) ; 

reminder->notify.nmStr = (StringPtr)&reminder->alert; 

GetDitem( dialog, iSoundCheckBox, &itemType, 

&itemHandle, &itemRect ); 

if ( GetCtlValue( (ControlHandle)itemHandle ) 

reminder->notify.nmSound (Handle)-lL; 

else 
reminder->notify.nmSound = nil; 

GetDitem( dialog, iRotateCheckBox, &itemType, 

&itemHandle, &itemRect ); 

if ( GetCtlValue( (ControlHandle)itemHandle ) ) 
reminder->notify.nmicon 
else 

GetResource( 'SICN', kBaseResID ); 

reminder->notify.nmicon = nil; 

GetDitem( dialog, iLaunchCheckBox, &itemType, 

&itemHandle, &itemRect ); 

if ( reminder->launch = GetCtlValue( (ControlHandle)itemHandle ) ) 

reminder->notify.nmResp 

else 

&LaunchResponse; 

reminder->notify.nmResp = &NormalResponse; 

GetDitem( dialog, iHoursPopup, &itemType, &itemHandle, &itemRect }~ 

val= GetCtlValue( (ControlHandle)itemHandle ); 

NumToString( (long) val, string); 

StringToNum (string, &tmp }; 
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reminder->hour = tmp; 

reminder->menuString[O] = O; 
ConcatString( reminder->menuString, string); 
ConcatString( reminder->menuString, "\p:" ); 

GetDitem( dialog, iMinutesPopup, &itemType, &itemHandle, &itemRect ); 
val= GetCtlValue( (ControlHandle)itemHandle ); 
menu= GetMHandle( mMinutes ); 
Getltem( menu, val, string); 
StringToNum ( string, &tmp ); 
reminder->minute = tmp; 

ConcatString( reminder->menuString, string); 
ConcatString( reminder->menuString, "\p "); 

GetDitem( dialog, iAMorPMPopup, &itemType, &itemHandle, &itemRect ); 
val= GetCtlValue( (ControlHandle)itemHandle ); 

if { val == kPM ) 
reminder->hour += 12; 

menu= GetMenu ( mAMorPM ); 
Getitem( menu, val, string); 
ConcatString( reminder->menuString, string); 

reminder->notify.qType = nmType; 
reminder->notify.nmMark = kMarkApp; 

/************************** ConcatString ************/ 

void ConcatString( Str255 strl, Str255 str2) 

short i; 

for (i=strl[O];i<str2[0)+strl[O];i++) 

strl[i+l]=str2[i-strl[O]+l]; 

strl[O]=i; 
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/************************** NormalResponse ************/ 

pascal 
{ 

void NormalResponse( NMRecPtr notifyPtr ) 

ReminderPtr reminder; 
OSErr err; 

reminder GetReminderFromNotification( notifyPtr ); 
err= NMRemove( notifyPtr ); 
reminder->dispose = true; 

/************************** LaunchResponse *******/ 

pascal 
{ 

void LaunchResponse( NMRecPtr notifyPtr 

LaunchParamBlockRec 
OS Err 
FSSpec 
ReminderPtr 
Boolean 
Boolean 

launchParams; 
err; 
fileSpec; 
reminder; 
isFolder; 
wasAlias; 

reminder GetReminderFromNotification( notifyPtr ); 

fileSpec = reminder->file; 

err= ResolveAliasFile( &fileSpec, true, &isFolder, &wasAlias ); 

launchParams.launchBlockID = extendedBlock; 
launchParams.launchEPBLength = extendedBlockLen; 
launchParams.launchFileFlags = O; 
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launchParams.launchControlFlags = launchContinue + launchNoFileFlags; 
launchParams.launchAppSpec = &fileSpec; 

launchParams.launchAppParameters = nil; 

if ( LaunchApplication( &launchParams ) SysBeep( 20 ); 

err= NMRemove( notifyPtr ); 

reminder->dispose = true; 
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/************************** GetReminderFromNotification ************/ 

ReminderPtr GetReminderFromNotification( NMRecPtr notifyPtr ) 

return (ReminderPtr) notifyPtr->nmRefCon; 

#define kBaseResID 
#define kMoveToFront 

#define iText 

#define kDisableButton 
#define kEnableButton 

Chapter 7: ResWriter.c 
128 
(WindowPtr)-lL 

4 

255 
0 

#define kWriteTextOut true 
#define kDontWriteTextOut false 

#define kMinTextPosition 0 
#define kMaxTextPosition 32767 

/***************/ 
I* Functions */ 
/***************/ 

void 
Boolean 

ToolBoxinit( void); 
DoTextDialog( StringHandle oldTextHandle ); 

pascal OSErr SetDialogDefaultitem( DialogPtr\.heDialog, 
short newltem ) = { Ox303C, Ox0304, OxAA68 }; 

pascal OSErr SetDialogCancelitem( DialogPtr theDialog, 
short newltem ) = { Ox303C, Ox0305, OxAA68 }; 

pascal OSErr SetDialogTracksCursor( DialogPtr theDialog, 
Boolean tracks ) = { Ox303C, Ox0306, OxAA68 }; 

/**************************** main **********************/ 

void main( void ) 

StringHandle textHandle; 

ToolBoxinit(); 
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textHandle = GetString( kBaseResID ); 

if ( textHandle == nil ) 

SysBeep( 20 ); 
ExitToShell (); 

if ( DoTextDialog( textHandle ) == kWriteTextOut 

ChangedResource( (Handle)textHandle ); 
WriteResource( (Handle)textHandle ); 

/****************** ToolBoxinit *********************/ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
InitFonts(); 
InitWindows(); 
InitMenus(); 
TEinit (); 
InitDialogs( nil); 
InitCursor (); 

/****************** DoTextDialog *********************/ 

Boolean DoTextDialog( StringHandle textHandle ) 

DialogPtr 
Boolean 
short 
Handle 
Re ct 
Str255 

dialog 

dialog; 
done; 
itemHit, itemType; 
OKitemHandle, textitemHandle; 
itemRect; 
itemText; 

GetNewDialog( kBaseResID, nil, kMoveToFront ); 

GetDitem( dialog, ok, &itemType, &OKitemHandle, &itemRect ); 
GetDitem( dialog, iText, &itemType, &textitemHandle, &itemRect ); 
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HLock( (Handle)textHandle ); 
SetIText( textitemHandle, *textHandle ); 
HUnlock( (Handle)textHandle ); 

SelIText( dialog, iText, kMinTextPosition, kMaxTextPosition ); 

ShowWindow( dialog); 
SetPort( dialog); 

SetDialogDefaultitem( dialog, ok ); 
SetDialogCancelitem( dialog, cancel ); 
SetDialogTracksCursor( dialog, true); 

done = false; 
while ( ! done 
{ 

GetIText( textitemHandle, itemText ); 

if ( iternText[ 0 ] == 0 ) 

HiliteControl( (ControlHandle)OKiternHandle, kDisableButton ); 
else 

HiliteControl( (ControlHandle)OKitemHandle, kEnableButton ); 

ModalDialog( nil, &itemHit ); 

done = ( (itemHit == ok) I I (itemHit cancel) ); 

if ( itemHit == ok ) 

else 

Get!Text( textitemHandle, iternText ); 
SetHandleSize( (Handle)textHandle, (Size)(itemText[ 0] + 1) ); 

HLock( (Handle)textHandle ); 
Get!Text( textitemHandle, *textHandle ); 
HUnlock( (Handle)textHandle ); 

DisposDialog( dialog); 

return( kWriteTextOut ); 

DisposDialog( dialog); 
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return( kDontWriteTextOut ); 

Chapter 7: Pager.c 

#include <Values.h> 

#define kBaseResID 
#define kMoveToFront 
#define kScrollBarWidth 

#define kNilActionProc 
#define kSleep 

#define kVisible 
#define kStartValue 
#define kMinValue 
#define kNilRefCon 
#define kEmptyTitle 

#define kEmptyString 

#define kNilFilterProc 

#define kErrorAlertID 

/**************/ 
/* Globals */ 
/**************/ 

Boolean gDone; 

/***************/ 
/* Functions */ 
/***************/ 

ToolBoxinit( void); 
Windowlnit( void); 

128 
(WindowPtr)-lL 
16 
nil 
MAX LONG 

true 
1 
1 

OL 
"\p" 

"\p" 
nil 

kBaseResID 

void 
void 
void 
pascal 
void 
void 
void 
void 

SetUpScrollBar( WindowPtr window); 
void ScrollProc( ControlHandle theControl, 

EventLoop( void); 
DoEvent( EventRecord *eventPtr ); 
HandleMouseDown( EventRecord *eventPtr ); 
UpdateWindow( WindowPtr window); 
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short partCode ); 
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void 
void 
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CenterPict( PicHandle picture, Rect *destRectPtr ); 

DoError( Str255 errorString, Boolean fatal); 

/**************************** main **********************/ 

void main( void 

ToolBoxinit(); 
Winciowini t () ; 

EventLoop(); 

/****************** ToolBoxinit *********************/ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
InitFonts (); 
InitWindows (); 

InitMenus (); 
TEI nit(); 
InitDialogs( nil); 
InitCursor(); 

/******************************** Windowinit *********/ 

void Windowinit( void 

WindowPtr window; 

~f ( ( window= GetNewWindow( kBaseResID, nil, 
kMoveToFront ) ) == nil ) 

DoError( "\pCan't Load WIND resource!", true); 

SetUpScrollBar( window); 

ShowWindow( window); 
SetPort( window); 
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/********************************** SetUpScrollBar 

void SetUpScrollBar( WindowPtr window ) 

Rect vScrollRect; 
short 
Control Handle 

numPictures; 
scrollBarH; 

*******/ 

if ( ( numPictures = CountResources( 'PICT' ) ) <= 0 ) 
DoError( "\pNo PICT resources were found!", true); 

vScrollRect = window->portRect; 
vScrollRect.top -= 1; 
vscrollRect.bottom += 1; 
vScrollRect.left = vScrollRect.right - kScrollBarWidth + 1; 

vScrollRect.right += l; 

scrollBarH = NewControl( window, &vScrollRect, 
kEmptyTitle, kVisible, kStartValue, kMinValue, 
numPictures, scrollBarProc, kNilRefCon ); 

/********************************** ScrollProc *******/ 

pascal void ScrollProc( ControlHandle theControl, short partCode 
{ 

short curCtlValue, maxCtlValue, minCtlValue; 
WindowPtr window; 

maxCtlValue GetCtlMax( theControl ); 
curCtlValue GetCtlValue( theControl ); 
minCtlValue GetCtlMin( theControl ); 

window (**theControl) .contrlOwner; 

switch partCode ) 

case inPageDown: 
case inDownButton: 

if ( curCtlValue < maxCtlValue 

curCtlValue += 1; 
SetCtlValue( theControl, curCtlValue ); 
UpdateWindow( window); 

i I 

I ~83 



584 

break; 
case inPageUp: 
case inUpButton: 

if ( curCtlValue > minCtlValue 

curCtlValue -= 1; 
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SetCtlValue( theControl, curCtlValue ); 
UpdateWindow( window); 

/***~************** EventLoop ***********************/ 

void EventLoop( void ) 

Event Record event; 

gDone false; 

while ( gDone == false ) 
{ 

if ( WaitNextEvent( everyEvent, &event, kSleep, nil } } 
DoEvent( &event}; 

/****************** DoEvent ***********************/ 

void DoEvent( EventRecord *eventPtr } 

WindowPtr window; 

swit8h ( eventPtr->what 

case mouseDown: 
HandleMouseDown( eventPtr ); 
break; 

case updateEvt: 

window = (WindowPtr)eventPtr->message; 

BeginUpdate( window); 
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DrawControls( window); 
UpdateWindow( window); 
EndUpdate( window); 
break; 

/****************** HandleMouseDown ***********************/ 

void HandleMouseDown( EventRecord *eventPtr ) 

WindowPtr 
short 
Point 
ControlHandle 

window; 
thePart; 
thePoint; 
theControl; 

thePart = FindWindow( eventPtr->where, &window); 

switch ( thePart ) 
{ 

case inSysWindow 
SystemClick( eventPtr, window); 

break; 
case inDrag : 
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DragWindow( window, eventPtr->where, &screenBits.bounds );! 
break; 

case inContent: 
thePoint = eventPtr->where; 
GlobalToLocal( &thePoint ); 

thePart = FindControl( thePoint, window, &theControl ); 

if ( theControl == ((WindowPeek)window)->controlList 

if ( thePart == inThumb ) 

else 

break; 

thePart = TrackControl( theControl, 
thePoint, kNilActionProc ); 

InvalRect( &(window->portRect) ); 

the Part TrackControl( theControl, thePoint, 
&ScrollProc ); 
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case inGoAway : 
gDone = true; 
break; 
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/********************************** UpdateWindow *******/ 

void UpdateWindow( WindowPtr window 

PicHandle 
Re ct 
RgnHandle 

currentPicture; 
windowRect; 
tempRgn; 

tempRgn = NewRgn(); 
GetClip( tempRgn ); 

windowRect = window->portRect; 
windowRect.right -= kScrollBarWidth; 
EraseRect( &windowRect ); 

ClipRect( &windowRect ); 

currentPicture = (PicHandle)GetindResource( 'PICT', 
GetCtlValue( ((WindowPeek)window)->controlList ) ); 

if currentPicture == nil ) 

DoError( "\pCan't Load PICT resource!", true); 

CenterPict( currentPicture, &windowRect ); 
DrawPicture( currentPicture, &windowRect ); 

SetClip( tempRgn ); 
DisposeRgn( tempRgn ); 

/*******~********** CenterPict ********************/ 

void CenterPict( PicHandle picture, Rect *destRectPtr 

Rect windRect, pictRect; 

windRect = *destRectPtr; 
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pictRect = (**(picture )) .picFrame; 
OffsetRect( &pictRect, windRect.left - pictRect.left, 

windRect.top - pictRect.top); 
OffsetRect( &pictRect, (windRect.right - pictRect.right)/2, 

(windRect.bottom - pictRect.bottom)/2); 
*destRectPtr = pictRect; 

/***************** DoError ********************/ 

void DoError( Str255 errorString, Boolean fatal 
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ParamText ( errorString, kEmptyString, kEmptyString, kEmptyString ) ;; 

StopAlert( kErrorAlertID, kNilFilterProc ); 

if ( fatal 
ExitToShell (); 

Chapter 7: ShowClip.c 

#define kBaseResID 
idef ine kMoveToFront 

#define kEmptyString 
#define kNilFilterProc 

#define kErrorAlertID 

/***************/ 
/* Functions */ 
/***************/ 

ToolBoxinit( void); 
Windowinit( void); 
MainLoop( void); 

128 
(WindowPtr)-lL 

"\p" 
nil 

kBaseResID 

void 
void 
void 
void 
void 

CenterPict( PicHandle picture, Rect *destRectPtr ); 
DoError( Str255 errorString, Boolean fatal); 
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/****************** main ***************************/ 

void main( void 

ToolBoxinit(); 
Windowinit () ; 
MainLoop (); 

/****************** ToolBoxinit *********************/ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
InitFonts(); 
InitWindows (); 
Init:Menus(); 
TEI nit(); 
InitDialogs( nil ); 
InitCursor(); 

/****************** Windowinit ***********************/ 

void Windowinit( void 

WindowPtr window; 

window= GetNewWindow( kBaseResID, nil, kMoveToFront ); 

if ( window == nil ) 

DoError( "\pCan't load the WIND resource!", true); 

ShowWindow( window); 
SetPort( window); 

/******************************** MainLoop *********/ 

void MainLoop( void ) 

Rect pictureRect; 



Code Listings 

Handle 
long 
WindowPtr 

clipHandle; 
length, offset; 
window; 

clipHandle NewHandle( 0 ); 
window= FrontWindow(); 

if ( ( length= GetScrap( clipHandle, 'TEXT', &offset ) ) < 0 ) 

else 

if ( GetScrap( clipHandle, 'PICT', &offset) < 0) 

else 

DoError( "\pThere's no PICT and no text in the scrap ... ", 
true); 

pictureRect = window->portRect; 
CenterPict( (PicHandle)clipHandle, &pictureRect ); 
DrawPicture( (PicHandle)clipHandle, &pictureRect ); 

HLock( clipHandle ); 
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TextBox( *clipHandle, length, &(window->portRect), teJustLeft ); 

Hunlock( clipHandle ); 

while ( ! Button () ) 

/****************** CenterPict ********************/ 

void CenterPict( PicHandle picture, Rect *destRectPtr 

Rect windRect, pictRect; 

windRect = *destRectPtr; 
pictRect = (**(picture)) .picFrame; 
OffsetRect( &pictRect, windRect.left - pictRect.left, 

windRect.top - pictRect.top); 
OffsetRect( &pictRect, (windRect.right - pictRect.right)/2, 

(windRect.bottom - pictRect.bottom)/2); 

*destRectPtr = pictRect; 
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/***"************* DoError ********************/ 

void DoError( Str255 errorString, Boolean fatal 

ParamText( errorString, kEmptyString, kEmptyString, kEmptyString ); 

SropAlert( kErrorAlertID, kNilFilterProc ); 

::..r ( fatal 

Exit ToShell () ; 

Chapter 7: SoundMaker.c 

#include <Sound.h> 

#incl :Hie <Soundinput. h> 

#include <GestaltEqu.h> 

#de~ine kBaseResID 

#de~ine kNilSoundChannel 

#def in~ kSynchronous 

#de:lnP. kEmptyString 

#define kNilFilterProc 

#de:ine kErrorAlertID 

/**·~~**********/ 

/* ~unctions */ 
/**~·k~k********/ 

void ToolBoxinit ( 
Handle RecordSound( 

void 
void 

void Playsound( Handle 
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nil 

false 

"\p" 
nil 

kBaseResID 

) ; 

) ; 

soundHandle 
void DoError( Str255 errorString, 

) ; 

Boolean fatal ) ; 

/**~A~*********************** main **********************/ 

void main( void) 

!-:and le 

:ong 
soundHandle; 

feature; 



Code Listings 

OSErr err; 

MaxApplZone(); 
ToolBoxinit(); 

err= Gestalt( gestaltSoundAttr, &feature); 

if ( err != noErr ) 
DoError( "\pError returned by Gestalt!", true); 

if ( feature & (1 << gestaltHasSoundinputDevice) 

else 

soundHandle = RecordSound(); 
PlaySound( soundHandle ); 
DisposHandle( soundHandle ); 

DoError( "\pSound input device not available!!!", true); 

/****************** ToolBoxinit *********************/ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
InitFonts(); 
InitWindows (); 
InitMenus(); 
TEini t () ; 
InitDialogs( nil}; 
InitCursor(); 

/****************** RecordSound ***********************/ 

Handle RecordSound( void 

OS Err 
Point 
Handle 

err; 
upperLeft; 
soundHandle; 

SetPt( &upperLeft, SO, SO); 
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soundHandle = nil; 

err= SndRecord( nil, upperLeft, siBestQuality, &soundHandle ); 

if ( err == userCanceledErr ) 
DoError( "\pRecording canceled ... ", true); 

if ( err ! = 0 ) 
DoError( "\pError returned by SndRecord() ... ", true); 

return( soundHandle ); 

/****************** PlaySound ***********************/ 

void PlaySound( Handle soundHandle ) 

OSErr err; 

err= SndPlay( kNilSoundChannel, soundHandle, kSynchronous ); 

if ( err != noErr ) 
DoError( "\pError returned by SndPlay() ... ", true); 

/***************** DoError ********************/ 

void DoError( Str255 errorString, Boolean fatal 

ParamText( errorString, kEmptyString, kEmptyString, kEmptyString ); 

StopAlert( kErrorAlertID, kNilFilterProc ); 

if ( fatal 
ExitToShell (); 



Code Listings 

#include <GestaltEqu.h> 

#define kBaseResID 
#define kMoveToFront 

#define kEmptyString 
#define kNi!Fil terProc 

#define kErrorAlertID 

#define kPICTHeaderSize 

/***************/ 
I* Functions */ 
/***************/ 

Chapter 7: OpenPICT.c 

128 
(WindowPtr)-lL 

"\p" 
nil 

kBaseResID 
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void 
void 
PicHandle 
void 
void 
void 
void 

ToolBoxinit( void ); 
GetFileName( StandardFileReply *replyPtr ); 
LoadPICTFile( StandardFileReply *replyPtr ); 

Windowinit( void); 
DrawMyPicture( PicHandle picture); 
CenterPict( PicHandle picture, Rect *destRectPtr ); 
DoError( Str255 errorString, Boolean fatal); 

/**************************** main **********************/ 

void main( void ) 

PicHandle 
StandardFileReply 

ToolBoxinit (); 

GetFileName( &reply); 

if ( reply.sfGood ) 

picture; 
reply; 

picture= LoadPICTFile( &reply); 

if ( picture != nil ) 
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Windowinit(); 
DrawMyPicture( picture); 

while ( ! Button () ) ; 
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/******~*********** ToolBoxinit *********************/ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
InitFonts(); 
InitWindows(); 
InitMenus (); 
TEini t () ; 
InitDialogs( nil ); 
InitCursor(); 

/******************************** GetFileName *******/ 

void GetFileName( StandardFileReply *replyPtr ) 

SFTypeList 
short 

typeList; 
numTypes; 
feature; long 

OSErr err; 

err= Gestalt( gestaltStandardFileAttr, &feature ); 

if ( err != noErr ) 

DoError( "\pError returned by Gestalt!", true ); 

if ( feature & (1 << gestaltStandardFile58) 

typeList[ 0 ] = 'PICT'; 
numTypes = 1; 

StandardGetFile( kNilFilterProc, numTypes, typeList, replyPtr ); 



Code Listings 

else 

DoError( "\pThe new Standard File routines \ 
are not supported by this OS!", true); 

/******************************** LoadPICTFile *******/ 

PicHandle LoadPICTFile( StandardFileReply *replyPtr ) 

short 
PicHandle 
char 
long 
long 
OSErr 

srcFile; 
picture; 
pictHeader[ kPICTHeaderSize ]; 
pictSize, headerSize; 
feature; 
err; 

err= Gestalt( gestaltFSAttr, &feature); 

if ( err != noErr ) 
DoError( "\pError returned by Gestalt!", true); 

if ( feature & (1 << gestaltHasFSSpecCalls) ) 

if FSpOpenDF( &(replyPtr->sfFile), fsRdPerm, &srcFile) 

!= noErr ) 

DoError( "\pCan't open file ... ", false); 

return( nil); 

if ( GetEOF ( srcFile, &pictSize ) ! = noErr ) 

DoError( "\pError returned by GetEOF() ... ", false); 

return( nil ); 

headerSize kPICTHeaderSize; 

if FSRead( srcFile, &headerSize, pictHeader != noErr 

DoError( "\pError reading file header ... ", false); 
return( nil ); 
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else 
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pictSize -= kPICTHeaderSize; 

if ( ( picture = (PicHandle)NewHandle{ pictSize ) ) == nil ) 

DoError( "\pNot enough memory to read picture ... ", false); 
return( nil); 

HLock( (Handle)picture ); 

if ( FSRead{ srcFile, &pictSize, *picture ) != noErr ) 

DoError( "\pError returned by FSRead() ... ", false); 
return( nil); 

HUnlock{ (Handle)picture ); 
FSClose( srcFile ); 

return( picture); 

DoError( "\pThe new FSSpec File Manager routines \ 
are not supported by this OS!", true); 

/******~*********** Windowinit ***********************/ 

void Windowlnit( void 

Win:::lowPtr window; 

window= GetNewWindow( kBaseResID, nil, kMoveToFront ); 

if ( window == nil ) 

DoError( "\pCan't load WIND resource ... ", true); 

Sho#Window( window); 
SetPort( window); 



Code Listings 

/****************** DrawMyPicture ********************/ 

void DrawMyPicture( PicHandle picture ) 

Rect pictureRect; 
WindowPtr window; 

window= FrontWindow(); 

pictureRect = window->portRect; 

CenterPict( picture, &pictureRect ); 
DrawPicture( picture, &pictureRect ); 

/****************** CenterPict ********************/ 

void CenterPict( PicHandle picture, Rect *destRectPtr 

Rect windRect, pictRect; 

windRect = *destRectPtr; 
pictRect = (**(picture)) .picFrame; 
OffsetRect( &pictRect, windRect.left - pictRect.left, 

windRect.top - pictRect.top); 
OffsetRect( &pictRect, (windRect.right - pictRect.right)/2, 

(windRect.bottom - pictRect.bottom)/2); 
*destRectPtr = pictRect; 

/***************** DoError ********************/ 

void DoError( Str255 errorString, Boolean fatal 
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ParamText( errorString, kEmptyString, kEmptyString, kEmptyString );1 

StopAlert( kErrorAlertID, kNilFilterProc ); 

if ( fatal 
ExitToShell (); 
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Chapter 7: PrintPICT.c 

#include <PrintTraps.h> 

#def ir.e kBaseResID 

#define kDontScaleOutput 

#define kEmptyString 
#define kNilFilterProc 

#define kErrorAlertID 

/* Functions */ 
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nil 

"\p" 
nil 

kBaseResID 

voici 
PicHandle 
THPrint 
Bool<?an 

void 

ToolBoxinit( void); 
LoadPICT( void); 
Printinit( void); 

void 

void 

DoDialogs( THPrint printRecordH ); 

PrintPicture( PicHandle picture, THPrint printRecordH }; 
CenterPict( PicHandle picture, Rect *destRectPtr ); 
DoError( Str255 errorString, Boolean fatal); 

/***.************************main**********************/ 

void main( void ) 

PicHandle 
THPrint 

picture; 
printRecordH; 

ToolBoxinit(); 

~icture = LoadPICT(); 
~rintRecordH = Printinit(); 

( DoDialogs( printRecordH) ) 
PrintPicture( picture, printRecordH ); 



Code Listings i5~9 

/****************** ToolBoxinit *********************/ 

void ToolBoxinit( void 

InitGraf( &thePort ); 
InitFonts(); 
InitWindows(); 
InitMenus(); 
TEinit (); 
InitDialogs( nil); 
InitCursor(); 

/******************************** LoadPICT *********/ 

PicHandle LoadPICT( void 

PicHandle picture; 

picture= GetPicture( kBaseResID ); 

if ( picture == nil ) 
DoError( "\pCan't load PICT resource ... ", true); 

return( picture); 

/******************************** Printinit *********/ 

THPrint Printinit( void) 

THPrint printRecordH; 

printRecordH = (THPrint)NewHandle( sizeof( TPrint) ); 

if ( printRecordH == nil ) 

I 

DoError( "\pNot enough memory to allocate print record", ); 

PrOpen (); 
PrintDefault( printRecordH ); 

return( printRecordH ); 
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/******~************************* DoDialogs *******/ 

Boolean DoDialogs( THPrint printRecordH 

Boolean confirmed = true; 

confirmed= PrStlDialog( printRecordH ); 

if ( confirmed ) 

confirmed= PrJobDialog( printRecordH ); 

ret~rn( confirmed); 

/******************************** PrintPicture *******/ 

void PrintPicture( PicHandle picture, THPrint printRecordH 

TPPrPort 
Re ct 
TPrStatus 

printPort 

printPort; 
pictureRect; 
printStatus; 

PrOpenDoc( printRecordH, nil, nil); 

PrOpenPage( printPort, kDontScaleOutput ); 

if ( PrError () ! = noErr ) 

DoError( "\pError returned by PrOpenPage() ... ", true); 

pictureRect = (**printRecordH) .prinfo.rPage; 

CenterPict( picture, &pictureRect ); 
DrawPicture( picture, &pictureRect ); 

PrClosePage( printPort ); 
PrCloseDoc( printPort ); 

if ( (**printRecordH) .prJob.bJD'ocLoop ::::= bSpoolLoop ) 
PrPicFile( printRecordH, nil, nil, nil, &printStatus ); 

P rClose () ; 

DisposHandle( (Handle)printRecordH ); 
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/****************** CenterPict ********************/ 

void CenterPict( PicHandle picture, Rect *destRectPtr 

Rect windRect, pictRect; 

windRect = *destRectPtr; 
pictRect = (**(picture)) .picFrame; 
OffsetRect( &pictRect, windRect.left - pictRect.left, 

windRect.top - pictRect.top); 
OffsetRect( &pictRect, (windRect.right - pictRect.right)/2, 

(windRect.bottom - pictRect.bottom)/2); 

*destRectPtr = pictRect; 

/***************** DoError ********************/ 

void DoError( Str255 errorString, Boolean fatal 

601 

ParamText( errorString, kEmptyString, kEmptyString, kEmptyString ); 

StopAlert( kErrorAlertID, kNilFilterProc ); 

if ( fatal 
ExitToShell (); 
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THINK C Is a simple but powerful programming environment. This 
appendix provides an overview of its operations. 

The Project Menu 

THINK C keeps track of all aspects of your current program in a 
project file. All object code is stored in the project file, as well. as 
information describing the compilation state and interdependenc~ of 
all files that make up the project. To create a project, select New 
Project ... from the Project menu. To open an existing project, use 
Open Project. If you have a project open, and you want to look at 
another project, use Close Project. If you choose Close: & 
Compact, the project file will be compressed. This makes it smaller, 
but means that it takes longer to open. Set Project Type ... brings 
up a dialog box, which allows you to specify the type of project you'd 
like to build (Figure C.1). There are four types of projects: applications, 
desk accessories, device drivers, and code resources. 

® Application 

O Desk Accessory 

0 Deuice Driuer 

0 Code Resource 

Partition (K) ~ 

SIZE Flogs ~ j 1000 I 

(( OK )) 

File Type I APPL 

Creator l'R'"I 

0 Far CODE 

0 Far DATR 

0 Separate STRS 

( Cancel ) 

Figure C.l The Set Project Type ... dialog box. 

I 

~05 
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Applications 

In most cases, you'll use THINK C to build a standard, double­
clickable application. Use the Set Project Type ... dialog to enter the 
application's File Type and Creator. The default File Type is APPL 
and the default Creator is ????. For more on application file and 
creator types, go back to Chapter 8. 

The Far C 0 0 E check box tells your application to reference all code 
by using 32-bit addresses instead of 16-bit addresses. This allows you a 
larger jump table (256K instead of the normal 32K). Far CODE causes 
your application to grow by about 6% due to the larger addresses. 

Similarly, the Far DATA check box causes program data references 
to use 32-bit addresses instead of 16-bit addresses. With Far OATH 
unchecked, your application is limited to 32K of global data. With Far 
OATH checked, you are limited to 32K of global data per file in your 
project. Far ORTH causes your application to grow by about 8% due to 
the larger addresses. 

Separate STRS asks THINK C to store string literals in a separate 
STRS resource. This option is not particularly useful and is available 
primarily for compatibility with older versions of THINK C. 

Specify your application's preferred memory partition in the 
Partition (K) field. Specify the partition in multiples of 1024 bytes. 

Finally, the Set Project Type ... dialog allows you to completely 
specify the SIZE resource. The s I ZE resource is detailed in Chapter 8. 

Desk Accessories and Device Drivers 

Although THINK C still supports them, System 7 has made desk 
accessories obsolete. If you're thinking of writing a desk accessory, 
Apple recommends that you write a small application instead. 

If you are building a driver, your Set Project Type ... dialog will 
look like the one shown in Figure C.2. Normally, drivers are limited to 
a single segment. No longer! The Multi-Segment check box allows 
you to build a driver of up to 31 segments. 

The Name field contains the name of the desk accessory or device 
driver resource. THINK C will add a null byte to the beginning of 
your desk accessory (a convention). It will also place a period before 
the device driver name if you don't put one there. 

Drivers always have a Type of ORUR. Enter the resource ID you'd 
like your driver saved as in the I 0 field. 

Code Resource 

THINK Callows you to build standalone CODE resources. This comes 
in really handy for building INITs, WDEFs, and cdevs. The code 
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0 Application 

0 Desk Accessory 

® Oeuice Driuer 

0 Code Resource 

Name 

Type lonun 

OK ) 

File Type I???? 

Creator I???? 

D Multi-Segment 

mLJ 

(( Cancel JJ 
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Figure C.2 The Set Project Type •.• dialog box for a Desk Accessory. 

resource Set Project Type ... dialog has the same basic fields as the 
driver dialog (Figure C.3). If the Custom Header check box is 
unchecked, THINK C builds a standard 16-byte header for your CODE 

resource. The header places the address of your resource into register 
AO and branches to your main () function. Check the Custom 
Header check box if you plan on adding your own custom header to 
the CODE resource. 

The Rttrs field allows you to select the standard resource 
attributes for your code resource. You can use the pop-up menu 

0 Application 

0 Desk Accessory 

O Oeuice Driuer 

® Code Resource 

Name 

Type 

D Custom Header 

OK 

File Type I???? 

Creator I 1111 

D Multi-Segment 

ID 

Attrs ~~ 

(( Cancel J) 

./ Purgeabl'.~ I 
Locked 
System Heap 
Preloaded 
Protected 

Figure C.3 The CODE resource Set Project Type ..• dialog. 
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(shown to the right of the dialog box in Figure C.3) to set these 
attributes or you can type a value directly in the text edit field. You 
can also use ResEdit to set these flags. 

More on the Project Menu 

Selecting Remoue Objects from the Project menu removes the 
object code for all files in your project. Doing this can significantly 
reduce the size of your project and ensure that you'll have to reload or 
recompile all project files the next time you run your project. Remoue 
Objects if you plan on filing your project away for a while, or to 
ensure that you are using the latest version of all files and libraries 
(such as MacTraps). Bring Up to Date compiles source code and 
loads library files that haven't been compiled or loaded yet. Check 
Link checks the link-worthiness of your project without running it. 

Build Library ... takes the current project and saves it as a binary 
library so it can be used by other projects. Build Application ... (or 
Desk Accessory, Device Driver, or CODE Resource) saves the project 
as a standalone application (or desk accessory, device driver, or CODE 
resource), depending on the project type chosen. 

If you set the Use Debugger flag, the debugger will be launched 
automatically the next time you run your application. The final menu 
item, Run, runs your application as a separate entity. 

The File Menu 

Most of the options in the File menu are self-explanatory (Figure C.4). 
To create a new file, select New. To open an existing file, choose 
Open. You can also open a file by double-clicking its name in the 
Project window. If a file name is highlighted in an edit window, Open 
Selection will open the file. Close will close your file; you are 
prompted to save or discard your changes if any have been made. 

Soue will save the current file you're working on. Saue Rs ••• will 
save your current file under a new name and change the name in the 
Project window. Saue R Copy Rs ... will save your current file under 
a different name and use the original file. Re u e rt will return the 
current file to the saved version of that file. Page Setup ... and 
Print ... perform their usual functions. Transfer ... allows you to go 
directly to another program without going back to the Finder. Quit 
allows you to leave THINK C; you are prompted to save changes in 
any open files. 
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New 8€N 
Open... 8€0 
Open Selection 880 
Close OOW 

Saue 8€S 
Saue Rs ... 
Saue A Copy Rs ••. 
Reuert 

Page Setup ..• 
Print... 8€P 

Transfer .•• 
Quit OOQ 

Figure C.4 THINK C's File menu. 

The Edit Menu 

The Ed It Menu provides options for working on your current file 
(Figure C.5). The Undo, Cut, Copy, Paste, Clear, and Select RH 
menu items are the standard text editing options available on most 
Macintosh applications. Set Tabs & Font ••• allows you to select the 
tab size (usually, one tab every four character positions) as well as the 
font type and size for any open source code file. 

Shi ft Le ft and Shi ft Right will move selected text one tab to the 
right or left. Balance will highlight the code balanced by the nearest 
(), [], or {} before and after the cursor position. 0 p ti on s ••• brings up a 
dialog box that allows you to set the default options for six different 
areas of THINK C (Figure C.6). 

The popup at the top of the 0 pt ions... dialog box allows you to 
select one of Preferences, Language Settings, Compiler 
Settings, Code Optimization, Debugging, and PrefiH (Figure 
C. 7). Each of these settings brings up its own set of buttons and check 
boxes. The Options ••. dialog has a built-in help facility. To find out 
what any specific item does, click on it and a complete description 
appears in the help area toward the bottom of the dialog box. 
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Undo Paste 

Cut HH 
Copy HC 
Paste HU 
Clear 
Select All HA 

Set Tabs & Font ••. 
Shift Left HI 
Shift Right H) 
Balance HB 

Options... H; 

Figure C.5 THINK C's Edit menu. 

® This Project »Copy» O New Projects 

(;] I Preferences 

f" Starch Options ·-·-····--·-·-.. --····----·--···----·--·-·-·1 
! D Whole words only I 
! I 
j 181 Wrap around I 
I 1811 gnore case I 
~--............................. -···-·--·-·-···-·-·· .. ······ ............................................ . 

D Confirm project updates 
D Confirm saues 
D Always compact projects 
D Generate llnk map 
D Projector-aware 

lTM~-1;·;;;;o;,-;t;,;"d~109. c1i;k"~~~ butt;·;·;;;;;·~ore ·~-t·i;;;;-t;:LJs. th;;;~;=~-t~··-·1 
j go to a specific page, or use the arrow button to move to the next or previous pages. ! 
! ! "---·--······-.. ·-·-.. ···-·----·-·---···-·------· .. ·-·--··-····-......................... --·-·-····-.. ··--·-·-.. ···-·--·--·-·-·-·---·········· .. ·· 
( Factory Settings J ([ OK )J Cancel 

Figure C.6 THINK C's Options .•• dialog box showing settings for 
Preferences. 
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../Preferences 
Language Settings 
Compiler Settings 
Code Optimization 
Debugging 
PrefiH 

Figure C.7 The Options ... pop-up menu. 

The Fa ct ory Set tin gs button at the bottom of the dialog box 
resets that screen's settings to the way they were when you first 
installed THINK C. The two radio buttons at the top of the window, 
This Project and New Projects, allow you to set options for the 
current project only or set options that will carry over to all new 
projects. The Copy button allows you to copy settings between these 
two states. 

The Search Menu 

The Search menu (Figure C.8) offers a number of options that allow 
you to find and change text in your files. 

Find ••• brings up a dialog box that allows you to specify a search 
string and, optionally, a replacement string (Figure C.9). Whole 
Words Only restricts search matches to whole words only. Wrap 
Around tells Find ••• to continue searching from the top of the file once 

Find... HF 
Enter Selection KE 
Find Again 386 
Replace 38= 
Replace & Find Again KH 
Replace All 

Find In Ne Ht File KT 

60 To Line ... 
Mark .•. 
Remoue Marker ••• 

Figure C.8 THINK C's Search menu. 
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Search for: Replace with: 

I OldDoEuent I DoEuen~ 
D Whole Words Only D Grep D Multi-File Search 

ne.( ~F~in~d~~)j( Don't Find ) ( Cancel 181 Wrap Rround 

18) Ignore Case 

Figure C.9 The Find ••• dialog box. 

the bottom is reached. Ignore Case tells Find .•• to treat upper- and 
lowercase letters equally. If 6rep is checked, a utility similar to the 
Grep utility in UNIX is run. If Multi-File Search is checked, a dialog 
box is put up to allow you to select which files to search. 

Enter Selection copies any currently highlighted text into the 
Search for: field in the Find ... dialog box. Find Rgain searches for 
the next occurrence of the Search for: text without bringing up the 
dialog box again. Replace replaces the highlighted string with the 
text in the Find ••• dialog's Replace with: field; if there is no string in 
the Replace with: field, the highlighted text is deleted. Replace 
and Find Rgain will replace the highlighted text and search for the 
next occurrence of the Search for: string. Replace RH replaces all 
occurrences of the sought string. Find In NeHt File is used in 
conjunction with the Multi-File Search check box; it continues the 
search with the next file on the list. 

The Source Menu 

The Source menu (Figure C.10) deals with the project source code 
files. Rdd adds the front-most source code file to the project. If Rdd is 
dimmed, the current window has not been saved, or does not have the 
.c suffix. Remo u e removes a file, selected in the project window, from 
the project. Get Info provides a dialog that displays information 
about the current file, such as number of lines of code and data and 
string resources used. Debug sends the current source code file to the 
debugger's source code window. This option is available only when the 
debugger is running. 

Check SyntaH compiles a file to check syntax without adding 
object code to the project. Prep ro c es s creates a new window showing 
the source code as it exists in memory after the first compile pass and 
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Add 
Add ••• 
Remoue 
Get Info 
Debug 001 

Check SyntaH OOY 
Preprocess 
Disassemble 

Precompile .•. 
Compile OOK 
Load Library 
Make... 00\ 

Browser OOJ 

Figure C.10 THINK C's Source menu. 

all #includes and #defines have been applied. Disassemble 
translates a source code file into assembly language, placing the 
output in a new window. 

Precompile •.. rebuilds the selected precompiled header (such as 
<MacHeaders> ). Although you have to have a project open for this 
option to be available, the precompiled header is changed for all 
projects, not just for the one currently open. Compile compiles the 
current source code file, saving the object code in the project file. Load 
Library loads the specified library's object code into the project. 
Make ••• allows you to specify dependencies between your project files 
instead of depending on THINK C's recompilation rules. 

The Windows Menu 

The Windows menu (Figure C.11) controls all of THINK C's 
windows. Clean Up resizes and stacks currently opened windows. 
2 o om resizes the current window to fill the screen; if selected again, 
the window returns to the previous size. Fu 11 Tit I es puts the full path 
of each file in the window's title. Close Rll closes all edit windows. 
Sau e R II saves all edit windows. The remaining items correspond to 
the project window (880) and any other open windows. Selecting a 
window on the list brings it to the front. 
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Clean Up 
Zoom 
Full Titles 
Close All 
Saue All 
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<> Reminder.c 8€1 
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Figure C.11 THINK C's Windows menu. 

Changes to THINK C 

Perhaps the most noticeable change from earlier versions is THINK 
C's tighter typechecking. A common complaint is that source code that 
compiles under THINK C 4 won't compile under THINK C 5, no 
matter how the options are set up. This is true. Here's why: THINK C 
4 played fast and loose with typechecking. For example, this line of 
code: 

window= GetNewWindow( 128, nil, -lL ); 

compiles just fine under THINK C 4 but yields the error 1 as t 
argument to function 'GetNewWindow' does not match proto­
type under THINK C 5. If you run into this type of error, you are 
trying to pass a value of one type in a parameter of another type. The 
solution? Use typecasting when mixing types. For example, this line: 

window= GetNewWindow( 128, nil, (WindowPtr)-lL ); 

compiles without a hitch. You might say that THINK C forces you to 
write cleaner, more maintainable code. 

Another major change is THINK C's commitment to and support of 
the current ANSI C standard. By selecting the appropriate THINK C 
options, you can force your code to adhere exactly to the ANSI 
standard. 

This appendix is meant to provide only an overview of THINK C. 
For detailed information about. THINK C, read the THINK C User 
Manual and Standard Libraries Reference. 



AppendixD 

The Debugger 
Command 
Summary 

This appendix uses Chapter 5's 
WorldClock program as the basis of a 

guided tour through the THINK C 
source level debugger. Fire up your 

Mac and follow along. 
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THINK C's SOURCE-LEVEL debugger allows you to watch your appli­
cation execute, routine by routine and line by line. To use the 
debugger, you'll need at least two megabytes of memory and you 111ust 
be running under either System 7 or MultiFinder. 

This programmer's tour of the debugger uses Chapter 3's Mondrian 
program as an example. If you'd like to follow along, open up your 
WorldClock folder and double-click on WorldClock . 7t. When THINK 
C starts up, select Use Debugger from the Project menu. A check 
mark should appear next to the Use Debugger item, and the project 
window should look like the one shown in Figure D.1. 

Notice the* just under the left edge of the title bar, and the •just 
to the left of the source code file name WorldClock. c . The * tells 
you that the debugger is on. The • next to a file name tells you that 
debugging information is available for that file. Click on the + to turn 
it off and on again. You'll want the • next to any file you plan on 
debugging. 

When you're ready to debug your software, select Run from the 
Project menu. Click Yes to bring the project up to date. If the 
program compiled successfully, the two debugger windows will appear. 

WorldClock. n 
* Name obj size 

l.~ ... ;;_~.~;,;,~~~.'.~ ........................................... , .. ; .. ~ 

Figure D.1 Mondrian's project window with the debugger turned on. 

The Debugger's Source Window 

The window on the left (in this case, labeled WorldClock. 'Jl' ) is the 
debugger's source code window. Using this window, you can scroll 
through your project's source code. Figure D.2 shows the source code 
for WorldClock. c. 

617 
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l /***************************>+c ma in ************* mm 
! void moin( void ) !j!j!j 

I < 

<>
<> •.•. • Too lBox l ni t < >; 

Windowlni t < >; 

II 
<>! MenuBor I n i t o; 

oi 
<>! 
I 
• 

Even tLoop<); 

main 

Figure D.2 The debugger's source code window. 

If your project has more than one source code file, the source code 
window starts off with the file containing the function main (). To 
switch source code files, highlight a source code file name in the 
project window, then select Debug from the Source menu. 

Once you enter the debugger, a dark arrow ( .. ) will appear to the 
left of the first line of code in main() . In Figure D.2, the arrow points 
to the ToolBox init () call. This arrow indicates the line of code that 
the debugger is about to execute. 

The six buttons at the top of the source code window enable you to 
step through your source code in different ways. The I Go I button 
will start executing your program, continuing until a breakpoint is 
encountered (we'll get to those in a minute) or until the program exits. 
The I Step I button executes the line of code the dark arrow is 
~ to, moving the arrow to the next executable statement. The 
~ button executes code until a function call is encountered. 
The arrow stops at the first line of code inside that function. The 
I Out I button executes code until the current function exits, 
stoppinf at the first line of code outside the current function. 

The Trace I button is very similar to the I Step I button. 
A single statement is executed but I Trace I will fall into a function 
if it encounters one. I Step I will never fall into a function-it stays 
at the same level until it hits the end of the current function. 

The diamonds ( o) to the left of the source code are used to set 
breakpoints. If you set a breakpoint next to a line of code, and then 
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press the I Go I button, the debugger will execute until it hits that 
breakpoint. To set up a breakpoint, just click on the appropriate 
diamond. To clear a breakpoint, click on the diamond again. To set up 
a t emporary breakpoint, hold down the command or option key when 
you click on a statement's diamond. The debugger will automatically 
start executing until it hits the breakpoint. Notice that you didn't have 
to hit the I Go I button, and that the breakpoint was cleared once 
the break occurred. 

I 
One really nice feature of the aebugger is that it automatically saves 
your debugging environment between runs. That means that you 
can set a bunch of breakpoints, open a whole series of data 
windows (we'll get to those in a minute), and when you quit the 
debugger, the breakpoints and data windows will be preserved 
exactly as you left them. 

J_, 

The I Stop I button halts execution, if at all possible. For the 
most part, your program must contain an event loop for the 
I Stop I button to work. 

There is a debugger option in THINK C's Options ... dialog box 
that allows you to turn "session saving" on and off. If you have 
this option turned on and you don't want the debugger to run 
with the last session intact, hold down the option key when you 
launch the debugger. If you have the option turned off and yoli 
want to save your current session, select Saue from the 
debugger's File menu. 

~ I I 

Back in the debugger, click on the Go I button. When 
WorldClock's time window appears, click on the debugger's source 
code window to bring it to the front, then click on the I Stop I 
button. Chances are you landed right next to a call to 
Wai tNextEvent ( ) . 

To get to the debugger if the debugger windows are obscUI!eq, 
select THINK C Debugger 5.0 from System 7's active applica­
tion menu on the extreme right end of the menu bar. 
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The field in the lower left-hand corner of the source code window 
indicates the name of the currently executing function. If you click on 
this field, a pop-up menu will appear, listing the names of all the 
functions called to get from main () to where you are now. Selecting 
one of the function names from this menu jumps to that function in 
the source code window. 

The button actions can also be selected from the debugger's Debug 
menu. The first six items correspond to the six buttons at the top of 
the source code window. Remember the Debug menu's command-key 
equivalents. They really come in handy. 

The Debug menu item 60 Unt'I Here is the same as setting a 
temporary breakpoint. If you click on a line of source code and select 
60 Until Here, the debugger will run until that line of code is 
reached. Skip To Here allows you to skip execution of portions of your 
code. Be careful that whatever you are testing doesn't depend on the 

code you arj s~r5 You can Step or I Tr ace I continuously through your pro-
gram if you c ic on these buttons with either the command or the 
option key depressed. To cancel the action, click on the I Stop I 
button or type 38- ~-.(Command-Shift-period). 

Monitor invokes the currently installed monitor (low-level 
debuggers like Macsbug or TMON). EHitToShell halts execution of 
your program and quits to THINK C. 

Finally, check out the S menu's Shortcuts ... item. A dialog box 
appears, allowing you to step through a list of really cool debugger 
shortcuts. Once you've got the debugger down, take the time to step 
through all of the shortcuts. 

The Debugger's Data Window 

Along with the source code window, the debugger also opens up a data 
window. The data window lets you find out' the values of your 
variables as the program runs. To use it, type a C expression in the 
data entry area just under the title bar, then press the 0 button, or 
hit the enter or return key. The expression will appear in the scrolling 
list on the left side of the window, and the value of the expression will 
appear on the right side. Here's an example. 

In the source code window, set a breakpoint in the routine 
HandleFontChoice (),just after the call of Get Item (). This call to 
Get Item() retrieves the name of the font just selected from the Font 
menu. The font's name is stored in the variable fontName. Figure D.3 
shows our setup. 
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Figure D.3 HandleFontChoi ce () with a single breakpoint set. 
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Now, click the I Go I button to jump to the breakpoint. Use the 
cursor to highlight the variable name fontName, as we did in Figure 
D.3. Go to the Edit menu and select Copy To Data. The variable 
font Name will appear on the left side of the data window and, after a 
brief delay, its value will appear on the right side (Figure D.4). 

Notice that fontName's value appears in hex. If you pull down the 
Data menu, you'll see that the Address item is checked. Since we 
want to look at the data as a Pascal string, go back to the Data menu 
and select Pascal String. The data will change from hex to pascal 
string format, as shown in Figure D.5. 

Data 

font.tf•Jme Cl Ox 3BC568 

Figure D.4 The data window with the variable font Name copied to it. 
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Data 0 

fontName "\pGeneva" O 

Figure D.5 fontName viewed as a Pascal string. 

Keeping the data window in view, click I Go to bring the clock 
window to the front. Select a new font from the Font menu. Notice 
that f ontName's new value has been updated in the Data window. 

To clear a variable from the data window, click on the variable's 
name on the left side of the data window and select Clear from the 
Edit menu. To expand a struct, double-click on its name in the data 
window. The debugger will open up a new window, allowing you to 
track all the fields in the struct. 

In the Data menu, you can also Show ConteHt, which displays 
the context for an expression selected in the data window in the source 
window. If you select a line in the source window, you can then Set 
ConteHt to change the context to the line highlighted in the source 
window. If you want to make sure that an expression doesn't change 
its value, select Lock in the Data menu with the desired variable 
highlighted. 

This appendix is meant to provide an overview of the Debugger. For 
more detailed information, read Symantec's THINK C User Manual 
and Standard Libraries Reference. 



AppendixE 

Debugging 
Techniques 
One of the most frustrating experiences 
in programming is running up against 

a really tough bug. In this appendix, 
we'll discuss some techniques for 

hunting down bugs, and some others 
for avoiding them in the first place. 
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Compilation Errors 

THE FIRST Buas you're likely to encounter will pop up during 
compilation, when you've typed in your code and select Run from the 
Project menu. The first sign that something's amiss is the 
appearance of a bug alert, like the one shown in Figure E. l. 

II If 
syntaH error 

II 
Figure E.1 One of the more frustrating bug alerts. 

This alert crops up a lot and seems frustratingly uninformative. 
Syntax errors are usually indicative of a misspelled keyword or bad 
programming grammar. For example, if you misspell #define or type 
something like: 

EventRecord theEvent; 

instead of: 

EventRecord theEvent; 

you'll end up with a syntax error. This happens frequently. Once 
you've clicked away the bug alert, carefully review the line of code 
with the blinking cursor in the left-hand column. If you still can't find 
the bug, check the previous line. Is there a semicolon at the end of the 
line? Is there supposed to be one? 

Missing semicolons can cause several different types of bugs. For 
example, in Chapter 4's Event Tracker. c, we took the semicolon 
away from the end of two different lines and got two different errors­
an invalid declaration error and a missing semicolon error. C 
compilers can be tricky. 

Another popular error message is the xxx has not been 
declared alert. Sometimes this is the result of a missing declaration, 
but often it's the result of a misspelled variable name. Remember, in 
C, upper and lower case are crucially different when it comes to 
identifiers. The variables myPicture and MyPicture are completely 
different. Check your case. 

625 
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Another indicator of a typing error is the illegal character 
error message. Usually, these are pretty straightforward. For 
example, this line of code: 

myVar $ = 27; 

generates the message illegal character '$ '. That seems clear 
enough. This line of code, however: 

myVar . = 27; 

generates the classic syntax error message. Hmmm. So much for 
consistency. 

Indirect Compiler Errors 

An indirect compiler error seems to point to one source but was 
caused by another. The classic example of an indirect compiler 
error is caused by a missing #include file. For example, Chapter 5's 
WorldClock program depends on the #include file <GestaltEqu. h::>. 
This file is not one of the standard #includes automatically included 
by THINK C. If you leave out this #include, you'll get' the error 
message gestaltPopupAttr has not been declared, and THINK 
C highlights the line: 

myErr =Gestalt( gestaltPopupAttr, &feature); 

This error seems pretty easy to figure out. Since you know that 
gestaltPopupAttr is not local to WorldClock, you suspect that you 
left out a #include file. If you scroll through the files in the Apple 
#includes folder, you'll spot the file associated with Gestalt() 
pretty quickly. 

A more difficult item to track down is a variable or constant that 
doesn't necessarily reflect the #include file name in its name. 
For example, what file would you find MAXLONG defined in? As it 
turns out, MAXLONG is defined in <Values. h>. But how would you 
find that out? 

For starters, check out the indexes in the Inside Macintosh X-Ref 
(Revised Edition). If you can't find your reference in there, try using 
THINK Reference, or one of the other Inside Macintosh cross-reference 
tools. As a last resort, open up the files in the Apple #includes 
folder, one at a time, and use the THINK C search utilities. 

Another indirect compiler error stems from not closing your 
comment blocks. For example: 
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/* my 1st comment * 
int i; 

/* my 2nd comment */ 
i 10; 

This code will lead to an 'i' was not declared error. The 
declaration of i was swallowed up by the my 1st comment comment 
block, which was never closed. 

Linker Errors 

If you call a procedure or function in your program that was never 
declared, you'll get a link failed error and a Link Errors window 
will appear, listing the routines that were called but that the linker 
couldn't locate. This error is often the result of a misspelled procedure 
name. For example: 

sysBeeep( 20 ); 

The compiler will accept this line because it will assume that you've 
written a routine called sysBeeep () that will be provided at link time. 

Improving Your Debugging Technique 

Once your program compiles, your next step is to get the bugs out. One 
of the best ways to debug a Mac program is to use a debugger like the 
THINK C debugger described in Appendix D, The Debugger by Steve 
Jasik, or the TMON debugger from ICOM Simulations. Debuggers are 
real lifesavers. 

No matter which debugging tool you use, there are some things you 
can do to improve your debugging technique. 

Being a Good Detective 

When your program crashes or exhibits some unusual behavior, you 
have to be a detective. Did the system error occur just before your 
dialog box was scheduled to appear? Did those wavy lines start 
appearing immediately after you clicked on the OK button? 

The key to being a good detective is having a good surveillance 
technique. Try to establish a definite pattern in your program's mis­
behavior. Can you pinpoint exactly where in your code things started 
to go awry? These clues will help you home in on the offending code. 

If you can't tell by observation exactly when things went sour, don't 
give up. You can always use the binary method of bug control. 
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The Binary Method 

The key to the binary method lies in establishing good boundary 
conditions for the bug. First, you'll need to establish a lower limit, a 
place in your code at which you feel fairly certain the bug has not yet 
occurred. It's best if the lower limit is as close to the actual bug as 
possible, but make sure the bug has not yet happened. 

Next, establish an upper limit in your code, a point by which 
you're certain the bug has occurred (because the system has crashed, 
or the screen has turned green, or whatever). 

To use the binary method, split the difference between the upper 
and lower limits. If the bug still has not occurred, split the difference 
again. Now, if the bug has occurred; you have a new upper limit. By 
repeating this procedure, you'll eventually locate the exact line of 
source code where the bug occurs .. 

There are several different ways to split the difference between two 
lines of source code. If you're using a debugger, you can set a 
breakpoint halfway between the lines of code representing the upper 
and lower limits. Did you hit the breakpoint without encountering the 
bug? If so, set a new breakpoint, halfway between this one and the 
upper limit. 

If you don't have a debugger, use a ROM call like SysBeep () to 
give you a clue. Did you hear the beep before the bug occurred? If so, 
put a new SysBeep () halfway between the old one and the upper 
limit. The nice thing about using SysBeep () is that it is reasonably 
nonintrusive, unlike putting up a new window and drawing some 
debugging information in it, which tends to interfere with your 
program's basic algorithm. 

Recommende<J Reading 

In closing, we'd like to recommend some good reading material: your 
THINK C User Manual! The User Manual is a treasure trove of 
valuable tips for writing and debugging Mac programs. The more you 
know about the Macintosh and the THINK C development environ­
ment, the better you'll be at debugging your programs. 



AppendixF 

Building 
HyperCard 

XCMDs 
The introduction of HyperCard back in 
August 1987 caused quite a stir in the 

Macintosh world. A complete 
programming environment in its own 
right, HyperCard became even richer 

with the addition of XCMDs and 
XFCN s, the standalone code resources 
that allow you to access the raw power 

of THINK C from inside HyperCard. 
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HYPERCARD comes with its own powerful programming language, 
HyperTalk. The designers of HyperTalk thoughtfully provided a 
mechanism for adding extensions to the HyperTalk command set. 
These extensions are code resources of type ' XCMD ' and ' XFCN ' . 

XCMDs (pronounced as X-commands) take a parameter block as 
input from HyperCard, perform some calculations, put the results 
back into the parameter block, and return to the calling script. XFCN s 
(pronounced as X-functions) take the same parameter block as input, 
perform the same types of calculations, but return the results as a C or 
Pascal function would. 

We've written an XCMD called xFinclApplication that takes a four­
character signature as input and returns true if an application with 
that signature is currently running, and returns false otherwise. A 
typical call of xFindApplication looks like this: 

xFindAppli.cation KAHL 
Put the result into card field 1 

We also created an XFCN called fFindApplication that performs the 
same service. A typical call of fFindApplication looks like this: 

Put fFindApplication( KAHL ) into card field 1 

The source code for xFindApplication and fFinclApplication is 
identical. One is saved as an XCMD and the other as an XFCN. We've 
included the source code and project files, as well as a HyperCard test 
stack, on the Mac Primer source code disk (use the coupon on the last 
page). 

The xFind.Application XCMD 

Create a new folder in your Development folder called xF indApp. 
Launch THINK C and create a project called xFindApp. 7t in the 
xFindApp folder. Add MacTraps to the project. Next, add HyperXLib 
to the project. You'll find HyperXLib in the same folder as MacTraps. 

Select New from the File menu and type in the following source 
code: 

#include "HyperXCmd.h" 
#include "Processes.h" 

631 
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/******************************** main *********/ 

pascal void main( XCmdPtr paramPtr 
{ 

OSErr 
ProcessSerialNumber 
ProcessinfoRec 
Boolean 
Str255 

err; 
process; 
info; 
appRunning=false; 
string; 

if ( paramPtr->params[O] ==nil 
SysBeep ( 20 ) ; 

else 

process.highLongOfPSN = O; 
process.lowLongOfPSN = kNoProcess; 

info.processinfoLength = sizeof 
( ProcessinfoRec ); 

info.processName = (StringPtr) NewPtr( 32 ); 
info.processAppSpec = nil; 

while GetNextProcess( &process 
&& !appRunning ) 

noErr 

if ( GetProcessinformation( &process, 
&info) == noErr ) 

appRunning = info.processSignature 
*(long *)*(paramPtr->params[O]) 

BoolToStr( paramPtr, appRunning, string); 
paramPtr->returnValue = PasToZero 

( paramPtr, string); 

Save the file as xFindApp. c and Hdd it to the project. 

Building the XCMD 

Select Set Project Type ... from the Project menu and click on the 
Code Resource radio button. Next, change the settings to match 
those found in Figure F. l. Make sure you change the resource ID to 
128 and the resource type to XCMD. When you're done, click the OK 
button. 
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0 Desk Accessory 

O Deuice Driuer 

® Code Resource 

Name I HFindApplication 
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Figure F.1 The Set Project Type ... dialog for the XCMD. 
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To create a file containing the XCMD resource, select Build Code 
Resource ••• from the Project menu. Click Yes when asked to 
update the project. Once the project compiles, a dialog will appear, 
asking you to name your new code resource file (Figure F.2). Save the 
code resource under the name xFindApplication. Finally, quit 
THINKC. 

I 61 HyperCard HCMD ~ I 
D m:MO.c 
D m:M0,11 

~ 

-0' 
Saue code resource as: 

l8J Smart Link D Merge 

~Tremont 

( E:j•~c1 ) 
( Desktop ) 

€ Saue n 
( Cancel ) 

Figure F.2 The Build Code Resource ... dialog. 
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Adding Your XCMD to a Stack 

Use HyperCard to create a stack to test your new XCMD. Once the 
stack is saved, quit HyperCard and launch ResEdit. Inside ResEdit, 
open the file containing your XCMD. When the main window appears, 
double-click on the XCMD icon. A window similar to the one shown in 
Figure F.3 should appear. Select the XCMD, then copy it to the 
clipboard. Next, open your test stack from within ResEdit and paste 
the XCMD. Quit ResEdit, saving your changes. 

§0~ HCMDs from HfindRpplication ~E!I§ 

Figure F.3 A ResEdit window, listing all XCMDs in the file 
xFindApplication. 

Yo~ can aJso,copy :tbe XOMD ctirectJy:Jnt61.~ete~«.J~Jput work witfl~:=-,·: 
a copy ·to. stay ·on tfle~ safe side •• -XCMD~ witnfo, tf1~. ~~MP~rG~~~t .·':i 
:qpplioatio:n are ·aecessibte.from'~.11 :f:ly~erCar<t$tjj~~··~tJ·~®M,D··ir;!~:~'._:.:J 

:~: '~P:@Qlfic:$t~~~,i$.:,~vatl~pt~:q,nJY,·.~n~lJ:t·that:sta:¢k~ · ,., · ·, .:' 1;~~./:-Z~;:::1 
'' " ';'~- \ 

·~.-~~- .... · ... -· - ~-=~'.··;·,··-·~ 

Test out your stack by creating a field with an ID of 1 and a test 
button within your test stack. Enter this script in the button's script 
editing window: 

on mouseUp 
xFindApplication KAHL 
put the result into card field 1 

end mouseUp 
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Try out your new button. If THINK C is running when you press 
the button, the word true should appear in card field 1. If THINK C is 
not running, the word false should appear. 

Let's take a look at the source code for this XCMD. 

Walking Through the Source Code 

Whenever you write an XCMD or XFCN, you'll start by including the 
file HyperXCmd. h. HyperXCmd. h gives you access to the XCMD 
utilities found in the library HyperXLib. The include file 
Processes. h gives you access to the routines used by the Process 
Manager. 

#include "HyperXCmd.h" 
#include "Processes.h" 

All XCMDs and XFCNs are declared this way. The single param­
eter is a pointer to a HyperCard parameter block. The parameter block 
contains the data passed into and returned from the XCMD. 

/******************************** main *********/ 

pascal void main( XCmdPtr paramPtr 
{ 

OS Err 
ProcessSerialNumber 
Processinf oRec 
Boolean 
Str255 

err; 
process; 
info; 
appRunning 
string; 

false; 

At this point, the input parameter is hidden in the params field of 
the parameter block. params is an array of handles, one handle per 
parameter. Since we're expecting one parameter, we'll check the first 
handle to see if it has any data in it. If the handle is n i 1, we'll beep 
once. Otherwise, we'll go on with the Process Manager code. 

if ( paramPtr->params[O] ==nil ) 
SysBeep( 20 ); 

else 
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Calling SysBeep () from within an XCMD isn't particularly helpful. 
We did it here for illustrative purposes. 

The next chunk of code is specific to the Process Manager. We build 
a process descriptor, passing it to the routine GetNextProcess () . 
GetNextProcess () steps through each running process, checking 
to see if the process's signature matches the signature passed in 
pa ram [ 0 ] . If the signatures match, appRunning is set to t rue and 
the loop exits. The loop a lso exits once all processes have been 
checked. 

process . highLongOfPSN = 0 ; 
process .lowLongOfPSN = kNoProcess ; 

info . processinfoLength sizeof 
( ProcessinfoRec ) ; 

info . processName = (StringPtr) NewPtr( 32 ); 
info . processAppSpec = nil ; 

while GetNextProcess( &process 
&& !appRunning 

noErr 

if GetProcessinformat i on ( &process , 
&info ) == noErr ) 

appRunning = info . processSignature 
* (long *)*(paramPcr- >params[O] ) ; 

The routines BoolToStr () and PasToZero () are part of the 
HyperXLib library. BoolToStr () converts a Boolean value to a 
string format a nd PasToZero () converts a pascal string to a zero­
terminated C string. 

BoolToStr( paramPtr , appRunning , string); 
paramPtr- >returnValue = PasToZero( paramPtr , 

string) ; 



_J 
Getting More Information 

If you plan on developing XCMDs, get the HyperCard Development 
Kit from Claris. You can reach Claris at (800) 325-2747 in the United 
States and at (800) 668-8948 in Canada. The Development Kit will fill 
you in on all the routines that are part of the HyperXLib library and 
will keep you up to date with the latest version of HyperCard. 

To learn more about the Process Manager routines used in this 
appendix, read the Process Manager chapter in Inside Macintosh, 
Volume VI. 
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Macintosh programming fundamentals. Topics include the Macintosh 
interface, compatibility guidelines, the event loop, resources, program­
ming languages and tools, and international software considerations. 
Fall 1992. 

Toolbox Titles 

Inside Macintosh: Macintosh Toolbox Essentials 
Describes how to implement essential user interface components in 
Macintosh applications. Covers the Control, Dialog, Event, Menu, and 
Window Managers, and a discussion of the Finder interface. Fall 1992. 

Inside Macintosh: More Macintosh Toolbox 
Covers the Help, List, Resource, Scrap, and Sound Managers, the 
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discussion of International Resources. Winter 1992. 
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Inside Macintosh: Imaging 
Covers 32-bit QuickDraw, working with color, and picture utilities. 
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Inside Macintosh: Interapplication Communication 
Discusses in-depth collaborative computing, plus chapters describing 
the AppleEvent, and Edition Managers, and the PPC Toolbox. Winter 
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Inside Macintosh: QuickTime Components 
Describes how to use QuickTime components such as clock compo­
nents, image compressors, movie controller, sequence grabbers, and 
video digitizers. Spring 1993. 

Other 

Inside Macintosh: Networking 
Describes how to write software that uses AppleTalk networking 
protocols. Spring 1993. 

Inside Macintosh: Communications 
Covers the Data Access Manager and Communications Toolbox. 
Spring 1993. 

Inside Macintosh: Devices 
Covers the Device, SCSI, Power, Component, Serial, and Slot 
Managers, writing a device driver, and the Apple Desktop Bus. Spring 
1993. 
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Button tool. 296 
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214 
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Copy button, 611 
Copy command, 406, 609 
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CopyDialogToReminder() routine, 324-

326, 355-358 
Copying 

to desk scrap, 406 
icons, 465-466 
settings, 611 

Core event classes, 142 
Count suffix for selector codes, 159 
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CountRemindersOnMenu() routine, 

319, 343, 348-349 
CountResources() routine, 396 
CreateWindowO routine, 482-483 
Creator IDs, 461 
Cross-reference tools, 626 
CToPstr() routine, 32 
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for dialogs, 272 
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tracking, 137, 160 

Cut command, 406, 609 
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Data menu, 621-622 
Data types, 32, 34 
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typecasting, 61, 614 
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dBoxProc windows, 58-59 
Debug command, 612 
Debug menu, 620 
Debugger, The, 627 
Debugging, 9-10, 500 

compilation errors, 625-627 
data window for, 620-622 
and naming standards, 36 
options for, 609 
source window for, 617-620 
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Default items in dialogs, 272, 306, 353, 

374,377 
#define statements 

for dialog boxes, 269 
for EventTracker, 144, 154 
for EventTrigger, 193, 197 
for FlyingLine, 114, 119 
for Hello2, 76, 79 
literals in, 31 
for Mondrian, 89, 93 
names for, 36, 236 
for OpenPICT, 430-431, 437 
for Pager, 385-386, 393-394 
for PrintPICT, 445, 450 
for Reminder, 309-310, 335-336 
for ResWriter, 369, 373-374 
for ShowClip, 407-408, 411-412 
for ShowPICT, 106, 109 
for SoundMaker, 417, 420-421 
for Updater, 170, 177 
for WorldClock, 221-222, 235-236 

DeleteReminder() routine, 321, 344, 
350-351 

DeleteReminderFromMenu() routine, 
320, 342, 349-350 

Dequeue() routine, 338, 342, 351 
Descriptors, 190-191, 484-485, 487 
Desk accessories, menus for, 240, 606 
Desk scrap. See Scrap Manager; 

ShowClip program 
Developer CD Series, 497 
Developer Programs Hotline, 498 
Developer Technical Support, 461 
Development environments, 499 
Device drivers, Project menu for, 606 
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Dialog Manager, initializing, 80 
Dialogs, 261-262 

adding, to programs, 268-275 
alerts, 261, 267, 275-277 
controls for, 262-266 
filters with, 277, 422 
item lists for, 262 
memory for, 356 
modal, 267-268 
modeless, 267-268 
position of, 305, 307, 368-369 
for Reminder, 293-295, 352-358 
resources for, 268-269 
visibility of, 272 
windows for, 58-59 

DialogSelect() routine, 268 
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Dimmed menu items, 204 
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C Libraries, 45-46 
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Disabled dialog items, 273, 275 
Disabled menu items, 204 
Disassemble command, 613 
Disassemblers, 500 
Disk for desk scrap, 405 
diskEvt events, 131, 154 
DisposDialog() routine, 356, 379 
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DisposeReminder() routine, 321, 342, 

351 
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for Pager, 383-384 
for PrintPICT, 445 
for Reminder, 295-303, 352 
for ResWriter, 367-368 
for ShowCJip, 407 
for SoundMaker, 416 

DLOG resources, 39, 262, 268-269, 272 
for Reminder, 305-307, 352 
for ResWriter, 368-369, 376 

DoActivate() routine, 175, 184 
DoAEError() routine, 484-485 
Document windows, 57 
documentProc windows, 57, 59 
Documents 

opening, 138, 158, 162 
printing, 138, 158, 163 

DoDialogs() routine, 447, 451, 453 
DoError() routine 

for OpenPICT, 430, 435, 438, 440, 
443 

for Pager, 392, 394-396, 403-404 
for PrintPICT, 449, 452, 454-455 
for ShowClip, 410, 415 
for SoundMaker, 416, 419, 422-424 

DoEvent() routine, 134-135, 137-138, 
141 

for EventTracker, 148-149, 158, 
160-162 

for Pager, 389, 399 
for Reminder, 313-314, 341 
for Updater, 173, 180 
for WorldClock, 225, 242-243 

DoOpenApp() routine, 149, 158, 162, 
482-484 
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482-487 

DoPictureO routine, 175-176, 182, 188 
DoPrintDoc{) routine, 150, 158, 163, 

482, 487-488 
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482,489 
DoTextDialog() routine, 371-372, 374, 

376-379 
DoUpdate() routine 

for Updater, 175, 181-182 
for WorldClock, 231-232, 239, 244, 

254-255 
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clicks in, 166, 185 
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Dragging windows, 246 
DragWindow() routine, 166, 246 
DrawControls() routine, 255, 381, 399 
DrawEventString() routine, 150, 157-

158, 161-163 
DrawGrowlconO routine, 184, 189 
Drawings. See QuickDraw 
DrawLine() routine, 124, 126 
DrawMenuBar() routine, 241 
DrawMyPicture() routine 

for OpenPICT, 435, 442-443 
for ShowPICT, 107, 109-110 

DrawPicture() routine, 111 
for PrintPICT, 454 
for Updater, 189 

DrawRandomRect() routine, 91, 96, 99-
100, 102-103 

DrawString() routine, 32, 83, 162, 165 
driverEvt events, 132 
Drop shadows, 207-208 
DRVR resources and type, 240, 606 

Edit menu, 609-611 
with Debugger, 621-622 
with Reminder, 284, 288-289, 330 
with WorldClock, 209, 212, 214, 233 

Editable text fields, 273-275, 300-301 
Editing. See also ResEdit 

BNDL resources, 461-464, 466-467 
data forks, 500 

Edition Manager, 480 
Ellipses ( ... ), 261 
Enabled dialog items, 273 
Enabled menus, 212, 214 
EndUpdate() routine, 161, 182-183 
Enqueue() routine, 338 
Enter Selection option, 612 
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EraseRect() routine, 189 
Errors, 261, 267, 275-277. See also 

Debugging 
Event Manager, 129-133 
Eventlnit() routine, 140, 146-147,.155, 

157-159 
EventLoop() routine, 134-135, 141 

for EventTracker, 147-148, 155, 
158-160 

for Pager, 389, 398 
for Reminder, 313, 340 
for Updater, 172, 178, 180 
for WorldClock, 225, 242 

EventRecord structure, 129, 136 
Events, 11, 14, 129 

Apple. See Apple events; 
EventTrigger program 

classes of, 142 
high-level and low-level, 139, 153, 

473 
IDs for, 142, 484 
masks for, 135-136 
and program structure, 133-134 
types of, 130-133 
waiting for, 135-138 

Eventslnit() routine, 194, 198 
EventTracker program, 14 

building, 167-168 
resources for, 143-144 
running, 151-154 
source code for, 144-151, 154-165, 

534-541 
EventTrigger program, 15-16, 190-192 

running, 195-196 
source code for, 193-199, 481-482, 

547-549 
everyEvent constant, 135 
ExitToShell command, 620 
ExitToShell() routine, 82 
Expressions with debugger, 620 
Extended text style, 85-86 
extern statements, 31-32 

Factory Settings button, 611 
Families of icons, 464-467 
Far CODE check box, 606 
Far DATA check box, 606 
feature parameter for Gestalt(), 157, 

159 
FIFO (First In, First Out) queues; 130 
File Manager, 427-429 
File menu, 608-609 

with Reminder, 284, 288, 328-329 
with WorldClock, 209, 212, 214, 233 

File reference numbers, 429 
File system specification, 429, 439, 486 
Files, 424. See also OpenPICT program 

archive, 25-28 
closing, 429, 608 
File Manager for, 427-429 
names for, 426, 428 
opening, 429, 608 
project, 10, 25 
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size of, 429, 440-441 
Standard File Package for, 424-427 
types of, 462-463, 474, 606 
version information for, 476-477 

FillRectl) routine, 122-123 
Filters 

with dialogs, 277, 422 
with file lists, 425-426 
with sending events, 192 

Find Again option, 612 
Find ... command. 611 
FindControH) routine, 245-246, 381, 400 
Finder 

and Apple events, 480-481 
flags with, 282-283, 474-475 
information with, 475-476 
resources for, 459-460, 463, 471-478 
testing database of, 470-471 

FindReminderOnMenu() routine, 318, 
344, 346-34 7 

FindReminderToDispose() routine, 318-
319, 347-348 

FindReminderToPost() routine, 318, 
341-342, 347 

FindWindowO routine 
for EventTracker, 165 
for scroll bars, 381 
for Updater, 184 
for WorldClock, 245 

Flnfo structure, 475-476 
Flags 

Finder, 282-283, 474-475 
SIZE, 152, 328 

Flat file format, 427-428 
FlyingLine program, 13-14, 113 

running, 118 
source code for, 114-125, 529-534 

Folders 
C Libraries, 45-46 
in HFS, 428 
for source code, 25 

Font Manager, 80, 87 
Font menu, 212, 215-216, 233, 240-241, 

251-252 
Fonts, 65-66 

for applications, 84 
for code, 20 
for Hello2, 83-85, 87 
for menu text, 203 
for projects, 42 
for ShowClip, 414 
TrueType,87 

ForeCololi I routine, 96 
Forks,40,393,500 
Formatted text on desk scrap, 414 
FrameArc() routine, 101 
FrameRoundRect() routine, 99 
Frames for windows, 153, 177 
FREF resource, 463, 466, 4 73 
Front Window<) routine 

for Mondrian, 96 
for ShowClip, 413 

for ShowPICT, 110 
for WorldClock, 241 

FSClose() routine, 429 
FSGetFile() routine, 429 
FSpOpenDFO routine, 429, 440 
FSReadO routine, 429, 440-441 
FSSpec,429,439,486 
Full Titles command, 613 
Functions, 30 

for EventTracker, 145, 155 
for EventTrigger, 193, 197 
for FlyingLine, 114, 120 
for Hello2, 76 
for Mondrian, 90, 94 
names for, 36 
for OpenPICT, 431, 437 
for Pager, 386, 394 
for PrintPICT, 446, 451 
prototypes for, 79 
for Reminder, 310-311, 337-338 
for ResWriter, 370, 374 
for ShowClip, 408, 412 
for ShowPICT, 106, 109 
for SoundMaker, 417, 421 
for Updater, 171, 178 
for WorldClock, 222, 237 

General Control Panel, 256 
Gestalt() routine 

for EventTracker, 154, 157 
for EventTrigger, 196, 198 
for OpenPICT, 436, 438 
selector codes for, 159 
for SoundMaker, 420-421 
for WorldClock, 235, 241 

Get Info command, 469, 612 
GetllndResourceO routine, 396 
GetClip() routine, 188, 401-402 
GetCtlValue() routine, 246 
GetDateTimeO routine, 95, 254 
GetDitemO routine, 269-271 

for Reminder, 353, 356-357 
for ResWriter, 377 

GetEOFO routine, 429, 440 
GetFileName() routine 

for OpenPICT, 432, 437-439 
for Reminder, 321-322, 351-352, 354 

GetFirstReminder() routine, 317, 346 
GetFNum() routine 

calling sequence for, 33 
for fonts, 84 
for WorldClock, 252 

GetFontName() routine, 34 
GetlndResource() routine, 396, 402 
Getltem() routine, 251-252 
GetIText() routine, 273-275, 353, 379 
GetMenu() routine, 240, 343 
GetMHandle() routine, 240 
GetNewControl() routine, 241 
GetNewDialog() routine, 267, 269 

for Reminder, 352 
for ResWriter, 376-377 

GetNewMBar() routine, 239 
GetNewWindowO routine, 7 

calling sequence for, 30-31 
for FlyingLine, 122 
for Hello2, 73, 82 
for Mondrian, 95 
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for WIND resources, 60-61 
GetNextEvent() routine, 137 
GetNextProcess() routine, 636 
GetNextReminder() routine, 317, 346 
GetPicture() routine, 111, 113 

for PrintPICT, 452 
for Updater, 182 

GetReminderFromNotification() 
routine, 327, 360 

GetResource() routine, 274 
GetScrapO routine, 404-406, 413-414 
GetStringO routine, 274, 375 
GetWReOC:on() routine, 179, 182 
GetZoneOffsetO routine, 232-233, 

254-257 
gFillColor global variable, 93, 96, 102 
Global coordinate system, 52-54, 248 
Global variables, 81, 121 

for EventTracker, 145, 155 
for FlyingLine, 114, 120 
for Mondrian, 89, 93-94 
naming, 36 
for Pager, 386, 394 
for Reminder, 312, 338 
for Updater, 170, 178 
for WorldClock, 222 

Glossary, 503-520 
Go-away boxes, 56 

clicks in, 166, 185 
in frames, 153, 177 

Go button with debugger, 618-619 
Go Until Here command, 620 
GotRequiredParamsO routine, 485 
GrafPorts, 63 

global variables for, 81 
pointers to, 247 
for printing, 444-445, 454 
saving, 188 
scrolling, 163-165 

Graphical User Interfaces (GUI), 3-5 
Grep check box, 612 
Grid, 51-53 
Grow boxes, 57, 59, 184 
GrowWindowO routine, 185-187 

HandleAppleChoice() routine 
for Reminder, 316-317, 344-345 
for WorldClock, 229, 250-251 

HandleDialog() routine, 322-324, 345, 
352-356 

HandleFileChoice() routine 
for Reminder, 317, 344-346 
for WorldClock, 229, 251 

HandleFontChoice() routine, 229-230, 
241, 251-252 

HandleKeyDown() routine, 137 
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HandleMenuChoice() routine 
for Reminder, 315-316, 344 
for WorldClock, 228-229, 245, 249-

250 
HandleMouseDown() routine, 137, 139 

for EventTracker, 150-151, 160, 
165-166 

for Pager, 390, 399-401 
for Reminder, 315, 341-343 
for Updater, 173-174, 184-190 
for WorldClock, 226-227, 243-247 

HandleNull() routine 
for Reminder, 314, 341-342 
for WorldClock, 226, 242, 244 

Handles, 113, 248, 379 
for desk scrap, 405, 413 
for memory, 112, 378-379 
for menu data, 240 
for print records, 453 
for regions, 164 

HandleStyleChoice() routine, 230-231, 
252-254 

Hard drive requirements, 20, 25 
Hardware, information on, 157 
Headers 

for CODE resources, 607 
for PICT files, 440-441 

Headers & Libs.sea archive, 26 
Hello, World program 

creating, 40-42 
running, 43-48 
source code for, 43, 523 

Hello2 program, 69 
project file for, 75 
resources for, 70-75 
running, 78 
signature for, 461 
source code for, 76-77, 79-83, 523· 

524 
variants of, 83-88 

HELO resources, 466 
Help and Help Manager, 478-480 

editing, 500 
for Options command, 609 
resources for, 479 

HideWindowO routine, 61 
Hierarchical File System (HFS), 428 
Hierarchical menus, 203, 206, 215, 240 
High-level events, 139, 153, 473 
Highlighted menu items, 204 
HiliteControlO routine, 273, 353, 373 
HiliteMenuO routine, 250 
HiWord() routine, 249 
HLock() routine, 377, 414 
Hours menu, 289-290, 293, 330 
How to Write Macintosh Software, 

Third Edition (Knaster), 497 
HyperCard, 10, 18 

buttons in, 264 
forks for, 40 
XCMDs for, 631-637 

Hyper'I'alk, 631 

HyperXCmd.h file, 635 
HyperXLib file, 635 

Icon edit panel, 464-465 
Icons 

color for, 465-466 
in dialog boxes, 266 
families of, 464-467 
masks for, 465 
with menu items, 204 
for notifications, 278-281, 331 
resources for, 307-308, 333, 356, 464 
for standalone applications, 463-4 71 
with stationery pads, 473 
testing, 467-468 

ICxx icon resources, 464 
Identifiers, errors with, 625 
Ignore Case option, 612 
Illegal characters, 626 
In button with debugger, 618 
Inactive pop-up states, 207 
#include statements, 31 

errors from, 626 
for EventTracker, 144, 154 
for EventTrigger, 193, 196-197 
for OpenPICT, 430, 436 
for Pager, 385, 393 
for PrintPICT, 445, 450 
for Reminder, 309, 335 
for SoundMaker, 417, 420 
for Updater, 170, 177 
for WorldClock, 221, 235 

inContent part code, 185 
Indentation style, 35 
Indirect compiler errors, 626-627 
inDrag part code, 166, 185 
InfoScrapO routine, 404-405 
InfoWorld magazine, 493 
inGoAway part code, 166, 185 
InitCursorO routine, 80 
lnitDialogs() routine, 80 
InitFonts() routine, 80 
InitGraft) routine, 80 
InitMenusO routine, 80-81 
INITs, 606 
InitWindows() routine, 80-81 
lnsertMenu() routine, 240 
InsertReminderlntoMenuO routine, 

319,348 
Inside Macintosh, 8, 20, 29, 493-496, 

645-646 
Inside Macintosh X-Ref, 626 
Installing Think C, 25-29 
inSysWindow part code, 166, 184-185, 

343 
Intelligence At Large, 501 
Interfaces, 3-5 
International Resources, 254 
International Utilities Package, 255 
InvalRect() routine 

for Updater, 186-188 
for WorldClock, 244 

lnvertArcO routine, 101 
lnvertRoundRect() routine, 100 
IsDialogEvent() routine, 268 
lsHighBitSet() macro, 237 
isStationery flag, 474 
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Italic text style, 66, 85-86 
IUTimeString() routine, 235, 254 

Job dialog box, 261, 450, 453 

kAEOpenApplication event, 138, 142, 
153, 158, 480-483 

kAEOpenDocuments event, 138, 142, 
158,461,471,480-487 

kAEPrintDocuments event, 138, 142, 
158, 191, 481-482, 487-488 

kAEQuitApplication event, 138, 142, 
158, 481-482, 489 

kCoreEventClass constant, 142, 191 
Keyboard, repeat rate for, 131, 154, 243 
keyDown events, 130, 243 
KeyRepThresh global variable, 131 
KeyThresh global variable, 131 
keyUp events, 131 
kHighLevelEvent constant, 139 

Labels for pop-up menus, 218-219 
Language Settings options, 609 
LaunchApplication() routine, 281-283 
Launching applications with Reminder, 

334 
LaunchParamBlockRec structure, ~282 
LaunchResponse() routine, 327, 357, 359 
Learn Con the Macintosh (Mark), 8 
Length byte in Pascal strings, 32 
Libraries, 10, 27, 45-47 
Lines, drawing, 63-64 
Lineslnit() routine, 116, 120, 123 
LineTo() routine, 63-64· 
Link Errors window, 44-45 
"Link failed" dialog box, 44 
Linking 

data, 480 
object files, 44-45, 627 

Literal parameters, 31 
Load Library command, 613 
LoadPICTO routine, 447, 451 
LoadPICTFile() routine, 433-434, 437-

442 
LoadScrap() routine, 404-405 
Local coordinate system, 53-55, 621 248 
LocalToGlobal() routine, 248 
Lock command, 622 
Low-level events, 139 
Lower limits in debugging, 628 
LoWordO routine, 249 

Mac Programming 101 series, 501 
Macintosh Developer Technical 

Support (MacDTS), 498 
Macintosh File System (MFS), 4270.428 
Macintosh Inside Out series, 497 
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Macintosh interface, 4-5 
Macintosh Programmer's Workshop 

<MPWJ, 9, 499 
Macintosh Revealed, 8 
Macintosh Technical Notes, 20, 496-498 
Macintosh Toolbox. See Toolbox 
MacNosy debugger, 500 
MacsBug debugger, 500 
MacTraps file, 77 
MacTutor magazine, 493, 501 
MacUser magazine, 493 
MacWorld magazine, 493 
Main event loops, 135 
main() routine, 68, 134-135 

for EventTracker, 145, 155 
for EventTrigger, 193-194, 197 
for FlyingLine, 114, 120 
for Hello2, 76, 79-80 
for Mondrian, 90, 94 
for OpenPICT, 431, 437-438 
for Pager, 386, 394-395 
for PrintPICT, 446, 451 
for Reminder, 312, 338-339 
for Res Writer, 370, 375 
for ShowClip, 408, 412 
for ShowPICT, 106, 109 
for SoundMaker, 417-418, 421-422 
for Updater, 171, 178 
for WorldClock, 223, 238 
for XCMD, 632, 635 

Main text, 19 
MainLoop< I routine 

for FlyingLine, 116, 123-124 
for Mondrian, 91, 95-96, 102-103 
for ShowClip, 409-410, 413-415 

Make ... command, 613 
Managers, 6 
Map Control Panel, 234-235 
Masks 

for events, 135-136 
for icons, 465 

MaxApp!ZoneO routine, 421 
MAXLONG constant, 137, 393 
MBAR resources, 208 

for Reminder, 285-286 
for WorldClock, 210-211, 239 

MBarHeight global variable, 121 
Memory 

for applications, 283, 421 
for desk scrap, 404-406 
for dialogs, 356 
for editing resources, 37 
handles for, 112, 378-379 
for PICT files and resources, 182, 

441 
for regions, 188 
requirements for, 20 
for windows, 60, 74, 82 

Menu bars, 203-204 
drawing, 81 
rectangles with, 122 

Menu lists, 239 

Menu Manager, 80-81 
MENU resources, 38, 208 

for Reminder, 286-293 
for WorldClock, 212-218 

MenuBarlnit() routine 
for Reminder, 312-313, 339-340 
for WorldClock, 224, 239-242 

MenuKey() routine, 243 
Menus. See also WorldClock program 

adding, to programs, 208-209 
components of, 203-205 
hierarchical, 203, 206, 215, 240 
items on, 204 
pop-up. See Pop-up menus 
THINK C, 605-614 
titles for, 204, 208, 218-219 

MenuSelect() routine, 243, 245 
message field for WaitNextEvent(), 136 
Message string resources, 4 77 
Minutes menu, 290-291, 294, 330 
Modal dialogs, 267-268 
ModalDialog() routine, 267-269, 272-

273, 353 
for ResWriter, 378 
for SoundMaker, 422 

Modeless dialogs, 267-268 
Modes 

file access, 429 
text, 66-67 

modifiers field for WaitNextEvent(), 
136 

Mondrian program, 13, 64-65 
resources for, 88-89 
running, 92-93 
source code for, 89-98, 524-527 
variants of, 98-103 

Monitor command, 620 
mouseDown events, 130, 137, 139 

for EventTracker, 150-151, 154, 
160, 165-166 

for Pager, 390, 399-401 
for Reminder, 315, 341-343 
for scroll bars, 381 
and SIZE resource, 4 73 
for Updater, 173-174, 184-190 
for WorldClock, 226-227, 243-247 

mouseMoved events, 133, 137 
mouseRgn parameter for 

WaitNextEvent(), 137 
mouseUp events, 130 

with EventTracker, 154 
and SIZE resource, 473 

Movable modal dialog boxes, 268 
MoveTo() routine, 62, 84, 165 
Moving windows, 55 
Multi-File Search option, 612 
Multi-Segment check box, 606 
MultiFinder-Aware flag, 472 

Name Project dialog box, 41 
Name string resources, 477-478 
Names 

Index 

for accessories and device drivers, 
606 

for #define statements, 236 
for files, 426, 428 
for projects, 41, 70 
for resources, 39, 42, 74 
for source code, 10, 42 
for variables and functions, 36 

networkEvt events, 132 
New command, 608 
New Project ... command, 605 
New Projects button, 611 
NewControlO routine, 379-380, 393, 

396 
NewHandle() routine, 413, 444 
NewRgnO routine, 188 
NewWindow() routine, 119, 122, 268 
NMinstallO routine, 279-280, 350 
NMRec structure, 280-281 
NMRemove() routine, 280, 360 
noGrowDocProc windows, 57-59 
NormalResponse() routine, 326, 357, 

359 
Note alerts, 275-277 
NoteAlert{) routine, 276-277, 345 
Notification Manager, 278-281 
Null events, 130, 160 

background,257,472 
masking, 135 
for WorldClock, 242 

Object code 
linking, 44 
in project files, 605 
removing, 608 
resources for, 42 

OK buttons, 264, 272 
creating, 296-298 
position of, 277 

Open command, 425, 608 
Open Project command, 40-41, 605 
Open Selection command, 608 
OpenDeskAcc() routine, 251, 345 
Opening 

applications, 138, 158, 162 
documents, 138, 158, 162 
files,429,608 
projects, 40-41, 605 

OpenPICT program, 429 
resources for, 430 
running, 436 
source code for, 430-443, 593-597 

Options ... command, 609-610, 619 
osEvt events, 133 

with EventTracker, 154 
flags for, 152 

Out button with debugger, 618 
Ovals, 64-65, 88-103 

P-RAM,256 
Page Setup ... command, 263, 449, 453, 

608 
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Page setup information, 444 
Pager program 

resources for, 382-385, 402 
running, 392-393 
source code for, 385-404, 581-587 

Pages, printing, 444, 454 
PaintArc() routine, 102 
PaintOvalO routine, 96 
PaintRect() routine, 98, 123 
PaintRoundRect() routine, 98 
Parameter RAM, 256 
Parameters 

for Apple events, 484-485, 487 
for functions, 31 
passing, 33-34 
typecasting and typechecking, 61, 

614 
ParamText() routine, 274, 394, 403 
Parentheses for functions, 31 
Part codes, 165-166 
Partition (K) field, 606 
Partners program, 497 
Pascal 

case-sensitivity in, 31 
data types in, 30 
stringsin,32,621 

Pascal String option with debugger, 
621 

Paste command, 609 
PasToZero() routine, 636 
Patterns 

fill, 123 
for pens, 62 

PCWeek magazine, 493 
PenMode() routine, 62, 64, 122 
PenPat() routine, 62 
Pens, drawing, 62, 100 
PenSizeO routine, 62 
Periodicals, 493 
PICT files and format. See also 

OpenPICT program; PrintPICT 
program 

for desk scrap, 404, 406, 411, 414 
in dialog boxes, 266 
icons for, 466-467, 469-470 
with QuickDraw, 67 

PICT resources, 67 
displaying, 103-113 
memory for, 182 
for Pager, 385, 402 
for PrintPICT, 445 
for ShowPICT, 105 
for Updater, 168-170 

Pixels, 52 
plainDBox windows, 58-59 
PlaySound() routine, 419-420, 422-424 
Pointers, 112, 247 
Points data type, 34 
Pop-up menus, 203, 206-208 

for Reminder, 293-295, 330, 358 
for WorldClock, 212, 215-219, 234 

Pop·up rectangles, 206 

portRect field, 97 
Position 

of buttons, 277 
of dialogs, 305, 307, 368-369 
of scroll bars, 380 
of windows, 71-72 

PostReminder() routine, 321, 342, 350 
PrCloseDoc() routine, 444 
PrClosePageO routine, 444 
Precompile command, 613 
Preferences options, 609, 611 
Prefix options, 609 
Preprocess command, 612 
PrError() routine, 454 
Previewing 

dialogs, 304, 306 
windows, 72-73 

Print ... command, 608 
Print Job dialog box, 261, 450, 453 
Printjobs, 444 
Print records, 444, 453 
PrintDefault() routine, 453 
printf() routine, 45 
Printing documents, 138, 158, 163, 482, 

487-488 
Printing Manager, 443-444. See also 

PrintPICT program 
Printlnit() routine, 447, 451-453 
PrintMonitor application, 279 
PrintPICT program, 443-444 

resources for, 445 
running, 449-450 
source code for, 445-455, 598-601 

PrintPicture() routine, 448, 450-451, 
454-455 

Priorities 
with sending events, 192 
of windows, 60-61 

PrJobDialogO routine, 444, 453 
PROCEDUREs, 30 
Process Manager, 281-283 
Processes.h file, 635 
ProclD: field, 73 
Programming for System 7, 497 
Programs, structure of, 68-69, 133-142. 

See also Applications 
Project files, 10 

for Hello2, 75 
for old versions, 25 

Project menu, 605-608 
Projects 

creating, 40-42 
running, 43-48 
source code for, 43 

PrOpen() routine, 444, 453 
PrOpenDoc() routine, 444, 454 
PrOpenPage() routine, 444, 450, 454 
prototypes, function, 79 
PrPicFileO routine, 444, 454 
PrStlDialog() routine, 444, 453 
PtoCstr() routine, 32 
PtToAngle() routine, 34 

Pull-down menus, 203 
Purgeable windows, 74 
PutScrap() routine, 404-406 

Queues 
event, 129-130 
notification, 279-281 
reminder, 338, 346-34 7, 360 

QuickDraw, 13, 20 
coordinate system for, 51-56 
for dialogs, 271 
for FlyingLine, 113-125 
for Hello2, 69-88 
initializing, 80 
for Mondrian, 88-103 
for ShowPICT, 103-113 
Toolbox for, 62-69 
windows for, 56-61 

Quit command, 608 

Radio buttons, 265, 270 
Random numbers, 81, 95 
Random() routine, 98 
Randomize() routine 

for FlyingLine, 117, 125 
for Mondrian, 92, 97-98 

RandomRect() routine 
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for FlyingLine, 116-117, 124 
for Mondrian, 92, 97 

randSeed global variable, 81, 95 
rDocProc windows, 57-59 
Reading, opening files for, 429 
ReadLocationO routine, 255 
RecalcLine() routine, 117-118, 125-126 
Recording sound. See SoundMaker 

program 
RecordSound() routine, 418-419, 422-

423 
Rect structure, 33 
Rectangles 

drawing, 54 
with menu bars, 122 
pop-up, 206 
rounded-comer, 64-65 
zoom state, 24 7 

Redrawing windows, 165 
Reference constants, 179, 182, 219 
Regions, 67-68 

content, 97, 185 
drag, 56-57, 153, 177 
handles to, 164 
memory for, 188 
and mouseMoved events, 137 
for redrawing windows, 165 
update, 183, 186-187 

Registering signatures, 461 
Reminder program, 15, 17, 284 

ALRT resources for, 303-305 
CNTL resources for, 293-295 
DITL resources for, 295-303, 352 
DLOG resources for, 305-307, 352 
MBAR resources for, 285-286 
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MENU resources for, 286-293 
running. 328-334 
SICN resources for, 307-308, 333, 

~~/i6 

source code for, 309-327, 335-360, 
!>60-fi78 

ReminderRec !'tructure, 336 
Reminch·rs menu, 292-293 
RemO\·e command, 612 
Remo\'c Objects command, 608 
RenumlwrTrailingRemindersO routine, 

:~20. 349-350 
Repeat rates. keyboard, 131, 154, 243 
Replacing text. 612 
reply parameter with DoOpenDoc(), 

.JS:J 
Required events. See Apple events; 

EventTrigger program 
ResEd it. 7 -8 

for Finder information, 476 
obtaining. ;37 
with Toolbox, 36-37 
for WIND resources, 59-60 

ResEdit Complete, 497 
ResEdit Info window, 37 
ResErrorl 1 routine, 376 
Resolvc:\JiasFilel >routine, 360 
Resourn· forks, 40, 393 
Resource IDs, 39, 59-61, 73 

for menus, 213-214, 236 
numbering of, 93 

Resoun'l' Utilities.sea archive, 28 
Resou1TPrer resource editor, 480, 500 
Resource:;. 4. 7-8, 38-40 

attributes for, 607-608 
for dialogs, 268-269 
for EventTracker, 143-144 
file•:-; for. 78 
Finder, 459-460, 463, 471-478 
for Hello2, 70-75 
help. 479 
for icons, 307-308, 333, 356, 464 
for menus. 208-209 
for Mondrian, 88-89 
namef' for, 39, 42, 74 
for OpenPICT, 430 
for Pager, 382-385, 402 
for PrintPICT, 445 
for Reminder, 285-307 
for ResWriter, 367-369, 374-377 
for ShowClip, 407 
for ShowPICT, 104-105 
for Soundl\faker, 416 
for Updater, 168-170 
for versions, 476-477 
for \\lorldClock, 210-220 
writing out. See Res Writer program 

Respornw procedures, 279, 281 
ResWritt•r program, 365-366 

resources for. 367-369 
running, 372-373 
source code for, 369-379, 578-581 

Revert command, 608 
RgnHandle, 164 
ROM (read-only memory) for Toolbox, 

36 
Rounded-corner rectangles, 64-65 
Routines, names for, 36 
Run command, 608, 617 
Running 

EventTracker, 151-154 
EventTrigger, 195-196 
FlyingLine, 118 
Hello, World, 43-48 
Hello2, 78 
Mondrian, 92-93 
OpenPICT, 436 
Pager, 392-393 
PrintPICT, 449-450 
Reminder, 328-334 
ResWriter, 372-373 
ShowClip, 411 
ShowPICT, 108 
SoundMaker, 419-420 
Updater, 176-177 
WorldClock, 233-235 

Sample applications, 11-12 
Save command, 425, 608 
Save A Copy As ... command, 608 
Save All command, 613 
Save As ... command, 425, 608 
Saving 

debugging environment, 619 
files, 425-426, 608 
GrafPorts, 188 
projects, 41 
windows, 613 

Scaling fonts, 87 
ScheduleReminder() routine, 320, 345 
Scrap Manager, 404-406. See also 

ShowClip program 
ScrapStuff structure, 405 
Screen saver program, 113-125 
screenBits global variable, 81 
Scripts, 255 
Scroll bars, 57. See also Pager program 

creating, 379-382 
as dials, 265-266 

ScrollProcO routine, 388-389, 397-398, 
401 

ScrollRect() routine, 163-165 
scrxxx text modes, 66-67 
Search menu, 611-612 
Seeds for random numbers, 81, 95 
Segmentation, code, 40 
Select All command, 609 
Selected menu items, 204 
Selecting files, 425 
Selector codes, 159 
Select Window() routine, 185 
Self-extracting archives, 25-28 
Semicolons(;), 625 
SendEventO routine, 195, 198 

Index 

Sending Apple events. See 
EventTrigger program 

Separate STRS check box, 606 
Separator lines in menus, 212-213 
Serial numbers for applications, 283 
Set Context command, 622 
Set Project Type ... command. 151-152, 

4 72, 605-607, 633 
Set Tabs & Font ... command. 609 
SetClipO routine, 188 
SetCtlValue() routine, 269-271, 355 
SetDialogCancelltem() routine, 272, 

353,374,377 
SetDialogDefaultltem() routine, 272, 

306,353,374,377 
SetDialogTracksCursorO routine, 272, 

353, 374-375, 377 
SetHandleSize() routine, 378 
SetHighByte() macro, 237 
SetIText() routine, 273-275 

for Reminder, 353, 355 
for ResWriter, 374, 377 

SetMenuBarO routine, 239, 340 
SetPort() routine, 63 

for dialogs, 271 
for FlyingLine, 122 
for Hello2, 83-84 
for Pager, 395 
for printing, 444 

SetRectO routine, 122 
SetupReminderMenu() routine, 315, 

343 
SetUpScrollBar() routine, 387-388, 393, 

395-396 
SetUpZoomPosition() routine, 227-228, 

246-249 
SetWRefCon() routine, 179 
Shadow text style, 85-86 
Shapes 

of cursors, 81 
draY.ing, 64-65 

Shift Left command, 609 
Shift Right command, 609 
Shortcuts ... command, 620 
Show Context command, 622 
ShowClip program, 406 

resources for, 407 
running, 411 
source code for, 407-415, 587-590 

Show PICT program, 13-14, 103. See 
also Updater program 

resources for, 104-105 
running, 108 
source code for, 106-113, 527-529 

ShowWindow() routine, 61 
for dialogs, 272 
for EventTracker, 156 
for Hello2, 83 
for Pager, 395 
for Updater, 180 

SICN resources, 281, 307-308, 333, 356 
Signatures, 191, 460-461, 480 
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Simple controls, 218 
Single-stepping, 618, 620 
Size 

of buttons, 296 
of files, 429, 440-441 
of menu text, 203 
of object code, 42 
of pens, 62, 100 
of resources, 378 
of text, 66, 86-88, 203 
ofwindows, 177,185-188 
ofWorldClock, 257 

Size boxes, 57, 59, 184 
SIZE flags, 152, 328 
SIZE resource, 151-152, 472-473, 606 
SizeWindow() routine, 186 
Skip To Here command, 620 
sleep parameter for WaitNextEvent{), 

137, 393 
SndPlay() routine, 420, 423 
SndRecordO routine, 416, 422-423 
Software 

development tools for, 499-501 
information on, 157 

Sound with notifications, 278-279, 281, 
331 

SoundMaker program 
resources for, 416 
running, 419-420 
source code for, 417-424, 590-592 

Source code 
editor for, 10 
for EventTracker, 144-151, 154-165, 

534-541 
for EventTrigger, 193-199, 481-482, 

547-549 
for FlyingLine, 114-125, 529-534 
folder for, 25 
font for, 20 
for Hello, World, 43, 523 
for Hello2, 76-77, 79-83, 523-524 
for Mondrian, 89-98, 524-527 
names for, 42 
for old versions, 25 
for OpenPICT, 430-443, 593-597 
for Pager, 385-404, 581-587 
for PrintPICT, 445-455, 598-601 
for Reminder, 309-327, 335-360, 

560-578 
for ResWriter, 369-379, 578-581 
for ShowClip, 407-415, 587-590 
for ShowPICT, 106-113, 527-529 
for SoundMaker, 417-424, 590-592 
sources of, 501 
for Updater, 170-184, 541-547 
for WorldClock, 220-233, 235-257, 

549-560 
for XCMDs, 633, 635-636 

Source code window for debugger, 617-
620 

Source menu, 612-613 
Spaces in source code, 43 

Spacing of text, 66 
Specialmenu,209,212,214,216,233 
Spooling, 444 
Squares, 64-65 
Stacks, adding XCMDs to, 634-635 
Stages, alert, 275 
Standalone applications, 10, 83 

BNDL resources for, 461-464, 466-
467 

EventTracker, 167-168 
Finder resources for, 459-460 
icons for, 463-471 
signatures for, 460-461 

Standard File Package, 424-427 
Standard Get File dialog box, 425 
Standard Put File dialog box, 426 
Standard window state, 24 7 
StandardFileReply structure, 426-427 
StandardGetFile() routine, 351-352, 

354,425,427,429,439 
StandardPutFileO routine, 426-427 
Standards in C, 35-36 
Static text fields, 273-274, 297, 300-301 
Stationery pads, 473-475 
Step button with debugger, 618, 620 
Stop alerts, 275-277 
Stop button with debugger, 619 
StopAlertO routine, 276-277, 394, 403 
'STR ' resources, 38, 27 4 

for ResWriter, 365-367, 374-375, 
377 

types of, 477-478 
STR# resources, 27 4 
Str255 data type, 32, 34 
Strings, 34 

C versus Pascal, 32 
concatenating, 358-359 

Style menu, 212, 215-217, 233-234, 240-
241, 252-254 

Styles, text, 66, 85-86 
Submenus,206,215,240 
Subscribing to editions, 480 
SuperCard, 10 
Suspend & Resume Events flag, 4 72 
Syntax errors, 625-627 
SysBeep() routine, 82, 246 

for debugging, 628 
inXCMD,636 

System 7, 6, 19, 21 
System files, resource forks in, 393 
System fonts, 84 

loading, 80 
for menu text, 203 

System global variables, 121. See also 
Global variables 

System windows, clicks in, 166, 184-
185, 245, 343 

System Click() routine, 166, 245, 343 
System Task() routine, 137 

Table suffix for selector codes, 159 
Tabs in source code, 43 

Target addresses, 190, 192 
TCL 1.1 Demos.sea archive, 27 
Tech blocks, 19 
Tech Notes, 20, 496-498 
Technical references, 496-497 
Technical support, 461, 498-499 
TEinit() routine, 80 
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Templates, stationery pads as, 473-475 
Text 

in dialogs, 273-274 
drawing, 65-67, 85-88 
for menus, 203 

TEXT files and format 
for desk scrap, 404, 406, 411, 414 
icons for, 466-467, 469-470 

TextBoxO routine, 414 
TextEdit, initializing, 80 
TextFace( J routine, 85-86 
TextFont() routine, 84, 252 
TextSize() routine, 86-88 
theAEEventClass parameter for 

AEinstallEventHandler< ), 142 
theAppleEvent parameter for 

DoOpenDoc(), 483 
thePort global variable, 81 
THINK C, 8-11 

changes to, 614 
debugger in, 617-622 
Edit menu in, 609-611 
File menu in, 608-609 
installing, 25-29 
Project menu in, 605-608 
Search menu in, 611-612 
Source menu in, 612-613 
Toolbox access with, 29-40 
Windows menu in, 613-614 

THINK C Debugger 5.0 file, 28 
THINK C User Manual, 628 
THINK C Utilities.sea archive, 28 · 
THINK C 5.0 Demos.sea archive, 26 
THINK C 5.0 file, 28 
THINK C 5.0 Utilities fi1e, 36-37 
THINK Class Library 1.1.sea archive, 

27 
32-bit mode and SIZE resource, 473 
This Project button, 611 
Thumb, 57, 398 
Time, displaying. See WorldClock . 

program 
Time outs with sending events, 192 
Time Zone menu, 217-218 
Titles 

for menus, 204, 208, 218-219 
for windows, 72, 613 

TMON debugger, 500, 627 
Toolbox, 3-4, 6, 20-21, 29 

calling sequences for, 30-31 
#include, #define, and extern 

statements with, 31-32 
parameter passing with, 33-34 
for QuickDraw, 62-69 
ResEdit with, 36-37 
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resources with, 38-40 
standards for, 35-36 
strings with, 32 

ToolBoxlnit() routine, 76, 79-81 
TopLeft< l macro, 236, 248 
TPrint records, 452 
Trace button with debugger, 618, 620 
TrackBox< l routine, 187, 246 
TrackControl( J routine, 246, 381, 393, 

397, 400-401 
Transfer ... command, 608 
Trap addresses, 495 
Triangles in menus, 206, 208 
TrueType fonts, 87 
Two-pass compiling, 31 
Type suffix for selector codes, 159 
Typecasting, 61, 614 
Typechecking, 614 
Typefaces, 65-66 
Types 

of events, 130-133 
of files, 462-463, 474, 606 
of projects, 605-607 
of resources, 38-39 
of windows, 57-59 

Underline text style, 66, 85-86 
Undo command, 609 
UnionRect( J routine, 33 
UnloadScrap( J routine, 404-405 
Update regions, 183, 186-187 
updateEvt events, 131, 153, 161, 177 
Updater program, 15-16 

mouseDown events in, 173-174, 
184-190 

resources for, 168-170 
running, 176-177 
source code for, 170-184, 541-547 

Update Window() routine, 391, 397, 399, 
401-403 

Upper limits in debugging, 628 
Use Debugger command, 608, 617 
User-defined events, 132-133 
User groups, 501 
User items in dialog boxes, 266-267, 

271 
User window state, 247 

Variables 
global See Global variables 

monitoring, 621-622 
names for, 36 

vers resource, 476-477 
Version suffix for selector codes, 159 
Versions, resource for, 476-477 
Visibility of windows, 61 
Volumes, 427 

WaitNextEvent() routine, 135-138 
for EventTracker, 158 
for modeless dialogs, 268 
for Pager, 393 
for Reminder, 340 
for Updater, 180 
for WorldClock, 242, 244 

Warnings,19,261,267,275-277 
WDEFs,606 
what field for WaitNextEventO, 136 
when field for WaitNextEvent(), 136 
where field for WaitNextEvent(), 136 
white global variable, 81 
White space, 43 
Whole Words Only option, 611 
Width 

ofpens, 100 
of windows, 72 

'WIND' Characteristics dialog box, 72-
73 

WIND resources, 38-39, 59 
for EventTracker, 143-144 
for Hello2, 70-74 
for Mondrian, 88-89 
for OpenPICT, 430 
for Pager, 382-383 
problems with, 82 
for ShowClip, 407 
for ShowPICT, 104-105 
for Updater, 168-169 
for WorldClock, 220 

Window Manager, 13, 56, 80-81, 177 
Windowlnit() routine 

for EventTracker, 146, 156 
for FiyingLine, 115, 119, 121-123 
for Hello2, 76-77, 79, 82-88 
for Mondrian, 90-91, 95, 100 
for OpenPICT, 434, 442 
for Pager, 387, 395 
for ShowClip, 409, 413 
for ShowPICT, 107, 109-110 
for Updater, 171-172, 179-180 

Index 

for WorldClock, 223-224, 238-239 
Windows 

activating, 131-133 
closing, 56, 166, 185 
creating, 122, 482-483 
current, 63 
dragging, 246 
frames for, 153, 177 
on grid, 52-53 
memory for, 60, 74, 82 
moving, 55 
part codes for, 165-166 
parts of, 56-57 
position of, 71-72 
redrawing, 165 
saving, 613 
setting up, 59-61 
size of, 177, 185-188 
types of, 57-59 
update regions in, 183, 186-187 
visibility of, 61 

Windows menu, 613-614 
WorldClock program, 15, 17, 209 

CTRL resources for, 218-219, 241 
MBAR resources for, 210-211, 239 
MENU resources for, 212-218 
running, 233-235 
source code for, 220-233, 235-257, 

549-560 
variants of, 257-258 
WIND resources for, 220 

Wrap Around option, 611 
WriteLocation() routine, 255 
WriteResource() routine, 274, 375 
Writing applications, 11-12 • 
Writing out resources. See Res Writer 

program 
wStorage parameter for 

GetNewWindow(), 60 

XCMDs, 18, 631-637 
XFCNs,631 
xFindApplication XCMD, 631-636 

ZeroScrap() routine, 404-406 
Zoom boxes, 57, 59, 73, 153, 177 
Zoom command, 613 
Zoom state rectangles, 247 
Zoom Window() routine, 246 
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